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Information in this document is subject to change without notice. No part of this document may be 
reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without 
the express written permission of: 
 

Sonotron NDT, 4, Pekeris st., Rabin Science Park, Rehovot, Israel, 76702 
 
 
Covered by the United States patents 5524627, 5952577, 6545681; other US & foreign patents pending 
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Sonotron NDT 
4, Pekeris str., Rabin Science Park, Rehovot, 76702, Israel 
Phone:++972-(0)8-9477701          Fax:++972-(0)8-9477712 

http://www.sonotronndt.com 
 

EC Declaration of Conformity  
 
 

Council Directive 89/336/EEC on Electromagnetic Compatibility, as amended by 
Council Directive 92/31/EEC & Council Directive 93/68/EEC 
Council Directive 73/23/EEC ( Low Voltage Directive ), as amended by Council 
Directive 93/68/EEC 
   
We, Sonotron NDT Ltd., 4 Pekeris Street, Rehovot, 76702 Israel,  
certify that the product described is in conformity with the Directives 73/23/EEC and 
89/336/EEC as amended  
 

ISONIC / ISONIC 2001 
 

Ultrasonic Testing and Defect Recording Workstation and Accessories 
 

The products identified above comply with the requirements of the above EU directives by 
meeting the following standards: 
 
Safety 

EN 61010-1:1993 
EMC 

EN 61326:1997  
EN 61000-3-2:1995 /A1:1998 /A2:1998 /A14:2000 
EN 61000-3-3:1995  
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Declaration of Compliance 

 
 

We, Sonotron NDT Ltd., 4 Pekeris Street, Rehovot, 76702 Israel certify that the product 
certify that the product described is in conformity with the ASME Code as amended 
 

ISONIC / ISONIC 2001 
 

Ultrasonic Testing and Defect Recording Workstation and Inspection and True To 
Location Defects Imaging Software Packages 

 
The products identified above comply with the requirements of the following rules: 
 

•  ASME Section I – Rules for Construction of Power Boilers 
•  ASME Section VIII, Division 1 – Rules for Construction of Pressure Vessels 
•  ASME Section VIII, Division 2 – Rules for Construction of Pressure Vessels. Alternative 

Rules 
•  ASME Section VIII Article KE-3 – Examination of Welds and Acceptance Criteria 
•  ASME Code Case 2235 Rev 6 – Use of Ultrasonic Examination in Lieu of Radiography 

 
 

  
 

 

http://www.sonotronndt.com/
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FCC Rules 
 
This ISONIC / ISONIC 2001 workstation (hereinafter called ISONIC / ISONIC 2001) has been tested and found to comply with the limits 
for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
•  Reorient or relocate the receiving antenna 
•  Increase the separation between the equipment and receiver 
•  Connect the equipment into an outlet on a circuit different from that to which the receiver is connected 
•  Consult the dealer or an experienced radio/TV technician for help 
 
Safety Regulations 

 
Please read this section carefully and observe the regulations in order to ensure your safety and operate the system as intended 
 
Please observe the warnings and notes printed in this manual and on the unit 
 
The ISONIC / ISONIC 2001 has been built and tested according to the regulations specified in EN60950/VDE0805. It was in perfect 
working condition on leaving the manufacturer's premises 
 
In order to retain this standard and to avoid any risk in operating the system, the user must make sure to comply with any hints and 
warnings included in this manual 
 
Depending on the power supply you ordered the ISONIC / ISONIC 2001 complies with protection class I /protective grounding/, 
protection class II, or protection class III 
 
Exemption from statutory liability for accidents 
 
The manufacturer shall be exempt from statutory liability for accidents in the case of non-observance of the safety regulations by any 
operating person 
 
Limitation of Liability 
 
The manufacturer shall assume no warranty during the warranty period if the equipment is operated without observing the safety 
regulations. In any such case, manufacturer shall be exempt from statutory liability for accidents resulting from any operation 
 
Exemption from warranty 
 
The manufacturer shall be exempt from any warranty obligations in case of the non-observance of the safety regulations 
The manufacturer will only warrant safety, reliability, and performance of the ISONIC / ISONIC 2001 if the following safety regulations 
are closely observed: 
 
•  Setting up, expansions, re-adjustments, alterations, and repairs must only be carried out by persons who have been authorized by 

manufacturer 
•  The electric installations of the room where the system is to be set up must be in accordance with IEC requirements 
•  The system must be operated in accordance with the instructions 
•  Any expansions to the system must comply with the legal requirements, as well as with the specifications for the unit concerned 
•  Confirm the rated voltage of your ISONIC / ISONIC 2001 matches the voltage of your power outlet 
•  The mains socket must be located close to the system and must be easily accessible 
•  Use only the power cord furnished with your ISONIC / ISONIC 2001 and a properly grounded outlet /only protection class I/ 
•  Do not connect the ISONIC / ISONIC 2001 to power bar supplying already other devices. Do not use an extension power cord 
•  Any interruption to the PE conductor, either internally or externally, or removing the earthed conductor will make the system 

unsafe to use /only protection class I/ 
•  Any required cable connectors must be screwed to or hooked into the casing 
•  The system must be disconnected from mains before opening 
•  To interrupt power supply, simply disconnect from the mains 
•  Any balancing, maintenance, or repair may only be carried out by manufacturer authorized specialists who are familiar with the 

inherent dangers 
•  Both the version and the rated current of any replacement fuse must comply with specifications laid down 
•  Using any repaired fuses, or short-circuiting the safety holder is illegal 
•  If the system has suffered visible damage or if it has stopped working, it must be assumed that it can no longer be operated 

without any danger. In these cases, the system must be switched off and be safeguarded against accidental use 
•  Only use the cables supplied by manufacturer or shielded data cable with shielded connectors at either end 
•  Do not drop small objects, such as paper clips, into the ISONIC / ISONIC 2001 
•  Do not put the ISONIC / ISONIC 2001 in direct sunlight, near a heater, or near water. Leave space around the ISONIC / ISONIC 

2001 
•  Disconnect the power cord whenever a thunderstorm is nearby. Leaving the power cord connected may damage the ISONIC / 

ISONIC 2001 or your property 
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•  When positioning the system unit, monitor, and keyboard, take into account any local or national regulations relating to ergonomic 
requirements. For example, you should ensure that little or no ambient light is reflected off the monitor screen as glare, and that 
the keyboard is placed in a comfortable position for typing 

•  Do not allow any cables, particularly power cords, to trail across the floor, where they can be snagged by people walking past 
•  The voltage of the External DC Power Supply below 12 V is not allowed for the ISONIC 2001 unit 
•  The voltage of the External DC Power Supply above 24 V is not allowed for the ISONIC 2001 unit 
•  If the voltage supplied by the external DC Power supply is between 12 V and 19 V then the use of the internal battery inside the 

ISONIC 2001 unit is not allowed. Oppositely it may damage the circuits controlled the internal battery charge / discharge and 
temperature monitoring, causing further internal battery overheating and destroying 

•  Charge of the internal battery either inside the ISONIC 2001 unit or outside is allowed only with use of the AC/DC converters / 
chargers supplied along with the unit or authorized by Sonotron NDT 

•  Charge of the internal battery inside the ISONIC 2001 unit is not allowed if the unit is suited with the soft carrying case 
 
Remember this before: 
 
•  balancing 
•  carrying out maintenance work 
•  repairing 
•  exchanging any parts 
 
Please make sure batteries, rechargeable batteries, or a power supply with SELV output supplies power 
 
Software 
 
ISONIC / ISONIC 2001 is a software controlled inspection device. Based on present state of the art, software can never be completely 
free of faults. ISONIC / ISONIC 2001 should therefore be checked before and after use in order to ensure that the necessary functions 
operate perfectly in the envisaged combination. If you have any questions about solving problems related to use the ISONIC / ISONIC 
2001, please contact your local Sonotron NDT representative 
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1. Introduction 
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ISONIC is the computerized workstation for ultrasonic non-destructive testing and defects recording. The 
main features of the ISONIC are: 
 
Fully objective acquisition, storing and representing of the ultrasonic inspection data observed 
through 
 

•  Mechanics-free monitoring and imaging of the location and orientation of the probe manually 
manipulated over the object under test (X,Y,Z coordinates and swiveling angle) 

•  Monitoring and imaging of the coupling degree for the probe manually manipulated over the 
object under test 

•  Creating of the background image of the scanning plan in accordance with the dimensions of 
object under test and necessary coverage  

•  Creating the background image of the inspected volume (projection views or 3D) 
•  Imaging of the actual scanning performance and testing integrity 
•  Receiving, recording and real time processing of the signals 
•  Real time imaging of the defects either projection views or 3D 
•  Observing the unique Defects Outlining Technology (DOT) while scanning manually 
•  On the spot creating and storing of the fully objective inspection data files 
•  Measuring and sizing defects 

 
Intelligent postprocessing of the stored inspection data provided by 
 

•  Generating of the fully objective Inspection Report 
•  Interactive off-line evaluation of the stored defects at the different sensitivity thresholds 
•  Filtering and zooming of the stored images 

 
ISONIC meets the requirements of ASME Code Case 2235 Rev 6 “Use of Ultrasonic Inspection in Lieu of 
Radiography” 
 
ISONIC Implementation: 
 
 

♦  PC based ( ISONIC ) – the workstation on 
board of the industrial host computer 
either Lap Top or Desk Top 

  
 

♦  Portable ( ISONIC 2001 ) – the 
workstation styled as portable flaw 
detector with the original all purpose extra 
miniature PC on board 

 
 

 
 

  
Note: the Laptop based units are still in the field but 
not in production since 2002. The Desktop based 
units are manufactured as per special orders 
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2. Principles of Operation and Technical 
Data Sheet 
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2.1. Principles of Operation 
 

The principles of the ISONIC operation are explained with reference to the below picture illustrating: 
•  a planar butt weld  
•  the typical setup to perform the angle beam pulse echo inspection of this weld through the scanning 

above the adjacent material from one side  
•  the corresponding ISONIC instrument screenshot taken during the entire scanning 
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•  ISONIC instrument generates the background images of the 
� Scanning Plan 
� Top View 
� Side View  
� End View 

related to the inspected volume - the images are stipulated by the dimensions of the said volume and by 
the number of the suitable parameters such as Scan Index, Skip Distance, Probe Angle, etc. 
 

•  The typical angle beam probe (search unit) is clamped into the probe holder, which is a hand held 
implement for manipulation by an operator 

 
•  The operator grips probe holder and applies probe to the object under test then manipulates it over the 

scanning area 
 
•  ISONIC instrument transmits the ultrasonic pulses toward the volume under test, detects signals 

reflected there from via the probe, and measures the received signals  
 
•  There are two emitters of airborne ultrasound equipping the probe holder. There are two receivers of 

airborne ultrasound placed on the object under test; said receivers detect the emitters' pulses. ISONIC 
instrument determines the probe coordinates and swiveling angle through the detected travel time of 
airborne ultrasound 

 
•  Vibrator emits the low frequency noise into the object under test. The low frequency noise saturating the 

volume of the object under test is available for pick up by the probe at any point of the scanning area. 
ISONIC instrument determines the coupling degree through the measuring level of the received low 
frequency noise 

 
•  ISONIC instrument images the actually observed probe trace through the on-line correlating between 

the current coupling degree and the probe coordinates and swiveling angle. The image of the actually 
observed probe trace represents the testing integrity 

 
•  On the said testing integrity image ISONIC instrument continuously generates the perceptible marks 

corresponding to the current coupling degree and the probe location and swiveling angle 
 
•  ISONIC instrument generates and records the projection images of the defects in 3 planes through the  

on-line correlating between the signals received by the probe from the volume under test, the probe 
coordinates and swiveling angle, and the coupling degree  

 
•  ISONIC instrument provides the recording, storing and off-line representing, postprocessing and 

documentation for all above data 
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2.2. Technical Data Sheet 
 
2.2.1. Special Data 
 
Mechanics Free Airborne Ultrasound Monitoring of the Probe Position and Swiveling Angle: 
 

 
Area of probe manipulation: 

 
≤≤≤≤2000××××3000 mm 

≤≤≤≤80××××120 in 

 
≤≤≤≤500××××500 mm 

≤≤≤≤20××××20 in 

 
≤≤≤≤200××××200 mm 

≤≤≤≤8××××8 in 
 
Curvature radius of the 
scanning surface: 

 
≥≥≥≥2000 mm 

≥≥≥≥40 in 

 
≥≥≥≥200 mm 

≥≥≥≥8 in 

 
≥≥≥≥37 mm 
≥≥≥≥1.5 in 

 
Scanning Speed: 

 
≤≤≤≤150 mm/s  

≤≤≤≤6 in/s 

 
≤≤≤≤150 mm/s  

≤≤≤≤6 in/s 

 
≤≤≤≤150 mm/s  

≤≤≤≤6 in/s 
 
Scan Index: 

 
1 to 20 mm 

controllable in 1 mm 
step 

 
1 to 20 mm 

controllable in 1 mm 
step 

 
0.25 mm; 0.5 mm or 

1 to 20 mm 
controllable in 1 mm 

step 
 
Resolution for the determining 
of probe coordinates: 

 
≥≥≥≥1 mm 
≥≥≥≥0.04 in 

 
≥≥≥≥1 mm 
≥≥≥≥0.04 in 

 
≥≥≥≥0.25 mm 
≥≥≥≥0.01 in 

 
Resolution for the determining 
of probe swiveling angle: 

 
 
- 

 
 

1o 

 
 

0.5o 
 
Range of the probe swiveling: 

 
- 

 
±±±±90o 

 
±±±±90o 

 
Immunity to the ambient noise: 

 
≤≤≤≤60 dB 

 
≤≤≤≤60 dB 

 
≤≤≤≤60 dB 

 
Skip Distance Range – angle 
beam weld inspection 
applications: 

 
0.5 to 2 skips 

controllable in 0.5 
skip step 

 
0.5 to 2 skips 

controllable in 0.5 
skip step 

 
0.5 to 2 skips 

controllable in 0.5 
skip step 

 
Coupling Monitor for Any Kind of Ultrasonic Probe: 
 

Resolution  ≥≥≥≥0.5 dB 
 

Scanning Speed ≤≤≤≤150 mm/s // ≤≤≤≤6 in/s 
 
Monitoring of the Testing Integrity: 
 

Background imaging of the scanning plan 
 

Recording and imaging of the actual probe trace (testing integrity) 
 

Generating perceptible marks corresponding to the current coupling degree, probe position and 
swiveling angle whilst scanning 

 

Interrupting the recording and imaging of the actual probe trace on missing coupling and/or probe 
position and swiveling angle 
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Defects Imaging 
 

Inspection: Angle Beam Straight Beam 
 
Image Type (depending on 
Application): 

 
•  B-Scan 
•  C-Scan 
•  D-Scan 
•  P-Scan 
•  TOFD 

 
•  B-Scan 
•  D-Scan 
•  C-Scan 
•  P-Scan 

 
Width of the Volume under test: 

 
5 to 300 mm controllable in 
1 mm resolution – 
expandable /// 
0.2 to 12 in controllable in 
0.01 in resolution - 
expandable 

 
50 to 2000 mm controllable 
in 1 mm resolution – 
expandable /// 
0.2 to 80 in controllable in 
0.01 in resolution – 
expandable 

 
Thickness of the Volume under test: 

 
5 to 300 mm controllable in 
1 mm resolution – 
expandable /// 
0.2 to 12 in controllable in 
0.01 in resolution - 
expandable 

 
0.5 to 300 mm controllable 
in 0.1 mm resolution – 
expandable /// 
0.02 to 12 in controllable in 
0.01 in resolution - 
expandable 

 
Image Resolution: 

 
0.5 mm ×××× 0.5 mm ×××× 0.5 • 
Scan Index ×××× ≤≤≤≤2dB /// 
0.02 in ×××× 0.02 in ×××× 0.5 • 
Scan Index ×××× ≤≤≤≤2dB 

 
0.2 mm ×××× 0.5 mm ×××× 0.5 • 
Scan Index ×××× ≤≤≤≤2dB /// 
0.01 in ×××× 0.02 in ×××× 0.5 • 
Scan Index ×××× ≤≤≤≤2dB 

 
Resolution for the Dynamic Tuning of 
the Gate Delay / Width: 

 
 
0.01 µµµµs over whole volume 

 
 

not necessary 
 
Imaging Protocol: 

 
•  Raw data 
•  SAFT 
•  TOFD 
•  Custom 

 
•  Raw data 
•  SAFT 
•  Custom 

 
Standard Color Scale (Palette): 

 
•  Pseudo Color 
•  Gray 
•  Thermal 

 
•  Pseudo Color 
•  Gray 
•  Thermal 

 
User Defined Color Scales: 

 
≤≤≤≤232 colors 

 
≤≤≤≤232 colors 

 
Coloring Protocol: 

 
•  Linear 
•  TCG Normalizing 
•  DAC Normalizing 
•  DGS Normalizing 
•  Custom 

 
•  Linear 
•  TCG Normalizing 
•  DAC Normalizing 
•  Custom 
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Inspection Report File / Printout: 
 

Pre Inspection Data – description of the object under test, scope of the test, calibration dumps, 
etc. 

 

Main Inspection Data – testing integrity evidence (Scanning Pattern), the defects images and 
the parameters of the inspection procedure 

 
Communicating to the Central Office PC:    
 

Internet / Ethernet communicating to the Office PC: 
� Off-Line 
� Real Time transaction of the Defects, Testing Integrity Images and Signals (while 

scanning) accompanied with the calibration dump – IP Protocol (option) 
 
Postprocessing: 
 

3D - defects measuring and sizing 
 

Comprehensive Kit of the Image Processing Features 
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2.2.2. General Data 
 
Ultrasound Velocity: 300 to 20000 m/s controllable in 1 m/s resolution - expandable 

11.81 to 787.4 in/ms controllable in 0.1 in/ms resolution – expandable 
 

Probe Angle:  0…90o controllable in 1o resolution 
 

Probe Delay:  0 to 70 µµµµs controllable in 0.01µµµµs resolution - expandable 
 

Angle Probe X-value: 0 to 50 mm controllable in 1 mm resolution – expandable 
0 to 2 in controllable in 0.01 in resolution – expandable 

 

On-Board Computer  
for ISONIC 2001 
at least:   Pentium – 300MHz, 128M RAM, 10G HDD 
 
Host Computer for 
the industrial  
Desk Top  
implementation 
at least:   Pentium III – 500 MHz, 128M RAM, 30G HDD 
 

Operating System: Windows-98 SE or higher 
 
Interfaces:  LAN (Ethernet), COM, LPT 
 
Screen:   super VGA, 640X480, High Color Resolution (32 bit), Sun-readable 
 
Controls:  All Functional Sealed PC Keyboard, Mouse Pointer, Touch Screen 
 
Powering:  100 – 240 VAC, 40 – 70 Hz, auto-switch; 12 – 24 VDC; Internal Battery 
 
Dimensions:  265X157X300 mm /// 320X190X300 mm with the handle 
 
Weight:   ≤≤≤≤ 6.5 kg with the battery 
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2.2.3. UDS3-3 – ISONIC Pulser Receiver (Internal Flaw Detector Card) – 
Technical Data Sheet (obsolete since Sep 1, 2004) 
 
Pulser  
 

Pulse Type: Negative Spike Pulse 
 

Initial Transition: ≤≤≤≤5 ns (10-90%) 
 

Pulse Amplitude: – 140 to – 210 V into 50 ΩΩΩΩ 
 – 170 to – 310 V into 250 ΩΩΩΩ

 

Pulse Duration: 10 to 70 ns for 50 ΩΩΩΩ load depending on Energy and Damping 
 

Energy: 4 discrete energy values / 12 µµµµJ (min) to 120 µµµµJ (max) 
 

Modes: Single / Dual 
 

Damping:   16 discrete resistances values / 24.7    ΩΩΩΩ  min to 333 ΩΩΩΩ max 
 

PRF: 0 ... 5000 Hz controllable in 1 Hz step 
 

Sync Output / Input: Max +5V, ττττ    ≤≤≤≤ 5 ns, t ≥≥≥≥100 ns, Load Impedance ≥≥≥≥ 50 ΩΩΩΩ 

  

 

 

  

 Software Controlled Sync Feature 
 
Receiver 
 

Gain:    0...110 dB controllable in 0.5 dB or coarser steps  
 

Advanced Low Noise Design: 93 µµµµV peak to peak input  
referred 80 dB gain / 35 MHz bandwidth 

 

Frequency Band: 0.001 … 35 MHz Wide Band / 15 Sub Bands: 
 

0.001 – 35 MHz
0.3 – 35 MHz

1 – 35 MHz
5 – 35 MHz 

0.001 – 25 MHz
0.3 – 25 MHz

1 – 25 MHz
5 – 25 MHz

 

0.001 – 15 MHz 
0.3 – 15 MHz 

1 – 15 MHz 
5 – 15 MHz 

 

0.001 – 10 MHz
0.3 – 10 MHz

1 – 10 MHz
5 – 10 MHz

 
 

Display: RF 
 Rectified: Full Wave / Negative or Positive Half Wave 
 Signal's Spectrum (FFT)

 

Reject: 0 ... 99 % of screen height controllable in 1% resolution 
 

Absolute Sensitivity: 120 dB 
 

DAC / TCG:   Available for both Rectified and RF Display 
 

DAC / TCG Dynamic Range: 40 dB 
 
DAC / TCG Slew Rate: 160 dB/µµµµs

 

Range: 0.5 ... 3000 µµµµs - controllable in 0.01 µµµµs resolution 
 

 Delay: 0 ... 3200 µµµµs - controllable in 0.01 µµµµs resolution 
 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 27 of 550  

Other Features: 
 

DAC Capacity:   ≤≤≤≤ 40 points 
 

DGS Support:   Standard Library for 18 probes / unlimitedly expandable 
 
Gates:    2 Independent Gates  / unlimitedly expandable 
 

Gate Start and Gate Width: Controllable over whole Delay / Range Variety  
    in 0.1 mm /// 0.001 in resolution 

     Drag and Drop setup supported 
 

Gate Threshold:   5 to 95 % of the A-Scan height controllable in 1 % resolution 
     Drag and Drop setup supported 

 

Measure Functions – Digital 
Display readout:   27 automatic functions  / expandable 
  

Freezing and Zooming:  A-Scans 
    Spectrum Graphs 
  

Storing Capacity:  Practically Unlimited (at least 1,000,000 sets) including the  
� Calibrations 
� A-Scans 
� Spectrum Graphs 

  

Data Reporting:   Printing Out (hard copy):  
� Calibrations 
� A-Scans 
� Spectrum Graphs 

     
Internet / Ethernet communicating to the Office PC: 
Real Time transaction of the current A-Scan or Spectrum Graph 
Along with the calibration dump (option) 
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2.2.4. UDS3-4 – ISONIC Pulser Receiver (Internal Flaw Detector Card) – 
Technical Data Sheet 
 

Pulser  
 

Pulse Type: 
 

Initial Transition: 
 
Pulse Amplitude: 
 
 
 
 
Pulse Duration: 
 
 
 

Energy: 
 
 

Modes: 
 

Damping: 
 

Internal Matching Coil – 
Probe Impedance 
Matching: 
 

PRF: 
 

Sync Output / Input: 

Positive Spike Pulse  / Positive Square Pulse 
 

≤≤≤≤5 ns (10-90%) 
 

Spike Pulse Square Pulse 
200 to 500 V into 1000 ΩΩΩΩ 

  

 

200 to 500 V into 500 ΩΩΩΩ 

  

 

200 to 500 V into 250 ΩΩΩΩ 

  

 

180 to 400 V into 75 ΩΩΩΩ 

  

 

150 to 320 V into 50 ΩΩΩΩ    
 

10 to 70 ns for 50 ΩΩΩΩ load 
depending on Energy and 

Damping 
 

4 discrete energy values / 40 µµµµJ 
(min) to 250 µµµµJ (max) 

400 V into 1000 ΩΩΩΩ 

  

 

400 V into 500 ΩΩΩΩ 

  

 

400 V into 250 ΩΩΩΩ 

  

 

400 V into 75 ΩΩΩΩ 

  

 

400 V into 50 ΩΩΩΩ    
 

  

 

65 to 600 ns  
controllable in 5ns step 

  

 

 
 

 

Single / Dual 
 

21 discrete resistances values / 13 ΩΩΩΩ min to 1000 ΩΩΩΩ max 
 

 
16 discrete inductivity values / 2 µµµµH min to 78 µµµµH max 

 
0 ... 5000 Hz controllable in 1 Hz resolution 

 

Max +5V, ττττ    ≤≤≤≤ 5 ns, t ≥≥≥≥100 ns, Load Impedance ≥≥≥≥ 50 ΩΩΩΩ 

  

 

Software Controlled Sync Feature 
 

Receiver 
 

Gain: 0...120 dB controllable in 0.5 dB or coarser steps 
 

Advanced Low Noise Design: 93 µµµµV peak to peak input 
 referred 80 dB gain / 35 MHz bandwidth 
 

Frequency Band:  0.35 … 35 MHz Wide Band / 34 Sub Bands: 
 

Bandpass 
 

0.35 – 35 MHz 
0.7 – 35 MHz 
1.4 – 35 MHz 
2.8 – 35 MHz 

7 – 35 MHz 
10.5 – 35 MHz 

 

Resonant 
 

0.5 ± 0.15 MHz 
1 ± 0.3 MHz 
2 ± 0.6 MHz 
4 ± 1.2 MHz 
10 ± 3 MHz 

15 ± 4.5 MHz 

 
 

0.35 – 19.5 MHz 
0.7 – 19.5 MHz 
1.4 – 19.5 MHz 
2.8 – 19.5 MHz 

7 – 19.5 MHz 
10.5 – 19.5 MHz 

 
 

0.35 – 13 MHz 
0.7 – 13 MHz 
1.4 – 13 MHz 
2.8 – 13 MHz 

7 – 13 MHz 
10.5 – 13 MHz 

 

 
 

0.35 – 5.2 MHz 
0.7 – 5.2 MHz 
1.4 – 5.2 MHz 
2.8 – 5.2 MHz 

 

 
 

0.35 – 2.6 MHz 
0.7 – 2.6 MHz 
1.4 – 2.6 MHz 

 

 
 

0.35 – 1.3 MHz 
0.7 – 1.3 MHz 

 

 
 

0.35 – 0.65 MHz 

 

Display: RF 
 Rectified: Full Wave / Negative or Positive Half Wave 
 Signal's Spectrum (FFT)

 

Reject: 0 ... 99 % of screen height controllable in 1% step 
 

Absolute Sensitivity: 140 dB 
 

DAC / TCG:   Available for both Rectified and RF Display 
 

DAC / TCG Dynamic Range: 40 dB 
 

DAC / TCG Slew Rate: 160 dB/µµµµs
 

Range: 0.5 ... 3000 µµµµs - controllable in 0.01 µµµµs resolution 
 

 Delay: 0 ... 3200 µµµµs - controllable in 0.01 µµµµs resolution 
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Other Features: 
 

DAC Capacity:   ≤≤≤≤ 40 points 
 

DGS Support:   Standard Library for 18 probes / unlimitedly expandable 
 
Gates:    2 Independent Gates  / unlimitedly expandable 
 

Gate Start and Gate Width: Controllable over whole Delay / Range Variety  
    in 0.1 mm /// 0.001 in resolution 

     Drag and Drop setup supported 
 

 Gate Threshold:   5 to 95 % of the A-Scan height controllable in 1 % resolution 
     Drag and Drop setup supported 

 

Measure Functions – Digital 
Display readout:   27 automatic functions  / expandable 
  

Freezing and Zooming:  A-Scans 
    Spectrum Graphs 
  

Storing Capacity:  Practically Unlimited (at least 1,000,000 sets) including the  
� Calibrations 
� A-Scans 
� Spectrum Graphs 

  

Data Reporting:   Printing Out (hard copy):  
� Calibrations 
� A-Scans 
� Spectrum Graphs 

     
Internet / Ethernet communicating to the Office PC: 
Real Time transaction of the current A-Scan or Spectrum Graph 
Along with the calibration dump (option) 

 
Encoder Interface:  Built In interface for the incremental one-axis mechanical  

encoder 
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3. ISONIC Components 
 



ISONIC Workstation from Son

The example of the typical accessories accompanying the electronic unit of the ISONIC (ISONIC 2001) 
includes:  
 

•  Set of Acoustic Sensors for Mechanics Free Monitoring Location (X,Y,Z), Swiveling Angle and 
Acoustic Coupling of Manually Manipulated Ultrasonic Probe: 
� Double Emitter of Airborne Ultrasound - 1 piece (S 4050) 
� Single Emitter of Airborne Ultrasound - 1 piece (S 4060) 
� Airborne Ultrasound Receiver - 2 pieces (S 4030A) 
� Emitter of Acoustic Coupling Monitor Signal With Magnetic Attachment - 1 piece (S 4010) 
� Holder for Airborne Ultrasound Receivers with Magnetic Attachments to the Object Under Test - 

1 set (S 2040 B) 
•  Holders for Standard Ultrasonic Probes with Receiver of Acoustic Coupling Monitor Signal inside: 

� Probe Holder for MWB type Ultrasonic Probes with Rear Connector - 1 piece (S 4070) or probe 
holder for any other type of ultrasonic probe 

� Probe Holder for SWB type Ultrasonic Probes with Rear Connector - 1 piece (S 4080) or probe 
holder for any other type of ultrasonic probe 

•  Long Single Cable System (6m) - 1 (S 70010) 
•  Carrying Case for Sensors and Accessories - 1 piece (S 20001) 

 

 
Refer also to the Packing List coming

 
 
 
 
 
 
 

 

  

 

S 4070
otron NDT - Operating  

 with your unit 
S 4050
S 4030A
Manual – Revision 8.00 - P
S 4030A
S 4010
 S 70010
S 2040B
age 31 of 550 
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4. Operating the ISONIC 
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Please read the following information before you use the ISONIC Instrument. It is essential to read and 
understand the following information so that no errors occur during operation, which could lead damaging of 
the unit or misinterpretation of the inspection results 

 
4.1. Preconditions for ultrasonic testing with ISONIC 
 
The operator of ISONIC must be certified as at least Level 2 Ultrasonic Examiner additionally having the 
adequate knowledge of 
 
•  operating digital ultrasonic flaw detector 
•  basics of computer operating in the Windows environment including turning computer on/off, keyboard, 

touch screen and mouse / trackball / touch pad manipulations, starting programs, saving and opening 
files 

 



IS

4.2. ISONIC Controls 
 

4.2.1. ISONIC 2001  
 

Units manufactured before May 31, 2001 
 
 
 
 

 
 
 
 
 
 
 

 
 
� 
 

(a) 

(b) 
 
 

Power Switch Parallel Port (LPT) 

Serial Port (COM)

s.VGA Output

DC Input (12-24 V)

Battery USB Ports 
(Optional)

Coaxial Jumpers Inputs

Analogue Interface 
UDS3-3 Ultrasonic 
Flaw Detector PC 

Card 
Waterproof Sealed 
Keyboard 
ONIC Workstation from Sonotron NDT - Operating Manual –  

The PCMCIA Socket replaces the UDS3-3 Card in the ISONIC
USLT 2000 Ultrasonic Flaw Detector PC Card (Configuration SA
Refer to the paragraphs 4.2.4 – 4.2.6 for the analogue interface 
Waterproof Sealed 
Mouse Pointer 
Sun Readable s.VGA 
Touch Screen 
Revision 8.0

 

 2001 (Config
 80420)  
cabling guide
Coaxial Jumpers 
Outputs 
0 - Page 34 of 550 

uration SA 80410) with 

 and tips 



ISONIC Workstation from Sonotron NDT - Operating Man 

Units manufactured after May 31, 2001 – UDS 3-3 Pulser Reciver Card 
  

 
 
 
 
 

 

 
 
 
 

 

Power Switch Parallel Port (LPT) 

s.VGA Output

DC Input (12-24 V)

Battery Socket 

Dual PCMCIA Slot or 
Connector for the 

Incremental 
Mechanical Encoder 

(Optional) 

Coaxial Jumpers Inputs

Analogue Interface 

 

Ethernet 
connector 

Screen 
Brightness 

control 

PS/2 
For the 
service 

staff 
only 
Serial 
Port 

(COM)
 
 

UDS 3-4 Ultrasonic
Flaw Detector PC 

Card 
Waterproof Sealed 
Keyboard 
ual – 
Waterproof Sealed 
Mouse Pointer 
 

Sun Readable s.VGA 

Touch Screen 
Revision 8.0
Coaxial Jumpers 
Outputs 
0 - Page 35 of 550 
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Units manufactured after May 31, 2001 – UDS 3-4 Pulser Reciver Card 
  

 
 
 
 
 

 

 
 
 
 

 
 
� 
 

(a) The PCMCIA Socket replaces the UDS 3-3 or UDS3-4 C
80410 or SA 80430) with USLT 2000 Ultrasonic Flaw Dete

(b) Refer to the paragraphs 4.2.4 – 4.2.6 for the analogue inte
 

 
 

Power Switch Parallel Port (LPT) 

s.VGA Output

DC Input (12-24 V)

Battery 

Coaxial Jumpers Inputs

Analogue Interface 

Ethernet 
connector 

Screen 
Brightness 

control 

PS/2 
For 

service 
staff 
only 
Serial 
Port 

(COM)
Connector for 
the Incremental 

Mechanical 
Encoder
 
 
 

UDS3-4 Ultrasonic 
Flaw Detector PC 

Card 
Waterproof Sealed 
Keyboard 
ual – 

ard in
ctor P
rface 
Waterproof Sealed 
Mouse Pointer 
 

Sun Readable s.VGA 

Touch Screen 
Revision 8.0

 the ISONIC 
C Card (Con
cabling guide
Coaxial Jumpers 
Outputs 
0 - Page 36 of 550 

2001 (configurations SA 
figuration SA 80420) 
 and tips 
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The Optional Rear Panel Commutation Box 
 
In order to ease the rear panel commutation required for the true-to-location imaging setup variations the 
Rear Panel Commutation Box is available as an option (Order Code SH 98C0202 M). For the units equipped 
with the Rear Panel Commutation Box the positions of the Parallel Port (LPT) and Screen Brightness Control 
on the are different comparing to the units, which are not equipped with that box 
 
 
 
 
 
 

 
 
The AC/DC converter is located inside the Rear Panel Commutation Box, which is equipped with the 
necessary AC power cord input. The DC Power Plug outgoing from the Rear Panel Commutation Box is 
connected to the DC Input as usual  

Parallel Port (LPT) 

Screen 
Brightness 

control 

AC Power 
Cord 

DC Power 
Plug 



ISONIC

 
4.2.2. ISONIC Lap Top (obsolete since Dec 2001) 

 
 
 
 
 

 
 
 
 
 
 

                    
 

� 
 

(a) The
USL

(b) Ref
 
 

Parallel Port (LPT) 
2 Serial Ports 

(COM) 

DC Input (12-24 V) 

Analogue Interface 

P
Con

AC Input 

Pow

Battery
UDS3-3 Ultrasonic 
Flaw Detector PC 

Card
 Workstation from Sonotron NDT - Operating  

 

 
 
 
 
 
 

                            

 empty bracket replaces the UDS3-3 card in the 
T 2000 Ultrasonic Flaw Detector PC Card (Config

er to the paragraphs 4.2.4 – 4.2.6 for the analogue

s.VGA OutputFloppy 
Drive 

S 2 
nector 

(110-240 V)

er Switch 
Waterproof Sealed 
Mouse Touch Pad 
PCMCIA Socket 
Manual – Revision 8.00 - Page 38 of 550 

ISONIC Lap Top (Configuration SA 80310) with 
uration SA 80320)  
 interface cabling guide and hints 
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4.2.3. ISONIC Desk Top  

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

� 
 

(a) The PCMCIA Socket replaces the UDS 3-3 or UDS3-4 Card in the ISONIC 200
80210 or SA 80230) with USLT 2000 Ultrasonic Flaw Detector PC Card (Configu

(b) Refer to the paragraphs 4.2.4 – 4.2.6 for the analogue interface cabling guide an
 

Keyboard 
Connectors 

Parallel Port (LPT) 
2 Serial Ports 

(COM) 
s.VGA 
Output 

AC Input 
(110-240 V) 

AC 
Extension 

Analogue 
Interface 

PS 2 
Connectors 

Keyboard 
Lock Switch 

PC Reset 

UDS3-3 or UDS3-4 

Ultrasonic Flaw 
Detector PC Card
Network 
Adapter 

(Optional)
P

1
ra
d 
Floppy and CD 
(Optional) 

Drives
age 39 of 550 

 (configurations SA 
tion SA 80220) 
hints 

Power Switch
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4.2.4. Analogue Interface – Cabling Guide for the True-to-Scale Imaging 
with Use of the Airborne Ultrasound Probe Location 
 

 

 
Scheme A.1: UDS3-3 based models: 

♦  Probe Swiveling Monitoring is active 
♦  Use of the Single Element Probe  

 

 
Scheme A.2: UDS3-4 based models: 

♦  Probe Swiveling Monitoring is active 
♦  Use of the Single Element Probe  
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Scheme A.3: USLT 2000 based models: 

♦  Probe Swiveling Monitoring is active 
♦  Use of the Single Element Probe  

 
Scheme A.4: UDS3-3 based models: 

♦  Probe Swiveling Monitoring is not active 
♦  Use of the Single Element Probe  
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Scheme A.5: UDS3-4 based models: 

♦  Probe Swiveling Monitoring is not active 
♦  Use of the Single Element Probe  

 
Scheme A.6: USLT 2000 based models: 

♦  Probe Swiveling Monitoring is not active 
♦  Use of the Single Element Probe  
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Scheme A.7: UDS 3-3 based models: 

♦  Probe Swiveling Monitoring is not active 
♦  Use of the Dual Probe  

 
Scheme A.8: UDS 3-4 based models: 

♦  Probe Swiveling Monitoring is not active 
♦  Use of the Dual Probe  
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Scheme A.9: USLT 2000 based models: 

♦  Probe Swiveling Monitoring is not active 
♦  Use of the Dual Probe  
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4.2.5. Analogue Interface – Cabling Guide for the A-Scan / t-B-Scan / t-
TOFD / t-FLOORMAP_L / Encoded B-Scan / Encoded TOFD / Encoded 
FLOORMAP_L / Creeping Wave Inspection, Recording, and Imaging 
 

 
Scheme B.1: UDS3-3 based models  

♦  ISONIC 2001 
♦  Use of the Single Element Probe  

 

 
Scheme B.2: UDS3-3 based models  

♦  ISONIC 2001R 
♦  Use of the Single Element Probe  
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Scheme B.3: UDS3-4 based models  

♦  ISONIC 2001M 
♦  Use of the Single Element Probe  

 

 
Scheme B.4: UDS3-4 based models  

♦  ISONIC 2001RM 
♦  Use of the Single Element Probe  
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Scheme B.5: USLT 2000 based models  

♦  ISONIC 2001U, ISONIC 2001 RU 
♦  Use of the Single Element Probe  

 

 
Scheme B.6: UDS3-3 based models  

♦  ISONIC 2001 
♦  Use of the Dual Probe 
♦  Use of 2 Probes (Emitting and Receiving) 

 

 
Scheme B.7: UDS3-3 based models  

♦  ISONIC 2001R 
♦  Use of the Dual Probe 
♦  Use of 2 Probes (Emitting and Receiving) 
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Scheme B.8: UDS3-4 based models  

♦  ISONIC 2001M 
♦  Use of the Dual Probe 
♦  Use of 2 Probes (Emitting and Receiving) 

 

 
Scheme B.9: UDS3-4 based models  

♦  ISONIC 2001RM 
♦  Use of the Dual Probe 
♦  Use of 2 Probes (Emitting and Receiving) 
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Scheme B.10: USLT 2000 based models  

♦  ISONIC 2001U, ISONIC 2001 RU 
♦  Use of the Dual Probe 
♦  Use of 2 Probes (Emitting and Receiving) 
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4.2.6. Analogue Interface – Jumpering Pulser Receiver Sockets to the 
Front Panel in the UDS 3-3 / UDS 3-4 Based Models 
 

Photo Note 
 

 

 

+ 
 

 
 

 
 
UDS3-3 / UDS3-4 based ISONIC 2001 (SA 80410 / SA 
80430) – Use of Single Element Probe, Inspection and 
Measurements without the 3D Imaging (Variant 2) 
 

UDS3-3 / UDS3-4 based ISONIC 2001R (SA 80411 / SA 
80431) – Use of Single Element Probe, Inspection and 
Measurements without the Imaging (Variant 2) 

 
 

 

 

 

+ 

 
 

 
UDS3-3 / UDS3-4 based ISONIC 2001 (SA 80410 / SA 
80430) – Use of the Dual Probe, Inspection and 
Measurements without the 3D Imaging  (Variant 2) 
 

UDS3-3 / UDS3-4 based ISONIC 2001R (SA 80411 / SA 
80431) – Use of Dual Probe, Inspection and 
Measurements without the 3D Imaging (Variant 2) 
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4.2.7. Analogue Interface – Rear Panel Commutation Box 
 
In order to ease the rear panel commutation required for the true-to-location imaging setup variations the 
Rear Panel Commutation Box is available as an option (Order Code SH 98C0202 M) 
 

 
 

The single plug-in / plug-out connector  is located at the instrument end of the long cable for the units 
equipped with the Rear Panel Commutation Box 
 

All necessary commutations related to the IN X, IN Y, IN Z, IN Cpl and IN Sig sockets as per above Fig.4.1a 
– c through Fig. 4.3 a – c are made inside the Rear Panel Commutation Box. Other commutations are pre-
made through the jumpers outgoing from the commutation box, just the yellow-jacketed jumper  has to be 
  

      
 

swapped between Out Ang and REC sockets manually depending on the scanning mode selected according 
to the above Fig.4.1a – c through Fig. 4.3 a – c 
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4.3. Turning On 
 
4.3.1. Power Supplies of ISONIC 2001 
 
ISONIC 2001 is equipped with both AC/DC power supplies and with the rechargeable battery (optionally). The 
AC Power Supply/Charger is implemented as an external unit having AC input and DC output. 
 

 
 
 
AC Power Supply 
 
•  Ensure the power switch is in the OFF position before connecting the power cords 
•  Connect one end of the AC power cord to the power socket of the AC Power Supply/Charger and the 

other end to the mains socket 
•  Connect the DC power cord with the suppression filter outgoing from the AC Power Supply/Charger to 

the DC Input of ISONIC 2001 
•  The AC Power Supply/Charger recognizes the supply voltage 100V/250V. There is no need to manually 

switch from 250V to 100V 
•  A voltage outside the range of 90V to 138V AC or 180V to 264V AC respectively is not permissible 
•  After turning the ISONIC 2001 OFF, please wait about at least 10 seconds before switching it ON again 
 
External DC Power Supply 
 
•  Ensure that the power switch is in the OFF position 
•  Connect one end of the DC power cord with the suppression filter to the DC Input of ISONIC 2001 and 

the other to the voltage supply 
•  The external DC power supply for the operating the unit must supply the voltage between 12 V and 24 V. 

However if the voltage supplied by the external DC Power supply is between 12 V and 19 V then the use 
of the internal battery inside the unit is not allowed! Oppositely it may damage the circuits controlling the 
internal battery charge / discharge and temperature monitoring, causing further internal battery 
overheating and destroying. The voltages below 12 V and above 24 V are not allowed 

•  After turning the ISONIC 2001 OFF, please wait about at least 10 seconds before switching it ON again 
 
Battery 
 
•  Ensure that the power switch is in the OFF position 
•  Insert the battery 
•  After turning the ISONIC 2001 OFF, please wait about at least 10 seconds before switching it ON again 
 
 
Power-Up 
 
To Power-Up the ISONIC 2001 set power switch into the "ON" position. An automatic system test program 
will then be executed; during this test, various texts and information appear on the screen. At the end of the 
test, the message ISONIC is Starting Up will be reported 

AC Power Supply / 
Charger for ISONIC 2001 

AC Power Cord 

DC Power Cord 
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4.3.2. Power Supplies of the ISONIC Lap Top 
 
ISONIC Lap Top is equipped with both AC/DC power supplies and with rechargeable battery (optionally).  
 
 
AC Power Supply 
 
•  Ensure the power switch is in the OFF position before connecting the power cord 
•  Connect one end of the AC power cord to the DC Input of ISONIC Lap Top and the other end to the 

mains socket 
•  The ISONIC Lap Top auto switch power supply unit recognizes the supply voltage 100V/250V. There is 

no need to manually switch from 250V to 100V 
•  A voltage outside the range of 90V to 138V AC or 180V to 264V AC respectively is not permissible 
•  After turning the ISONIC Lap Top OFF, please wait about at least 10 seconds before switching it ON 

again 
 
DC Power Supply 
 
•  Ensure that the power switch is in the OFF position 
•  Connect one end of the DC power cord with the suppression filter to the DC Input of ISONIC Lap Top 

and the other to the voltage supply 
•  The DC power supply unit requires a voltage between 10.5V and 30V 
•  After turning the ISONIC Lap Top OFF, please wait about at least 10 seconds before switching it ON 

again 
 
Battery 
 
•  Ensure that the power switch is in the OFF position 
•  Insert the battery 
•  After turning the ISONIC Lap Top OFF, please wait about at least 10 seconds before switching it ON 

again 
 
 
Power-Up 
 
To Power-Up the ISONIC Lap Top set power switch into the "ON" position. An automatic system test 
program will then be executed; during this test, various texts and information appear on the screen. At the 
end of the test, the message ISONIC is Starting Up will be reported 
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4.3.3. Power Supply of the ISONIC Desk Top 
 
ISONIC Desk Top is equipped with the AC power supply 
 
 
•  Ensure the power switch is in the OFF position before connecting the power cord 
•  Connect one end of the AC power cord to the AC Input of ISONIC Desk Top and the other end to the 

mains socket 
•  The ISONIC Desk Top auto switch power supply unit recognizes the supply voltage 100V/250V. There is 

no need to manually switch from 250V to 100V 
•  A voltage outside the range of 90V to 138V AC or 180V to 264V AC respectively is not permissible 
•  After turning the ISONIC Desk Top OFF, please wait about at least 10 seconds before switching it ON 

again 
 
 
Power-Up 
 
To Power-Up ISONIC Desk Top set power switch into the "ON" position. An automatic system test program 
will then be executed; during this test, various texts and information appear on the screen. At the end of the 
test, the message ISONIC is Starting Up will be reported 
 
 

4.4. Turning OFF 
 
To turn the ISONIC Off: 
 
•  Close all working software 
 
•  Press Alt+F4, or click on Shut Down… from the Start menu 
 
•  In the Shut Down Windows dialog box, select Shut down, then press Enter key, or click on Yes or 

press Y 
 
Wait until the message It's now safe to turn off the ISONIC appears, then put power switch into the "OFF" 
position 
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4.5. Mains and Internal Battery Powering of the ISONIC 2001 
unit 
 
ISONIC 2001 may be powered by the mains either AC or DC or by the internal battery. Battery will be 
recharge while inside the unit connected to mains. The unit may be either switched on or off entire the battery 
recharge. There are few LEDs on the front panel of the ISONIC 2001 unit: 
 
 
 
 
 
 
 
 

 

 

 

Power This LED is continuously lighting while the ISONIC 2001 unit powered 
either by the internal battery or mains is switched on 

 
 

 
 

Low-bat 

This LED is not lighting if mains power the ISONIC 2001 unit. If the 
internal battery powers the ISONIC unit then the Low-bat LED will 
start flashing if the remaining battery resource is down to 10-20 min. 
If the remaining battery resource is down to 2-3 min then the 
perceptible sound alarm will accompany the Low-bat LED flashing. 
It's required to complete the current session to save all open jobs if 
necessary and switch the ISONIC 2001 unit off as per above Chapter 
4.4 

 

 
 

 

Temp. 

This LED is normally not lighting. If the temperature of the battery 
entire the recharge or powering unit is up to 60oC then the Temp. 
LED starts lighting continuously. Simultaneously the ISONIC 2001 
unit automatically discontinues the battery recharge. It's 
recommended to pull battery out of the unit in order to get it to the 
normal temperature faster 

 
 

Charge 

This LED is not lighting if the battery is not inside the unit. The 
Charge LED ins continuously lighting entire the battery recharge. 
Upon getting the battery fully charged the Charge LED starts 
flashing. Simultaneously the ISONIC 2001 unit automatically 
discontinues the battery charge  

 

Temp. 
 

Charge 
 

These LEDs may be simultaneously lighting if the external DC source 
powering the ISONIC 2001 unit produces the voltage below 20VDC 
while the internal battery is not inside the unit. In that case the Temp. 
LED is lighting continuously and the Charge LED is slowly flashing 

 

 
Precautions:  
 

•  If the voltage supplied by the external DC Power supply is between 12 V 
and 19 V then the use of the internal battery inside the unit is not 
allowed! Oppositely it may damage the circuits controlling the internal 
battery charge / discharge and temperature monitoring, causing further 
internal battery overheating and destroying 

•  Charge of the of the of the internal battery either inside the unit or 
outside is allowed only with use of the AC/DC converters / chargers 
supplied along with the unit or authorized by Sonotron NDT 

•  Charge of the internal battery inside the unit is not allowed if the unit is 
suited with the soft carrying case 
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4.6. ISONIC Settings 
 
Click on Start, select Settings then Control Panel and double click on the corresponding icon  located in 
the Control Panel window 
 

 
 
The window allowing setup of the user interface/help language and measurement units appears: 
 

 

To close ISONIC Settings window press Esc  or <Alt> + <C> on the keyboard or click on   
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4.7. ISONIC Encoder Calibration Utility 
 

This utility allows calibrating of the user’s incremental one axis encoder to be used with the ISONIC ABIScan 
and/or FLOORMAP_L Inspection SW Packages. The user’s encoder must be connected to the 
appropriate connector according to the circuit diagram approved by Sonotron NDT!!! 
 

Click on Start, select Settings then Control Panel and double click on the corresponding icon  located in 
the Control Panel window 

 
 

 
The ISONIC Encoder Settings window allowing to key in the name for the new encoder name and to 
calibrate it appears: 
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To proceed click on the Add... button or press <Alt> + <A> on the keyboard then type the name of the new 

encoder in the appearing window then click on the OK button or press Enter  or <Alt> + <K> on the 
keyboard 

 
To negate just click on the Cancel button or press Esc  or <Alt> + <C> on the keyboard 
 
The Calibrate Encoder window appears upon typing the new encoder name, said window contains the 
simple instructions to follow: 
 

  
 

 

The encoder’s wheel while calibrating must pass linearly the distance of 300 mm (12 in) between the Start 
Point designated through the clicking on the Step 1 button or pressing <Alt> + <1> on the keyboard and End 
Point along the scale bar placed on the flat surface  
 
Upon reaching the End Point and clicking on the Step 2 button or pressing <Alt> + <2> on the keyboard the 
new Encoder Test window appears allowing to check the accuracy of the new encoder calibration while 
manipulating it along the scale bar. 
 
If it’s necessary to re-designate the Start Point click on the Restart button or press <Alt> + <R> on the 
keyboard 
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•  Click on the Reset button or press <Alt> + 

<R> on the keyboard to designate the local zero 
point 

 

•  Click on the Yes button or press Enter  or 
<Alt> + <Y> on the keyboard to rename the 
selected encoder 

 

•  Click on the No button or press Esc  or 
<Alt> + <N> on the keyboard to recalibrate the 
encoder 

 

 
 
 

 

 

The ISONIC Encoder Settings window returns to the screen upon completing entering and calibrating of the 

new encoder. To update the registry click on the OK button or press Enter  or <Alt> + <K> on the 
keyboard – this will automatically terminate the running of the Encoder Calibration utility 
 

 
 

If running the utility next time: 
 

•  Click on the Add... button or press <Alt> + <A> on the keyboard to proceed with the next new 
encoder as described above 

 

•  Click on the Rename button or press <Alt> + <N> on the keyboard to rename the selected encoder 
 

•  Click on the Test button or press <Alt> + <T> on the keyboard to check the accuracy of the selected 
encoder calibration 

 

•  Click on the Calibrate button or press <Alt> + <L> on the keyboard to recalibrate the selected 
encoder 

 

•  Click on the Remove button or press <Alt> + <R> on the keyboard to remove the selected encoder 
from the registry 

 

•  Click on the Cancel button or press Esc  or <Alt> + <C> on the keyboard to negate all changes 
and terminate the running of the Encoder Calibration utility 

 

•  Click on the OK button or press Enter  or <Alt> + <K> on the keyboard to update the registry and 
terminate the running of the Encoder Calibration utility 
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5. Operating ISONIC Pulser Receiver 
(Internal Ultrasonic Flaw Detector PC 

Card) Through "PULREC" or "USLTPR" 
Software Package 

 
 

The contents of this chapter is valid for the  
PULREC SW Package version 6.1.0.6 or higher
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5.1. Cabling 
 

Ultrasonic Flaw Detector PC Card Applicable Cabling Scheme Paragraph 
UDS 3-3 B.1; B.2; B.6; B.7 4.2.5 
UDS 3-4 B.3; B.4; B.8; B.9 4.2.5 

USLT 2000 B.5; B.10 4.2.5 
 

5.2. Start Up PULREC Software Package (ISONIC Pulser 
Receiver) 
 

Double click on the icon  located on the ISONIC desktop 
 
 
 

5.3. Start Up USLTPR Software Package (USLT 2000 Pulser 
Receiver) 
 

Double click on the icon  located on the ISONIC desktop 
 
 

5.4. Operating PULREC and USLTPR Software Packages 
 

PULREC software package operates the UDS 3-3 and UDS 3-4 internal ultrasonic flaw detector card. The 
card existing in the ISONIC is recognized automatically 
 

USLTPR software package operates the USLT 2000 internal ultrasonic flaw detector card 
 

PULREC and USLTPR software packages have almost identical user interface. All modes of operation are 
realized through the main screen including the A-Scan and all controls. All further explanations relate to both 
software packages excluding the specially noted cases 
 

 

 
 

UDS 3-3: Operating Surface 
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UDS 3-4: Operating Surface 
 

 
 

 
 

USLT 2000: Operating Surface 
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5.4.1. Main Menu 
 
The Main Menu consists of eight topics one of then is active. The active topic is highlighted 
 

 

 
To select a topic the following manipulations are applicable: 
 

•  Mouse 
 
� Click on the topic's name  

 
OR  
 

� Click on the buttons  
 
 
•  Keyboard 
 
� Pressing <Alt>+<M> ⇒ Menu Selection fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  

buttons on the keyboard  (In the Menu Selection the letter M is underlined) 
 
•  Combined 
 
� Click on Menu Selection ⇒ Menu Selection fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  

buttons on the keyboard 
 
Each topic is associated with the corresponding submenu, which appears as the vertical bar showing the 
names for five parameters or modes of operation, their current setup and, if applicable, the current value for 
the next increment / decrement of the parameter  
 
 

Main MenuActive Topic Vertical bar – Submenu 
corresponding to the 
highlighted active topic



 
5.4.2. Sub Menu BASICS 
 
 
 
 

 
Current value for the next 

increment/decrement of the Gain 
setup dB 
 
 
 

Current value of the
Gain 
dB 
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To setup Gain the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button   

 
•  Keyboard 
 
� Pressing <Alt>+<G> ⇒ Gain fore color changes to white - then

keyboard  (In the Gain the letter G is underlined) 
 
•  Combined 
 
� Click on Gain ⇒ Gain fore color changes to white - then use ↑↑↑↑  , 

 
 
����  
Gain setup is also possible through the most of other submenus follo
 

Click on this button or press 
<Alt>+<1> on the keyboard to 
select the value for the next 
increment/decrement of the Gain
setup in dB. The possible steps 
are: 0.5, 1, 2, 6, and 20 dB 
evision 8.00 - Page 64 of 550 

 use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

→→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 

wing the same rules as above 
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To setup Range the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<A> ⇒ Range fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Range the letter a is underlined) 
 
•  Combined 
 
� Click on Range ⇒ Range fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 

 
����  
Range setup is also possible through some other submenus following the same rules as above 
 

 

 

Current value of 
the Range 
mm or in 

Current value for the next 
increment/decrement of the 

Range setup 
mm or in 

Click on this button or press 
<Alt>+<2> on the keyboard to 
select the value for the next 
increment/decrement of the Range
setup in mm or in. The possible 
steps are: 0.1, 0.2, 0.5, 1, 2, 5, 10, 
20, 50, and 100 mm or 0.001, 
0.002, 0.005, 0.01, 0.02, 0.05, 0.1, 
0.2, 0.5, 1, 2, and 5 in 
Note: the steps of 0.1, 0.2, and 0.5 
mm are possible for the Range not 
exceeding 100 mm; the steps of 
0.001, 0.002, and 0.005 in are 
possible for the Range not 
exceeding 4 in  



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
T
m
 
•  

 

 
•  

 

 
•  

 

 

Current value for the next 
increment/decrement of the 

US Velocity setup 
m/s or in/ms 
Current value of 
the US Velocity 
 m/s or in/ms 
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o setup US Velocity the following  
anipulations are applicable: 

Mouse 

� Click or press and hold on the appropriate button  

Keyboard 

� Pressing <Alt>+<U> ⇒ US Velocity fore color changes to white 
the keyboard  (In the US Velocity the letter U is underlined) 

Combined 

� Click on US Velocity ⇒ US Velocity fore color changes to white
the keyboard 

 

 

Click on this button or press 
<Alt>+<3> on the keyboard to 
select the value for the next 
increment/decrement of the US 
Velocity setup in m/s or in/ms. 
The possible steps are:  
1, 2, 5, 10, 20, 50, 100, 200, 500, 
and 1000 m/s or 0.1, 0.2, 0.5, 1, 2,
5, 10, 25, and 50 in/ms 
evision 8.00 - Page 66 of 550 

- then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

 - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
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To setup Display Delay the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<E> ⇒ Display Delay fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard  (In the Display Delay the letter e is underlined) 
 
•  Combined 
 
� Click on Display Delay ⇒ Display Delay fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  

buttons on the keyboard 
 

 

Current value for the next 
increment/decrement of the 

Display Delay setup 
µs 

Click on this button or press 
<Alt>+<4> on the keyboard to 
select the value for the next 
increment/decrement of the 
Display Delay setup in µs. The 
possible steps are: 0.01, 0.02, 
0.05, 0.1, 0.01, 0.2, 0.5, 1, 2, 5, 10, 
20, 50, and 100 µs 

Current value of 
the Display Delay 

µs 
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To setup Reject the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<E> ⇒ Reject fore color changes to white - th

keyboard  (In the Reject the letter R is underlined) 
 
•  Combined 
 
� Click on Reject ⇒ Reject fore color changes to white - then us

keyboard 
 

 
����  
Reject setup is also possible through some other submenus followi
 

 

Current value for the next 
increment/decrement of the 

Reject setup 
% 

 

 

Click on this button or press 
<Alt>+<5> on the keyboard to 
select the value for the next 
increment/decrement of the Reject
setup in %. The possible steps are:
1, 2, 5, 10, 20, and 50 % 
 
 
 
 

Current value of
the Reject 

% 
 Revision 8.00 - Page 68 of 550 

en use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

e ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

ng the same rules as above 
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5.4.3. Sub Menu PULSER (UDS 3-3 and USLT 2000) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To setup Pulser Mode the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<U> ⇒ Pulser Mode fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard  (In the Pulser Mode the letter u is underlined) 
 
•  Combined 
 
� Click on Pulser Mode ⇒ Pulser Mode fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard 
 

 
����  
There are two Pulser Modes available: Single and Dual 
 

 

Current Pulser Mode 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To
ma
 
 
•  

 

 
•  

 

 
•  

 

 
 

����
 

 

 

 

Current Energy of  
the Intitial Pulse 

µµµµJ 
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 setup Energy the following  
nipulations are applicable: 

Mouse 

� Click or press and hold on the appropriate button  

Keyboard 

� Pressing <Alt>+<E> ⇒ Energy fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Energy the letter E is underlined) 

Combined 

� Click on Energy ⇒ Energy fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 

♦  The are four levels of excitation energy are available for the UDS 3-3: 120 µJ, 64 µJ; 24µJ; and 12 µJ 

♦  There are two levels of excitation energy available for the USLT 2000, shown as the value of the 
capacitor discharging onto the ultrasonic probe: 1000 pF and 220 pF. The higher excitation energy 
corresponds to the higher capacity 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To
m
 
 
•  

 

 
•  

 

 
•  

 

 
 

����
 

 

 

 

 
Current Damping of
the pulser 

ΩΩΩΩ 
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 setup Damping the following  
anipulations are applicable: 

Mouse 

� Click or press and hold on the appropriate button  

Keyboard 

� Pressing <Alt>+<A> ⇒ Damping fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Damping the letter a is underlined) 

Combined 

� Click on Damping ⇒ Damping fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 

♦  There are 16 (sixteen) discrete values of damping available for the UDS 3-3: 24.7Ω, 26.3Ω, 
28.1Ω, 30.3Ω, 32.8Ω, 35.7Ω, 39.2Ω, 43.4Ω, 48.8Ω, 55.6Ω, 64.6Ω, 76.9Ω, 95.4Ω, 125Ω, 
182Ω, and 333 Ω 

♦  There are 2 (two) discrete values of damping available for the USLT 2000: 50Ω, and 500 Ω 
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To setup PRF the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<R> ⇒ PRF fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the PRF the letter R is underlined) 
 
•  Combined 
 
� Click on PRF ⇒ PRF fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 

 
 
 
 
 
 
 
 
 

Current value of the PRF
(Pulse Repetition 

Frequency) 
Hz

Current value for the next 
increment/decrement of the PRF 

setup 
Hz 

Click on this button or press 
<Alt>+<5> on the keyboard to 
select the value for the next 
increment/decrement of the PRF 
setup in Hz. The possible steps 
are: 20, 100, and 200 Hz
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5.4.4. Sub Menu PULSER (UDS 3-4) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To setup Tuning the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<G> ⇒ Tuning fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Tuning the letter g is underlined) 
 
•  Combined 
 
� Click on Tuning ⇒ Tuning fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 
 
 
 

���� 
 

♦  UDS 3-4 has 16 (sixteen) matching coils on-board that may be connected to the ultrasonic probe in 
order to get the best probe impedance matching / signal to noise ratio for the signals received from 
the object under test. The values of these matching coil inductances are: 2µH, 7µH, 12µH, 17µH, 
24µH, 29µH, 34µH, 39µH, 41µH, 46µH, 51µH, 56µH, 63µH, 68µH, 73µH, and 78 µH 

 

♦  Setting the Tuning to "NO" disconnects the matching coil 
 

 

Current value of 
Tuning 

µµµµH 
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To setup Pulser Mode the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<U> ⇒ Pulser Mode fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard  (In the Pulser Mode the letter u is underlined) 
 
•  Combined 
 
� Click on Pulser Mode ⇒ Pulser Mode fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard 
 

 
����  
There are two Pulser Modes available: Single and Dual 
 

 

Current Pulser Mode 
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To setup Pulse Width the following  
manipulations are applicable: 
 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<E> ⇒ Pulse Width fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard  (In the Pulse Width the letter E is underlined) 
 
•  Combined 
 
� Click on Pulse Width ⇒ Pulse Width fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard 
 
 

���� 
 

♦  The Pulse Width (Duration of the Square Wave Initial Pulse) may be tuned from 65 ns to 600 ns in 5 ns 
steps 

 

♦  Attempt to further decrease the Pulse Width after setting to the minimal value of 65 ns leads to the 
generation of the Spike Pulse instead of the Square Wave Pulse. There are 4 (four) energy levels 
available for the spike pulse excitation; said levels are indicated in the Pulse Width field:  
o Spike (250µJ) – spike pulse with the 250 µJ energy of excitation 
o Spike (160µJ – spike pulse with the 160 µJ energy of excitation 
o Spike (90µJ) – spike pulse with the 90 µJ energy of excitation 
o Spike (40µJ) – spike pulse with the 40 µJ energy of excitation 

 

♦  The energy of the Spike Pulse excitation is controllable through the same controls as Pulse Width 
 

♦  Attempt to further increase the energy of the Spike Pulse excitation after setting to the maximal level of 
250 µJ value leads to the generation of the Square Wave Pulse instead of the Spike Pulse 

 
 

Current value of the Pulse 
Width (Duration of the 

Square Wave Initial Pulse) 
ns 
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To setup Damping the following  
manipulations are applicable: 
 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<A> ⇒ Damping fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard  (In the Damping the letter a is underlined) 
 
•  Combined 
 
� Click on Damping ⇒ Damping fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 
 
����  
There are 21 (twenty one) discrete values of damping available for the UDS 3-4: 13Ω, 15Ω, 17Ω, 20Ω, 
25Ω, 30Ω, 35Ω, 40Ω, 45Ω, 56Ω, 65Ω, 76Ω, 90Ω, 115Ω, 130Ω, 150Ω, 180Ω, 240Ω, 320Ω, 500Ω, 
and 1000 Ω 
 
 

Current Damping of 
the pulser 

ΩΩΩΩ 
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To setup PRF the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<R> ⇒ PRF fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the PRF the letter R is underlined) 
 
•  Combined 
 
� Click on PRF ⇒ PRF fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 

 
 
����  
UDS 3-4 is equipped with the special protection circuit preventing the damage of the probe or firing driver, 
which may be caused by the not suitable settings of Tuning, or Damping, or Pulse Width, or their 
combination. The protection circuit limits the total energy delivered to the firing output through the automatic 
reducing of the PRF to the safe value 
 
 
 
 
 
 
 
 

 

Current value of the 
PRF (Pulse Repetition 

Frequency) 
Hz

Current value for the next 
increment/decrement of the PRF 

setup 
Hz 

Click on this button or press 
<Alt>+<5> on the keyboard to 
select the value for the next 
increment/decrement of the PRF 
setup in Hz. The possible steps 
are: 1, 10, 50, 100, and 200 Hz



 
5.4.5. Sub Menu RECEIVER (UDS 3-3 and USLT 2000) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
T
t
a
 
•
 

 
•
 

 
•
 

 
 

����
 
♦
 

♦

 
 

 
Current Frequency band of
the receiver 

MHz  
From … To 
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o setup Frequency band of the receiver 
he following manipulations are  
pplicable: 

 Mouse 

� Click or press and hold on the appropriate button  

 Keyboard 

� Pressing <Alt>+<E> ⇒ Frequency fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Frequency the letter e is underlined) 

 Combined 

� Click on Frequency ⇒ Frequency fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 

 There are 16 (sixteen) frequency bands of the receiver available for the UDS 3-3:  
0.001 – 35 MHz

0.3 – 35 MHz
1 – 35 MHz
5 – 35 MHz 

0.001 – 25 MHz
0.3 – 25 MHz

1 – 25 MHz
5 – 25 MHz

 

0.001 – 15 MHz 
0.3 – 15 MHz 

1 – 15 MHz 
5 – 15 MHz 

 

0.001 – 10 MHz
0.3 – 10 MHz

1 – 10 MHz
5 – 10 MHz

 
 There are 4 (four) frequency bands of the receiver available for the USLT 2000:  

0.5 – 3MHz     7 – 20 MHz     2 – 7 MHz     3 – 20 MHz 
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To select the mode of signal presentation  
(Display) the following manipulations  
are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<I> ⇒ Display fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Display the letter i is underlined) 
 
•  Combined 
 
� Click on Display ⇒ Display fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 

Current mode of the signal 
presentation (Display) 
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����  
 

♦  There are four Display modes available for the time domain signal presentation: 
 

 
 

 
 

 
 

 

RF – no 
rectifying 

PosHalf – 
positive half 

wave  
rectifying 

NegHalf – 
negative half 

wave  
rectifying 

Full – both 
waves  

rectifying 
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♦  The frequency domain signal presentation is available through the FFT Display mode. Refer to the 
paragraph 5.4.17 of this Operating Manual for the frequency domain signal presentation and 
measurements tips 
 

 
 

 

 
 



 
5.4.6. Sub Menu RECEIVER (UDS 3-4) 
 
 
 

 

 
 
 
 
 

Current setting of the Filter 
representing the Central 
Frequency of the Narrow Band
Resonant Filter 

MHz 
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To setup Filter the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<L> ⇒ Filter fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Filter the letter l is underlined) 
 
•  Combined 
 
� Click on Filter ⇒ Filter fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 

 

���� 
 

♦  The are 6 (six) narrow bands resonant filters in the UDS 3-4 having the central frequencies of  
0.5 ± 0.15 MHz 

1 ± 0.3 MHz 
2 ± 0.6 MHz 
4 ± 1.2 MHz 
10 ± 3 MHz 

15 ± 4.5 MHz 
 

♦  The narrow band resonant filtering is negated upon setting up Filter to BB (Broad Band) 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
T
r
a
 
•
 

 
•
 

 
•
 

 
 

����
T

 
 

 

 
Current Frequency band of
the receiver 

MHz  
From … To 
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o setup the Frequency band of the  
eceiver the following manipulations are  
pplicable: 

 Mouse 

� Click or press and hold on the appropriate button  

 Keyboard 

� Pressing <Alt>+<E> ⇒ Frequency fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Frequency the letter e is underlined) 

 Combined 

� Click on Frequency ⇒ Frequency fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

  
here are 28 (twenty eight) Frequency bands of the receiver available: 

 
 

0.35 – 35 MHz 
0.7 – 35 MHz 
1.4 – 35 MHz 
2.8 – 35 MHz 

7 – 35 MHz 
10.5 – 35 MHz 

 
 

 
 

0.35 – 19.5 MHz 
0.7 – 19.5 MHz 
1.4 – 19.5 MHz 
2.8 – 19.5 MHz 

7 – 19.5 MHz 
10.5 – 19.5 MHz 

 
 

0.35 – 13 MHz 
0.7 – 13 MHz 
1.4 – 13 MHz 
2.8 – 13 MHz 

7 – 13 MHz 
10.5 – 13 MHz 

 

 
 

0.35 – 5.2 MHz 
0.7 – 5.2 MHz 
1.4 – 5.2 MHz 
2.8 – 5.2 MHz 

 

 
 

0.35 – 2.6 MHz 
0.7 – 2.6 MHz 
1.4 – 2.6 MHz 

 

 
 

0.35 – 1.3 MHz 
0.7 – 1.3 MHz 

 

 
 

0.35 – 0.65 MHz 
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To select the mode of the signal presentation  
(Display) the following manipulations  
are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<I> ⇒ Display fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Display the letter i is underlined) 
 
•  Combined 
 
� Click on Display ⇒ Display fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 

Current mode of the signal 
presentation (Display) 
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����  
 

♦  There are four Display modes available for the time domain signal presentation: 
 

 
 

 
 

 
 

 

RF – no 
rectifying 

PosHalf – 
positive half 

wave  
rectifying 

NegHalf – 
negative half 

wave  
rectifying 

Full – both 
waves  

rectifying 
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♦  The frequency domain signal presentation is available through the FFT Display mode. Refer to the 
paragraph 5.4.17 of this Operating Manual for the frequency domain signal presentation and 
measurements tips 
 

 
 

 

 
 



 
5.4.7. Sub Menu GATE A 
 
 
 
 
 

 Current status of the Gate A 
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To switch Gate A ON / OFF the  
following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<T> ⇒ aSwitch fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the aSwitch the letter t is underlined) 
 
•  Combined 
 
� Click on aSwitch ⇒ aSwitch fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
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To setup the delay of the Gate A  
(aStart) the following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<A> ⇒ aStart fore color changes to white - the

keyboard  (In the aStart the letter a is underlined) 
 
•  Combined 
 
� Click on aStart ⇒ aStart fore color changes to white - then u

keyboard 
 
•  Drag / Drop technology (refer to the paragraph 5.4.9 of this Oper
 
 

 
����  
aStart setup is also possible though some other submenus followin
 

 
 
 

Current value of the 
aStart (delay of the Gate 

A with respect to the 
interface between probe 
and object under test) 

mm or in 

Current value for the next 
increment/decrement of the 

aStart setup 
mm or in 

 

Click on this button or press 
<Alt>+<3> on the keyboard to 
select the value for the next 
increment/decrement of the aStart
in mm or in. The possible steps 
are: 0.1, 0.2, 0.5, 1, 2, 5, 10, 20, 
50, and 100 mm or 0.001, 0.002, 
0.005, 0.01, 0.02, 0.05, 0.1, 0.2, 
0.5, 1, 2, and 5 in 
evision 8.00 - Page 88 of 550 

n use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

se ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

ating Manual) 

g the same rules as above 
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To setup the duration of the Gate A  
(aWidth) the following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<W> ⇒ aWidth fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the aWidth the letter W is underlined) 
 
•  Combined 
 
� Click on aWidth ⇒ aWidth fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 
•  Drag / Drop technology (refer to paragraph 5.4.9 of this Operating Manual) 
 

Current value of the 
aWidth (duration of 

the Gate A)  
mm or in 

Current value for the next 
increment/decrement of the 

aWidth setup 
mm or in 

Click on this button or press 
<Alt>+<4> on the keyboard to 
select the value for the next 
increment/decrement of the 
aWidth in mm or in. The possible 
steps are: 0.1, 0.2, 0.5, 1, 2, 5, 10, 
20, 50, and 100 mm or 0.001, 
0.002, 0.005, 0.01, 0.02, 0.05, 0.1, 
0.2, 0.5, 1, 2, and 5 in 
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To setup the threshold level for the Gate A  
(aThreshold) the following manipulations  
are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<E> ⇒ aThreshold fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard  (In the aThreshold the letter e is underlined) 
 
•  Combined 
 
� Click on aThreshold ⇒ aThreshold fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard 
 
•  Drag / Drop technology (refer to paragraph 5.4.9 of this Operating Manual) 
 

Current value of the 
aThreshold (threshold level 

for the Gate A) 
% 

Current value for the next 
increment/decrement of 
the aThreshold setup 

% 
Click on this button or press 
<Alt>+<5> on the keyboard to 
select the value for the next 
increment/decrement of the 
aThreshold setup in %. The 
possible steps are: 1, 2, 5, 10, 20, 
and 50 % 



 
5.4.8. Sub Menu GATE B 
 
 
 
 
 
 

 Current status of the Gate B 
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To switch Gate B ON / OFF the  
following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<T> ⇒ bSwitch fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the bSwitch the letter t is underlined) 
 
•  Combined 
 
� Click on bSwitch ⇒ bSwitch fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
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To setup the delay of the Gate B  
(bStart) the following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<A> ⇒ bStart fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the bStart the letter a is underlined) 
 
•  Combined 
 
� Click on bStart ⇒ bStart fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 
•  Drag / Drop technology (refer to paragraph 5.4.9 of this Operating Manual) 
 
 

Current value of the 
bStart (delay of the Gate 

B with respect to the 
interface between probe 
and object under test) 

mm or in 

Current value for the next 
increment/decrement of 

the bStart setup 
mm or in 

Click on this button or press 
<Alt>+<3> on the keyboard to 
select the value for the next 
increment/decrement of the bStart 
in mm or in. The possible steps 
are: 0.1, 0.2, 0.5, 1, 2, 5, 10, 20, 
50, and 100 mm or 0.001, 0.002, 
0.005, 0.01, 0.02, 0.05, 0.1, 0.2, 
0.5, 1, 2, and 5 in 
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To setup the duration of the Gate B  
(bWidth) the following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<W> ⇒ bWidth fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the bWidth the letter W is underlined) 
 
•  Combined 
 
� Click on bWidth ⇒ bWidth fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 
•  Drag / Drop technology (refer to paragraph 5.4.9 of this Operating Manual) 

Current value of the 
bWidth (duration of 

the Gate B)  
mm or in 

Current value for the next 
increment/decrement of 

the bWidth setup 
mm or in

Click on this button or press 
<Alt>+<4> on the keyboard to 
select the value for the next 
increment/decrement of the 
bWidth in mm or in. The possible 
steps are: 0.1, 0.2, 0.5, 1, 2, 5, 10, 
20, 50, and 100 mm or 0.001, 
0.002, 0.005, 0.01, 0.02, 0.05, 0.1, 
0.2, 0.5, 1, 2, and 5 in 
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To setup the threshold level for the Gate B  
(bThreshold) the following manipulations  
are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<E> ⇒ bThreshold fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard  (In the bThreshold the letter e is underlined) 
 
•  Combined 
 
� Click on bThreshold ⇒ bThreshold fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard 
 
•  Drag / Drop technology (refer to paragraph 5.4.9 of this Operating Manual) 
 

Current value of the 
bThreshold (threshold 

level for the Gate B) 
% 

Current value for the next 
increment/decrement of 
the aThreshold setup 

% 

Click on this button or press 
<Alt>+<5> on the keyboard to 
select the value for the next 
increment/decrement of the 
bThreshold setup in %. The 
possible steps are: 1, 2, 5, 10, 20, 
and 50 % 
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5.4.9. Drag and Drop technology: setup of the Gate A and Gate B 
 
The Drag and Drop technology is applicable for the setup of both gates (Gate A and Gate B) provided that 
they are visible: if placing the mouse pointer above the appropriate section of the gate then it changes the 
shape correspondingly. To setup the gate just press and hold left mouse button or touch screen stylus and 
drag, then drop through the releasing of the left mouse button or touch screen stylus 
 

 
 
 
 



 
5.4.10. Sub Menu ALARM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
To
fo
ap
 
•  
 

 
•  

 

 
•  

 

 
 

Alarm Switch indication 
corresponds to the Gate 

shown here 
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 select the Gate for the Alarm Setup the  
llowing manipulations are  
plicable: 

Mouse 
� Click or press and hold on the appropriate button  

Keyboard 

� Pressing <Alt>+<T> ⇒ Setup Gate fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Setup Gate the letter t is underlined) 

Combined 

� Click on Setup Gate ⇒ Setup Gate fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 
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To setup the Alarm Switch the  
following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<W> ⇒ Alarm Switch fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard  (In the Alarm Switch the letter w is underlined) 
 
•  Combined 
 
� Click on Alarm Switch ⇒ Alarm Switch fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  

buttons on the keyboard 
 
 

Alarm Switch 
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To select the Alarm Logic the  
following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<L> ⇒ Alarm Logic fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard  (In the Alarm Logic the letter L is underlined) 
 
•  Combined 
 
� Click on Alarm Logic ⇒ Alarm Logic fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard 
 

Alarm Logic 



 
 

���� 
Alarm Examples 
 
 
 
 

 
 
 
 
 
 
♦  

 
♦  

 
 
 
 
 

Gate B 

A
t

Gate A
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There is a pulse matching with the Gate A and exceeding its threshold; the logic of the Gate A is setup to 
Negative. As a result, the Alarm Indicator for the Gate A is not active 

There is a pulse matching with the Gate B exceeding its threshold; the logic of the Gate B is setup to 
Positive. As a result, the Alarm Indicator for the Gate B is active 

larm Indicator for 
he Gate A 

Alarm Indicator for 
the Gate B 



IS

5.4.11. Sub Menu DAC/TCG 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To sele
DAC/T
manipu
 
•  Mo
 
� 

 

•  Ke
 

� 

 

•  Co
 

� 

 
 
 

���� 
 

♦  Th
 

 

♦  It i
Po

 

♦  It i
car

 

♦  To
Ma

 

♦  Fo
 
 

 
Current status of the
DAC/TCG/DGS 
 
Current quantity of
the stored DAC 

echoes 
 
 

Status of the
DAC curve 
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ct the required mode of the 
CG/DGS the following  
lations are applicable: 

use 

Click or press and hold on the appropriate button  

yboard 

Pressing <Alt>+<T> ⇒ DAC/TCG/DGS fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 
on the keyboard  (In the DAC/TCG/DGS the letter T is underlined) 

mbined 

Click on DAC/TCG/DGS ⇒ DAC/TCG/DGS fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard 

ere are four modes available for the DAC/TCG: 

•  OFF - DAC Curve switches automatically to OFF if setting mode to OFF 
•  DAC - available if the quantity of stored echoes is 2 (two) or more. DAC Curve switches 

automatically to ON in the DAC mode 
•  TCG - available if the quantity of stored echoes is 2 (two) or more. DAC Curve switches 

automatically to OFF in the TCG mode 
•  Update - allows to creating a new or to update the existing DAC. Update of the existing DAC allows 

to erase a number of the sequentially recorded echoes, starting from the latest one, and/or to 
record new echoes. The maximal number of echoes recorded into the one DAC is 40 (forty) for 
UDS 3-3 and UDS 3-4 or 25 (Twenty Five) for USLT 2000. The DAC Curve switches automatically 
to ON if the number of recorded echoes is 2 (two) or more switches automatically to OFF if the 
number of recorded echoes is less than 2 (two) in the Update mode 

s possible to Create / Modify / Activate DAC and TCG for all Display modes (RF, Full, Negative, and 
sitive) if using UDS 3-3 or UDS 3-4 Card 
s not possible to Create / Modify / Activate DAC and TCG for the RF Display mode if using USLT 2000 
d 
 create / modify DAC/TCG or DGS refer to the paragraphs 5.4.12, 5.4.13, 5.4.14 of this Operating 
nual 
r USLT 2000 DAC/TCG/Update modes are not available if the RF setup of the Display    
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5.4.12. Create / Modify DAC 
 
Switch on the Gate A then switch DAC/TCG/DGS to Update; place probe into the position of receiving the 
maximized echo from the nearest reflector (first echo), then provide the coincidence between the echo and 
Gate A and store the first DAC echo 
 

 
 
To store the DAC echo the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click on  

 
•  Keyboard 
 
� Pressing <Alt>+<R> ⇒ Rec fore color changes to white - then press ↑↑↑↑  or →→→→ button on the keyboard  

(In the Rec the letter R is underlined) 
 
•  Combined 
 
� Click on Rec ⇒ Rec fore color changes to white - then press ↑↑↑↑  or →→→→ button on the keyboard 
 

As a result the first DAC echo will be stored and the corresponding indication  will appears 
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Place probe into the position ensuring the receiving of the maximized echo from the second reflector then 
provide the coincidence between the echo and Gate A and store the next DAC echo 
 

As result the second DAC echo will be stored and the incremented indication  appears: 
 

 
 
 

���� 
 

♦  A total number of 40 echoes may be stored one by one by the same way as described above if using 
the UDS 3-3 or UDS 3-4 

♦  A total number of 25 echoes may be stored if using the USLT 2000 
 
 



ISONIC Workstation from Sonotr

 
 
 
 
After creating a DAC (2 or more echoes stored) the DAC and / or TCG may be activated.  
There are two styles of DAC indication in the DAC mode: Main Curve Only and Main Curve ± N dB, where 
N may be setup either as 2, 4, 6, 8, 10, 12, or 14 dB . To proceed follow the rules below: 

 

 
 

 
•  Mouse 
 
� Click or press and hold on the a

 
•  Keyboard 
 
� Pressing <Alt>+<H> ⇒ Show D

the keyboard  (In the Show DA
 
•  Combined 
 
� Click on Show DAC ⇒ Show D

the keyboard 
 

+ N dB
o

C

- N dB
n NDT - Operating Manual – Revision 8.00 - Page 103 of 550  

 

ppropriate button    

AC fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
 the letter h is underlined) 

AC fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
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It’s possible to erase the last stored echo from the DAC. To proceed set the DAC/TCG/DGS to Update: 
 

 
 

To erase the last stored echo  
from the DAC the following  
manipulations are  
applicable: 
 

•  Mouse 
 

� Click on  
 

•  Keyboard 
 

� Pressing <Alt>+<R> ⇒ Rec fore color changes to white - then press ←←←← or ↓↓↓↓  button on the keyboard  
(In the Rec the letter R is underlined) 

 

•  Combined 
 

� Click on Rec ⇒ Rec fore color changes to white - then press ←←←← or ↓↓↓↓  button on the keyboard 
 

As a result the last stored echo will be erased and the decremented indication  will appear: 
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5.4.13. DGS (UDS3-3 and UDS 3-4) 
 

To setup DGS set Display to Full then click on  or press <Alt>+<D> on the keyboard. The following 
screen appears: 
 
 

 

 
 
 

 
 
 
 
 

Back echo amplitude as function of the metal 
travel distance in the reference block for the 

probe noted in the Probe box 

Echo amplitude from the disk shaped reflector 
(flat bottom hole - FBH) as function of the 

metal travel distance in the material under test 
for the probe noted in the Probe box. The FBH

diameter is noted in the Equivalent Dia box 

Probe box Equivalent 
Diameter box 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 106 of 550  

To activate DGS follow the steps below: 
 
Step 1: Probe 

 
The following manipulations are applicable for the Probe selection: 

 
•  Mouse 
 
� Click on  
 
� Drag / drop scrolling button  to select the probe 
 
 
� Click on the selected probe  

 
 
•  Keyboard 
 
� Pressing <Alt>+<P> ⇒ Probe fore color changes to white (In the Probe area letter P is underlined) 

then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard to select the probe 
 
•  Combined 
 
� Click on Probe ⇒ Probe fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard to select the probe 
 
 
 
Step 2: Equivalent Diameter of disk shaped reflector (flat bottom hole – FBH) 
 
The following manipulations are applicable for the selection of the Equivalent Diameter of disk shaped 
reflector: 
 
•  Mouse 
 
� Click on  

 
� Drag / drop scrolling button  to select the equivalent diameter 

 
� Click on the selected equivalent diameter  

 
 
 
•  Keyboard 
 

� Pressing <Alt>+<D> ⇒ Equivalent Dia fore color changes to white (In the Equivalent Dia area 
letter D is underlined) then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard to select the equivalent 
diameter 

 

•  Combined 
 

� Click on Equivalent Dia ⇒ Equivalent Dia fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard to select the equivalent diameter 

 
 



Step 3: Attenuation in the reference block 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
T
a
 
•
 

•
 

 
•
 

 

 

Current setup of the attenuation 

in the reference block 
(Reference Attenuation) 

dB/m 
ISONIC Workstation from Sonotron NDT

he following manipulations are  
pplicable: 

 Mouse 

� Click or press and hold on the appropri
 

 Keyboard 

� Pressing <Alt>+<N> ⇒ Reference Att
buttons on the keyboard  (In the Refere

 Combined 

� Click on Reference Attenuation ⇒ Re
, →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
Click on the Setup Step option or press <Alt> + <1> or 
<Alt> + <2> or <Alt> + <3> to select the required value for

increment / decrement of the Reference Attenuation 
either 1 dB/m or 2 dB/m or 6 dB/m correspondingly. The 

last selected step is checked: � 
 - Operating Manual – Revision 8.00 - Page 107 of 550  

ate button  

enuation fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
nce Attenuation area letter n is underlined) 

ference Attenuation fore color changes to white - then use ↑↑↑↑  



 
Step 4: Attenuation in the object under test 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
T
a
 
•  

 

 
•  

 

 
•  

 

 
 

 
in  
Current setup of the Material 
Attenuation (attenuation in the

object under test)  
dB/m 
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he following manipulations are  
pplicable: 

Mouse 

� Click or press and hold on the approp

Keyboard 

� Pressing <Alt>+<M> ⇒ Material At
buttons on the keyboard  (In the Mat

Combined 

� Click on Material Attenuation ⇒ Ma
, ←←←← , ↓↓↓↓  buttons on the keyboard 
Click on the Setup Step option or press <Alt> + <1> or 
<Alt> + <2> or <Alt> + <3> to select the required value for 
crement / decrement of the Material Attenuation either 1

dB/m or 2 dB/m or 6 dB/m correspondingly. The last 
selected step is checked: � 
DT - Operating Manual – Revision 8.00 - Page 108 of 550  

riate button  

tenuation fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
erial Attenuation area letter M is underlined) 

terial Attenuation fore color changes to white - then use ↑↑↑↑  , →→→→ 



Step 5: Transfer loss 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
T
a
 
•  

 

•  

 

 
•  

 

 
 

 
Current setup of the 
Transfer Loss 

dB 
ISONIC Workstation from Sonotron NDT -

he following manipulations are  
pplicable: 

Mouse 

� Click or press and hold on the appropriat
 
Keyboard 

� Pressing <Alt>+<T> ⇒ Transfer Loss f
on the keyboard  (In the Transfer Loss a

Combined 

� Click on Transfer Loss ⇒ Transfer Lo
buttons on the keyboard 
Click on the Setup Step option or press <Alt> + <1> or 
<Alt> + <2> or <Alt> + <3> to select the required value 
for increment / decrement of the Transfer Loss either 1
dB or 2 dB or 6 dB correspondingly. The last selected 

step is checked: � 
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e button  

ore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 
rea letter T is underlined) 

ss fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  



ISONIC W

Step 6: Gain 
 

Apply probe to the reference block to get the appropriate echo. There are two methods available: 
� K1 or K2 reference block (reference block and reflector are defined in the probe data sheet and 

reproduced automatically from the DGS data base upon probe selection) 
� Inclined reference block (reference reflector – back surface)  

 
 
 
 
 
 
 
 
 
 

 

 
Current Gain
dB 
orkstation from Sonotron NDT

The goal of the Gain s
getting the tip of max
reference echo reach
back echo level (blue
Click on the Setup Step option or press <Alt> + <1> or 
<Alt> + <2> or <Alt> + <3> to select the required value 
for increment / decrement of the  Gain either 1 dB or 2 
dB or 6 dB correspondingly. The last selected step is 

checked: � 
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The following manipulations are 
applicable for the Gain setup: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  
 

•  Keyboard 
 
� Pressing <Alt>+<G> ⇒ Gain fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Gain area letter T is underlined) 
 
•  Combined 
 
� Click on Gain ⇒ Gain fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
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Step 7: Finalizing DGS curve and return to the main UDS 3-3 / UDS 3-4 window 
 
Before finalizing the DGS curve: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

To finalize the DGS curve the following  
manipulations are applicable: 
 
 

Case 1 (K1 or K2 reference block) 
 

•  Mouse 
 
� Click on  

 
•  Keyboard 
 
� Pressing <Alt>+<K> 

 

Case 2 (Inclined reference block) 
 

•  Mouse 
 
� Click on  

 
•  Keyboard 
 
� Pressing <Alt>+<B> 

 
 

Finalized back echo curve (blue): depends on 
Probe and Reference Attenuation 

Finalized FBH echo curve (white): depends on 
Probe and Equivalent Dia and Material 

Attenuation 
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The finalized DGS curve appears accompanied with the Simultaneous Automatic Gain Correction: 
 
 
 
 
 
 
 

 
To accept the finalized DGS curve and return to the main UDS 3-3 / UDS 3-4 window the followi
manipulations are applicable: 
 

•  Mouse 
 

� Click on  
 
then 
 

� Click on  
 
•  Keyboard 
 

� Pressing <Alt>+<A>, then Esc  or  <Alt>+<C> 
 

Finalized back echo 
curve (blue) 

Finalized FBH echo 
curve (white) Finalized DGS curve (red)

a
co
Finalized 
utomatically 
rrected Gain
3 of 550 

ng 
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To negate the finalized DGS curve and return to the main UDS3-3 / UDS 3-4 window the following 
manipulations are applicable: 
 
•  Mouse 
 
� Click on  
 
then 
 
� Click on  

 
•  Keyboard 
 

� Pressing <Alt>+<O>, then Esc  or  <Alt>+<C> 
 
 
To create a new DGS curve the following manipulations are applicable: 
 
•  Mouse 
 
� Click on  
 

 
•  Keyboard 
 
� Press <Alt>+<O> 
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Step 8: Work whilst the DGS is active 
 
The typical screenshot with active DGS is shown below 
 
 

 
 

Some parameters and modes may not be modified whilst DGS is active - the corresponding messages 
appear if attempting to modify: 
 
 
 

 

 

 

To continue operations press Enter  or Esc  or click on the button  after the message appears 

To negate the active DGS or create a new one click on  or press <Alt>+<D> on the keyboard 
 
 

Probe and Equivalent Diameter of the FBH 
corresponding to the active DGS are indicated in 

the caption of the UDS3-3 / UDS 3-4 window 
DGS 
curve 
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5.4.14. DGS (USLT 2000) 

To use DGS set Display to Full (refer to the paragraph 5.4.5) then click on  or press <Alt>+<D> on 
the keyboard. The following screen appears: 
 
 
 
 

 
 
 

Back echo amplitude as function of the metal 
travel distance in the reference block for the 

probe noted in the Probe box 

Probe box Equivalent 
Diameter box 
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To activate DGS follow the steps below: 
 
Step 1: Probe 

 
The following manipulations are applicable for the Probe selection: 
 

•  Mouse 
 
� Click on  
 
� Drag / drop scrolling button  to select the probe 
 
 
 
� Click on the selected probe  

 
 
•  Keyboard 
 
� Pressing <Alt>+<P> ⇒ Probe fore color changes to white (In the Probe area letter P is underlined) 

then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard to select the probe 
 
•  Combined 
 
� Click on Probe ⇒ Probe fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard to select the probe 
 
 
 
Step 2: Equivalent Diameter of disk shaped reflector (flat bottom hole – FBH) 
 
The following manipulations are applicable for the selection of Equivalent Diameter of disk shaped reflector: 
 
•  Mouse 
 
� Click on  

 
� Drag / drop scrolling button  to select the equivalent diameter 

 
� Click on the selected equivalent diameter  

 
 
 
•  Keyboard 
 
� Pressing <Alt>+<D> ⇒ Equivalent Dia fore color changes to white (In the Equivalent Dia area 

letter D is underlined) then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard to select the equivalent 
diameter 

 
•  Combined 
 
� Click on Equivalent Dia ⇒ Equivalent Dia fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  

buttons on the keyboard to select the equivalent diameter 
 
 



Step 3: Attenuation in the reference block 
 
 
 
 
 
 
 
 

 
T
a
 
•
 

 
•
 

 
•
 

 

 
Current setup of the attenuation 
in the reference block 

(Reference Attenuation) 
dB/m 
ISONIC Workstation from Sonotron NDT

he following manipulations are 
pplicable: 

 Mouse 

� Click or press and hold on the appropri

 Keyboard 

� Pressing <Alt>+<N> ⇒ Reference Att
buttons on the keyboard  (In the Refere

 Combined 

� Click on Reference Attenuation ⇒ Re
, →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
Click on the Setup Step option or press <Alt> + <1> or 
<Alt> + <2> or <Alt> + <3> to select the required value for

increment / decrement of the Reference Attenuation 
either 1 dB/m or 2 dB/m or 6 dB/m correspondingly. The 

last selected step is checked: � 
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enuation fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
nce Attenuation area letter n is underlined) 

ference Attenuation fore color changes to white - then use ↑↑↑↑  
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Step 4: Attenuation in the object under test 
 
 
 
 
 
 
 
 

 
The following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  
 

•  Keyboard 
 
� Pressing <Alt>+<M> ⇒ Material Attenuation fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  

buttons on the keyboard  (In the Material Attenuation area letter M is underlined) 
 
•  Combined 
 
� Click on Material Attenuation ⇒ Material Attenuation fore color changes to white - then use ↑↑↑↑  , →→→→ 

, ←←←← , ↓↓↓↓  buttons on the keyboard 
 
 

Current setup of the Material 
Attenuation (attenuation in the 

object under test)  
dB/m 

Click on the Setup Step option or press <Alt> + <1> or 
<Alt> + <2> or <Alt> + <3> to select the required value 
for increment / decrement of the Material Attenuation

either 1 dB/m or 2 dB/m or 6 dB/m correspondingly. 
The last selected step is checked: � 
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Step 5: Transfer loss 
 
 
 
 
 
 
 
 

 
The following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  
 

•  Keyboard 
 
� Pressing <Alt>+<T> ⇒ Transfer Loss fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard  (In the Transfer Loss area letter T is underlined) 
 
•  Combined 
 
� Click on Transfer Loss ⇒ Transfer Loss fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  

buttons on the keyboard 
 
 

Current setup of the 
Transfer Loss 

dB 

Click on the Setup Step option or press <Alt> + <1> or 
<Alt> + <2> or <Alt> + <3> to select the required value 
for increment / decrement of the Transfer Loss either 
1 dB or 2 dB or 6 dB correspondingly. The last selected 

step is checked: � 
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Step 6: Gain 
 

Apply probe to the reference block to get the appropriate echo. There are two methods available: 
� K1 or K2 reference block (reference block and reflector are defined in the probe data sheet and 

reproduced automatically from the DGS data base upon probe selection) 
� Inclined reference block (reference reflector – back surface)  

 
 
 
 
 
 
 
 
 
 

 
 

Current Gain 
dB 

Click on the Setup Step option or press <Alt> + <1> or 
<Alt> + <2> or <Alt> + <3> to select the required value 
for increment / decrement of the  Gain either 1 dB or 2 
dB or 6 dB correspondingly. The last selected step is 

checked: � 

The goal of the Gain setup is 
getting the tip of maximized 
reference echo reaching the 
back echo level (blue curve) 
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The following manipulations are  
applicable for the Gain setup: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  
 

•  Keyboard 
 
� Pressing <Alt>+<G> ⇒ Gain fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Gain area letter T is underlined) 
 
•  Combined 
 
� Click on Gain ⇒ Gain fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
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Step 7: Finalizing DGS curve and return to the main USLT 2000 window 
 
Before finalizing the DGS curve: 
 
 

To finalize the DGS curve 
the following manipulations are applicable: 
 
Case 1 (K1 or K2 reference block) 
 

•  Mouse 
 
� Click on  

 
•  Keyboard 
 
� Pressing <Alt>+<K> 

 

Case 2 (Inclined reference block) 
 

•  Mouse 
 
� Click on  

 
•  Keyboard 
 
� Pressing <Alt>+<B> 

 
 

Finalized back echo curve (blue): depends on 
Probe and Reference Attenuation 
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The finalized DGS curve appears accompanied with the Simultaneous Automatic Gain Correction: 
 
 
 

 

To accept the finalized DGS curve and return to the main USLT 2000 window the following manipulations are 
applicable: 
 
•  Mouse 
 
� Click on  
 
then 
 
� Click on  

 
•  Keyboard 
 

� Pressing <Alt>+<A>, then Esc  or  <Alt>+<C> 
 

Finalized DGS curve Finalized automatically corrected Gain 
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To negate the finalized DGS curve and return to the main USLT 2000 window the following manipulations are 
applicable: 
 
•  Mouse 
 
� Click on  
 
then 
 
� Click on  

 
•  Keyboard 
 

� Pressing <Alt>+<O>, then Esc  or  <Alt>+<C> 
 
To create a new DGS curve the following manipulations are applicable: 
 
•  Mouse 
 
� Click on  
 

 
•  Keyboard 
 
� Press <Alt>+<O> 
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Step 8: Work whilst the DGS is active 
 
The typical screenshot with active DGS is shown below 
 

 
 
 

 
 
 

Some parameters and modes cannot be modified while DGS is active - the corresponding messages appear 
if attempting to modify: 

 
To continue the operation wait until the message disappears 

To negate the active DGS or create a new one click on  or press <Alt>+<D> on the keyboard 
 
 

Probe and Equivalent Diameter of 
the FBH corresponding to the active 

DGS are indicated in the caption of the 
USLT 2000 window 

DGS 
curve 



5.4.15. Sub Menu MEASURE 
 
 

 
 The last selected 
Measured Value 
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To select required Measured  
Value the following manipulations  
are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<V> ⇒ Meas Value fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard  (In the Meas Value area letter V is underlined) 
 
•  Combined 
 
� Click on Meas Value ⇒ Meas Value fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard 
 
 

����  
Refer to the paragraph 5.4.16 to get the complete list of values available for automatic measurement and 
indication in the Value Box (Digital Readout) 
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To select the Measurement Mode  
the following manipulations are  
applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<E> ⇒ Meas Mode fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard  (In the Meas Mode area letter e is underlined) 
 
•  Combined 
 
� Click on Meas Mode ⇒ Meas Mode fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard 
 
 

����  
Refer to the paragraph 5.4.16 for the Top and Flank tips 

 
 
 

The Currently Active 
Measurement Mode
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To setup Probe Delay the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<R> ⇒ Probe Delay fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard  (In the Probe Delay area letter r is underlined) 
 
•  Combined 
 
� Click on Probe Delay ⇒ Probe Delay fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard 
 
 
 

���� Refer to the paragraph 5.4.16 for the determining of the Probe Delay 
 
 

Current value of 
the Probe Delay 

µs 

Current value for the next 
increment/decrement of the Probe 

Delay setup 
µs 

Click on this button or press 
<Alt>+<4> on the keyboard to 
select the value for the next 
increment/decrement of the Probe 
Delay setup in µs. The possible 
steps are: 0.01, 0.02, 0.05, 0.1, 
0.01, 0.2, 0.5, 1, 2, 5, 10, 20, 50, 
and 100 µs 
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To setup Incident Angle the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 
� Pressing <Alt>+<N> ⇒ Angle fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Angle area letter n is underlined) 
 
•  Combined 
 
� Click on Angle ⇒ Angle fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 
 
 

����  
Refer to the paragraph 5.4.16 for the Probe Angle measuring techniques 

 
 
 

Current value of the 
Incident Angle 

Deg 

Current value for the next 
increment/decrement of the 

Incident Angle setup 
Deg 

Click on this button or press 
<Alt>+<4> on the keyboard to 
select the value for the next 
increment/decrement of the 
Incident Angle setup in Deg. The 
possible steps are: 1°, 2°, 5°, 10°, 
20°, and 50° 
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5.4.16. Time Domain Signal Evaluation - Measurements Guide 
 
List of the Values available for the Automatic Measurements and Digital Readout 
  

Value 1: T(A)  
The Time of Flight - µs for the echo 
matching with the Gate A with respect to the 
Probe Delay: 
 

T(A) = Absolute Delay A - Probe Delay 
 

Value 2: T(B)  
The Time of Flight - µs for the echo 
matching with the Gate B with respect to the 
Probe Delay: 
 

T(B) = Absolute Delay B - Probe Delay 
 

Value 3: s(A)  
The Material Travel Distance - mm or in for 
the echo matching with the Gate A: 
 

s(A) = ½ · T(A) · US Velocity 
 

Value 4: s(B)  
The Material Travel Distance - mm or in for 
the echo matching with the Gate B: 
 

s(B) = ½ · T(B) · US Velocity 
 

Value 5: a(A)  
The Projection Distance - mm or in for reflector returning the echo matching with the Gate A, the distance 

measured with respect to the Beam Incident 
Point: 
 

a(A) = s(A) · sin ( Angle ) 
 

Value 6: a(B)  
The Projection Distance  - mm or in for 
reflector returning the echo matching with the 
Gate B, the distance measured with respect 
to the Beam Incident Point: 
 

a(B) = s(B) · sin ( Angle ) 
 

Value 7: t(A)  
The Depth - mm or in of the reflector 
returning the echo matching with the Gate A: 
 

t(A) = s(A) · cos ( Angle ) 
 

Value 8: t(B)  
The Depth - mm or in of the reflector returning the echo matching with Gate B: 
 

t(B) = s(B) · cos ( Angle ) 
 

Value 9: ∆∆∆∆T - µs: 
 

∆∆∆∆T = T(B) – T(A) 
 

Value 10: 
  

 ∆∆∆∆s  - mm or in: 
 

∆∆∆∆s = s(B) – s(A) 
 

Value 11: ∆∆∆∆a  - mm or in: 
 

∆∆∆∆a = a(B) – a(A) 
 

Value 12: 
  

 ∆∆∆∆t  - mm or in: 
 

∆∆∆∆t = t(B) – t(A) 
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Value 13: H(A)  
The Amplitude - % of A-Scan height of the 
highest echo matching with the Gate A   
 
Value 14: H(B)  
The Amplitude - % of A-Scan height of the 
highest echo matching with the Gate B 
 
Value 15: V(A) 
The Amplitude - dB of the highest echo 
matching with the Gate A with respect to the 
aThreshold: 
 

V(A) = 20 · log10 ( H(A) / aThreshold ) 
 

Value 16: V(B) 
The Amplitude - dB of the highest echo 

matching with the Gate B with respect to the bThreshold: 
 

V(B) = 20 · log10 ( H(B) / bThreshold ) 
 

Value 17: 
  

 ∆∆∆∆V - dB: 
 

∆∆∆∆V = V(B) – V(A) 
 
 

Value 18: 
  

 ∆∆∆∆VC(A) – dB ( so called dB to DAC ): 
 

∆∆∆∆VC(A) = 20 · log10 ( H(A) / C (Absolute Delay A_Top) ) 
 

Value 19: 
  

 ∆∆∆∆VC(B) – dB ( so called dB to DAC ): 
 

∆∆∆∆VC(B) = 20 · log10 ( H(B) / C (Absolute Delay B_Top) ) 
 

 
���� 
 

♦  To proceed with the measurements the corresponding Gate or and/or both Gates and/or DAC/DGS must 
be active 

 

♦  The height of echo (~es) may not exceed 100% of the A-Scan height for all amplitude measurements 
 

♦  If there are few pulses in the gate (more than 1) then the amplitude of the highest echo will be measured 
 

♦  The height of measured echo (echoes) must exceed the corresponding Gate Threshold only if 
measuring the sound path / reflector’s coordinates / time of flight while the Meas Mode is set to Flank  
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∆∆∆∆s  - Dual Ultrasound Velocity Measurement Mode 
  

For some practical applications it may be necessary to measure the sound path distances in the different 
materials or in the same materials for the signals representing the different kind of waves. Such cases are 
characterized by different values of the USVelocity (ultrasound velocity) to be applied to different signals. In 
order to optimize the measurement procedure the Dual Ultrasound Velocity Measurements Mode is available 
and illustrated by the typical example sketch and short guidance below 
 

There is a need to measure the thickness of each layer of the bi-metallic part made through the explosion 
welding between regular carbon steel ( USVelocity = 5920 
m/s ) and brass alloy ( USVelocity = 4720 m/s ). The probe 
must be placed at the low carbon steel while measuring. The 
dual 10 MHz probe with the ( Probe Delay = 5.8 µµµµs ) while 
placed on the steel side provides the receiving of two clear 
signals 1 and 2 form the steel-brass boundary and from the 
back surface of the brass layer correspondingly: 
 

 
 

The USVelocity setup is suitable for the steel so the thickness of the steel layer is available for the direct 
reading upon placing Gate A above the signal 1: 
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If placing now Gate B above the signal 2 and selecting the ∆∆∆∆s value to be measured then the difference 
between the ultrasonic path distances covered by the signals 1 and 2 will be displayed however such 
distance is still calculated using the value of USVelocity suitable for steel: 
 

 
 
 

To obtain the proper reading of the brass layer thickness: 
 

•  press <Shift> + <V> on the keyboard 
 

 
 

•  in the appeared Second USVelocity subwindow set the proper value (in this specific example – the 
value suitable for the brass alloy) and get the proper reading immediately in the said subwindow 

 

To return to the main ISONIC Pulser Receiver window click on the  or press <Alt>+<K> or 

Enter  or Esc  on the keyboard 
 

To printout the A-Scan accompanied with the setup list and with the measured value of ∆∆∆∆s and the Second 

USVelocity click on the  or press <Alt>+<P> on the keyboard 
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Top and Flank 
 

 
 

���� 
 

♦  Top and Flank relate to the measuring of the time of flight and coordinates 
 

♦  First gate-cross point (F) is used for the Flank related measurements 
 

♦  The tip of highest echo in the gate (T) used for the Top related measurements 
 

♦  Signals out of the gate are not be measured 
 

♦  If there are no signals exceeding the gate threshold than the Top related measurement only are possible  
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Probe Delay: 
 

(a) Miniature Angle Beam Probes (contact face width 12.5 mm / 0.5 in or less) – Shear or Longitudinal 
Waves 

 

 

 

Activate the PULSER topic then set: 
 

� Pulser Mode to Single or Dual depending on the 
probe 

� Energy to 120 µµµµJ �UDS 3-3 
� Energy to High�USLT 2000 
� Pulse Width to Spike (240 µµµµJ) for the probe having 

resonant frequency of 8 MHz and higher or to PW 
ns, were PW = 0.5 / F (F is the probe resonant 
frequency) for the probes having resonant frequency 
below 8 MHz �UDS 3-4 

� Damping to 333 ΩΩΩΩ �UDS 3-3 
� Damping to 500 ΩΩΩΩ �USLT 2000 
� Damping to 1000 ΩΩΩΩ �UDS 3-4 
� Tuning to NO�UDS 3-4 

 

Activate the RECEIVER topic then set: 
 

� Display to Full or RF  
� Filter to BB�UDS 3-4 
� Frequency to completely cover the probe's effective 

bandwidth  
 

Activate the BASICS topic then set: 
 

� US Velocity to 5920 m/s (233.1 in/ms) for the 
longitudinal wave probes or 3255 m/s (128.1 in/ms) 
for the shear wave probes   

� Range to 50.0 mm (2 in) 
� Display Delay to 0 µs 
� Reject to 0% 

 

Stage 1: Manipulate the probe over the main 
working surface of the V-2 reference standard and 
maximize the echo from the 25 mm (1 in) radius 
concave reflector  
 

Stage 2: Fix the probe in the found position - the 
center of 25 mm (1 in) radius concave reflector will 
indicate the incident point while the distance 
between the frontal probe edge and the incident 
point is equal to X-Value 
 

Stage 3: Tune the Display Delay while the probe 
is still fixed in the found position until rising edge of 
the maximized echo will match with 50%-grid of the 
A-Scan width: in such case the obtained value of 
Display Delay is equal to the actual Probe Delay 

 
 

���� 
♦  It's necessary to setup Gain bringing the height of the maximized echo to the level of 75-80% of the A-

Scan height 
 

♦  For the units equipped with UDS 3-4 Pulser Receiver Card it is recommended to optimize Tuning in the 
PULSER submenu upon obtaining the maximized echo. The goal of the optimization is increasing of the 
energy of ultrasonic excitation though the better matching between firing output and probe. Level of the 
energy of ultrasonic excitation is clearly represented by the echo amplitude. Upon completing optimization 
of the Tuning the Gain to be adjusted to bring the height of the maximized echo to the vertical level of 75-
80% of the A-Scan height 
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(b) Large and Medium Size Angle Beam Probes (contact face width more than 12.5 mm / 0.5 in) – 
Shear or Longitudinal Waves 

 

 

Activate the PULSER topic then set: 
 

� Pulser Mode to Single or Dual depending on the 
probe 

� Energy to 120 µµµµJ �UDS 3-3 
� Energy to High�USLT 2000 
� Pulse Width to Spike (240 µµµµJ) for the probe having 

resonant frequency of 8 MHz and higher or to PW 
ns, were PW = 0.5 / F (F is the probe resonant 
frequency) for the probes having resonant frequency 
below 8 MHz �UDS 3-4 

� Damping to 333 ΩΩΩΩ �UDS 3-3 
� Damping to 500 ΩΩΩΩ �USLT 2000 
� Damping to 1000 ΩΩΩΩ �UDS 3-4 
� Tuning to NO�UDS 3-4 

 

Activate the RECEIVER topic then set: 
 

� Display to Full or RF  
� Filter to BB�UDS 3-4 
� Frequency to completely cover the probe's effective 

bandwidth  
 

Activate the BASICS topic then set: 
 

� US Velocity to 5920 m/s (233.1 in/ms) for the 
longitudinal wave probes or 3255 m/s (128.1 in/ms) 
for the shear wave probes   

� Range to 200.0 mm (4 in) 
� Display Delay to 0 µs 
� Reject to 0% 

 

Stage 1: Manipulate the probe over the main 
working surface of the V-2 reference standard and 
maximize the echo from the 100 mm (4 in) radius 
concave reflector  
 

Stage 2: Fix the probe in the found position - the 
center of 100 mm (4 in) radius concave reflector 
will indicate the incident point while the distance 
between the frontal probe edge and the incident 
point is equal to X-Value 
 

Stage 3: Tune the Display Delay while the probe 
is still fixed in the found position until rising edge of 
the maximized echo will match with 50%-grid of the 
A-Scan width: in such case the obtained value of 
Display Delay is equal to the actual Probe Delay 

 
 

���� 
♦  It's necessary to setup Gain bringing the height of the maximized echo to the level of 75-80% of the A-

Scan height 
 

♦  For the units equipped with UDS 3-4 Pulser Receiver Card it is recommended to optimize Tuning in the 
PULSER submenu upon obtaining the maximized echo. The goal of the optimization is increasing of the 
energy of ultrasonic excitation though the better matching between firing output and probe. Level of the 
energy of ultrasonic excitation is clearly represented by the echo amplitude. Upon completing optimization 
of the Tuning the Gain to be adjusted to bring the height of the maximized echo to the vertical level of 75-
80% of the A-Scan height 
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(c) Straight Beam (Normal) Single Element and Dual (TR) Probes 
 

Activate the PULSER topic then set: 
 

� Pulser Mode to Single or Dual 
depending on the probe 

� Energy to 120 µµµµJ �UDS 3-3 
� Energy to High�USLT 2000 
� Pulse Width to Spike (240 µµµµJ) for 

the probe having resonant frequency 
of 8 MHz and higher or to PW ns, 
were PW = 0.5 / F (F is the probe 
resonant frequency) for the probes 
having resonant frequency below 8 
MHz �UDS 3-4 

� Damping to 333 ΩΩΩΩ �UDS 3-3 
� Damping to 500 ΩΩΩΩ �USLT 2000 
� Damping to 1000 ΩΩΩΩ �UDS 3-4 
� Tuning to NO�UDS 3-4 

 

Activate the RECEIVER topic then set: 
 

� Display to Full or RF  
� Filter to BB�UDS 3-4 
� Frequency to completely cover the 

probe's effective bandwidth  
 

Activate the BASICS topic then set: 
 

� US Velocity to 5920 m/s (233.1 
in/ms) for the longitudinal wave 
probes or 3255 m/s (128.1 in/ms) for 
the shear wave probes   

� Range to 25.0 mm (1 in) 
� Display Delay to 0 µs 
� Reject to 0% 

 

 
 
Stage 1: Apply probe to the side surface of V-2 reference standard and obtain the back echo 
 
Stage 2: Tune the Display Delay until rising edge of the back echo will match with the 50%-grid of the A-
Scan width: in such case the obtained value of the Display Delay is equal to the actual Probe Delay 
 
 

���� 
♦  It's necessary to setup Gain bringing the height of the back echo to the level of 75-80% of the A-Scan 

height 
 

♦  For the units equipped with UDS 3-4 Pulser Receiver Card it is recommended to optimize Tuning in the 
PULSER submenu upon getting the back echo. The goal of the optimization is increasing of the energy of 
ultrasonic excitation though the better matching between firing output and probe. Level of the energy of 
ultrasonic excitation is clearly represented by the back echo amplitude. Upon completing optimization of 
the Tuning the Gain to be adjusted to bring the height of the back echo to the vertical level of 75-80% of 
the A-Scan height 
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Incidence Angle (Probe Angle) 
 
 

Determining of the incidence angle is 
based on maximizing echo from the 
side-drilled hole in the reference block 
and reading the value of angle from 
the corresponding scale. Depending 
on probe dimensions and angles the 
are different reference blocks and 
scales applicable: 
 
Case 1: Miniature angle beam probe, 
incidence angle 35o to 65o, V-2 
reference block 
 
Case 2: Miniature angle beam probe, 
incidence angle 65o to 75o, V-2 
reference block 
 
Case 3: Medium or large size angle 
beam probe, incidence angle 40o to 
66o, V-1 reference block 
 
Case 4: Medium or large size angle 
beam probe, incidence angle 60o to 
76o, V-1 reference block 
 
Case 5: Medium or large size angle 
beam probe, incidence angle 74o to 
80o, V-1 reference block 



I

5.4.17. Frequency Domain Signal Presentation and Evaluation 
 
To activate FFT Mode: 

Using Range and Delay parameters select the portion of signal for FFT presentation and then do as follows: 

UDS 3-3 / UDS 3-4: in the RECEIVER submenu switch the Display mode to FFT. The window will look as 
below: 
 

 
 
 
 

 

���� 
 

The 
 

USLT
appe
 
 
 

FF

F

 
FFT Graph
SONIC Workstation from Sonotron

 

 
Display mode may not be switched into the FFT if the Range value is too large or DAC/TCG/DGS is active 

 2000: Switch the Display parameter to RF and click on the FFT button upon. The FFT window 
ars: 

T Measurements 
Controls 

FFT Measurements 
Indicator 

Displayed Frequency 
Range Controls 

FT Measurements 
Controls 

FFT Measurem
Indicator 
FFT Graph
 NDT - Operating Manual – Revision 8.00  
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Source Signal
 

isplayed Frequency 
Print Button
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The lower frequency bound of the displayed FFT graph: 
 

UDS 3-3 / UDS 3-4: 
 
 
 
 
 
 

 
 

To setup LowerFreq the following  
manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
•  Keyboard 
 

� Pressing <Alt>+<W> ⇒ LowerFreq fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the LowerFreq area letter w is underlined) 

 
•  Combined 
 

� Click on LowerFreq ⇒ LowerFreq fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 
USLT 2000: 
To setup LowerFreq the following manipulations are applicable: 
 
•  Mouse 
 
� Click or press and hold on the appropriate button  

 
 

 
 

Current value of the lower 
frequency bound  -

LowerFreq 
MHz 

Current value for the next 
increment/decrement of the Gain setup 

LowerFreq setup 
MHz Click on this button or press 

<Alt>+<2> on the keyboard to 
select the value for the next 
increment/decrement of the 
LowerFreq setup in MHz. The 
possible steps are: 0.1, 0.2, and 
0.5 MHz 

Clicking on this slider changes 
the increment / decrement for the 
LowerFreq setup. The possible 
steps are varying depending on 
the duration of the source signal 

Current value of the lower 
frequency bound  

LowerFreq 
MHz 
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The upper frequency bound of the displayed FFT graph: 
 
UDS 3-3 / UDS 3-4: 
 
 
 
 
 
 

 
 

 
To setup UpperFreq the following  
manipulations are applicable: 
 
•  Mouse 
 

� Click or press and hold on the appropriate button  
 
•  Keyboard 
 

� Pressing <Alt>+<U> ⇒ UpperFreq fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the UpperFreq area letter U is underlined) 

 
•  Combined 
 

� Click on UpperFreq ⇒ UpperFreq fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 
USLT 2000: 
To setup UpperFreq the following manipulations are applicable: 
 

•  Mouse Clicks 
 
� Click or press and hold on the appropriate button  

 

 

Current value of the upper 
frequency bound  - 

UpperFreq 
MHz 

Current value for the next 
increment/decrement of the Gain 

setup UpperFreq setup 
MHz 

Click on this button or press 
<Alt>+<3> on the keyboard to 
select the value for the next 
increment/decrement of the 
UpperFreq setup in MHz. The 
possible steps are: 0.1, 0.2, and 
0.5 MHz 

Clicking on this slider changes 
the step of increment or 

decrement for the UpperFreq 
setup. The possible steps are 

varying depending on the 
duration of the source signal 

Current value of the upper 
frequency bound 

UpperFreq 
MHz 
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Find the maximum between two selected points on the FFT graph: 
 

Click on . The mouse pointer may be guided now just over the FFT graph. The FFT Measurements 
Indicator displays the frequency corresponding to the pointer position whilst guiding the cursor. Select the 
first point of interest by the mouse click or through the release of the touch screen stylus. The appropriate 
mark  appears: 

 

Select the second point of interest by the same way - t
FFT Measurements Indicator displays the found valu
screen stylus: 

UDS 3-3 / UD

USLT 200

 

f

First point FFT Mark
 
 

he maximum’s frequency mark  appears and the 
e upon the mouse click or releasing of the touch 

S 3-4 
Maximum’s 
requency mark
rating 

0 

f

Found value of  the 
maximum’s 
frequency 
 

 
Found value of  the
maximum’s 
frequency 
Maximum’s 
requency mark
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Find the –3db / –20db level bounds: 

Find the maximum as described above. Click on  or . Two points found corresponding to the 
selected level appear on the FFT graph and the FFT Measurements Indicator shows their corresponding 
frequencies: 

 
UDS 3-3 / UDS 3-4 

 
USLT 2000 

 
 

 
 
Return to the FFT Measurements toolbar: 
 

Click on  

Maximum’s 
frequency mark

Frequencies of the 
- 3 dB level 

Frequencies of the 
- 20 dB level 

Maximum’s 
frequency 

mark 

Marks of the 
- 3 dB level 

Marks of the 
- 20 dB level 
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Find the frequency corresponding to the selected single point on the FFT graph: 
 

Click on . The mouse pointer may be guided now just over the FFT graph. The FFT Measurements 
Indicator displays the frequency corresponding to the pointer position whilst guiding the cursor. Select the 
point of interest by the mouse click or through the release of the touch screen stylus. The appropriate mark 

 appears and the FFT Measurements Indicator shows the corresponding frequency: 
 

 
Frequency difference (deviation) between two points: 
 

Click on . The mouse pointer may be guided now just over the FFT graph. The 
Indicator displays the frequency corresponding to the pointer position whilst guiding th
first point of interest by the mouse click or through the release of the touch screen sty
mark  appears. Select the second point of interest by the same way - the appropria
and the FFT Measurements Indicator displays the difference (deviation) between
frequencies: 
 

 

 

Sel
diff

corres
Selected point
and the 

corresponding
frequency
age 145 of 550 

 

FFT Measurements 
e cursor. Select the 
lus. The appropriate 
te mark  appears 
 the corresponding 

 

ected point and the 
erence (deviation) 

between the 
ponding frequencies
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Clear the FFT Marks: 
 

Click on  
 
Print the FFT graph: 
 
UDS 3-3 / UDS 3-4: 
 

Click on  or press <Alt> + <P> on the keyboard. 

 
USLT 2000: 
 

Click on . 
 
Exit FFT Mode: 
 
UDS 3-3 / UDS 3-4: 
 
Change the Display mode.  
 
USLT 2000: 
 

Click on  or press Esc  
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5.4.18. Freeze the A-Scan 
 

 
 
To freeze / unfreeze the A-Scan click on  or press <Alt>+<F> on the keyboard 
 
���� 
 

♦  The following operations are available while the time domain A-Scan is frozen: 
 

o Manipulating Gates A and B according to the paragraphs 5.4.7 through 5.4.9 of this Operating 
Manual 

 

o Varying Alarm modes according to the paragraph 5.4.10 of this Operating Manual 
 

o Varying selection of the automatic measurements mode and probe parameters (Probe Delay and 
Angle) as per Chapter 5.4.15 of this Operating Manual and getting the corresponding 
measurements results in the Value digital readout box 

 

♦  The caption of the appropriate button changes upon freeze / unfreeze the A-Scan 
 

                                                          
 



ISONIC Workstation from Sonotron NDT - Operating  

"Infinite Scrolling Tape" while freezing  (USLTPR Software Package - USLT 2000 only) 

 
 
  

  
 
 
 
 
 
 
 
 
 
 
 
 

 

To pause/continue the scrolling left mouse click on . 
"Infinite scrolling tape" disappears automatically upon 
unfreezing the A-Scan 
Freezing A-Scan while some gate is
active will cause appearing of the so-
called "infinite scrolling tape" 
showing the results for all possible 
measurements
Manual – Revision 8.00 - Page 148 of 550 
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5.4.19. Save an A-Scan and its Calibration Dump into a file 
 

To save the A-Scan and Calibration Dump into a file click 

on  or press <Alt>+<S> on the keyboard – the typical 
ISONIC Save/Open window appears. The automatically 
created name for a new file appears in the File Name: field 
 
To save a file: 
 

•  select disk drive and directory for placing a file 
 

•  approve the automatically created or type a new file 
name consisting of not more of 8 symbols (letters from 
a to z and / or numbers from 0 to 9 only) or choose one 
of existing files to be replaced 

•  click on  or double click on the name of the 

file to be replaced or press Enter  or <Alt>+<S> on the 
keyboard 
 

ISONIC Save / Open window disappears automatically upon completing saving a file. To exit from ISONIC 

Save / Open window without saving a file click on  or press Esc  or <Alt>+<C> on the 
keyboard 
 
5.4.20. Load an A-Scan and its Calibration Dump from a file 

 

To load A-Scan and Calibration Dump from a file click on 

 or press <Alt>+<O> on the keyboard – the typical 
ISONIC Save/Open window appears 
 

To open a file: 
 

•  select disk drive and directory containing a file required 
 

•  select then file then double click on its name or click on 

 or press Enter  or <Alt>+<O> on the 
keyboard 

 

ISONIC Save/Open window disappears automatically upon 
completing loading a file. To exit from ISONIC Save/Open 

window without opening a file click on  or press 

Esc  or <Alt>+<C> on the keyboard 
 
5.4.21. Printing A-Scan and Calibration Dump 
 

To print the A-Scan and Setup list click on  or press <Alt>+<P> on the keyboard. The automatic 
measurements results if exist appear in the A-Scan and Setup list printout 
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5.4.22. Zoom Function - Enlarging the A-Scan (UDS3-3 and UDS 3-4) 
 
Double click on the A-Scan to get it enlarged. The enlarged A-Scan occupies the full screen width while all 
controls are hidden. To return back to the main ISONIC Pulser / Receiver window double click on the 
enlarged A-Scan  
 
5.4.23. Set Up Language for the User Interface and On-Line Help 

To select the user interface language and on-line help click on . Refer to the paragraph 4.6 of this 
Operating Manual 
 
5.4.24. On-Line Help 
 

To get the On-Line Help select an object then right mouse click on it – the help topic appears automatically. 

To close help topic press Esc  or click on it. To print help topic or copy it into the Windows clipboard right 
mouse click on it 
 

 
 
5.4.25. Switch OFF Pulser / Receiver 
 

To switch OFF Pulser / Receiver click on  or press Esc  or <Alt>+<C> on the keyboard 
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5.5. Signals' Recording and Simplest Imaging Features   
 
The simple and fast recording and imaging of defects / thickness profile without any form of encoding device 
may be performed according to the following imaging schemes: 
 

•  t-B-Scan(Th) – timed (time-based) thickness B-Scan - graphically representing thickness profile of 
the object under test in the selected section allowing fast identification of the corroded, laminated or 
pitted areas 

 
•  t-B-Scan(A) – timed (time-based) amplitude multi-echo B-Scan - graphically representing in the 

selected section of the object under test with all amplitude defects and geometry responses 
 

•  t-TOFD – timed (time-based) Time of Flight Diffraction Record – the RF B-Scan 
 
5.5.1. Timed (time-based) Thickness B-Scan: t-B-Scan(Th) 
 
t-B-Scan(Th) mode allows to display a thickness profile of the test object in the selected section through the 
taking continuous thickness measurements along the scanning path over a maximum measurement period of 
72 seconds. To perform the imaging the probe must be linearly driven over the section to be 
displayed during the measurement period with the approximately constant speed  
 
5.5.1.1. Prior to the running t-B-Scan(Th) mode 
 

•  Carry out the valid calibration for the Probe Delay and US Velocity  
 

•  Activate Gate A  
 

•  Referring to the table below define the region of interest through the setup of the Display Delay, 
Range, aStart and aWidth  

 

•  Select the section of the object under test to scan over and the length of the corresponding scanning 
line (Scan Length) 

 

•  Provide the appropriate calibration for Gain and aThreshold. Check the possibility of the receiving of 
the desired signals along the selected scanning line: 

 

� The first signal matching with the Gate A and exceeding its threshold will be measured 
during the t-B-Scan(Th) recording if the Meas Mode is setup to Flank 

 

� The maximal signal matching with the Gate A and exceeding its threshold will be measured 
during the t-B-Scan(Th) recording if the Meas Mode is setup to Top 
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Defining of the Region of Interest (ROI) for the t-B-Scan(Th) recording 
 

 

 

 

 
 
 
Case 1 

 

 
 

aStartSRD =  
 

aWidthRW =  

 
 
 
 
Case 2 

 

 

USVelocityayDisplayDelSRD ×=
2

 

 
SRDaWidthaStartRW −+=  

 
 
 
 
Case 3 

 

 
aStartSRD =  

 

aStartRange

USVelocityayDisplayDelRW

−+

+×=
2  

 
 
 
 
Case 4 

 

 
 

USVelocityayDisplayDelSRD ×=
2

 

 
RangeRW =  
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Gate

Gate
 

Start

Scanning Len

5.5.1.2. Startup the t-B-Scan(Th) mode 
 

To run t-B-Scan(Th) mode click on  or press <Alt>+<B> on the keyboard.  
 

The pre-recording ISONIC Control menu appears: 
 

 
 

Click on  or press <Alt>+<H> on the keyboard to 
run t-B-Scan(Th) mode. The screen as below 
appears upon:  

Click on  or press <Alt>+<C> or Esc  on the keyboard 
to return to the Pulser / Receiver window 

 

 

d 
Empty t-B-Scan(Th) record fiel
ating Manual – Revision 8.00 - Page 153 of 550 

 

End

gth / Scanning Time 

 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 154 of 550  

5.5.1.3. t-B-Scan(Th) Control Panel 
 
Scan Length and Scan Time 
 
The value of L (Scan Length or, in other words, Scan Path) 
represents the length of the section of the test object to be 
displayed, over which the probe will be guided during the recording 
period. Time (Scan Time) is the duration of the said recording 
period. There are 4 (four) possible values for L and there are 3 
(three) possible values for Time corresponding to the each value 
of L: 
 

Scan Length – L Possible Scan Time – Time 
100 mm or 4 in 8, 16 and 24 sec 
150 mm or 6 in 12, 24 and 36 sec 
200 mm or 8 in 16, 32 and 48 sec 
300 mm or 12 in 24, 48 and 72 sec  

 
To select the required value of Scan Length – L the following manipulations are applicable: 
 
•  Mouse 
 

� Click on the corresponding button  or  
 
•  Keyboard 
 

� Pressing <Alt>+<L> ⇒ L fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (L is underlined) 

 
•  Combined 
 

� Click on L ⇒ L fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 
 
 
To select the required value of Scan Time – Time the following manipulations are applicable: 
 
•  Mouse 

� Click on the corresponding button  or  
 
•  Keyboard 
 

� Pressing <Alt>+<T> ⇒ Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Time area letter T is underlined) 

 
•  Combined 
 

� Click on Time ⇒ Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
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Threshold 
 
The Threshold is the thickness limit, selectable by an operator. The thickness limit is permanently indicated 
on the cross-sectional thickness profile easing the graphic evaluation of the obtained results. The value of the 
Threshold may be setup over the whole Region of Interest. This provides direct reading of the object 
thickness at any point of interest along the t-B-Scan(Th) record 
 
To select the required value of Thickness Limit – Threshold the following manipulations are applicable: 
 
•  Mouse 

� Click on the corresponding button  or  
 
•  Keyboard 
 

� Pressing <Alt>+<H>  ⇒ Threshold fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Threshold area the first letter H is underlined) 

 
•  Combined 
 

� Click on Threshold ⇒ Threshold fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 
Time-out 
 
The Time-out is the waiting time for intermissions. The time-out counting starts as soon as missing an echo 
in the gate during t-B-Scan(Th) recording (Event 1). Immediately since an echo matches with the gate again 
(Event 2) the t-B-Scan(Th) recording is continued if the time between Event 1 and Event 2 does not exceed 
the value of Time-out. Otherwise the t-B-Scan(Th) recording will be stopped. The value of Time-out in sec 
is adjustable in 1 sec steps in the range 0 to 15 sec  
 
To select the required value of Time-out the following manipulations are applicable: 
 
•  Mouse 
 

� Click on the corresponding button  or  
 
•  Keyboard 
 

� Pressing <Alt>+<I>  ⇒ Time-out fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Time-out area the first letter i is underlined) 

 
•  Combined 
 

� Click on Time-out ⇒ Time-out fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 
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Insert Text Note 

A text note may be keyed in to accompany the t-B-Scan(Th) record. To proceed click on  or press 
<Alt>+<X> on the keyboard 
 

 
 
 
 
Click on  or press <Alt>+<K> or Enter  on the 
keyboard to end typing and storing of the note 

Click on  or press <Alt>+<C> or Esc  on the 
keyboard to discard the new note / comments 

 
Preview the Instrument Settings 

The instrument settings for the t-B-Scan(Th) record may be previewed through the clicking on  or 
pressing <Alt>+<U> on the keyboard. The corresponding window appears: 
 

 
 
Click on  or press <Alt>+<K> or Esc  on the keyboard to return to the t-B-Scan(Th) screen 
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Other Controls 
 

Clicking on  or pressing <Alt>+<S> on the keyboard starts the t-B-Scan(Th) recording 
  

The  button becomes invisible since the t-B-Scan(Th) recording starts. The  button occupies its 

position. Clicking on  or pressing <Alt>+<S> on the keyboard will terminate the t-B-Scan(Th) 
recording prior to the automatic completion 
 

The  button becomes invisible after completion / termination of the t-B-Scan(Th) recording. The 

 button returns to its position. 
 

Clicking on  or pressing <Alt>+<P> on the keyboard will print the ISONIC t-B-Scan(Th) Scanning 
Report  comprising the t-B-Scan(Th) graphical record, instrument settings and accompanied text notes to 
the default printer  
 

Clicking on  or pressing <Alt>+<A> on the keyboard will save the once captured t-B-Scan(Th) record 
and accompanying instrument calibration dump and text notes / comments into a file. Refer to the paragraph 
5.4.19 of this Operating Manual to proceed with saving a file 
 
 

Clicking on  or pressing <Alt>+<O> on the keyboard will load the once captured t-B-Scan(Th) record 
and accompanying instrument calibration dump and text notes / comments from a file. Refer to the paragraph 
5.4.20 of this Operating Manual to proceed with opening a file 
 

Clicking on  or pressing <Alt>+<C> or Esc  on the keyboard will return back to the Pulser / 
Receiver window 
 



ISO

5.5.1.4. Recording t-B-Scan(Th) 
 
To capture t-B-Scan(Th): 
 

•  Apply probe to the test object in the start point of the selected scanning line 

•  Click on  or press <Alt>+<S> on the keyboard 
•  Guide the probe over the scanning line – the typical display during the scanning progress is shown 

and explained below 
 

 
 
 
 
 
Status 
 

n
Current A-Sca
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Indicator 

Status Indicator is empty prior to and after the completing/termination of the t-B-Scan(Th) recording 

The  status may appear once just if there is no any signal matching with 
Gate A and exceeding its threshold immediately after the start of the t-B-Scan(Th) recording. The 
first signal matching with Gate A and exceeding its threshold after the start of the t-B-Scan(Th) 

recording causes appearance of the  status. If the signal matching with Gate 
A and exceeding its threshold disappears then the count of the Time-Out starts: 

. It is required to provide the sufficient signal again prior to the end of Time-
Out count to continue the scanning 

t-B-Scan(Th) record 
Back Wall Profile 

Recording 
Progress Bar 

Status 
Indicator 

Currently 
measured wall 

thickness 

The minimal wall thickness 
measured over the elapsed 

recording time  

Thickness limit  -
Threshold, selected 

by an operator 
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5.5.2. Timed (time-based) Amplitude B-Scan: t-B-Scan(A) 
 
t-B-Scan(A) mode allows to display a section of the test object through the taking continuous measurements 
of defect responses (amplitude and coordinate) along the scanning path over a maximum measurement 
period of 72 seconds. To perform the imaging the probe must be linearly driven over the section to be 
displayed during the measurement period with the approximately constant speed  
 
5.5.2.1. Prior to the running t-B-Scan(A) mode 
 

•  Carry out the valid calibration of the Probe Delay and US Velocity 
 

•  Activate Gate A  
 

•  Referring to the table below define the region of interest through the setup of the Display Delay, 
Range, aStart and aWidth  

 

•  Select the section of the object under test to scan over and the length of the corresponding scanning 
line (Scan Length) 

 

•  All signals matching with the Gate A and exceeding its threshold will be measured and recorded 
during the t-B-Scan(A) recording – provide the appropriate calibration for Gain and aThreshold. 
Check the possibility of receiving of the desired signals along the selected scanning line 
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Defining of the Region of Interest (ROI) for t-B-Scan(A) recording 
 

 

 

 

 
 
 
Case 1 

 

 
 

aStartSRD =  
 

aWidthRW =  

 
 
 
 
Case 2 

 

 

USVelocityayDisplayDelSRD ×=
2

 

 
SRDaWidthaStartRW −+=  

 
 
 
 
Case 3 

 

 
aStartSRD =  

 

aStartRange

USVelocityayDisplayDelRW

−+

+×=
2  

 
 
 
 
Case 4 

 

 
 

USVelocityayDisplayDelSRD ×=
2

 

 
RangeRW =  
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Gate
 

Start

Scanning Length / Sca

Echo Amplitude Palette (Color Scale) 

5.5.2.2. Startup the t-B-Scan(A) mode 

To run t-B-Scan(A) mode click on  or press <Alt>+<B> on the keyboard.  
 

The pre-recording ISONIC Control menu appears: 
 

 
 

Click on  or press <Alt>+<A> on the keyboard 
to run t-B-Scan(A) mode. The screen as below 
appears upon:  

Click on  or press <Alt>+<C> or Esc  on the keyboard to 
return to the Pulser / Receiver window 

 

 

Empty t-B-Scan(A) record field
anual – Revision 8.00 - Page 161 of 550 

Gate
 

End

nning Time 
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5.5.2.3. t-B-Scan(A) Control Panel 
 
Scan Length and Scan Time 
 
The L (Scan Length or, in other 
words, Scan Path) is the length of 
the section of the test object to be 
displayed, over which the probe will 
be guided during the recording 
period. Time (Scan Time) is the 
duration of the said recording period. 
There are 4 (four) possible values 
for L and there are 3 (three) possible 
values for Time corresponding to 
the each value of L: 
 
 

Scan Length – L Possible Scan Time – Time 
100 mm or 4 in 8, 16 and 24 sec 
150 mm or 6 in 12, 24 and 36 sec 
200 mm or 8 in 16, 32 and 48 sec 
300 mm or 12 in 24, 48 and 72 sec 

 
To select the required value of Scan Length – L the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<L>  ⇒ L fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (L is underlined) 

 

•  Combined 
 

� Click on L ⇒ L fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 
 
 
To select the required value of Scan Time – Time the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<T>  ⇒ Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Time area letter T is underlined) 

 

•  Combined 
 

� Click on Time ⇒ Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
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Y-Marker 
 
The Y-Marker is permanently indicated on the cross-sectional image of the test object easing the graphic 
evaluation of the obtained results. Y-Marker may be manipulated over the whole Region of Interest providing 
the direct reading of the defect's depth 
 
To setup the position of the Y-Marker the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<Y> ⇒ Y-Marker fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Y-Marker area the first letter Y is underlined) 

 

•  Combined 
 

� Click on Y-Marker ⇒ Y-Marker fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 
 
Time-Wait 
 
The Time-Wait is the waiting time for intermissions predcessing the t-B-Scan(A) recording. The t-B-Scan(A) 
recording starts unconditionally upon the Time-Wait period is over. The value of Time-Wait in sec is 
adjustable in 1 sec step in the range 0 to 15 sec  
 
To select the required value of the Time-Wait the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<I>  ⇒ Time-Wait fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Time-Wait area the first letter i is underlined) 

 

•  Combined 
 

� Click on Time-Wait ⇒ Time-Wait fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 
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Echo Amplitude Palette (Color Scale) 
 
The color coding of echo amplitudes is provided for the t-B-Scan(A) over the 24 dB range. There are 3 
(three) palettes (color scales) and 2 (two) coloring protocols available 

Clicking on  or pressing <Alt>+<G> on the keyboard will activate the Gray-Level palette: 

 
 

 

Clicking on  or pressing <Alt>+<E> on the keyboard will activate the Thermo-Level palette: 

 
 

 

Clicking on  or pressing <Alt>+<R> on the keyboard will activate the Rainbow-Level palette: 

 
 

 
 
Two coloring protocols provide linear or DAC (DGS) normalizing of the recorded echoes. DAC (DGS) 
normalizing becomes active automatically upon setting up the DAC or DGS mode of operation 
 
 
Insert Text Note 

A text note may be keyed in to accompany the t-B-Scan(Th) record. To proceed click on  or press 
<Alt>+<X> on the keyboard 
 

 
 
 
 
Click on  or press <Alt>+<K> or Enter  on the 
keyboard to end typing and storing of the note 

Click on  or press <Alt>+<C> or Esc  on the 
keyboard to discard the new note / comments 
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Preview the Instrument Settings 

The instrument settings for the t-B-Scan(A) record may be previewed through the clicking on  or 
pressing <Alt>+<U> on the keyboard. The corresponding window appears: 
 

 
 
Click on  or press <Alt>+<K> or Esc  on the keyboard to return to the t-B-Scan(A) screen 
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Other Controls 
 

Clicking on  or pressing <Alt>+<S> on the keyboard will start the t-B-Scan(A) recording 

The  button becomes invisible since the t-B-Scan(A) recording starts. The  button 

occupies its position. Clicking on  or pressing <Alt>+<S> on the keyboard will terminate the t-B-
Scan(A) recording prior to the automatic completion  
 

The  button becomes invisible after completion / termination of the t-B-Scan(A) recording. The 

 button returns to its position 
 

Clicking on  or pressing <Alt>+<P> on the keyboard will print the ISONIC t-B-Scan(A) Scanning 
Report  comprising the t-B-Scan(A) graphical record, instrument settings and accompanied text notes to the 
default printer  
 

Clicking on  or pressing <Alt>+<A> on the keyboard will save the once captured t-B-Scan(A) record 
and accompanying instrument calibration dump and text notes / comments into a file. Refer to the paragraph 
5.4.19 of this Operating Manual to proceed with saving a file 
 
 

Clicking on  or pressing <Alt>+<O> on the keyboard will load the once captured t-B-Scan(A) record 
and accompanying instrument calibration dump and text notes / comments from a file. Refer to the paragraph 
5.4.20 of this Operating Manual to proceed with opening a file 
 

Clicking on  or pressing <Alt>+<C> or Esc  on the keyboard will return back to the Pulser / 
Receiver window 
 



ISO

5.5.2.4. Recording t-B-Scan(A) 
 
To capture t-B-Scan(A): 
 

•  Apply probe to the test object in the start point of the selected scanning line 

•  Click on  or press <Alt>+<S> on the keyboard 
•  Wait for the end of Time-Wait period then guide the probe over the scanning line – the typical display 

during the scanning progress is shown and explained below 
 

 
 
 
 
Status 
 

n
Current A-Sca
t-B-Scan(A) record 
NIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 

Indicator 
Status Indicator is empty prior to and after the completing/termination of t-B-Scan(A

status appears upon clicking on  if the
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 status. Since this moment the t-B-Scan(A) recordin
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Recording 
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5.5.3. Timed (time – based) TOFD Record: RF t-B-Scan / t-TOFD 
 
t-TOFD mode allows to display a section of the test object through the continuous capturing of successive RF 
A-Scans along the scanning path over a maximum measurement period of 48 seconds. To perform the 
imaging a probe or probe pair must be linearly driven over the section to be displayed during the 
measurement period with the approximately constant speed  
 
5.5.3.1. Prior to the running t-TOFD mode 
 

•  Setup Pulser Mode to Dual and Display Mode to RF Display mode 
 

•  For t-TOFD mapping place two longitudinal wave angle beam probes (probe pair) from both sides of 
the inspected volume providing the receiving and displaying of both Lateral Wave and Back Echo - 
the appropriate calibration of the Gain, Display Delay, Range must be provided – refer to the 
paragraph 20.6.4 of this Operating Manual to get prepared for the TOFD Instrument settings 

 
•  All RF A-Scans will be measured and recorded while creating the t-TOFD – check the possibility of 

receiving of the desired signals along the selected scanning line 
 
���� 
The typical placement of the TOFD probes and the original TOFD inspection scheme are shown here for the 
t-TOFD mapping. It is also possible to use other probes and inspection schemes if there is a need to capture 
the successive RF A-Scans along the selected scanning line (RF t-B-Scan) 
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A-Scan
 

Start 

Scanning 

 

5.5.3.2. Startup the t-TOFD mode 

To run t-TOFD mode click on  or press <Alt>+<B> on the keyboard.  
 

The pre-recording ISONIC Control menu appears: 
 

 
 

Click on  or press <Alt>+<T> on the keyboard to run 
t-TOFD mode. The corresponding screen consisting 
of three fields appears:  

Click on  or press <Alt>+<C> or Esc  on the 
keyboard to return to the Pulser / Receiver window 

 
 
 

     

 
 

Empty t-TOFD record field
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A-Scan
 

End 

Length / Scanning Time 
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5.5.3.3. t-TOFD Control Panel 
Scan Length and Scan Time 
 
The value of L (Scan Length or, in other words, Scan Path) represents 
the length of the section of the test object to be displayed, over which 
the probe (probe pair) will be guided during the recording period. Time 
(Scan Time) is the duration of the said recording period. There are 3 
(three) possible values for L and there are 3 (three) possible values for 
Time corresponding to the each value of L: 
 

Scan Length – L Possible Scan Time – Time 
50 mm or 2 in 4, 8 and 12 sec 
100 mm or 4 in 8, 16 and 24 sec 
200 mm or 8 in 16, 32 and 48 sec 

To select the required value of Scan Length – L the following 
manipulations are applicable: 
•  Mouse 

� Left mouse click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<L>  ⇒ L fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (L is underlined) 

 

•  Combined 
 

� Click on L ⇒ L fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 

 
 
To select the required value of Scan Time – Time the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<T>  ⇒ Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Time area letter T is underlined) 

 

•  Combined 
 

� Click on Time ⇒ Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
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Time-Wait 
 
The Time-Wait is the waiting time for intermissions predcessing the t-TOFD recording. The t-TOFD 
recording starts unconditionally upon the Time-Wait period is over. The value of Time-Wait in sec is 
adjustable in 1 sec step in the range 0 to 15 sec  
 

To select the required value of the Time-Wait the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<I>  ⇒ Time-Wait fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Time-Wait area the first letter i is underlined) 

 

•  Combined 
 

� Click on Time-Wait ⇒ Time-Wait fore color changes to whit - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Time-Wait area the first letter i is underlined) 

 

Pointers 
 
Pointers relate to the postprocessing operations applicable to the once captured t-TOFD map. The meaning 
of each active pointer and their controls are described below in the paragraph 5.5.3.5 
 
Insert Text Note 

A text note may be keyed in to accompany the t-TOFD record. To proceed click on  or press 
<Alt>+<X> on the keyboard 
 

 
 
 
 
Click on  or press <Alt>+<K> or Enter  on the 
keyboard to end typing and storing of the note 

Click on  or press <Alt>+<C> or Esc  on the 
keyboard to discard the new note / comments 

 
 
 
 
 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 172 of 550  

Preview the Instrument Settings 

The instrument settings for the t-TOFD record may be previewed through the clicking on  or 
pressing <Alt>+<U> on the keyboard. The corresponding window appears: 
 

 
 
Click on  or press <Alt>+<K> or Esc  on the keyboard to return to the t-TOFD screen 
 
Other Controls 
 

Clicking on  or pressing <Alt>+<S> on the keyboard will start the t-TOFD recording 

The  button becomes invisible since the t-TOFD recording starts. The  button occupies its 

position. Clicking on  or pressing <Alt>+<S> on the keyboard will terminate the t-TOFD recording 
prior to the automatic completion  
 

The  button becomes invisible after completion / termination of the t-TOFD recording. The  
button returns to its position 
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Clicking on  or pressing <Alt>+<P> on the keyboard will print the ISONIC t-TOFD Scanning Report  
comprising the t-TOFD graphical record, instrument settings and accompanied text notes to the default 
printer  
 

Clicking on  or pressing <Alt>+<A> on the keyboard will save the once captured t-TOFD record and 
accompanying instrument calibration dump and text notes / comments into a file. Refer to the paragraph 
5.4.19 of this Operating Manual to proceed with saving a file 
 
 

Clicking on  or pressing <Alt>+<O> on the keyboard will load the once captured t-TOFD record and 
accompanying instrument calibration dump and text notes / comments from a file. Refer to the paragraph 
5.4.20 of this Operating Manual to proceed with opening a file 
 

Clicking on  or pressing <Alt>+<C> or Esc  on the keyboard will return back to the Pulser / 
Receiver window 
 
 
 



ISO

5.5.3.4. Recording t-TOFD 
 

To capture t-TOFD: 
 

•  Apply probe (probe pair) to the test object in the start point of the selected scanning line 

•  Click on  or press <Alt>+<S> on the keyboard 
•  Wait for the end of the Time-Wait period then guide the probe (probe pair) over the scanning line – 

the typical display during the scanning progress is shown and explained below 
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5.5.3.5. t-TOFD Postprocessing 
 
After the t-TOFD recording the captured map may be evaluated off-line (postprocessing). The 
postprocessing allows recovering of the RF A-Scans along the scanning line and measuring the time of flight 
for each recovered signal. The off-line measurements are activated through the pointers.  
 

Active Pointer 
 

To select the active pointer the following manipulations are applicable: 
 

•  Mouse 
 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<R>  ⇒ Active Pointer fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 
on the keyboard  (In the Active Pointer area the first letter I is underlined) 

 

•  Combined 
 

� Click on Active Pointer ⇒ Active Pointer fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard 

 
The following grades are possible for the Active Pointer: 
 

� None – there are no any pointer either horizontal or vertical on the captured TOFD Map: the live RF 
A-Scan corresponding to the currently received signals is reproduced 

� X – there are 3 (three) pointers on the t-TOFD Map, one of them is vertical and two others are 
horizontal. The recovered A-Scan corresponding to the position of vertical pointer along the scanning 
path is reproduced. There are two pointers on the restored A-Scan, each one corresponds to the 
same color horizontal pointer on the t-TOFD Map. The pointer X (vertical) is guidable entire the t-
TOFD Map width 

� T1 – there are 3 (three) pointers on the t-TOFD Map, one of them is vertical and two others are 
horizontal. The recovered A-Scan corresponding to the position of vertical pointer along the scanning 
path is reproduced. There are two pointers on the recovered A-Scan, each one corresponds to the 
same color horizontal pointer on the t-TOFD Map. The pointer T1 (horizontal blue) is guidable entire 
the t-TOFD Map height and simultaneously entire the A-Scan width 

� T2 – there are 3 (three) pointers on the t-TOFD Map, one of them is vertical and two others are 
horizontal. The recovered A-Scan corresponding to the position of vertical pointer along the scanning 
path is reproduced. There are two pointers on the recovered A-Scan, each one corresponds to the 
same color horizontal pointer on the t-TOFD Map. The pointer T2 (horizontal red) is guidable entire 
the t-TOFD Map height and simultaneously entire the A-Scan width 

 
To guide the active pointer the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<N>  ⇒ Pointer Position fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard  (In the Pointer Position area the first letter N is underlined) 

 

•  Combined 
 

� Click on Pointer Position ⇒ Pointer Position fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard 

 

Pointer position is indicated in corresponding units allowing to read-out the off-line measurements results. 



ISONIC Workstation from Sonotron NDT - Operating Manu 

The below screenshot illustrates the t-TOFD posprocessing 
 
 
 
 
 

 
For the off-line t-TOFD image processing and defects sizing refer 

Recovered A-Scan corresponding to 
the position of the Pointer X 
Pointer T1
a

to

 
Pointer T2
Pointer X
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 the Chapter 22 of this Operating Manual 

The Captured 
t-TOFD Map
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6. Enhanced B-Scan Recording and 
Imaging - Operating 'ABIScan' Software 

Package - ISONIC ABIScan 
 
 
 
 

The contents of this chapter is valid for the  
ABIScan SW Package version 1.2.0.8 or higher 
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6.1. General 
 
ISONIC ABIScan inspection software package (inspection application) for the ISONIC / ISONIC 2001 
workstation provides the enhanced B-Scan recording and imaging 
 

6.2. Cabling and Fixture 
 

Ultrasonic Flaw Detector PC Card Applicable Cabling Scheme Paragraph 
UDS 3-3 B.1; B.2; B.6; B.7 4.2.5 
UDS 3-4 B.3; B.4; B.8; B.9 4.2.5 

USLT 2000 B.5; B.10 4.2.5 
 
For the encoded (true-to-scale) imaging 
 
 
 
 

o clamp the probe into the probe holder then 
into encoder 

 
 

     
 

o connect the encoder's cable to its input on the 
rear panel of the ISONIC 

 
 

6.3. Start Up 
Double click on the icon  located on the ISONIC 
desktop 

 
 

 
 

 
 

 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 179 of 550  

 

6.4. Operating ABIScan Software Package 
 

ABIScan software package operates the UDS 3-3, UDS 3-4 and USLT 2000 internal ultrasonic flaw detector 
card. The card existing in the ISONIC unit is recognized automatically. The ultrasonic flaw detector panel 
appears upon starting up. Operating of the flaw detector is exactly the same as for PULREC and USLTPR 
software packages described and explained in details in the Chapter 5 of this Operating Manual. 
 

  
 

Prior to proceeding with the ABIScan recording provide the proper setup for: 
 

� Gain 
� USVelocity 
� Reject (optional) 
� Pulser – mode, energy, damping, etc 
� Receiver – filtering 
� Display (either RF, Full, Neg or Pos) 
� DAC/DGS/TCG (optional) 
� Probe Delay 
� Angle 

 

After getting the ultrasonic flaw detector setup as necessary click on . The following window appears upon: 

 
 

Click on  or press 
<Alt>+<T> on the 
keyboard to start 
timed (time-based) 
enhanced B-Scan 
recording and imaging 

Click on  or press 
<Alt>+<P> on the 
keyboard to load the 
captured record for 
the off-line analysis 
(postprocessing) 

Click on  or or press 
<Alt>+<C> on the 
keyboard or Esc on the 
keyboard to return back 
to the ultrasonic flaw 
detector panel 

Click on  or press <Alt>+<A> on 
the keyboard to start encoded 
(true-to-scale) enhanced B-Scan 
recording and imaging – the 
button is enabled if the encoder 
is connected to the ISONIC 
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6.4.1. Time (time-based) Imaging – t-ABIScan – Normal Probe 
 

The screen as below appears upon clicking on  or pressing <Alt>+<T> on the keyboard if 
the Angle was setup to 0o (Normal Probe) in the submenu MEASURE  
 
 
 
 

 
 
 
 
 
 

Length of the 
scanning line

Current A-Scan Status Indicator

Start Position 
of the Probe 

Region of Interest -
Thickness 

Scanning 
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Empty t-ABIScan 
recording field 
End point of 
the scanning
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6.4.1.1. t-ABIScan Control Panel – Normal Probe 
 
 
Thickness and Skip# 
 
The value of Thickness defines 
the Region of Interest (ROI) 
starting from the scanning 
surface. t-ABIScan imaging is 
provided without using a gate – 
the whole visible A-Scan area is 
recorded. The A-Scan Range 
used for the t-ABIScan imaging – 
normal probe is defined as: 
 

Ranget-ABIScan = Thickness 
 

The A-Scan Display Delay used for the t-ABIScan imaging is defined as: 
 

Display Delayt-ABIScan = Probe Delay 
 
 

���� 
♦  The value of Thickness is controllable through the t-ABIScan Control Panel, 
♦  The value of Probe Delay is taken from the ultrasonic flaw detector setup (submenu MEASURE) 
♦  The value of Skip# is automatically ignored and may not be changed if the Angle was setup to 0o 

(Normal Probe) in the submenu MEASURE 
 

 
 
To setup the required value of Thickness the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<H> ⇒ Thickness fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (in the Thickness area the letter h is underlined) 

 

•  Combined 
 

� Click on Thickness ⇒ Thickness fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 
The value of Thickness is over the 5 … 300 mm (or 0.2 … 12 in) range with 1 mm (or 0.05 in) resolution. 

The resolution is selectable through clicking on  or pressing <Alt>+<1> on the keyboard 
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Scan Length and Scan Time 
 

The value of Length (Scan Length or, in other words, Scan Path) represents the length of the section of the 
test object to be displayed, over which the probe will be guided during the recording period. Time (Scan 
Time) is the duration of the said recording period 
 
To setup the required value of Length the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<L> ⇒ Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (in the Length area the letter L is underlined) 

 
 
 
 

•  Combined 
 

� Click on Length ⇒ Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 
The value of Length is controllable over the 50…300 mm range (or 2…12 in) with 1 mm (or 0.05 in) 

resolution. The resolution is selectable through clicking on  or pressing <Alt>+<3> on the keyboard 
 
 
To setup the required value of Time the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<T> ⇒ Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Time area letter T is underlined) 

 

•  Combined 
 

� Click on Time ⇒ Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 
 The value of Time is controllable over the 5…60 sec range with 1 sec resolution. The resolution is 

selectable through clicking on  or pressing <Alt>+<4> on the keyboard 
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Echo Amplitude Palette (Color Scale) 
 
The color coding of echo amplitudes is provided during the t-ABIScan recording over the 28 dB range (- 14 
dB through + 14 dB; 0 dB level corresponds to the 50% A-Scan Height) 
 
There are three palettes available: 

o Clicking on  or pressing <Alt>+<G> on the keyboard will activate the Gray-Level coloring 
of echo amplitudes 

o Clicking on  or pressing <Alt>+<E> on the keyboard will activate the Thermo-Level 
coloring of echo amplitudes 

o Clicking on  or pressing <Alt>+<D> on the keyboard will activate the Pseudocolor-Level 
coding of echo amplitudes 

 
Insert Text Note 
 

A text note/comments may be typed to accompany the t-ABIScan record after clicking on  or 
pressing <Alt>+<X> on the keyboard: 
 

 
 

Click on  or press <Alt>+<K> or Enter  on 
the keyboard to end typing and storing of the 
note/comments 

Click on  or press <Alt>+<C> or Esc  on the keyboard 
to discard the new note/comments 

 

 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 184 of 550  

Preview the Instrument Settings 

The instrument settings for the t-ABIScan record may be previewed through the clicking on  or 
pressing <Alt>+<U> on the keyboard: 
 

 
 
Click on  or press <Alt>+<K> or Esc  on the keyboard to exit this preview window 
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Start/Stop t-ABIScan recording 
 

Clicking on  or pressing <Alt>+<S> on the keyboard will start the t-ABIScan recording, which will 
be either completed automatically or terminated by an operator 
 

The  button becomes invisible upon the t-ABIScan recording starts. The  button 

occupies its position. Clicking on  or pressing <Alt>+<S> on the keyboard will terminate the t-
ABIScan recording prior to the automatic completion  

The  button becomes invisible after the completion / termination of the t-ABIScan recording – the 

 button returns to its position 
 
Save the captured t-ABIScan record 
 
 

Clicking on  or pressing <Alt>+<A> on the keyboard will save the t-ABIScan record and 
accompanying instrument calibration dump and text notes / comments into a file. Refer to the paragraph 
5.4.19 of this Operating Manual to proceed with saving a file 
 
Return to the Pulser Receiver window 
 
 

Clicking on  or pressing <Alt>+<C> or Esc  on the keyboard will return to the Pulser / Receiver 
window 
 



ISO

6.4.1.2. t-ABIScan Recording – Normal Probe 
 

To capture t-ABIScan: 
 

•  Apply probe to the test object in the start point of the selected scanning line 

•  Click on  or press <Alt>+<S> on the keyboard – the counting of the 3 sec interval 
reserved for the intermissions starts 

•  Wait for the end of the intermissions interval then guide the probe over the scanning line with the 
approximately constant speed – the typical display during the scanning progress is shown and 
explained below 

 

 
Status 
 

n
Current A-Sca
NIC
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Current Recalculated Probe 
Position Along the Scanning Line
t-ABIScan record
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ator 

us Indicator is empty prior to and after the completing/termination of t-ABIScan recording. The 

status appears upon clicking on . The expiring of the 
missions period causes appearance of the  status. Since this moment 
t-ABIScan recording is observed unconditionally. The current recalculated probe coordinate 
g the scanning path is permanently updated after the Scanning… in the Status Indicator whilst t-
Scan recording is in progress 

Status 
Indicator 
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6.4.1.3. t-ABIScan Postprocessing – Normal Probe 
 

The window as below appears upon clicking on  
 

 
 

 
 
Click on  or press <Alt>+<O> on the keyboard to 
open a file for the postrpocessing. Refer to the 
paragraph 5.4.20 of this Operating Manual to 
proceed with opening a file 
 

Click on  or press <Alt>+<C> or Esc  on the 
keyboard to return to the Pulser Receiver window 
 
 
The captured t-ABIScan (ABIScan) record appears 
in the window upon opening a file 
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The following controls allow managing of the postrocessing procedures: 
 

o  - opening the next t-ABIScan (ABIScan) record accompanied with the instrument 
calibration dump from a file. Refer to the paragraph 5.4.20 of this Operating Manual to proceed with 
opening a file 

 

o  - previewing the comments made prior to the t-ABIScan (ABIScan) recording 
 

o  - previewing the instrument calibration dump actual while capturing the t-ABIScan 
(ABIScan) record 

 

o  - print the t-ABIScan (ABIScan) record to the default printer 
 

o  - redrawing the map using the Gray palette 
 

o  - redrawing the map using the Thermo palette 
 

o  - redrawing the map using the Pseudocolor palette 
 

o  - checkbox. If the map was captured whilst DAC/DGS active then at the 
postprocessing stage it may be represented using the palette related to the signal amplitude either 
linearly (box is not checked) or with respect to the DAC/DGS (checked). The checkbox is disabled for 
the map captured whilst DAC/DGS inactive (refer to the paragraph 6.4.5 of this Operating Manual) 

 
 
 



 

o  - Off-line virtual scanning with A-Scan recovery 

Clicking on  will place the cursor above the "contact surface" line allowing the off-line virtual 
scanning. The cursor position matching with the probe's incidence point is accompanied with its 
central beam trace and indicated as A-Scan Position, mm 
 

Recovered A-Scan
ISONIC Workstation from Sonotron NDT - Operating Manual – Revisio 

 
The virtual scanning may be controlled by the touch screen stylus or m
the keyboard. The A-Scans are recovered and represented dynamically
allowing the defect's characterization according to BS EN 583-5 
 
Upon completing the virtual scanning and selection of the necessary A-
representing the maximal echo) release the stylus from the touch scree

Enter  on the keyboard – this will free the cursor for further procedur

To switch off the restored A-Scan click on  

 
Probe position
along the map 

and A-Scan 
selection line 
n 8.00 - Page 189 of 550 
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o  - Filtering the t-ABIScan (ABIScan) record through the 
suppressing of the echo amplitudes below the selected threshold level 

To proceed click on . As a result: 
 

� The amplitude threshold line representing the threshold level appears above the palette; 
the cursor is "sticked" to the amplitude threshold line, which may be moved left / right 
either by the touch screen stylus or by the mouse or by the ←←←← , →→→→ buttons on the keyboard 

 

� The value of the amplitude threshold is displayed as Filtering, dB 
 

� Images of the reflectors returning the echo amplitudes below the amplitude threshold are 
erased from the t-ABIScan (ABIScan) record i.e. rejected 

 

To fix the threshold level left mouse click or release the stylus from the touch screen.  

To switch back to the unfiltered t-ABIScan (ABIScan) record representation click on  
 

 
 

Amplitude 
Threshold 

Filtered ABIScan record: 
all areas corresponding 
to the echo amplitudes 

below threshold level are 
suppressed 
Amplitude Palette
 Page 190 of 550 
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o  - measuring defect's depth and projection height. To proceed 

click on . As a result: 
 

� The first horizontal measuring line appears on the (ABIScan) record; the mouse pointer is 
"sticked" to the first horizontal measuring line, which may be moved up / down either by the 
touch screen stylus or by the mouse or by the ↑↑↑↑  , ↓↓↓↓  buttons on the keyboard 

� The position of the first horizontal measuring line is indicated as Dr 
 

To fix the position of the first horizontal measuring line release the stylus from the touch screen or left 

mouse click or press Enter  on the keyboard 
 

 

 
 
 
 

  
 

The first horizontal 
measuring line and its 

position 
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As a result: 
 
� The second horizontal measuring line appears on the t-ABIScan (ABIScan) record; the 

mouse pointer is "sticked" to the second horizontal measuring line, which may be moved up / 
down either by the touch screen stylus or by the mouse or by the ↑↑↑↑  , ↓↓↓↓  buttons on the keyboard 

� The position of the second horizontal measuring line with respect to the first horizontal 
measuring line is indicated as Dg 

 

To fix the position of the second horizontal measuring line release the stylus from the touch screen or 

left mouse click or press Enter  on the keyboard 
 

To negate the horizontal measuring lines click on  
 

 
 
 

 
 
 

The second 
horizontal measuring 
line and its position 
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o  - measuring defect's coordinate and width along the t-ABIScan 

(ABIScan) record. To proceed click on . As a result: 
 

� The first vertical measuring line appears on the t-ABIScan (ABIScan) record; the cursor is 
"sticked" to the first vertical measuring line, which may be moved left / right either by the touch 
screen stylus or by the mouse or by the ←←←← , →→→→ buttons on the keyboard  

� The position of the first vertical measuring line is indicated as Wr 
 

To fix the position of the first vertical measuring line release the stylus from the touch screen or left 

mouse click or press Enter  on the keyboard 
 

 
 

  

The first vertical 
measuring line and its 

position 
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As a result: 
 
� The second vertical measuring line appears on the t-ABIScan (ABIScan) record; the mouse 

pointer is "sticked" to the second vertical measuring line, which may be moved left / right either 
by the touch screen stylus or by the mouse or by the ←←←← , →→→→ buttons on the keyboard 

 

� The position of the second vertical measuring line with respect to the first vertical measuring 
line is indicated as Wg 

 

To fix the position of the second vertical measuring line release the stylus from the touch screen or left 

mouse click or press Enter  on the keyboard 
 

To negate the vertical measuring lines click on  
 

 
 

The second vertical 
measuring line and its 

position 
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6.4.2. Encoded (true-to-scale) Imaging – ABIScan – Normal Probe 
 

The screen as below appears upon clicking on  or pressing <Alt>+<A> on the keyboard if 
the Angle was setup to 0o (Normal Probe) in the submenu MEASURE  
 
 
 
 

 
 
 
 
 
 

Length of the 
scanning line

Current A-Scan Status Indicator

Start Position 
of the Probe 

Region of Interest -
Thickness 

Scanning 
Direction 

 

Empty ABIScan 
recording field
End point of the
scanning line
 - Page 195 of 550 
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6.4.2.1. ABIScan Control Panel – Normal Probe 
 
Thickness and Skip# 
 
The value of Thickness defines 
the Region of Interest (ROI) 
starting from the scanning 
surface. ABIScan imaging is 
provided without using a gate – 
the whole visible A-Scan area 
is recorded. The A-Scan Range 
used for the ABIScan imaging – 
normal probe is defined as: 

 
 

RangeABIScan = Thickness 
 

The A-Scan Display Delay used for the ABIScan imaging is defined as: 
 

Display DelayABIScan = Probe Delay 
 

 
���� 
♦  The value of Thickness is controllable through the ABIScan Control Panel, 
♦  The value of Probe Delay is taken from the ultrasonic flaw detector setup (submenu MEASURE) 
♦  The value of Skip# is automatically ignored and may not be changed if the Angle was setup to 0o 

(Normal Probe) in the submenu MEASURE 
 
 
 
To setup the required value of Thickness the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<H> ⇒ Thickness fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (in the Thickness area the letter h is underlined) 

 

•  Combined 
 

� Click on Thickness ⇒ Thickness fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 
The value of Thickness is over the 5 … 300 mm (or 0.2 … 12 in) range with 1 mm (or 0.05 in) resolution. 

The resolution is selectable through clicking on  or pressing <Alt>+<1> on the keyboard 
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Scan Length 
 

The value of Length (Scan Length or, in other words, Scan Path) represents the length of the section of the 
test object to be displayed, over which the probe will be guided 
 
To setup the required value of Length the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<L> ⇒ Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (in the Length area the letter L is underlined) 

 
 
 
 

•  Combined 
 

� Click on Length ⇒ Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 
The value of Length is controllable over the 50…300 mm range (or 2…12 in) with 1 mm (or 0.05 in) 

resolution. The resolution is selectable through clicking on  or pressing <Alt>+<3> on the keyboard 
 
Encoder Selection 
Select the encoder to be used and click on its name: 

 
 
Echo Amplitude Palette (Color Scale) 
 
The color coding of echo amplitudes is provided during the ABIScan recording over the 28 dB range (- 14 dB 
through + 14 dB; 0 dB level corresponds to the 50% A-Scan Height) 
 
There are three palettes available: 

o Clicking on  or pressing <Alt>+<G> on the keyboard will activate the Gray-Level coloring 
of echo amplitudes 

o Clicking on  or pressing <Alt>+<E> on the keyboard will activate the Thermo-Level 
coloring of echo amplitudes 

o Clicking on  or pressing <Alt>+<D> on the keyboard will activate the Pseudocolor-Level 
coding of echo amplitudes 
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Insert Text Note 

A text note/comments may be typed to accompany the ABIScan record after clicking on  or 
pressing <Alt>+<X> on the keyboard 
 

Preview the Instrument Settings 

The instrument settings for the ABIScan record may be previewed through the clicking on  or 
pressing <Alt>+<U> on the keyboard 
 
Start/Stop ABIScan recording 
 

Clicking on  or pressing <Alt>+<S> on the keyboard will start the ABIScan recording 

The  button becomes invisible upon the ABIScan recording starts. The  button 

occupies its position. Clicking on  or pressing <Alt>+<S> on the keyboard will terminate the 
ABIScan recording prior to the completion  

The  button becomes invisible after the completion / termination of the ABIScan recording – the 

 button returns to its position 
 
Save the captured ABIScan record 
 
 

Clicking on  or pressing <Alt>+<A> on the keyboard will save the once captured ABIScan record 
and accompanying instrument calibration dump and text notes / comments into a file. Refer to the paragraph 
5.4.19 of this Operating Manual to proceed with saving a file 
 
Return to the Pulser Receiver window 
 
 

Clicking on  or pressing <Alt>+<C> or Esc  on the keyboard will return to the Pulser / Receiver 
window 
 



ISO

6.4.2.2. ABIScan Recording – Normal Probe 
 

To capture ABIScan: 
 

•  Apply probe to the test object in the start point of the selected scanning line 

•  Click on  or press <Alt>+<S> on the keyboard  
•  Guide the probe over the scanning line – the typical display during the scanning progress is shown 

and explained below 
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or to and after the completing/termination of ABIScan recording. The 
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6.4.3. Time (time-based) Imaging – t-ABIScan – Angle Beam Probe 
 

The screen as below appears upon clicking on  or pressing <Alt>+<T> on the keyboard if 
the Angle setup was > 0o value (Angle Beam Probe) in the submenu MEASURE  
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6.4.3.1. t-ABIScan Control Panel – Angle Beam Probe 
 
Thickness and Skip# 
 
The values of Thickness and 
Skip# define the Region of 
Interest (ROI) starting from the 
scanning surface. t-ABIScan 
imaging is provided without 
using a gate – the whole visible 
A-Scan area is recorded. The 
A-Scan Range used for the t-
ABIScan imaging – angle beam 
probe is defined as:  
 
 

Ranget-ABIScan = 2 ••••  Skip# ••••  Thickness / Cos(Angle) 
 

The A-Scan Display Delay used for the t-ABIScan imaging is defined as: 
 

Display Delayt-ABIScan = Probe Delay 
 

 
���� 
♦  The value of Thickness is controllable through the t-ABIScan Control Panel, 
♦  The value of Probe Delay is taken from the ultrasonic flaw detector setup (submenu MEASURE) 

 
 

To setup the required value of Thickness the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<H> ⇒ Thickness fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (in the Thickness area the letter h is underlined) 

 

•  Combined 
 

� Click on Thickness ⇒ Thickness fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 

The value of Thickness is over the 5 … 300 mm (or 0.2 … 12 in) range with 1 mm (or 0.05 in) resolution. 

The resolution is selectable through clicking on  or pressing <Alt>+<1> on the keyboard 
 
To select the required value of Skip# the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<K> ⇒ Skip# fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (in the Skip# area the letter k is underlined) 

 

•  Combined 
 

� Click on Skip# ⇒ Skip# fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 

The value of Skip# may be either 0.5 or 1 
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Scan Length and Scan Time 
 

The value of Length (Scan Length or, in other words, Scan Path) represents the length of scanning line, over 
which the probe will be guided during the recording period. Time (Scan Time) is the duration of the said 
recording period. The value of Length along with Skip# represents the length of the section of the test object 
to be displayed (Length of the Insonification and Recording area).  

 
 
= Length + 2 ••••  Skip# ••••  Thickness / Tan(Angle)  
 
 
 

Simultaneously the value of Length  
 
To setup the required value of Length the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<L> ⇒ Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (in the Length area the letter L is underlined) 

 
 
 
 

•  Combined 
 

� Click on Length ⇒ Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 
The value of Length is controllable over the 50…300 mm range (or 2…12 in) with 1 mm (or 0.05 in) 

resolution. The resolution is selectable through clicking on  or pressing <Alt>+<3> on the keyboard 
 
 
To setup the required value of Time the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<T> ⇒ Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Time area letter T is underlined) 

 

•  Combined 
 

� Click on Time ⇒ Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 
 The value of Time is controllable over the 5…60 sec range with 1 sec resolution. The resolution is 

selectable through clicking on  or pressing <Alt>+<4> on the keyboard 
 
 

Length of the 
Insonification and 

Recording area 
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Echo Amplitude Palette (Color Scale) 
 
The color coding of echo amplitudes is provided during the t-ABIScan recording over the 28 dB range (- 14 
dB through + 14 dB; 0 dB level corresponds to the 50% A-Scan Height) 
 
There are three palettes available: 

o Clicking on  or pressing <Alt>+<G> on the keyboard will activate the Gray-Level coloring 
of echo amplitudes 

o Clicking on  or pressing <Alt>+<E> on the keyboard will activate the Thermo-Level 
coloring of echo amplitudes 

o Clicking on  or pressing <Alt>+<D> on the keyboard will activate the Pseudocolor-Level 
coding of echo amplitudes 

 
Insert Text Note 

A text note/comments may be typed to accompany the ABIScan record after clicking on  or 
pressing <Alt>+<X> on the keyboard 
 

 

Preview the Instrument Settings 

The instrument settings for the ABIScan record may be previewed through the clicking on  or 
pressing <Alt>+<U> on the keyboard 
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Start/Stop t-ABIScan recording 
 

Clicking on  or pressing <Alt>+<S> on the keyboard will start the t-ABIScan recording, which will 
be either completed automatically or terminated by an operator 
 

The  button becomes invisible upon the t-ABIScan recording starts. The  button 

occupies its position. Clicking on  or pressing <Alt>+<S> on the keyboard will terminate the t-
ABIScan recording prior to the automatic completion  

The  button becomes invisible after the completion / termination of the t-ABIScan recording – the 

 button returns to its position 
 
Save the captured t-ABIScan record 
 
 

Clicking on  or pressing <Alt>+<A> on the keyboard will save the t-ABIScan record and 
accompanying instrument calibration dump and text notes / comments into a file. Refer to the paragraph 
5.4.19 of this Operating Manual to proceed with saving a file 
 
Return to the Pulser Receiver window 
 
 

Clicking on  or pressing <Alt>+<C> or Esc  on the keyboard will return to the Pulser / Receiver 
window 
 



ISO

6.4.3.2. t-ABIScan Recording – Angle Beam Probe 
 

To capture t-ABIScan: 
 

•  Apply probe to the test object in the start point of the selected scanning line 

•  Click on  or press <Alt>+<S> on the keyboard – the counting of the 3 sec interval 
reserved for the intermissions starts 

•  Wait for the end of the intermissions interval then guide the probe over the scanning line with the 
approximately constant speed – the typical displays for the Skip# = 0.5 and Skip# = 1 cases during 
the scanning progress are shown and explained below 
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6.4.3.3. t-ABIScan Postprocessing – Angle Beam Probe 
 

The window as below appears upon clicking on  
 

 
 

 
 
Click on  or press <Alt>+<O> on the keyboard to 
open a file for the postrpocessing. Refer to the 
paragraph 5.4.20 of this Operating Manual to 
proceed with opening a file 
 

Click on  or press <Alt>+<C> or Esc  on the 
keyboard to return to the Pulser Receiver window 
 
 
The captured t-ABIScan (ABIScan) record appears 
in the window upon opening a file 
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The following controls allow managing of the postrocessing procedures: 
 

o  - opening the next t-ABIScan (ABIScan) record accompanied with the instrument 
calibration dump from a file. Refer to the paragraph 5.4.20 of this Operating Manual to proceed with 
opening a file 

 

o  - previewing the comments made prior to the t-ABIScan (ABIScan) recording 
 

o  - previewing the instrument calibration dump actual while capturing the t-ABIScan 
(ABIScan) record 

 

o  - print the t-ABIScan (ABIScan) record to the default printer 
 

o  - redrawing the map using the Gray palette 
 

o  - redrawing the map using the Thermo palette 
 

o  - redrawing the map using the Pseudocolor palette 
 

o  - checkbox. If the map was captured whilst DAC/DGS active then at the 
postprocessing stage it may be represented using the palette related to the signal amplitude either 
linearly (box is not checked) or with respect to the DAC/DGS (checked). The checkbox is disabled for 
the map captured whilst DAC/DGS inactive (refer to the below Chapter 6.4.5) 



o  - Off-line virtual scanning with A-Scan recovery 

Clicking on  will place the cursor above the "contact surface" line allowing the off-line virtual 
scanning. The cursor position matching with the probe's incidence point is accompanied with its 
central beam trace and indicated as A-Scan Position, mm 
 

Recovered A-Scan
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The virtual scanning may be controlled by the touch screen stylus or mouse or ���� and ���� buttons on 
the keyboard. The A-Scans are recovered and represented dynamically for each cursor position 
allowing the defect's characterization according to BS EN 583-5 
 
Upon completing the virtual scanning and selection of the necessary A-Scan (for example – 
representing the maximal echo) release the stylus from the touch screen or left mouse click or press 

Enter  on the keyboard – this will free the cursor for further procedures 

To switch off the restored A-Scan click on  

Probe position along the 
realized scanning path Sound Path selected for 

the A-Scan recovery 
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o  - Filtering the t-ABIScan (ABIScan) record through the 
suppressing of the echo amplitudes below the selected threshold level 

To proceed click on . As a result: 
 

� The amplitude threshold line representing the threshold level appears above the palette; 
the cursor is "sticked" to the amplitude threshold line, which may be moved left / right 
either by the touch screen stylus or by the mouse or by the ←←←← , →→→→ buttons on the keyboard 

 

� The value of the amplitude threshold is displayed as Filtering, dB 
 

� Images of the reflectors returning the echo amplitudes below the amplitude threshold are 
erased from the t-ABIScan (ABIScan) record i.e. rejected 

 

To fix the threshold level left mouse click or release the stylus from the touch screen.  

To switch back to the unfiltered t-ABIScan (ABIScan) record representation click on  
 

Amplitude 
Threshold 

Filtered t-ABIScan 
(ABIScan) record: all 

areas corresponding to 
the echo amplitudes 

below threshold level are 
suppressed 
Amplitude Palette
 Page 210 of 550 
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o  - measuring defect's depth and projection height. To proceed 

click on . As a result: 
 

� The first horizontal measuring line appears on the (ABIScan) record; the mouse pointer is 
"sticked" to the first horizontal measuring line, which may be moved up / down either by the 
touch screen stylus or by the mouse or by the ↑↑↑↑  , ↓↓↓↓  buttons on the keyboard 

� The position of the first horizontal measuring line is indicated as Dr 
 

To fix the position of the first horizontal measuring line release the stylus from the touch screen or left 

mouse click or press Enter  on the keyboard 
 

 
 

  

The first horizontal 
measuring line and its 

position 
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As a result: 
 
� The second horizontal measuring line appears on the t-ABIScan (ABIScan) record; the 

mouse pointer is "sticked" to the second horizontal measuring line, which may be moved up / 
down either by the touch screen stylus or by the mouse or by the ↑↑↑↑  , ↓↓↓↓  buttons on the keyboard 

� The position of the second horizontal measuring line with respect to the first horizontal 
measuring line is indicated as Dg 

 

To fix the position of the second horizontal measuring line release the stylus from the touch screen or 

left mouse click or press Enter  on the keyboard 

To negate the horizontal measuring lines click on  
 

 
 

The second 
horizontal measuring 
line and its position 
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o  - measuring defect's coordinate and width along the t-ABIScan 

(ABIScan) record. To proceed click on . As a result: 
 

� The first vertical measuring line appears on the t-ABIScan (ABIScan) record; the cursor is 
"sticked" to the first vertical measuring line, which may be moved left / right either by the touch 
screen stylus or by the mouse or by the ←←←← , →→→→ buttons on the keyboard  

� The position of the first vertical measuring line is indicated as Wr 
 

To fix the position of the first vertical measuring line release the stylus from the touch screen or left 

mouse click or press Enter  on the keyboard 
 

 
  

The first vertical 
measuring line and its 

position 
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As a result: 
 
� The second vertical measuring line appears on the t-ABIScan (ABIScan) record; the mouse 

pointer is "sticked" to the second vertical measuring line, which may be moved left / right either 
by the touch screen stylus or by the mouse or by the ←←←← , →→→→ buttons on the keyboard 

 

� The position of the second vertical measuring line with respect to the first vertical measuring 
line is indicated as Wg 

 

To fix the position of the second vertical measuring line release the stylus from the touch screen or left 

mouse click or press Enter  on the keyboard 
 

To negate the vertical measuring lines click on  
 

 
 
 

The second vertical 
measuring line and its 

position 
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6.4.4. Encoded (true-to-scale) Imaging – ABIScan - Angle Beam Probe 
 

The screen as below appears upon clicking on  or pressing <Alt>+<A> on the keyboard if 
the Angle setup was > 0o value (Angle Beam Probe) in the submenu MEASURE  
 
 
 
 

 
 
 
 
 

Length of the 
scanning line

Current A-Scan Status Indicator

Start Position 
of the Probe 

Region of Interest -
Thickness 

Scanning 
Direction 

 

t
r

Length of the 
Insonification 
and Recording 

area 
End point of 
the scanning

line
Empty  
-ABIScan 
ecording 

field 
5 of 550 
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6.4.4.1. ABIScan Control Panel – Angle Beam Probe 
 
Thickness and Skip# 
 
The values of Thickness and 
Skip# define the Region of 
Interest (ROI) starting from the 
scanning surface. ABIScan 
imaging is provided without 
using a gate – the whole visible 
A-Scan area is recorded. The 
A-Scan Range used for the 
ABIScan imaging – angle beam 
probe is defined as: 
 
 

Ranget-ABIScan = 2 ••••  Skip# ••••  Thickness / Cos(Angle) 
 

The A-Scan Display Delay used for the ABIScan imaging is defined as: 
 

Display Delayt-ABIScan = Probe Delay 
 

 
���� 
♦  The value of Thickness is controllable through the ABIScan Control Panel, 
♦  The value of Probe Delay is taken from the ultrasonic flaw detector setup (submenu MEASURE) 

 
 

To setup the required value of Thickness the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<H> ⇒ Thickness fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (in the Thickness area the letter h is underlined) 

 

•  Combined 
 

� Click on Thickness ⇒ Thickness fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 

The value of Thickness is over the 5 … 300 mm (or 0.2 … 12 in) range with 1 mm (or 0.05 in) resolution. 

The resolution is selectable through clicking on  or pressing <Alt>+<1> on the keyboard 
 
To select the required value of Skip# the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<K> ⇒ Skip# fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (in the Skip# area the letter k is underlined) 

 

•  Combined 
 

� Click on Skip# ⇒ Skip# fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 

The value of Skip# may be either 0.5 or 1 
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Scan Length 
 

The value of Length (Scan Length or, in other words, Scan Path) represents the length of scanning line, over 
which the probe will be guided. The value of Length along with Skip# represents the length of the section of 
the test object to be displayed (Length of the Insonification and Recording area).  

 
 
= Length + 2 ••••  Skip# ••••  Thickness / Tan(Angle)  
 
 
 

Simultaneously the value of Length  
 
To setup the required value of Length the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding button  or  
 

•  Keyboard 
 

� Pressing <Alt>+<L> ⇒ Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (in the Length area the letter L is underlined) 

 
 
 
 

•  Combined 
 

� Click on Length ⇒ Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 
The value of Length is controllable over the 50…300 mm range (or 2…12 in) with 1 mm (or 0.05 in) 

resolution. The resolution is selectable through clicking on  or pressing <Alt>+<3> on the keyboard 
 
 
Encoder Selection 
Select the encoder to be used and click on its name: 

 
 
Echo Amplitude Palette (Color Scale) 
 
The color coding of echo amplitudes is provided during the t-ABIScan recording over the 28 dB range (- 14 
dB through + 14 dB; 0 dB level corresponds to the 50% A-Scan Height) 
 
There are three palettes available: 

o Clicking on  or pressing <Alt>+<G> on the keyboard will activate the Gray-Level coloring 
of echo amplitudes 

o Clicking on  or pressing <Alt>+<E> on the keyboard will activate the Thermo-Level 
coloring of echo amplitudes 

o Clicking on  or pressing <Alt>+<D> on the keyboard will activate the Pseudocolor-Level 
coding of echo amplitudes 

 

Length of the 
Insonification and 

Recording area 
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Insert Text Note 

A text note/comments may be typed to accompany the ABIScan record after clicking on  or 
pressing <Alt>+<X> on the keyboard 
 
 
 

Preview the Instrument Settings 

The instrument settings for the ABIScan record may be previewed through the clicking on  or 
pressing <Alt>+<U> on the keyboard 
 
Start/Stop t-ABIScan recording 
 

Clicking on  or pressing <Alt>+<S> on the keyboard will start the ABIScan recording 

The  button becomes invisible upon the ABIScan recording starts. The  button 

occupies its position. Clicking on  or pressing <Alt>+<S> on the keyboard will terminate the 
ABIScan recording prior to the completion  

The  button becomes invisible after the completion / termination of the ABIScan recording – the 

 button returns to its position 
 
Save the ABIScan record 
 
 

Clicking on  or pressing <Alt>+<A> on the keyboard will save the ABIScan record and 
accompanying instrument calibration dump and text notes / comments into a file. Refer to the paragraph 
5.4.19 of this Operating Manual to proceed with saving a file 
 
Return to the Pulser Receiver window 
 
 

Clicking on  or pressing <Alt>+<C> or Esc  on the keyboard will return to the Pulser / Receiver 
window 



ISO

 

6.4.4.2. ABIScan Recording – Angle Beam Probe 
 

To capture ABIScan: 
•  Apply probe to the test object in the start point of the selected scanning line 

•  Click on  or press <Alt>+<S> on the keyboard  
•  Guide the probe over the scanning line – the typical displays for the Skip# = 0.5 and Skip# = 1 cases 

during the scanning progress are shown and explained below 
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6.4.5. DAC/DGS Normalizing of the Captured B-Scan  
 

At the postprocessing stage the B-Scans captured whilst DAC/DGS active may be represented using the 
palette reflecting the signal amplitude either linearly (Normalize to DAC/DGS box is not checked) or with 
normalization respectively the DAC/DGS (Normalize to DAC/DGS box is checked). The Normalize to 
DAC/DGS checkbox is disabled for the maps captured whilst DAC/DGS inactive. The screenshots below 
illustrate the switching from the linear to the DAC/DGS normalized palette 
 

 
 

 
 

 

���� 
 

After switching to the DAC/DGS Normalized Palette the 0 dB the Filtering parameter is dB to DAC 
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7. Operating 'I2-ISONIC' Software Package 
- ISONIC Inspection of Planar Butt Joints, 
Scanning From One Side 

 
 
 
 

The contents of this chapter is valid for the  
I2-SONIC SW Package version 7.1.0.5 or higher 
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7.1. Preparing for the Inspection 
 

7.1.1. Fixture 
 
Apply the bar with the receivers of 
airborne ultrasound to the object 
under test at parallel to the weld. 
The distance between two receivers 
(Base) on the bar is defined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

Pos1 and Pos2 are the coordinates 
of the receivers taken form the left 
and right scales of bar 
correspondingly. The value of Base 
must be known prior to the 
scanning. Wrong determining of the 

Base causes mistakes in monitoring probe location and defects imaging  
 

 
Important: The Scanning Area is located at the opposite side of the weld with respect to the bar position 
 
 

Insert ultrasonic probe into the appropriate probe holder then fix the double or single emitter of airborne 
ultrasound on the top of the probe holder: 
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Remember! 
 

 
Double emitter of airborne ultrasound is required if there is a need to 
monitor the probe coordinates and swiveling angle simultaneously while 
scanning. Single emitter is required if there is a need to monitor the probe 
coordinates only 

 
 

7.1.2. Cabling 
 

 
Ultrasonic Flaw Detector PC Card Applicable Cabling Scheme Paragraph 

UDS 3-3 A.1; A.4 4.2.4 
UDS 3-4 A.2; A.5 4.2.4 

USLT 2000 A.3; A.6 4.2.4 
 

 
7.2. Start Up 
 

Double click on the icon  located on the ISONIC desktop 
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7.3. Operating the software: general hints 
 
 

•  All functions may be activated either through the mouse (trackball, touchpad, touchscreen, etc.) or 
keyboard manipulations or through the combining of both of them 

 

•  To activate the pseudo button click on it (left mouse button or touch screen stylus) or use the shortcut 
referring to the underlined letter in the button's caption by pressing <Alt> + <underlined letter> key on 

the keyboard. For example, the shortcut for  is <Alt>+<P> 
 

•  To get On-Line Help for some object, control, etc. right mouse click on it - the help topic appears 
 

•  To close the active help topic click on it or press Esc  on the keyboard. To print help topic or copy it into 
the Windows clipboard right mouse click on it 

•  Setup for all parameters is performed through the corresponding spins . To increment the parameter's 

value press and hold left mouse button on . To decrement the parameter's value press and hold left 

mouse button on   

•  Each spin  is associated with the label and display, showing the corresponding parameter's name and 

its value. For example the control for the Probe Delay looks like: . The parameter 
name Probe Delay, µµµµs is normally yellow; the letter "D" is underlined. Pressing <Alt>+<D> on the 
keyboard or click on the Probe Delay, µµµµs will change the fore color of Probe Delay, µµµµs to white making it 
controllable through the using of the keyboard arrows:  

 

� pressing ↑↑↑↑  or →→→→ on the keyboard acts as   - button of the spin 
 

� pressing ←←←← or ↓↓↓↓  buttons on the keyboard acts as   - button of the spin 
 
 
Other tips and hints applicable for operating the software are explained additionally while describing the 
corresponding modes of operation 
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7.4. Getting started... 
 
The Welcome... window appears after the program starts 

 
 
To open ISONIC Control Menu click on  or press 
or press <Alt>+<O> on the keyboard 
 

To terminate the current ISONIC Session click on  or press <Alt>+<C> or Esc  on the keyboard 
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7.5. ISONIC Control Menu 
 
 
 
 
 
7.5.1. Start New Inspection Procedure 
 
Click on  or press <Alt>+<I> on the keyboard: - the ISONIC 

Pre-Inspection Data… window  
appears 

 
 
 
 
7.5.2. Start Postprocessing 
 
Click on   
 
 
or press <Alt>+<P> on the keyboard 
 

7.5.3. Set Up Language for User Interface 
and On-Line Help 
 
 
 
Click on  or press <Alt>+<L> on the keyboard  
 
 

Click on  this button or press <Alt>+<C> or 

Esc  on the keyboard to close the ISONIC 
Control Menu and return to the welcome 
window 
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7.6. Pre-Inspection 
 
7.6.1. Describe the object under test… 
 
Left  mouse  click on   
 
or press <Alt>+<D> on the keyboard – the Describe the Object 
Under Test... window appears: there are 12 standard items to 
fill, each not longer then 16 symbols. It's possible to add free-
style comments to the Inspection Report, total length not more 
than 160 symbols. All items may be filled with some data existing 
from the previous session. Depending on the current need the 
existing data may be either applied or modified or replaced with a 
new data 
 

Click on    
 
or press <Alt>+<A> 
on the keyboard upon 
completing 
 

Click on    
or press <Alt>+<C>  

or Esc  on the  
keyboard to return to the 
ISONIC Pre- Inspection 
Data… window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
����  
 

Return to the ISONIC Pre-Inspection Data… window without applying discards all new keying in made 
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7.6.2. Inspection Data … 
 
Click on   
 
or press <Alt>+<N> on the keyboard –  
the corresponding window appears 
 
There are 6 standard items to fill in the Inspection Data... 
window, each not longer then 16 symbols. It's possible to add 
free-style scope of the test to Inspection Report, total length not 
more than 160 symbols. All items may be filled with some data 
existing from the previous session. Depending on the current 
need the existing data may be either applied or modified or 
replaced with a new data 
 
Click on    
 
 
 
 
 
or press <Alt>+<A> on the 
keyboard upon completing 
 
Click on    
 
 
 
 
 

or press <Alt>+<C> or Esc  on 
the keyboard to return to ISONIC Pre- Inspection Data… window 
 
 
����  
 

Return to the ISONIC Pre-Inspection Data… window without applying discards all new keying in made 
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7.6.3. Instrument … 
 
 
Click on   
 
 
or press <Alt>+<I> on the keyboard 
 
Case 1: UDS 3-3 Pulser Receiver Card – Ultrasonic Flaw 
Detector Inside 
 
ISONIC recognizes the UDS 3-3 card automatically and the 
corresponding question box appears: 

 
To continue click on  
 

or press <Alt>+<Y> or press Enter  on the keyboard, then the UDS 3-3 Pulser Receiver window appears 
allowing to calibrate the ultrasonic flaw detector according to the Inspection Specs. To proceed refer to the 
paragraph 5 of this Operating Manual  
 
Case 2: UDS 3-4 Pulser Receiver Card – Ultrasonic Flaw Detector Inside 
 
ISONIC recognizes the UDS 3-4 card automatically and the corresponding question box appears: 

 
 
 
 
 
 
 
 
 
 

To continue click on  
 

or press <Alt>+<Y> or Enter  on the keyboard, then the UDS 3-4 Pulser Receiver window appears 
allowing to calibrate the ultrasonic flaw detector according to the Inspection Specs. To proceed refer to the 
paragraph 5 of this Operating Manual 
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Case 3: USLT 2000 Pulser Receiver Card – Ultrasonic Flaw Detector Inside 
 
ISONIC recognizes the USLT 2000 card automatically and the corresponding question box appears: 

 
To continue click on  
 

or press <Alt> + <Y> or Enter  on the keyboard, then the USLT 2000 Pulser Receiver window appears 
allowing to calibrate ultrasonic flaw detector according to the Inspection Specs. To proceed refer to the 
paragraph 5 of this Operating Manual 
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7.6.4. Probe … 
 
Click on  
 
or press <Alt>+<P> on the keyboard –  
the corresponding window 
appears 
 
   

  
 
•  Select probe through the combo box or key in a new probe 

name 
� Click on   

 

(the list of the existing probes  
appears) then select probe from the  
list by clicking on its name: another way is to press 
<Alt>+<P> on the keyboard and then to select a probe 
from the list through pressing  
on ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 

OR 
 

� Key in a new probe name  here (8 symbols or less) 
 
•  Ensure that values of Probe Delay, Angle and X-Value are 

relevant, otherwise provide the appropriate update then 
click on   
or press <Alt>+<A> on the keyboard then click on  

or press Esc  or <Alt>+<C> on the keyboard 
  

 

���� 
 

There are three degrees for Setup Step  available for setting up the 
parameter's value. To select required Setup Step degree just  click on it or 
use corresponding shortcut on the keyboard: 
o <Alt>+<R> for Coarse 
o <Alt>+<E> for Medium 
o <Alt>+<F> for Fine 
 

 

Probe Delay 
 

To setup the value of Probe Delay the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<D> ⇒ Probe Delay fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Probe Delay area letter D is underlined) 
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•  Combined 
 

� Click on Probe Delay ⇒ Probe Delay fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 
on the keyboard 

 

The value of Probe Delay is set in µs  
The possible values of increment / decrement for Probe Delay are: 
0.1 µs - Fine 
0.5 µs - Medium 
1.0 µs - Coarse 

 

Angle 
 

To setup the value of Angle the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<N> ⇒ Angle fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Angle area letter N is underlined) 

 

•  Combined 
 

� Click on Angle ⇒ Angle fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 

The value for the   Probe Angle is set in degrees 
The possible values of increment / decrement for Probe Angle are: 
1 deg - Fine 
5 deg - Medium 
10 deg - Coarse 
 

X-Value 
 

To setup or update the X-Value the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<X> ⇒ X-Value fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the X-Value area letter X is underlined) 

 

•  Combined 
 
� Click on X-Value ⇒ X-Value fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 

The X-value is set in mm or in 
The possible values of increment / decrement for the X-value are: 
 

Resolution Metric Imperial 
Fine 1 mm 0.04 in 

Medium 2 mm 0.08 in 
Coarse 10 mm 0.4 in 
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7.6.5. ISONIC System Setup … 
 
Click on   
 
 
or press <Alt>+<O> on the 
keyboard to start ISONIC Setup 
window. The following observations to be  
performed in / from the ISONIC Setup window: 
 

•  setting up Static Parameters and Modes 
•  setting up Dynamic Parameters and Modes 
•  start of the Inspection (Scanning) 

 
 

 
 

Setup Static Parameters and Modes 
 

���� 
 

There are three degrees for the Setup Step  available for the setting up the value of 
each parameter. To select the required degree click on its name or use the 
corresponding keyboard shortcuts: 
o <Alt>+<R> for Coarse 
o <Alt>+<E> for Medium 
o <Alt>+<F> for Fine 
 

 

To return back to the ISONIC Pre-Inspection… window click on  or press 

<Alt>+<C> or Esc  on the keyboard 
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Scan Index 
 

To setup the value of Scan Index the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<X> ⇒ Scan Index fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Scan Index area letter x is underlined) 

 

•  Combined 
 

� Click on Scan Index ⇒ Scan Index fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 
 

The value for the Scan Index is set in mm or in 
The possible values of increment / decrement for Scan Index are: 

 

Resolution Metric Imperial 
Fine 1 mm 0.05 in 

Medium 2 mm 0.1 in 
Coarse 5 mm 0.5 in 

 

 
Base 
 

To setup the value of Base the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin  
 

•  Keyboard 
 

� Pressing <Alt>+<B> ⇒ Base fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Base area letter B is underlined) 

 

•  Combined 
 

� Click on Base ⇒ Base fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 
The value for the Base is set in mm or in 
The possible values of increment / decrement for Base are: 

 

Resolution Metric Imperial 
Fine 2 mm 0.25 in 

Medium 10 mm 0.5 in 
Coarse 100 mm 1 in 
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US Velocity 
 

To setup the value of US Velocity the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<U> ⇒ US Velocity fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the US Velocity area letter U is underlined) 

 

•  Combined 
 

� Click on US Velocity ⇒ US Velocity fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 

The value for the US Velocity is set in m/s or in/ms 
The possible values of increment / decrement for US Velocity are: 

 

Resolution Metric Imperial 
Fine 5 m/s 0.1 in/ms 

Medium 100 m/s 1 in/ms 
Coarse 500 m/s 10 in/ms 

 
 

���� 
 
Typically the shear wave angle beam probes are used for the inspection of welds made of low carbon steel. 
For the inspection of austenitic welds the longitudinal wave angle beam probe are applicable. The value of 
US Velocity must be setup accordingly 
 
 
Skip# 
 

To setup the value of Skip# the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<K> ⇒ Skip# fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Skip# area letter k is underlined) 

 

•  Combined 
 

� Click on Skip# ⇒ Skip# fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 
 

���� 
 
For the inspection of austenitic welds the longitudinal wave angle beam probe are applicable. The value of 
Skip# for such probes must be setup to 0.5 
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Weld Thick 
 

To setup the value of Weld Thick the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard shortcuts 
 

� Pressing <Alt>+<H> ⇒ Weld Thick fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Weld Thick area letter h is underlined) 

 

•  Combined 
 

� Click on Weld Thick ⇒ Weld Thick fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 

The value for the Weld Thick is set in mm or in 
The possible values of increment / decrement for Weld Thick are: 

 

Resolution Metric Imperial 
Fine 1 mm 0.05 in 

Medium 2 mm 0.2 in 
Coarse 5 mm 1 in 

 
 

���� 

Weld Thick setup – dependence of Nominal Material Thickness (NMT) 
 

Nominal Weld 
Thickness 

NMT 

Typical 
Probe 
Angle 

Possible 
value of 

the Skip# 

 
Weld Thick setup 

 
Note 

 
5 to 30 mm 

 
0.2 to 1.2 in 

 

 
 

70o 

 
 

0.5, 1 
and more 

 
 

Weld Thick = 
NMT 

 
 
Insonification of the whole volume of the weld 

 
30 to 60 mm 

 
1.2 to 2.4 in 

 

 
 

60o 

 
 

0.5 and 1 

 
 

Weld Thick = 
NMT 

 
 
Insonification of the whole volume of the weld 

 
≥≥≥≥ 60 mm 

 
≥≥≥≥ 2.4 in 

 

 
 

45o 

 
 

0.5 and 1 

 
 

Weld Thick = 
NMT 

 
 
Insonification of the whole volume of the weld 

 
≥≥≥≥ 60 mm 

 
≥≥≥≥ 2.4 in 

 
 

60o 

 
 

0.5 only 

 
 

Weld Thick = ULT 

Insonification of the Upper Layer (closest to 
the scanning surface) of the weld only. The 
thickness of the said layer - ULT is to be 
defined as the Weld Thick in order to provide 
the better resolution and the optimized 
scanning pattern 

 
≥≥≥≥ 60 mm 

 
≥≥≥≥ 2.4 in 

 
 

70o 

 
 

0.5 only 

 
 

Weld Thick = ULT 

Insonification of the Upper Layer (closest to 
the scanning surface) of the weld only. The 
thickness of the said layer - ULT is to be 
defined as the Weld Thick in order to provide 
the better resolution and the optimized 
scanning pattern 
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Weld Width 
 

To setup the value of Weld Width the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<D> ⇒ Weld Width fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard  (In the Weld Width area letter d is underlined) 

 

•  Combined 
 

� Click on Weld Width ⇒ Weld Width fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 
 
The value for the Weld Width is set in mm or in 
The possible values of increment / decrement for Weld Width are: 

 

Resolution Metric Imperial 
Fine 1 mm 0.05 in 

Medium 2 mm 0.2 in 
Coarse 5 mm 1 in 

 

Suppression of the Echoes Caused by Weld Geometry 
 

Click on  or press <Alt>+<T> on the keyboard to enable / disable the mode of operation providing 
suppression of echoes caused by the weld geometry, for example, signals caused by the reflections from the 
weld enforcements. The corresponding indication is provided: 
 

�  - Suppression of echoes caused by the weld geometry is ON 
 

�  - Suppression of echoes caused by the weld geometry is OFF 
 

Coloring (palette) 
 

To select the color scale (palette) for flaw imaging mouse-operate the combo box under Coloring label or 
press <Alt>+<G> and use ↑↑↑↑  , ↓↓↓↓  keys on the keyboard: 
 

 
 

Audible alarm of missing coupling 
 

Click on  or press <Alt>+<M> on the keyboard to enable / disable the audible alarm when missing 
the coupling. The corresponding indication is provided: 
 

�  - The audible alarm is ON 
 

�  - The audible alarm is OFF 
 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 239 of 550  

Setup Dynamic Parameters and Modes 
 
Coupling Monitor 

Click on  or press <Alt>+<O> on the keyboard to open the ISONIC Acoustic Coupling 
Monitor Setup window. 
 
To setup the value of Reference Signal Excitation Level 
the following manipulations are applicable: 

 
•  Mouse 

� Click on the corresponding spin    
 
•  Keyboard 
 
� Pressing <Alt>+<L> ⇒ Reference Signal 

Excitation Level fore color changes to white - 
then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard  
(In the Reference Signal Excitation Level area 
letter L is underlined) 

 
•  Combined 
 
� Click on Reference Signal Excitation Level 

⇒ Reference Signal Excitation Level fore color 
changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard 

 
To setup coupling monitor proceed as below: 

 
•  apply the emitter of reference signal and the probe inside the probe holder equipped with emitter(s) of 

airborne ultrasound to the object under test using excessive quantity of couplant as it is shown in the 
window  

 
•  find the threshold of Reference Signal Excitation Level, which is indicated trough the audible alarm if 

active and changing color of the Reference Signal Excitation Level horizontal bar indicator (red color 
means not sufficient coupling or still low level of excitation) 

 
•  add 3% to 7% to the found threshold of Reference Signal Excitation Level 
 
 

���� 
 

Sometime the dimensions of the object under test and its surface conditions don't allow reaching sufficient 
coupling indication even if the value of Reference Signal Excitation Level is set to 100%. If this is a case two 
or more emitters of reference signal must be connected to Out Cpl socket of ISONIC via special splitter 
(order code SE 20220) 
 

 
To switch the coupling monitor OFF set the Reference Signal Excitation Level to 0% or click on 

 or press <Alt>+<O> on the keyboard 
 

To return back to the ISONIC Setup window click on  or press <Alt>+<C> or 

Esc  on the keyboard 
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Airborne Ultrasound Velocity 
 

Click on  or press <Alt>+<A> on the keyboard to open the ISONIC Airborne 
Ultrasound Velocity Setup window 
 

 
 

To find and setup the actual values of Airborne US Velocity and Zero Offset proceed as below: 
 
•  Connect the first receiver of airborne ultrasound to the IN X socket of long cable box 
 
•  Connect the second receiver of airborne ultrasound to the OUT Coor socket of probe cable 
 
•  Place the receivers on the left or right side of the bar at the distance of 60 mm or 2.5 in (Short Base)  
 

•  Click on  or press <Alt>+<S> on the keyboard 
 
•  Place the receivers on the left or right side of the bar at the distance of 120 mm or 5 in (Long Base) 
 

•  Click on  or press <Alt>+<L> on the keyboard – this causes the automatic 
recalculation indication and setup of the new values for Airborne US Velocity and Zero Offset  

 

To restart the described procedure click on  or press <Alt>+<R> on the keyboard 
 

To return back to the ISONIC Setup window click on  or press <Alt>+<C> or 

Esc  on the keyboard 
 
 

���� 
 

Perform the Airborne US Velocity Setup at the beginning of the working shift and repeat it only in case of 
10oC change of the ambient temperature entire the working shift 
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Referring Probe Location Monitor to the Weld Position 
 

Click on  or press <Alt>+<L> on the keyboard to open the ISONIC Probe 
Location Monitor Setup window 
 

 
 
Apply the probe inside the probe holder equipped with emitter(s) of airborne ultrasound to the object under 

test as it is illustrated in the window and click on  or press <Alt>+<A> on the keyboard 
 

To return back to ISONIC Setup window click on  or press <Alt>+<C> or Esc  on 
the keyboard 
 
 

���� 
 

The described procedure also relates to the machined welds 
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Probe Swiveling Monitor Setup 
 

Click on  or press <Alt>+<S> on the keyboard to open the ISONIC Probe 
Swiveling Monitor Setup window 
 

Click on   
or press <Alt>+<S> on  
the keyboard to switch Probe 
Swiveling Monitor ON 
 
Click on   
or press <Alt>+<N> on  
the keyboard to switch Probe 
Swiveling Monitor OFF 
 
To setup the value of the Limit for Probe Swiveling 
Angle the following manipulations are applicable: 
 
•  Mouse 

� Click on the corresponding spin    
 
•  Keyboard 
 
� Press <Alt>+<L> ⇒ Limit for Probe Swiveling Angle fore color changes to white - then use ↑↑↑↑  , →→→→ , 

←←←← , ↓↓↓↓  buttons on the keyboard  (In the Limit for Probe Swiveling Angle area letter L is underlined) 
 
•  Combined 
 
� Click on Limit for Probe Swiveling Angle ⇒ Limit for Probe Swiveling Angle fore color changes 

to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 

To return back to the ISONIC Setup window click on  or press <Alt>+<C> or 

Esc  on the keyboard 
 
���� 
 

Probe Swiveling Monitor must be switched OFF if using single emitter of airborne ultrasound 
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Echo Amplitude Color Coding Protocol 
 

While scanning each echo amplitude is represented by the corresponding color of the appropriate segment of 
flaw image in 2 dB steps over 24 dB range 
 

The following protocols for the color coding of echo amplitude may be used: 
 

� Standard Level Linear Normalizing – the echo amplitude is normalized with respect to the 50% 
of A-Scan Height. Normalization law is: 
















 ××+=
%50

,%_20
2
16_ 10

HeightEchoLogIntIndexColor  

 
 

 
According to the above normalization law there are 13 colors having index from 0 to 12, each color 
covers echo variations over 2 dB sub-range: 
 

 Color Index Echo Height (EH) in % of the  
A-Scan Screen Height 

Color / dB 

 0 EH ≤ 12.5 % - 12 
 1 12.5 % < EH ≤ 15.8 % - 10 
 2 15.8 % < EH ≤ 19.9 % - 8 
 3 19.9 % < EH ≤ 25.0 % - 6 
 4 25.0 % < EH ≤ 31.5 % - 4 
 5 31.5 % < EH ≤ 39.7 % - 2 
 6 39.7 % < EH ≤ 50.0 % 0 
 7 50.0 % < EH ≤ 62.9 % 2 
 8 62.9 % < EH ≤ 79.2 % 4 
 9 79.2 % < EH ≤ 100.0 % 6 
 10 100.0 % < EH ≤ 125.6 % 8 
 11 125.6 % < EH ≤ 158.1 % 10 
 12 158.1 % < EH 12 
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� Standard Level TCG Normalizing – the echo amplitude is normalized with respect to the 50% of 
A-Scan Height while TCG is active. Normalization law is: 


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According to the above normalization law there are 13 colors having index from 0 to 12, each color 
covers echo variations over 2 dB sub-range: 
 

 Color Index Echo Height (EH) in % of the  
A-Scan Screen Height 

Color / dB 

 0 EH ≤ 12.5 % - 12 
 1 12.5 % < EH ≤ 15.8 % - 10 
 2 15.8 % < EH ≤ 19.9 % - 8 
 3 19.9 % < EH ≤ 25.0 % - 6 
 4 25.0 % < EH ≤ 31.5 % - 4 
 5 31.5 % < EH ≤ 39.7 % - 2 
 6 39.7 % < EH ≤ 50.0 % 0 
 7 50.0 % < EH ≤ 62.9 % 2 
 8 62.9 % < EH ≤ 79.2 % 4 
 9 79.2 % < EH ≤ 100.0 % 6 
 10 100.0 % < EH ≤ 125.6 % 8 
 11 125.6 % < EH ≤ 158.1 % 10 
 12 158.1 % < EH 12 
 

 
 

���� 
 

� TCG mode must be active  
 

� It's recommended to provide TCG setup at the 50% of the A-Scan Screen Height 
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� DAC Normalizing – the echo amplitude is normalized with respect to the corresponding DAC 

level. Normalization law is: 
 
















 ××+=
,%_
,%_20

2
16_ 10 LevelDAC

HeightEchoLogIntIndexColor  

 

 
According to the above normalization law there are 13 colors having index from 0 to 12, each color 
covers echo variations over 2 dB sub-range: 
 

 Color Index Echo Height (EH) with 
respect to the  

Corresponding DAC Level 

Color / dB 

 0 EH/DAC ≤ 0.250 - 12 
 1 0.250 < EH/DAC ≤ 0.316 - 10 
 2 0.316 < EH/DAC ≤ 0.398 - 8 
 3 0.398 < EH/DAC ≤ 0.500 - 6 
 4 0.500 < EH/DAC ≤ 0.630 - 4 
 5 0.630 < EH/DAC ≤ 0.794 - 2 
 6 0.794 < EH/DAC ≤ 1.000 0 
 7 1.000 < EH/DAC ≤ 1.258 2 
 8 1.258 < EH/DAC ≤ 1.584 4 
 9 1.584 < EH/DAC ≤ 2.000 6 
 10 2.000 < EH/DAC ≤ 2.512 8 
 11 2.512 < EH/DAC ≤ 3.162 10 
 12 3.162 < EH/DAC 12 
 
 

���� 
 

The DAC normalizing is supported by hardware configurations based on the internal flaw 
detector PC card either UDS 3-3 or UDS 3-4 or USLT 2000. It may not be implemented if 
using the external ultrasonic flaw detector 
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� DGS Normalizing – the echo amplitude is normalized with respect to the corresponding DGS 
level. Normalization law is: 
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According to the above normalization law there are 13 colors having index from 0 to 12, each color 
covers echo variations over 2 dB sub-range: 
 

 Color Index Echo Height (EH) with 
respect to the  

Corresponding DGS Level 

Color / dB 

 0 EH/DGS ≤ 0.250 - 12 
 1 0.250 < EH/DGS ≤ 0.316 - 10 
 2 0.316 < EH/DGS ≤ 0.398 - 8 
 3 0.398 < EH/DGS ≤ 0.500 - 6 
 4 0.500 < EH/DGS ≤ 0.630 - 4 
 5 0.630 < EH/DGS ≤ 0.794 - 2 
 6 0.794 < EH/DGS ≤ 1.000 0 
 7 1.000 < EH/DGS ≤ 1.258 2 
 8 1.258 < EH/DGS ≤ 1.584 4 
 9 1.584 < EH/DGS ≤ 2.000 6 
 10 2.000 < EH/DGS ≤ 2.512 8 
 11 2.512 < EH/DGS ≤ 3.162 10 
 12 3.162 < EH/DGS 12 
 
 

���� 
 

The DGS normalizing is supported by hardware configurations based on the internal flaw 
detector PC card either UDS 3-3 or UDS 3-4 or USLT 2000. It may not be implemented if 
using the external ultrasonic flaw detector 
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Follow the table below to select the required Echo Amplitude Color Coding Protocol 
 

Echo Amplitude 
Color Coding 

Protocol 

 
What is necessary 

 
DGS Normalizing 

 
 
 

 
o Internal flaw detector PC card UDS3-3 or UDS3-4 or USLT 2000 
o DAC/TCG/DGS Mode Setup: DGS (refer to the paragraph 5.4.13 or 

5.4.14) 
o Meas Value Setup: ∆∆∆∆VC(A) (submenu MEASURE in the Pulser 

Receiver window - refer to the paragraphs 5.4.15 and 5.4.16) 
 

DAC Normalizing 
 
 
 
 

o Internal flaw detector PC card UDS3-3 or UDS3-4 or USLT 2000 
o DAC/TCG/DGS Mode Setup: DAC (refer to the paragraph 5.4.11 and 

5.4.12) 
o Meas Value Setup: ∆∆∆∆VC(A) (submenu MEASURE in the Pulser 

Receiver window - refer to the paragraphs 5.4.15 and 5.4.16) 
 

Standard Level TCG 
Normalizing 

 
 
 

o All possible hardware configurations 
o DAC/TCG/DGS Mode Setup: TCG (refer to the paragraph 5.4.11 and 

5.4.12 for the internal flaw detector PC card or to the corresponding 
chapter of the external ultrasonic flaw detector operating manual) 

 
Standard Level 

Linear Normalizing 
 
 
 

o All possible hardware configurations 
o DAC/TCG/DGS Mode Setup: OFF or Update (refer to the 

paragraph 5.4.11 and 5.4.12 for the internal flaw detector PC card or to 
the corresponding chapter of the external ultrasonic flaw detector 
operating manual) 
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Start Inspection Procedure (Scanning) 
 
Scanning Schemes 
 
I2-SONIC software package supports 2 (two) scanning schemes: 
 
Scanning Scheme 1 – scanning above the material adjacent to the weld (suitable for all hardware 
configurations) 

 
The closest location (Position 1) of incidence point with relate to the weld edge: 
 

Position 1 = X-Value 
 
The farthest location (Position 2): 
 

Position 2 = 2 * Skip# * Material Thickness * Tan (Angle) 
 
 
Scanning Scheme 2 – scanning above the material adjacent to the weld and above the machined weld 
(Internal flaw detector card either UDS 3-3 or UDS 3-4 or USLT 2000 required) 

 
The closest location (Position 1) of incidence point with relate to the weld edge: 
 

Position 1 = −−−− Weld Width 
 
The farthest location (Position 2): 
 

Position 2 = 2 * Skip# * Material Thickness * Tan (Angle) 
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Flaw Imaging 
 
I2-SONIC software package supports 2 (two) techniques for the flaw imaging: 
 
Flaw Imaging Technique 1: SAFT imaging based on dynamic correlation analysis between sequences of 
probe locations and swiveling angles and received echoes (all hardware configurations) 
 
Flaw Imaging Technique 2: Raw imaging (Internal flaw detector card either UDS 3-3 or UDS 3-4 required) 
 
The following manipulations start the inspection procedure (scanning): 

 

 
Scanning Scheme 1 

and 
Flaw Imaging 
Technique 1 

 

 

Click on  or press <Alt>+<I> on the keyboard 
 

 
Scanning Scheme 2 

and 
Flaw Imaging 
Technique 1 

 
•  Press and hold <Shift>+<T> on the keyboard 

•  Click on  or press <Alt>+<I> on the keyboard 
•  Release <Shift>+<T> on the keyboard 
 

 
Scanning Scheme 1 

and 
Flaw Imaging 
Technique 2 

 
•  Press and hold <Shift>+<M> on the keyboard 

•  Click on  or press <Alt>+<I> on the keyboard 
•  Release <Shift>+<M> on the keyboard 
 

 
Scanning Scheme 2 

and 
Flaw Imaging 
Technique 2 

 
•  Press and hold <Shift>+<N> on the keyboard 

•  Click on  or press <Alt>+<I> on the keyboard 
•  Release <Shift>+<N> on the keyboard 
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7.7. Inspection 
 

The typical screens for the inspection of the weld using the I2-SONIC Inspection SW Package are shown 
below and comprehensively explained in the paragraph 2.1 of this Operating Manual 
 
 

 

 
 

The target of the operator is to completely "paint" over the Scanning Pattern area providing the necessary 
testing integrity. The defects are recorded and imaged automatically upon receiving the relevant echoes  
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The following controls are available while scanning: 

•   and  - clicking on the appropriate button or pressing 
<Alt>+<E> or <Alt>+<S> on the keyboard highlights the End View or Side View along with the Top 
View and Scanning Pattern permanently presented in the ISONIC On-line Imaging window  

 

•   - click on this button or press <Alt>+<S> on the keyboard to save a file containing inspection 
data. For the file placement and naming proceed according to the paragraph 5.4.19 of this Operating 
Manual 

 

•   - click on this button or press <Alt>+<Z> on the keyboard to zoom the ISONIC On-Line 
Imaging window 

 

•   - click on this button or press <Alt>+<R> on the keyboard to reset to background in the 
ISONIC On-Line Imaging window 

 

•   - click on this button or press <Alt>+<C> or Esc  on the keyboard to return back to the 
ISONIC Setup window 
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Inspection Note 1 
 

Background image of Scanning Pattern and Indication of the Current Probe Position depend on the selected 
scanning scheme: 
 

 
 
Inspection Note 2 
 

 
 
It may occur that the falling edge of initial pulse or reverberations caused by the initial pulse will not allow to 
process echoes while the probe is situated above the machined weld. To resolve the problem it is necessary 
to tune the gate threshold and delay for the "above weld" probe positioning through the pressing 
<Shift>+<↑↑↑↑>, <Shift>+<→→→→>, <Shift>+<←←←←>, <Shift>+<↓↓↓↓> on the keyboard: 
 

 

Initial Gate Setup for the "above 
weld" probe position 

Corrected Gate Setup for the 
"above weld" probe position 
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Inspection Note 3 
 

It is possible to pause scanning and recording of the inspection data and then to evaluate echoes trough the 
varying gain if using the internal flaw detector PC card. To proceed press <Shift>+<Z> on the keyboard: the 
additional gain-varying window appears  
 

 
To vary the value of Gain the following manipulations applicable: 

 
•  Mouse 

� Click on the corresponding spin    
 
•  Keyboard 
 
� Pressing <Alt>+<G> ⇒ Gain fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard  (In the Gain the letter G is underlined) 
 
•  Combined 
 
� Click on Gain ⇒ Gain fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 

To continue scanning and recording of the inspection data click on  or press 

<Alt>+<C> or Esc  on the keyboard – the value of Gain returns to the default level automatically  
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7.8. Postprocessing 
 
7.8.1. Start 
 
The empty ISONIC Postprocessing window appears when activating it from the ISONIC Control Menu 
 

•  Click on  or press <Alt>+<O> on the keyboard to start Postprocessing Mode 
- proceed according to the paragraph 5.4.20 of this Operating Manual for opening a file 

 

•  Click on  or press <Alt>+<C> or press Esc  on the keyboard to return back 
to ISONIC Control Menu 

 
  



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 255 of 550  

 

7.8.2. Postprocessing Procedures 
 

After loading results from file the following screen appears: 
 

 

•  Click on  or press <Alt>+<P> on the keyboard to preview the pre-inspection 
data including description of the object under test, inspection data, operator's comments and scope of 
inspection, ultrasonic flaw detector setup, probe information and ISONIC system setup 

 

•  Click on  or press <Alt>+<R> on the 
keyboard to manage printouts – the corresponding buttons block 
appears: 
� Click on   

or press <Alt>+<W> on the keyboard to print the 
complete Inspection Report 

� Click on   
or press <Alt>+<G> on the keyboard to print the graphical part of 
the Inspection Report only 

� Click on  
or press <Alt>+<P> on the keyboard for the  
Printer Setup 

� Click on   

or press <Alt>+<N> or Esc  on the keyboard to decline printing 
 

•  Click on  or press <Alt>+<I> on the 
keyboard to start Image Processing 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 256 of 550  

 

7.8.3. Image Processing 
 

 
 
The Image Processing Menu Bar provides 7 opportunities: 
 
•  Profiling – slicing the volume with the captured defects images in 3 planes 
 
•  Filtering – redrawing defect images with suppressing the segments corresponding to echo amplitudes 

below user-selected threshold level 
 
•  Measurements – measuring the coordinates and projection sizes for each defect and the distances 

between defects at any user-selected threshold 
 
•  Zoom – zooming, printing and filtering any region of Scanning Pattern, Top View and Side View, 

simultaneously or separately with automatic detection of highest echo in the user-selected region of 
interest 

 
•  Coloring – redrawing defect images referring to a newly selected color scale (palette) 
 
•  Print – printing processed images 
 
•  Exit – return back to unprocessed presentation of inspection results 
 
Some screenshots below illustrate Image Processing hints 
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Profiling 
 

 

LX – Profiling 
 
Profiling ���� LX-Profiling 

 

 
 
As a result: 
 

o two orthogonal lines appear above the Top View 
 

o the mouse pointer is "sticked" to the crossing point of the said lines 
 

o both lines may be moved up / down and left / right correspondingly by the mouse or touch screen stylus 
or buttons ↑↑↑↑  ↓↓↓↓  ���� ���� on the keyboard 

 

o the crossing point coordinates display appears 
 
 
 

o the horizontal line and its X-coordinate provide representing of the corresponding sectional Side View 
 

o the vertical line and its L-coordinate provide representing of the corresponding sectional End View 
 

Release the touch screen stylus or left mouse click or press Enter  on the keyboard to fix the obtained 
sectional Side View and End View and free mouse pointer for the further procedures 
 

To interrupt the LX-Profiling procedure right mouse click or press Esc  on the keyboard

The coordinates of 
the crossing point  
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Y- Profiling (Slicing) 
 

Profiling ���� Y-Profiling 
 

 
 

 
 
As a result: 
 

o two horizontal slicing lines reflecting the depth of the slice plane appear above the Side and End Views 
 

o the mouse pointer is "sticked" to the horizontal line above the Side View 
 

o the display of the slice depth appears  
 

o both horizontal lines may be moved up / down synchronously by the mouse or touch screen stylus or 
buttons ↑↑↑↑  ↓↓↓↓  on the keyboard 

o the reflectors matching with the slice plane are only visible in the sectional Top View 
 

Release the touch screen stylus or left mouse click or press Enter  on the keyboard to fix the selected 
threshold and free the mouse pointer for the further procedures 

To interrupt the Y-Profiling (Slicing) procedure right mouse click or press Esc  on the keyboard 
 
Profiling ���� Profiling OFF switches the active profiling function off 

Slice Plane 

Slicing Lines 

The depth of 
the slice 
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Filtering 
 
Filtering ���� Selected Amplitude Threshold 
 
As a result all 
defects images 
segments 
corresponding to 
the echo 
amplitudes below 
selected 
Threshold are 
erased in the Top 
View, Side View, 
and the End View 
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Measuring defects' coordinates and projection sizes 
 

Measurements ���� Selected Measurements Direction 
 

 
 
 
 

As a result: 
o the first reference 

line appear with the 
mouse pointer 
"sticked" to it 

o depending on the 
selected 
Measurement 
Direction the  first 
reference line be 
moved either up / 
down or left / right by 
the mouse or touch 
screen stylus or 
buttons ↑↑↑↑  ↓↓↓↓  or ���� ���� 
on the keyboard 

o the coordinate of the 
first reference line is 
shown under the "L-
Coordinate" or "X-
Coordinate" or "Y-
Coordinate - Depth" 
label while guiding 
along the 
corresponding 
Measurement 
Direction 

 

Release the touch screen 
stylus or left mouse click 

or press Enter  on the 
keyboard to fix the 
position of the first 
reference line  
 

As a result  
 

o the second 
reference line 
appear with the 
mouse pointer 
"sticked" to it   

For example: Measurements ���� L-Coordinate, Projection Length 
 

 

o depending on the selected Measurement Direction the  second reference line be moved either up / 
down or left / right by the mouse or touch screen stylus or buttons ↑↑↑↑  ↓↓↓↓  or ���� ���� on the keyboard 

o the relative coordinate of the second reference line with respect to the first reference line is shown 
under the "Projection Length" or "Projection Width" or "Projection Height" label while guiding along 
the corresponding Measurement Direction 

Release the touch screen stylus or left mouse click or press Enter  on the keyboard to fix the position of 
the first reference line 
 
To interrupt the Measuring defects' coordinates and projection sizes procedure right mouse click or 

press Esc  on the keyboard 
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Redrawing defects' images using a new color scale (palette) 
 

Coloring ���� Selected Palette 
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Print the postprocessing pages 
 
The postprocessing page may be printed at any moment, for example, after the necessary 
slicing, filtering measuring and coloring procedures are finalized. Click on Print to proceed: 

 
 
Zoom 
 

 

Zoom ���� Selected Zoom Area 
 
The selected Zoom Area appears in the additional window. The images from 
zoom windows may be filtered and printed 
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8. Operating 'Expert' Software Package - 
ISONIC Expert 

 
 
 
 

The contents of this chapter is valid for the  
EXPERT SW Package version 5.0.0.15 or higher 
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8.1. Preparing for the Inspection 
 

Follow the instructions of paragraph 7.1 of this Operating Manual and to the figures below 
 

Short and long bar for the receivers of airborne ultrasound 
 

It's possible to use either short or long bar for the receivers of airborne ultrasound while running the EXPERT 
Inspection SW Package. The value of Base (the distance between two receivers of airborne ultrasound) may 
be from 100 to 240 mm or 4 to 10 in. The short bar is required if the value of Base does not exceed 200 mm 
or 8 in. If this is a case then the distance between the receivers is defined as: 
 

Base = 100 + Pos1 + Pos2, mm 
or 

Base = 4 + Pos1 + Pos2, in 
 

The long bar is required if the value of Base is more than 200 mm or 8 in. If this is a case then the distance 
between the receivers is defined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

In the above formulas Pos1 and Pos2 are the coordinates of the receivers taken form the left and right 
scales of bar correspondingly 
 

Placement of the short ruler: 
 

 
 

 

8.2. Start Up 
 

Double click on the icon  located on the ISONIC desktop 
 

8.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

8.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

8.5. ISONIC Control Menu 
 

Refer to the paragraph 7.5 of this Operating Manual 
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8.6. Pre-Inspection 
 

Refer to the paragraph 7.6 of this Operating Manual and to the figures below  
 

 

 
 
 
Scan Index providing high frontal resolution  
 

To provide high frontal resolution the value of Scan Index may be setup to 0.25 or 0.5 mm / 0.01 or 0.02 in  
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The Defect Outlining Technology (DOT) 
 

The EXPERT Inspection SW Package is additionally featured with the Defect Outlining Technology (DOT) 
mode of operation based on the capturing of the Raw Data B-Scans whilst scanning multiply above the 
numerous weld cross-sections selected by an operator. This allows acquiring maximum possible information 
about the indications found: all A-Scans are captured entire the DOT scanning and may be recovered then 
off-line and utilized for the defect outlining and pattern recognition through the virtual rescanning 

The additional key-ins will be required upon clicking on the  button opening the 
intermediate Raw Data B-Scan Pre-Setup window, said key-ins are necessary for the characterization of the 
weld defects more precisely while utilizing DOT mode. If the Scanning Scheme 1 was selected as it is 
described in the paragraph 7.6.5 of the present Operating Manual (scanning above the parent material 
adjacent to the weld) then the Raw Data B-Scan Pre-Setup window looks as below 
 

 
 
 

Top Root Offset 
 

To setup the value of Top Root Offset the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<T> ⇒ Top fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Top area letter T is underlined) 

 

•  Combined 
 

� Click on Top ⇒ Top fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 

The value of Top Root Offset is set in mm or in with the increment of 1 mm or 0.05 in correspondingly 
between 0 and 30% of the WeldThick (refer to the paragraph 7.6.5 of this Operating Manual) 
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If the Scanning Scheme 2 was selected as it is described in the paragraph 7.6.5 of the present Operating 
Manual (scanning above both the machined weld cap and the adjacent material) then the value of Top Root 
Offset is automatically setup to 0 and may not be modified prior to the scanning 
 

 
 

Bottom Root Offset 
 

To setup the value of Bottom Root Offset the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<B> ⇒ Bottom fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Bottom area letter B is underlined) 

 

•  Combined 
 

� Click on Bottom ⇒ Bottom fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard 

 

The value of Bottom Root Offset is set in mm or in with the increment of 1 mm or 0.05 in correspondingly 
between 0 and 30% of the WeldThick (refer to the paragraph 7.6.5 of this Operating Manual) 
 

Bottom Bead Width 
 

To setup the value of Bottom Bead Width the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<W> ⇒ Bottom Bead Width fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard  (In the Bottom Bead Width area letter W is underlined) 

 

•  Combined 
 

� Click on Bottom Bead Width ⇒ Bottom Bead Width fore color changes to white - then use ↑↑↑↑  , →→→→ , 
←←←← , ↓↓↓↓  buttons on the keyboard 

 

The value of Bottom Bead Width is set in mm or in with the increment of 1 mm or 0.05 in correspondingly 
between 0 and 100% of the WeldWidth (refer to the paragraph 7.6.5 of this Operating Manual) 
 

Click on  or press <Alt>+<K> or Enter  on the keyboard upon completing with the settings in 
the Raw Data B-Scan Pre-Setup window to start scanning 
 

Click on  or press <Alt>+<C> or Esc  on the keyboard to return to the ISONIC Setup window 
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8.7. Inspection 
 

 
Refer to the paragraph 7.7 of this Operating Manual to scan the whole selected weld length  
 
Upon detecting an indication the Defect Outlining Technology (DOT) may be applied through the scanning 
multiply above the cross-sectional slice containing the indication found and capturing of the Raw Data B-
Scan.  For that purpose place the probe above the cross section where the indication was found and click on 

 or press <Alt>+<B> on the keyboard. The proper placement of the probe may be ensured through the 

getting again the echo just prior to the clicking on   
 
 
 
 
 

 
 
 



ISONIC Workstation fr

As a result the DOT window appears representing the cross sectional slice of the weld and adjacent material 
along with: 
 

� Coordinate L of the selected cross sectional slice along the weld axis 
� Width of the selected cross sectional slice, which is equal to the value of Scan Index designated in 

the ISONIC Setup window (refer to the paragraph 7.6.5 of the present Operating Manual) before the 
scanning 

 

� Current probe position above the selected cross sectional slice  
 

� Current A-Scan 
 

� Current trace of the probe's central beam in the selected cross sectional slice, said trace is 
modulated point by point according to the signal's amplitude in the current A-Scan 

 

� Weld geometry defined through the WeldThick and WeldWidth designated in the ISONIC Setup 
window and through the Top Root Offset, Bottom Root Offset, and Bottom Bead Width 
designated in the Raw Data B-Scan Pre-Setup window 

 

 
 
 
 
 
 

n

Cross Sectional 
Slice – Top View

Current Probe 
Position 

Coordinate of the 
Selected Cross Sectio

Slice Along the Wel
Current A-Sca
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 Cross Sectional 
Slice – End View 

Current Probe 
Position 

nal 
d 

Current Trace of the 
Probe's Central Beam in 
the Cross Sectional Slice
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It's necessary to scan multiply forward and back above the selected cross sectional slice to acquire the 
maximum of raw data A-Scans optimizing them for the better signal appearance. As a result the raw data B-
Scan with the sharply outlined defect will fill the End View of the cross sectional slice: 
 

 
 

The following controls are available in the DOT window: 

�  ,  ,  ,  - clicking on one of these buttons will designate the 
active palette representing the signal amplitude on the raw data B-Scan 

 

�  - clicking on this button will erase the raw data B-Scan and clear the DOT window while the 
DOT mode will remain still active 

 

�  - clicking on this button will erase the raw data B-Scan and return to the scanning mode  
(ISONIC On-Line Imaging window) without storing the DOT data 

 

�  - clicking on this button will store completely the DOT data as a part of the whole weld 
inspection data including Top, Side and End Views and return to the scanning mode  (ISONIC On-
Line Imaging window)  
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� 
 

Scanning violations interrupting the data acquisition whilst in the DOT window: 
 

� Placement of the probe aside of the selected cross sectional slice. In that case the actual probe 
position will be still indicated in the Top View plane while the probe itself will not be shown in the End 
View plane: 

 

                                   
 

� Improper probe orientation. This violation will be automatically detected if the Probe Swiveling Angle 
Monitor was activated before start scanning (refer to the paragraph 7.6.5 of the present Operating 
Manual). If this is a case then the actual probe position will be still indicated in the Top View plane 
along with the improper probe orientation sign � or � while the probe itself will not be shown in the 
End View plane: 

 

                                  
 

� Coupling loss. This violation will be automatically detected if the Acoustic Coupling Monitor was 
activated before start scanning (refer to the paragraph 7.6.5 of the present Operating Manual). If this 
is a case then the probe position will not be indicated in the Top View plane and the probe itself will 
not be shown in the End View plane. The No Coupling message will appear in the Top View plane 
image: 

 

 
 

� A combination of the above 
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The cross section with the already stored DOT data will be highlighted by the special mark  upon returning 
to the ISONIC On-Line Imaging window: 
 

 
 
It's possible to store practically unlimited number of the raw data B-Scans entire the scanning session for 
each cross sectional slice one by one selected by the operator as it is illustrated by the sequence of the 
screenshots below 
 

# ISONIC Screenshot Comments 
 
1 

 

 
 

 
Continuing 
scanning and 
detection of the 
next indication � 

click on   
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# ISONIC Screenshot Comments 
 
2 

 

 

 
Switch to the DOT 
window for the 
cross sectional 
slice containing the 
indication to be 
outlined 

 
3 

 

 
 

 
Completing 
outlining, storing 
the DOT data, and 
return to the 
scanning mode 
(ISONIC On-Line 
Imaging window) 
trough the clicking 

on  
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# ISONIC Screenshot Comments 
 
4 
 

 

 
 

 
Continuing 
scanning and 
detection of the 
next indication � 

click on   
 
 
 
 
 

Special 
marks 
indicate the 
presence of 
two cross 
sectional 
slices already 
filled with the 
DOT data 

 
 
  

 
5 

 

 
 

 
Completing 
outlining, storing 
the DOT data, and 
return to the 
scanning mode 
(ISONIC On-Line 
Imaging window) 
trough the clicking 

on  
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# ISONIC Screenshot Comments 
 
6 

 

 
 

 
Continuing 
scanning  
 
 
 
 
 
 
 
 
 

Special 
marks 
indicate the 
presence of 
three cross 
sectional 
slices already 
filled with the 
DOT data 

  
 

���� 
 

An attempt to record the new DOT data for the cross sectional slice already containing such data causes the 
warning as below: 
 

 
 

Clicking on  will erase the existing DOT data for the selected cross sectional slice and enter into 

the DOT window allowing capturing of the new data. Clicking on  will return to the scanning 
mode – ISONIC On-Line Imaging window 
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The following controls beside  are available while scanning: 
 

•   and  - clicking on the appropriate button or pressing 
<Alt>+<E> or <Alt>+<S> on the keyboard highlights the End View or Side View along with the Top 
View and Scanning Pattern permanently presented in the ISONIC On-line Imaging window  

 

•   - click on this button or press <Alt>+<S> on the keyboard to save a file completely 
containing the scanning results along with the complete DOT data for all cross sectional slices 
captured by an operator. For the file placement and naming proceed according to the paragraph 5.4.19 
of this Operating Manual 

 

•   - click on this button or press <Alt>+<Z> on the keyboard to zoom the ISONIC On-Line 
Imaging window 

 

•   - click on this button or press <Alt>+<R> on the keyboard to reset to background in the 
ISONIC On-Line Imaging window 

 

•   - click on this button or press <Alt>+<C> or Esc  on the keyboard to return back to the 
ISONIC Setup window 
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8.8. Postprocessing 
 
Refer to the paragraph 7.8 of this Operating Manual and to the below specific notes related to the off-line 
analysis of the DOT data 

 
 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To proceed with the off-line analysis of the DOT 

data click on  or press 
<Alt>+<I> on the keyboard upon opening the file 
then click on the B-Scan in the horizontal menu 
bar and select the cross sectional slice by it's L-
coordinate through the opened vertical menu bar  
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As a result the DOT off-line analysis window appears 
 

 
 
All operations in the DOT off-line analysis window are controlled through the horizontal menu bar as it is 
explained and illustrated below 
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B-Scan ���� L-coordinate 
 
Switch from the unfolded 
cross sectional slice to 
another one provided that 
there were more then one 
of them captured and 
stored along with the 
scanning data 
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Coloring ���� Normalize 
to DAC/DGS ���� ON 

 
If the DOT data was 
captured whilst DAC / 
DGS was active then the 
Raw Data B-Scan may 
be represented at   
dB to DAC / DGS rate 
where the palette reflects  
echo amplitudes  
normalized to DAC / DGS 
 
 

Coloring ���� Normalize 
to DAC/DGS ���� OFF 

 
This combination will 
return to representation of 
the Raw Data B-Scan 
using the palette linearly 
reflecting the echo 
amplitudes  
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Coloring ���� <Palette> 
where the <Palette> may 
be either Pseudo 1 or 
Pseudo 2 or Thermal or 
GrayScale 
 
Selection of the palette to 
represent the Raw Data 
B-Scan 
 
 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 282 of 550  

 

 
 

 
 
                                         
 

 
 
 
 
 
Recover A-Scan 
 
Clicking on this topic will 
place the cursor above 
the "contact surface" line 
of the cross sectional 
slice allowing the off-line 
virtual scanning across 
the weld. The cursor 
position matching with the 
probe's incidence point is 
accompanied with its 
central beam trace and 
indicated as  
Probe Position. The 
virtual scanning across 
the weld may be 
controlled by the touch 
screen stylus or by mouse 
or by the ���� and ���� 
buttons on the keyboard. 
The A-Scans are 
recovered and 
represented dynamically 
for each cursor position 
allowing the defect's 
characterization 
according to BS EN 583-5
 
Upon completing the 
virtual scanning and 
selection of the necessary 
A-Scan (for example –  
representing the maximal 
echo) release the stylus 
from the touch screen or 
left mouse click or press 

Enter  on the keyboard 
– this will free the cursor 
for further procedures 
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Filtering ���� ON 
 

Filtering of the Raw Data B-
Scan through the 
suppressing of the echo 
amplitudes below the 
selected threshold level:  
 

� The amplitude 
threshold line 
representing the 
threshold level appears 
above the palette; the 
cursor is "sticked" to the 
amplitude threshold 
line, which may be 
moved left / right either 
by the touch screen 
stylus or by the mouse 
or by the ←←←← , →→→→ buttons 
on the keyboard 

 

� The value of the 
amplitude threshold is 
displayed as Filtration 
Level, dB or dB to 
DAC/DGS depending on 
the DAC/DGS 
normalization is OFF or 
ON  

 

� Images of the reflectors 
returning the echo 
amplitudes below the 
amplitude threshold 
are erased from the 
Raw Data B-Scan i.e. 
rejected 

 

To fix the threshold level 
left mouse click or release 
the stylus from the touch 
screen 
 
Filtering ���� OFF 
 

This switches back to the 
unfiltered Raw Data B-Scan 
representation 
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Measurements ���� X-
Coordinate, Projection 
Width 

 
� The first vertical 

measuring line appears 
on the Raw Data B-
Scan; the cursor is 
"sticked" to the first 
vertical measuring 
line, which may be 
moved left / right either 
by the touch screen 
stylus or by the mouse 
or by the ←←←← , →→→→ buttons 
on the keyboard 

 
� The position of the first 

vertical measuring line  
is indicated as X-
Coordinate  

 
� To fix the position of the 

first vertical measuring 
line release the stylus 
from the touch screen or 
left mouse click or press 

Enter  on the 
keyboard  
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As a result: 
 
� The second vertical 

measuring line appears 
on the Raw Data B-
Scan; the mouse pointer 
is "sticked" to the 
second vertical 
measuring line, which 
may be moved left / right 
either by the touch 
screen stylus or by the 
mouse or by the ←←←← , →→→→ 
buttons on the keyboard 

 
� The position of the 

second vertical 
measuring line with 
respect to the first 
vertical measuring line 
is indicated as 
Projection Width 

 
� To fix the position of the 

second vertical 
measuring line release 
the stylus from the touch 
screen or left mouse 

click or press Enter  
on the keyboard 

 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 286 of 550  

 

 
 

 

 
 
 
 
 
 
 

Measurements ���� Y-
Coordinate, Projection 
Height 

 
� The first horizontal 

measuring line appears 
on the Raw Data B-
Scan; the mouse pointer 
is "sticked" to the first 
horizontal measuring 
line, which may be 
moved up / down either 
by the touch screen 
stylus or by the mouse 
or by the ↑↑↑↑  , ↓↓↓↓  buttons 
on the keyboard 

 
� The position of the first 

horizontal measuring 
line is indicated as Y-
Coordinate, Depth 

 
� To fix the position of the 

first horizontal 
measuring line release 
the stylus from the touch 
screen or left mouse 

click or press Enter  
on the keyboard  
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As a result: 
 
� The second horizontal 

measuring line appears 
on the Raw Data B-
Scan; the mouse pointer 
is "sticked" to the 
second horizontal 
measuring line, which 
may be moved up / 
down either by the touch 
screen stylus or by the 
mouse or by the ↑↑↑↑  , ↓↓↓↓  
buttons on the keyboard 

 
� The position of the 

second horizontal 
measuring line with 
respect to the first 
horizontal measuring 
line is indicated as 
Projection Height 

 
� To fix the position of the 

second horizontal 
measuring line release 
the stylus from the touch 
screen or left mouse 

click or press Enter  
on the keyboard 

 

 

 
Measurements ���� OFF 

 
This will negate the 
measurement lines on the 
Raw Data B-Scan and clear 
the measurement boxes 
 
 
Print - clicking on this topic 
will print the apparent 
postprocessing view along 
with the measurements and 
filtering data 
 
 
Exit – clicking on this button 
will return to the ISONIC 
Image Processing window 
containing Top View, Side 
View, and End View of the 
whole scanned weld 
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9. Operating 'SM-PIPE' Software Package 
- ISONIC Inspection of Small Diameter 

Welds 
 
 
 
 

The contents of this chapter is valid for the  
SM-PIPE SW Package version 4.1.0.5 or higher 
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9.1. Preparing for the Inspection 
 

9.1.1. Fixture 
Place the fixture and the bar with the 
receivers of airborne ultrasound on the pipe. 
The bar must be oriented at parallel to weld. 
Depending on the probe dimensions there 
are two ways for fitting the bar to the fixture – 
refer to the corresponding pictures. 
The value of Base (the distance between 
two receivers of airborne ultrasound) may be 
from 100 to 300 mm or 4 to 12 in. The short 
bar is required if the value of Base is not 
exceeding 200 mm or 8 in. If this is a case 
then the distance between the receivers is 
defined as: 
 

Base = 100 + Pos1 + Pos2, mm 
or 

Base = 4 + Pos1 + Pos2, in 
 

The long bar is required if the value of Base 
is more than 200 mm or 8 in. If this is a case 
then the distance between the receivers is 
defined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

In the above formulas Pos1 and Pos2 are 
the coordinates of the receivers taken form 
the left and right scales of bar 
correspondingly 

 

The value of Base must be known prior 
to the scanning. Wrong determining of 
the Base causes the mistakes in 
monitoring probe location and defects 
imaging  
 
 

Important:  
 

•  The exact length of the inspected 
area  (Weld Length) depends on 
Base and Weld Diameter and it is 
calculated automatically while running 
the SM-PIPE software package (refer 
to the below paragraphs 9.6 and 9.7 
of this Operating Manual) 

 

•  It may occur that reducing of the 
preliminary selected Base value will 
be required by the software running 
(refer to the paragraph 9.6 of this 
Operating Manual) 

 
 

Follow also the instructions of paragraph 
7.1 of this Operating Manual for fitting 
probe into the probe holder, etc.  

Large and Medium Size 
Angle Probes 

Miniature Angle 
Probes 
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9.1.2. Cabling 
 

Refer to the paragraph 7.1.2 of this Operating Manual 
 

9.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

9.3. Operating the software: general hints 
 

Follow the instructions of paragraph 7.3 of this Operating Manual 
 

9.4. Getting started... 
 

Follow the instructions of paragraph 7.4 of this Operating Manual 
 

9.5. ISONIC Control Menu 
 

Follow the instructions of paragraph 7.5 of this Operating Manual 
 

9.6. Pre-Inspection 
 

Refer to the paragraph 7.6 of this Operating Manual and to the figures below  
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Weld Diameter 
 

To setup the value of Weld Diameter the following manipulations applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard shortcuts 
 

� Pressing <Alt>+<W> ⇒ Weld Diameter fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 
on the keyboard  (In the Weld Diameter area letter W is underlined) 

 

•  Combined 
 

� Click on Weld Diameter ⇒ Weld Diameter fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard 

The value for the Weld Diameter is set in mm or in 
The possible values of increment / decrement for Weld Diameter are: 

 

Resolution Metric Imperial 
Fine 1 mm 0.05 in 

Medium 5 mm 0.25 in 
Coarse 10 mm 0.5 in 

 

 
 

���� 
 

•  The length of the inspected area (Weld Length) is defined by the SM-PIPE software 
package automatically with respect to the Base and Weld Diameter values. Generally, the 
upper limit for Base is 300 mm (12 in), however it can be lower for welds having small 
diameters and so the value of Base may be reduced automatically while keying the Weld 
Diameter value. If this is a case then: 

 

� provide the distance between the receivers of airborne ultrasound equal to the value of 
Base recalculated and indicated by SM-PIPE software 

� re-refer probe location monitor to the weld position (as it is explained in the paragraph 
7.6.5 of this Operating Manual) after each change of the distance between the 
receivers of airborne ultrasound (Base) 

 

•  The exact length of the inspected area (Weld Length) will be indicated in the ISONIC On-
Line Imaging  window after starting inspection. It will be also stored in each file containing 
the inspection results and printed in the Inspection Report 

 
 
Scan Index providing high frontal resolution  
 
To provide high frontal resolution the value of Scan Index may be setup to 0.25 or 0.5 mm / 0.01 or 0.02 in 
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9.7. Inspection 

 

 
The above screenshot illustrates ISONIC screen while scanning using the SM-PIPE Inspection SW Package. 
The exact length of weld under inspection is shown under the Top View in the ISONIC On-Line Imaging … 
window. The Scanning Pattern, Top View and Side View images are shown unfolded and simultaneously 
the additional Real Shape Side View window is generated making it possible to evaluate the defects 
locations more precisely. The End View and Side View are switch-able while scanning. It is also possible to 
obtain the separate cross-sectional B-Scan images during the inspection. Refer to the paragraphs 7.7 and 
8.7 of this Operating Manual – all instruction on the ISONIC operation while scanning are applicable to the 
SM-PIPE Inspection SW Package. 
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Additional Hint: obtaining the separate cross-sectional B-Scan image whilst scanning 
 
To record the cross-sectional B-Scan image:  

•  place probe above the selected section 

•  click on  or press <Alt>+<B> on the keyboard 
The additional B-Scan window appears on the ISONIC screen 
 

 
 
The B-Scan image is created in the said additional window through the moving probe across the selected 
section of the weld and 
 

LB-Scan – ½ * Scan Index  ≤≤≤≤        L        ≤≤≤≤  LB-Scan + ½ * Scan Index 
here: 

LB-Scan is the probe coordinate along the weld under test at the moment of activating of the 
additional B-Scan window 
L 
  

 is the current probe coordinate along the weld under test 
 

 
B-Scan image will not be created if 

L ≤≤≤≤         – ½ * Scan Index or L  
    

  ≥≥≥≥  LB-Scan + ½ * Scan Index  
 

 
The Top, Side and End View as well as the Scanning Pattern are continuously and unconditionally updated 
without any dependence on presence or not of the B-Scan window on the ISONIC screen 
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Separate B-Scan Imaging Notes: 
 

----(1)---- 
 

The special label indicates if the B-Scan image is under update  
 

                                 
Update                                                                     No Update 

 
----(2)---- 

 

To close the additional B-Scan window click on  or press <Alt>+<B> on the keyboard 
 
 

LB-Scan
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9.8. Postprocessing 
 
Refer to the paragraph 7.8 of this Operating Manual 
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10. Operating 'NOZZLE' Software Package 
- ISONIC Inspection of Nozzle Welds 

 
 
 
 

The contents of this chapter is valid for the  
NOZZLE SW Package version 3.1.0.5 or higher 
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10.1. Preparing for the Inspection 
 

10.1.1. Fixture 
 
Place the bar with the receivers of 
airborne ultrasound behind the 
scanning area at parallel to the 
weld. The value of Base (the 
distance between two receivers of 
airborne ultrasound) may be from 
100 to 480 mm or 4 to 19 in. The 
short bar is required if the value of 
Base is not exceeding 200 mm or 
8 in. If this is a case then the 
distance between the receivers is 
defined as: 
 

Base = 100 + Pos1 + Pos2, mm 
or 

Base = 4 + Pos1 + Pos2, in 
 

The long bar is required if the 
value of Base is more than 200 

mm or 8 in. If this is a case then the distance between the receivers is defined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

In the above formulas Pos1 and Pos2 are the coordinates of the receivers taken form the left and right 
scales of bar correspondingly 
 

The value of Base must be known prior to the scanning. Wrong determining of the Base causes the 
mistakes in monitoring probe location and defects imaging  
 
Insert ultrasonic probe into appropriate probe holder as it is shown in the paragraph 7.1.1 of this Operating 
Manual. The single emitter is required if there is a need to monitor the probe coordinates only. Fix the 
single emitter of airborne ultrasound on the top of probe holder as it is shown in the paragraph 7.1.1 of this 
Operating Manual.  
 
 

The double emitter of 
airborne ultrasound is required 
if there is a need to monitor the 
probe coordinates and 
swiveling angle simultaneously. 
The nozzle welds the double 
emitter must be fixed on the 
top of the probe holder 
together with the rotating 
adapter – refer to the picture 
below. Refer to the paragraph 
6.1.1 of this Operating Manual 
for the reference on proper 
manipulation of the probe 
holder equipped by single or 
double emitter of airborne 
ultrasound 
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10.1.2. Cabling 
 
Refer to the paragraph 7.1.2 of this Operating Manual 
 

10.2. Start Up 
 

Double left mouse  click on the icon  located on the ISONIC desktop 
 

10.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

10.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

10.5. ISONIC Control Menu 
 

Refer to the paragraph 7.5 of this Operating Manual 
 

10.6. Pre-Inspection 
 

Refer to the paragraph 7.6 of this Operating Manual and to the figures below  
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Referring Probe Location Monitor to the Nozzle Weld Position 

 

 
 
Place probe equipped with the single or double emitter of airborne ultrasound as it is shown in the 
corresponding window 
 
Probe Swiveling Monitor Setup 
 

 
Place probe equipped with the double emitter of airborne ultrasound as it is shown in the corresponding 
window 
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Flaw Imaging 
 
NOZZLE software package supports 2 (two) techniques for the flaw imaging: 
 
Flaw Imaging Technique 1: SAFT imaging based on dynamic correlation analysis between sequences of 
probe locations and swiveling angles and received echoes (all hardware configurations) 
 
Flaw Imaging Technique 2: Raw imaging (Internal flaw detector card either UDS 3-3 or UDS 3-4 required) 
 
The following manipulations start the inspection procedure (scanning): 

 

 
Flaw Imaging 
Technique 1 

 

 

Click on  or press <Alt> + <I> on the keyboard 
 

 
 

Flaw Imaging 
Technique 2 

 
•  Press and hold <Shift> + <M> on the keyboard 

•  Click on  or press <Alt> + <I> on the keyboard
•  Release <Shift> + <M> on the keyboard 
 

 

10.7. Inspection 
 

 
Refer to the paragraphs 7.7 and 8.7 of this Operating Manual 
 

10.8. Postprocessing 
 
Refer to the paragraph 7.8 of this Operating Manual 
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11. Operating 'PLCROSS' Software 
Package - ISONIC Inspection of Planar 

Butt Joints from Both Sides 
 
 
 
 

The contents of this chapter is valid for the  
PLCROSS SW Package version 5.1.0.6 or higher 
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11.1. Preparing for the Inspection 
 

11.1.1. Fixture 
Place the bar with the receivers of airborne 
ultrasound aside of the scanning area at 
rectangle to the weld. The distance between 
two receivers (Base) on the bar is defined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

Pos1 and Pos2 are the coordinates of the 
receivers taken form the left and right scales 
of bar correspondingly. The value of Base 
must be set up according to the paragraph 
11.6. Wrong determining of the Base causes 

mistakes in monitoring probe location and defects imaging.  
 
 

Important:  
 

•  There are two Scanning Areas located at the both sides of the weld 
 

•  The start point and length for both areas must be setup according to the paragraph 11.6 
 
  

Insert ultrasonic probe into the appropriate probe holder then fix the double or single emitter of airborne 
ultrasound on the top of the probe holder; use the rotary adapter for the double emitter of airborne ultrasound 
referring on the below sketches: 
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Remember! 
 

 
 

 
 

Double emitter of airborne ultrasound is required if there is a need to 
monitor the probe coordinates and swiveling angle simultaneously while 
scanning. Single emitter is required if there is a need to monitor the probe 
coordinates only 
 

 
11.1.2. Cabling 
 
Refer to the paragraph 7.1.2 of this Operating Manual 
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11.2. Start Up 
 

Double click on the icon  located on the ISONIC desktop 
 

11.3. Operating the software: general hints 
 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

11.4. Getting started... 
 
Refer to the paragraph 7.4 of this Operating Manual 
 

11.5. ISONIC Control Menu 
 
Follow the instructions of paragraph 7.5 of this Operating Manual  
 

11.6. Pre-Inspection 
Refer to the paragraph 7.6 of this Operating Manual and to the figures below   
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Weld Length 
 

Weld Length is the length of weld under test, inspection of which is to be performed and recorded in one 
shot. Weld Length is counted from the Zero Line selected by an operator – refer to the sketch in the ISONIC 
Setup window and to the below subchapter Referring Probe Location Monitor to Weld Position. To setup 
the value of Weld Length the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<N> ⇒ Weld Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 
on the keyboard  (In the Weld Length area letter N is underlined) 

 

•  Combined 
 

� Click on Weld Length ⇒ Weld Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 
on the keyboard 
 

The value for the Weld Length is set in mm or in 
The possible values of increment / decrement for Weld Length are: 

 

Resolution Metric Imperial 
Fine 10 mm 0.5 in 

Medium 50 mm 2 in 
Coarse 100 mm 4 in 

 

 
Region of Interest 

Click on  or press <Alt>+<G> on the keyboard to select the Region of Interest.  The 
corresponding indication is provided: 
 

�  - Inspection of weld area only / Suppression of echoes caused by the weld geometry 
is ON (for example, signals caused by the reflections from the weld enforcements will be 
suppressed) 

 

�  - Inspection of weld area only / Suppression of echoes caused by the weld geometry 
is OFF 

 

�  - Inspection of weld area and heat affected zones from both sides / Suppression of 
echoes caused by the weld geometry is ON (The width of heat affected zone is determined 
automatically as 1/3 of Weld Thick but not less than 10 mm (0.4 in) and not more than 20 mm (0.8 
in) as per Standard HP 5/3) 

 

�  - Inspection of weld area and heat affected zones from both sides / Suppression of 
echoes caused by the weld geometry is OFF 
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Confirm Base Value 
 
While running the PLCROSS software package the value of Base is recalculated automatically depending on 
the following operator's inputs: 
 

� Skip# 
� Weld Thick 
� Weld Width 
� Region of Interest 

 

After the completion of all inputs: 
 

•  Place the receivers of airborne ultrasound into the required positions 
 

Base ≤≤≤≤    480 mm  / 19.2 in –  Use the 
Standard Bar 

 
Base >>>>    480 mm / 19.2 in – Use the 

Special Long Bar 

Base >>>>    480 mm / 19.2 in – Use the 
Separate Supports for each Airborne 

Ultrasound Receiver 
 

The value of Base is determined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

Pos1, Pos2 are the coordinates of the 
receivers on the left and right scales of the 
bar 

The value of Base is determined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

Pos1, Pos2 are the coordinates of the 
receivers on the left and right scales 
of the bar 

 
 

 
Provide the required distance between 
the receivers using the measuring tape 

 

•  Click on  or click <Alt>+<B> on the keyboard  
 
 

 
Referring Probe Location Monitor to Weld Position 
 

Click on  or press <Alt>+<L> on the keyboard to open the ISONIC Probe 
Location Monitor Setup window 

 
Select the line closest to the bar (Zero Line); apply the probe equipped with probe holder and emitter(s) of 
airborne ultrasound to the Scanning Area 1 on the object under test as it is illustrated in the ISONIC Probe 
Location Monitor Setup window's sketch then: 
 

� click on  or press <Alt>+<N> on the keyboard – this will reset probe location 

monitor and enable  button 
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� click on  or press <Alt>+<Z> on the keyboard – this will reset Relative L-

Coordinate to 0 defining Zero Line and enable the first  button: 
 

 
 

� click on first  button or press <Alt>+<A> on the keyboard. This will refer the probe 
location monitor to the weld at the adjacent Scanning Area 1 and also change the guiding sketch in the 

ISONIC Probe Location Monitor Setup window enabling the second  button 

 
 
Apply the probe equipped with probe holder and emitter(s) of airborne ultrasound to the Scanning Area 2 on 
the object under test as it is illustrated in the ISONIC Probe Location Monitor Setup window's sketch then 

click on the second  button or press <Alt>+<A> on the keyboard. This refers probe 
location monitor to the weld from Scanning Area 2 and end probe location monitor setup 
 
 

To return back to the ISONIC Setup window click on  or press <Alt>+<C> or 

Esc  on the keyboard 
 
 

����  
The described procedure also relates to the machined welds  
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Probe Swiveling Monitor 
 
Place probe equipped with the double emitter of airborne ultrasound as it is shown in the corresponding 
window 

 
 

Flaw Imaging 
 

Refer to the paragraph 10.6 of this Operating Manual 
 

11.7. Inspection 
 

Region of Interest: Weld Only 
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Region of Interest: Weld and Heat Affected Zones 

 
 
The above screenshots illustrate the ISONIC screen while scanning using PLCROSS software. Refer to the 
paragraphs 7.7 of this Operating Manual to get instructed on control ISONIC while scanning. 
 
 

11.8. Postprocessing 
 
Refer to the paragraphs 7.8 of this Operating Manual  
 

Weld Area  

Heat Affected 
Zones Areas 
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12. Operating 'CIRCROSS' Software 
Package - ISONIC Inspection of 

Circumferential Butt Joints 
 
 
 
 

The contents of this chapter is valid for the  
CIRCROSS SW Package version 5.1.0.5 or higher 
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12.1. Preparing for the Inspection 
 

Refer to the paragraph 11.1 of this Operating Manual 
 

12.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

12.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

12.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

12.5. ISONIC Control Menu 
 

Follow the instructions of paragraph 7.5 of this Operating Manual  
 

12.6. Pre-Inspection 
 

Refer to the paragraphs 7.6 and 11.6 of this Operating Manual and to the figures below  
 

Weld Diameter 
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Weld Diameter 
 

To setup the value of Weld Diameter the following manipulations are applicable: 
 
•  Mouse 

� Click on the corresponding spin    
 
•  Keyboard 
 
� Pressing <Alt>+<W> ⇒ Weld Diameter fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  

buttons on the keyboard  (In the Weld Diameter area letter W is underlined) 
 
•  Combined 
 
� Click on Weld Diameter ⇒ Weld Diameter fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  

buttons on the keyboard 
 

The value for the Weld Diameter is set in mm or in 
The possible values of increment / decrement for Weld Diameter are: 

 

Resolution Metric Imperial 
Fine 2 mm 0.1 in 

Medium 10 mm 0.4 in 
Coarse 20 mm 2 in 

 

 

12.7. Inspection 
 

Region of Interest: Weld Only 
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Region of Interest: Weld and Heat Affected Zones 
 

 
 
The above screenshots illustrate the ISONIC screen while scanning using CIRCROSS software. Refer to the 
paragraphs 7.7 of this Operating Manual to get instructed on control ISONIC while scanning. 
 

12.8. Postprocessing 
 
Refer to the paragraph 7.8 of this Operating Manual  
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13. Operating 'TRANSCAN' Software 
Package - ISONIC Inspection of Butt 

Welds for Defects Transversal to the Weld 
 
 
 
 

The contents of this chapter is valid for the  
TRANSCAN SW Package version 5.1.0.5 or higher 
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13.1. Preparing for the Inspection 
 

13.1.1. Fixture 
Place the bar with the receivers of airborne 
ultrasound aside of the scanning area at 
rectangle to the weld. The distance between 
two receivers (Base) on the bar is defined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

Pos1 and Pos2 are the coordinates of the 
receivers taken form the left and right scales 
of bar correspondingly. The value of Base 
must be set up according to the paragraph 
11.6. Wrong determining of the Base causes 

mistakes in monitoring probe location and defects imaging.  
 
 
 
 

Important:  
 

•  There are two Scanning Areas located at the both sides of the weld 
 

•  The start point and length for both areas must be setup according to the paragraph 11.6 
 
  

 
 
Insert ultrasonic probe into the appropriate probe holder then fix the double emitter of airborne ultrasound on 
the top of the probe holder; use the rotary adapter for the double emitter of airborne ultrasound referring on 
the below sketches: 
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1 
Remember! 

 

 
 

Respect Angle ≥≥≥≥ 0o 
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Respect Angle = 0o 
 

 
 

 
 

 
13.1.2. Cabling 
 
Refer to the paragraph 7.1.2 of this Operating Manual 
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13.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

13.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

13.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

13.5. ISONIC Control Menu 
 

Follow the instructions of paragraph 7.5 of this Operating Manual  
 

13.6. Pre-Inspection 
 

Refer to the paragraphs 7.6 and 11.6 of this Operating Manual and to the figures below 
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Respect Angle 
 
Refer to the corresponding sketches in the paragraph 13.1.1 of this Operating Manual 
 
To select the required Respect Angle the following manipulations applicable: 
 
•  Mouse 

� Click on the corresponding spin    
 
•  Keyboard 
 
� Pressing <Alt>+<P> ⇒ Respect Angle fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard  (In the Respect Angle area letter p is underlined) 
 
•  Combined 
 
� Click on Respect Angle ⇒ Respect Angle fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  

buttons on the keyboard 
 

Probe Width Setup – Additional Referring of the Probe Location Monitor to the Weld Position 

Click on  or press <Alt>+<W> on the keyboard to open the Probe Width window 

 
Apply the probe equipped with probe holder and double emitter of airborne ultrasound to the object under test 
in the Scanning Area 1: 
 

� click on  or press <Alt>+<N> on the keyboard – this resets probe location 

monitor and enables  button 

� click on  or press <Alt>+<1> on the keyboard – this refers probe location 
monitor for scanning at parallel or at small angle to the weld in the Scanning Area 1 and enables 

 button 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 320 of 550  

 
Apply the probe equipped with probe holder and emitters of airborne ultrasound to the object under test – 
Scanning Area 2 then: 

� click on  or press <Alt>+<2> on the keyboard – this refers probe location 
monitor for scanning at parallel or at small angle to the weld in the Scanning Area 2 

 

To return back to ISONIC Setup window click on  or press <Alt>+<C> or press 

Esc  on the keyboard 
 
 
���� 
 
The described procedure also relates for welds with machined cup 
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Check Operation of the Probe Swiveling Monitor 
 

Click on  or press <Alt>+<S> on the keyboard to open the ISONIC Probe 
Swiveling Monitor window 

 
It's impossible to negate Probe Swiveling monitor while running the TRANSCAN software package as well as 
to change the fixed Limit for Probe Swiveling Angle of 5o for scanning the weld. The ISONIC Probe 
Swiveling Monitor Setup window allows just checking of the operation for this module 
 
To setup the Limit for Probe Swiveling Angle at the checking stage the following manipulations applicable: 
 
•  Mouse 
 

� Click on the corresponding spin    
 

•  Keyboard 
 
� Pressing <Alt>+<L> ⇒ Limit for Probe Swiveling Angle fore color changes to white - then use ↑↑↑↑  , 

→→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard  (In the Limit for Probe Swiveling Angle area letter L is 
underlined) 

 

•  Combined 
 

� Click on Limit for Probe Swiveling Angle ⇒ Limit for Probe Swiveling Angle fore color changes 
to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 

 

To return back to ISONIC Setup window click on  or press <Alt>+<C> or Esc  on 
the keyboard 
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13.7. Inspection 
 

Respect Angle = 0 (Scanning above the machined weld) 
 

 

Weld Area  

 
Heat Affected Zones Areas
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Respect Angle ≠≠≠≠ 0 (Scanning near the non machined weld) 
 

 
 
The above screenshots illustrate the ISONIC screen while scanning using TRANSCAN software. Refer to the 
paragraphs 7.7 of this Operating Manual to get instructed on control ISONIC while scanning.  
 
There is a possibility of changing the Scanning Direction with respect to the Zero Line. The defects images 
obtaining for both scanning directions are superimposed. To change the Scanning Direction click on 

 or press <Alt>+<D> on the keyboard 
 

13.8. Postprocessing 
 
Refer to paragraph 7.8 of this Operating Manual 

Weld Area  

Heat Affected Zones Areas 
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14. Operating 'LONGWELD' Software 
Package - ISONIC LongWeld Inspection 
(Inspection of the Longitudinal Welds in 

Pipes, Scanning from Both Sides) 
 
 
 
 

The contents of this chapter is valid for the  
LONGWELD SW Package version 5.1.0.9 or higher 
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14.1. Preparing for the Inspection 
 

14.1.1. Fixture 
 
Refer to the paragraph 11.1.1 of this Operating Manual and to the figures below 

Place the bar with the receivers of airborne 
ultrasound aside of the scanning area at rectangle 
to the weld. The center of the bar to be placed 
above the weld centerline. The distance between 
two receivers (Base) on the bar is defined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
Pos1 and Pos2 are the coordinates of the receivers 
taken form the left and right scales of bar 
correspondingly. The value of Base must be set up 
according to the paragraph 14.6. Wrong 
determining of the Base causes mistakes in 
monitoring probe location and defects imaging.  
 

 

Important:  
 

•  There are two Scanning Areas located at the both sides of the weld 
 

•  The start point and length for both areas must be setup according to the paragraph 14.6 
 
  

14.1.2. Cabling 
 
Refer to the paragraph 7.1.2 of this Operating Manual 
 

14.2. Start Up 
 

Double click on the icon  located on the ISONIC desktop 
 

14.3. Operating the software: general hints 
 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

14.4. Getting started... 
 
Refer to the paragraph 7.4 of this Operating Manual 
 

14.5. ISONIC Control Menu 
 
Follow the instructions of paragraph 7.5 of this Operating Manual  



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 326 of 550  

 

14.6. Pre-Inspection 
 

14.6.1. Step 1: Inspection Geometry 
The Step 1: Inspection Geometry protocol appears in the ISONIC Inspection Setup window upon getting 
into the pre-inspection stage  
 

 
 

For setting up the values of Skip#, Weld Length, Weld Thick, Weld Width, Pipe Diameter, and Scan 
Index refer to the paragraphs 7.6, 11.6, and 12.6 of this Operating Manual and to the note below 
 

 

���� 
Skip#, Weld Thick, and Pipe Diameter values are synchronized with the value of  Probe Angle. Sometimes 
if the selected Probe Angle is too high there is no complete insonification of the weld possible and the 
message as below appears: 
 

 
 

On ignoring the above message the partial half skip scanning only will be possible: 
 

  
 

 

Region of Interest 
 

Check / Uncheck the appropriate box if the heat affected zone to be inspected along with the weld volume: 
 

   
 

To return back to the ISONIC Pre-Inspection… window click on  press <Alt>+<C> or 

Esc  on the keyboard  
 

To proceed further click on  or press <Alt>+<T> on the keyboard - the Step 2 ISONIC 
Inspection Setup window appears upon 
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14.6.2. Step 2: Define Weld Location 
 

The Step 2: Defining Weld Location protocol appears in the ISONIC Inspection Setup window 
 

 
Coupling Monitor 
 
Refer to the paragraph 7.6.5 of this Operating Manual 
 
Airborne Ultrasound Velocity 
 
Refer to the paragraph 7.6.5 of this Operating Manual 
 
Probe Location Monitor 
 
Apply the bar with the receivers of airborne ultrasound (microphones) aside of the scanning area at rectangle 

to the weld placing the center of the bar above the weld centerline then click on  or press 
<Alt>+<N> on the keyboard.  
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Based on the data keyed in during implementing of Step 1: Inspection Geometry protocol the required 
positions L and R of the microphones on the bar are determined automatically and displayed.   
 

 

 
 
 
 
Place microphones into the required L and R 
positions in accordance with the left and right 
scales of bar correspondingly then click on 

 or press 
<Alt>+<F> on the keyboard upon placing the 
microphones appropriately 

 

 
 
 
 
 
Place probe above closest to the bar above 
border of the scanning area according to the 
sketch currently shown in the ISONIC Inspection 
Setup window then click on 

 or press 
<Alt>+<0> on the keyboard 

 

 
 
 
 
This will reset L-Coordinate to 0 defining Zero 
Line and enable the 

 button.  
 
Keeping probe in the same position click on 

 or press 
<Alt>+<1> on the keyboard 
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This will define weld edge in the yellow segment 
of the scanning area and enable the 

 button.  
Place probe at the opposite side of the weld 
according to the sketch currently shown in the 
ISONIC Inspection Setup window then click on 

 or press 
<Alt>+<2> on the keyboard 

 
This will end the probe location monitor calibration and activate validation of the received inputs 
If the received inputs are not valid then the following warnings are possible: 
 

 

 
 
The keying according to the above 
paragraph 14.6.1 to be double checked 
then probe location monitor procedure 
to be carefully repeated 

 

 
The center of the bar with airborne 
ultrasound receivers to be placed above 
the weld centerline then probe location 
monitor procedure to be carefully 
repeated  

 

 
 
 
The buttons 

 and 

 will be enabled upon 
validation of the received inputs will be received 

 

Probe Swiveling Monitor 
 

Refer to the paragraph 10.6 of this Operating Manual 
 
 
 

����  
� The described procedure also relates to the machined welds  
 

� If there is a need to interrupt the probe location monitor procedure without completing click on 

 or press <Alt> + <N> on the keyboard 
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To return back to Step 1: Inspection Geometry protocol click on  press <Alt>+<B> on the 
keyboard 

To return back to the ISONIC Pre-Inspection… window click on  press <Alt>+<C> or 

Esc  on the keyboard  
 
Flaw Imaging 

 
Refer to the paragraph 10.7 of this Operating Manual 
 

14.7. Inspection 
 

Refer to the paragraphs 7.7 and 11.7 of this Operating Manual 
 

14.8. Postprocessing 
 
Refer to the paragraph 7.8 of this Operating Manual  
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15. Operating 'CORROMAP' Software 
Package - ISONIC Corrosion Mapping 

 
 
 
 

The contents of this chapter is valid for the  
CORROMAP SW Package version 6.2.0.4 or higher 
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15.1. Preparing for the Inspection 
 

15.1.1. Fixture 
 
Apply the bar with the receivers of 
airborne ultrasound to the object 
under test at parallel to one of the 
scanning area sides. The distance 
between two receivers (Base) on the 
bar is defined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

Pos1 and Pos2 are the coordinates 
of the receivers taken form the left 
and right scales of bar 
correspondingly. The value of Base 

must be known prior to the scanning. Wrong determining of the Base causes mistakes in monitoring probe 
location and corrosion mapping  
 
 

����  
Region Length = Base 

 

 
Insert ultrasonic probe into the appropriate probe holder then fix the single emitter of airborne ultrasound on 
the top of the probe holder: 
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Remember! 
 

 
 

 
15.1.2. Cabling 
 

 
Ultrasonic Flaw Detector PC Card Applicable Cabling Scheme Paragraph 

UDS 3-3 A.4; A7 4.2.4 
UDS 3-4 A.5; A8 4.2.4 

USLT 2000 A.6; A9 4.2.4 
 
 

 

15.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

15.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

15.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
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15.5. ISONIC Control Menu 
 

Refer to the paragraph 7.5 of this Operating Manual and to the figures below    
 
 
 
The following parameters must be setup upon clicking on  
 
 
 
 
 
 
 

� Gain to ensure the receiving of the stable backwall echo and 
necessary sensitivity to the smallest thickness degradation 
areas to be detected 

� USVelocity to match with this property of the object under 
test 

� Probe Delay to match with this parameter of the probe 
� Gate A – aSwitch must be setup to ON 
� Gate A – aStart and aWidth parameters to correspond to 

the selected Region of Interest (refer to the below 
Paragraph 15.7.1 of this Operating Manual) 

 
� Display Delay and Range to ensure presence of the Gate A entire the A-Scan (refer to the below 

Paragraph 15.7.1 of this Operating Manual) 
� Gate A – aThreshold to observe the noise immunity and ensure the expected signals of interest will 

exceed that value 
 

 

����  
Setting the aSwitch to OFF or mismatch between aStart and aWidth on one hand and Display Delay 
and Range on the other hand (in other words nonappearance of the Gate A on the entire A-Scan) will 
cause the warning as below upon leaving ISONIC Pulser Receiver window 
 

 
 

It will not be possible to proceed with the scanning before returning to the ISONIC Pulser Receiver 
window and observing the necessary settings 
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15.6. Pre-Inspection 
 

Refer to the paragraph 7.6 of this Operating Manual and to the figures below  
 

The values of US Velocity  and Probe Delay keyed in the ISONIC Pulser Receiver window are valid for the 
scanning mode 
 

 
 
 

The Region of Interest (Region) to be designated prior to the scanning. The Region  shown in the ISONIC 
Setup window is characterized by two parameters Region Depth and Region Thick, which are defined 
through the Gate A settings in the ISONIC Pulser Receiver window (refer to the paragraph 15.5 and 
paragraph 15.7.1 of this Operating Manual)  

 

Region Length 
 

The Length of the Scanning Area is defined through the setting up the Base (distance between 
microphones on the bar – refer to the paragraph 15.1.1 of this Operating Manual) 

 

Region Width 
 

Region Width defines the Width of the Scanning Area (refer to the paragraph 15.1.1 of this Operating 
Manual). To setup the value of Region Width the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<W> ⇒ Region Width fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard  (In the Region Width area letter W is underlined) 

 

•  Combined 
 

� Click on Region Width ⇒ Region Width fore color changes to white - then use ↑↑↑↑  , →→→→ , 
←←←← , ↓↓↓↓  buttons on the keyboard 
 

The value for the Region Width is set in mm or in 
The possible values of increment / decrement for Region Width are: 

 

Resolution Metric Imperial 
Fine 1 mm 0.05 in 

Medium 5 mm 0.1 in 
Coarse 10 mm 0.5 in 
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Zero Line (Referring Probe Location Monitor) 

 

Click on  or press <Alt>+<L> on the keyboard to open the ISONIC 
Probe Location Monitor Setup window 

 

 
 

Apply the probe equipped with the probe holder and emitter of airborne ultrasound to the object under 
test as it is shown in the ISONIC Probe Location Monitor Setup window and click on the 

 or press <Alt>+<Z> on the keyboard. 
 

To return back to ISONIC Setup window click on  or press <Alt>+<C> or 

Esc  on the keyboard 
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15.7. Inspection 
15.7.1. Volume Under Test and Data Presentation 
 

The sketches and accompanying notes below explain the principles of the CORROMAP Data Presentation 
 

## Sketch Note 
 
1 

 

o Q1 (L1, X1, Y1) – Center of the Drill # 1's
o Q2 (L2, X2, Y2) – Center of the Drill # 2's
 

 
General 
 
(a) The Volume Under Test 

(Region of Interest) is 
located between the two 
parallel rectangles namely 
ABCD and EFGH 

(b) The scanning is provided 
above the surface of the 
rectangle A1 B1 C1 D1 

(c) The lines A1 B1 and AB are 
parallel to the line connecting 
the receivers of airborne 
ultrasound. The position of 
the lines A1 B1 and AB with 
respect to the said receivers 
is defined by setting up the 
Zero Line while calibrating 
the Probe Location Monitor 

(d) Refer to the ISONIC Setup 
window: 

 
 

 

e
Zero Lin
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 Bottom Surface 
 Bottom Surface 

o A1 A = Region Depth 
 

o AB = Region Length 
 
o AD = Region Width 
 
o DH = Region Thickness 
 
o A1 E = Normal Material 

Thickness 
 
(e) To give an example it is 

supposed that there are two 
drills in the object under test, 
said drills have different 
diameters, coordinates and 
depths of penetration into the 
Region of Interest and 
ended by the flat bottoms 
each 
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## Sketch Note 
2  

 

 

Testing Integrity 
 
The Scanning Pattern will be 
represented in the separate field if the 
coupling monitor was activated prior to 
the start of the inspection 

3  

Top View, Global Side and End 

Current 
Probe 
Position 

Actually 
Scanned 
Area 
(Coupling 
OK) 
 
Top View
Views 
 

Supposing that the scanning is 
performed completely the 
Top View generated by the 
CORROMAP software consists of 3 
areas; each area is painted with the 
color corresponding to the remaining 
material thickness. Partially the area 
above the drill # 1 will be painted with 
Y1-color; the area above drill # 2 will be 
painted with Y2-color; the remaining 
part of the Top View will be painted with 
the Material Thickness-color 
Side View

 

The Side View and End View are the 
orthogonal images composed through 
the superimposing of the 
corresponding cross sectional profiles 
along and across the whole Region of 
Interest, said superimposing is 
performed by overwriting of the high 
End View
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value of the remaining material 
thickness with the lower value providing 
the representation of the least 
remaining thickness values 
 

All acquired data is stored into a 3D-
matrix, so there is no any data loss – 
refer to the sketches ## 4-6 exampling 
the Sectional Side View and End 
View 
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## Sketch Note 
4  

 

 

Sectional Side View and End View 
 
Sketches ## 4 through 6 are the examples 
illustrating how the sectional Side View and 
End View are composed  
 
If the sectional viewing is selected by an 
operator then the section currently 
represented on the ISONIC screen will 
correspond to the current probe coordinate 
(X – for the sectional Side View; L – for the 
sectional Top View); replacement of the 
probe causes representation of the another 
sectional view 

Current 
Probe 
Position 
 
Top View
Side View
End View
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## Sketch Note 
5  

 

 

 Top View
Current 
Probe 
Position 
Side View
End View
notron NDT - 
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## Sketch Note 
6  

 

 

 Top View
Current 
Probe 
Position 
Side View
End View
notron NDT - 
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15.7.2. Scanning 
 
 
 

 

 
 

 
 
 
 
The above screenshot illustrates the ISONIC screen while scanning using the CORROMAP software. The 
target of the operator is to completely "paint" over the Scanning Pattern-Top View area providing the 
necessary testing integrity. The thickness map and the backwall profile are recorded and imaged 
automatically in real time  
 

 

Thickness Mapping Logic: The current lower value thickness reading (dominating) overwrites the already 
recorded higher value thickness reading if placing the probe above the same spot again. The higher value 
thickness reading does not overwrite the already recorded lower value thickness reading (dominating) if 
placing the probe above the same spot again 
 

Thickness Map "Repair" Logic: The Map Repair Function is active while keeping pressed the <Space> 
button on the keyboard – the new thickness readings unconditionally overwrite already recorded data. This 
allows the map corrections after finding the non-relevant dominating data recorded  
 

Thickness Map "Marks": Some eventually "unscanable" spots may exist on the scanning surface, for 
example the metal drops, deep surface corrosion, etc. or construction elements, such as rivets, bolts, etc. In 
order to mark the said spots one by one: place probe above each point to be marked and press 
<Shift>+<Space> on the keyboard. The corresponding marks appear over the Top View. To erase a mark 
use the Map Repair Function 
 

 

Current Probe position
Testing Integrity Thickness Map 

Global Side View 
The remaining material is shown 

in blue 
The Current Value of the 

Wall Thickness 
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It is possible to use the different styles of the back wall profile presentation while scanning: 
 

o Click on  or press <Alt>+<D> on the keyboard for the Side View back wall profile 
representing 

o Click on  or press <Alt>+<E> on the keyboard for the End View back wall profile 
representing 

o Click on  or press <Alt>+<I> on the keyboard for the sectional back wall profile 
representing for the currently active Side View or End View 

o Click on  or press <Alt>+<G> on the keyboard for the global back wall profile 
representing for the currently active Side View or End View 

 
There are another 4 controls available on the ISONIC screen while scanning: 
 

Click on  or press <Alt>+<S> on the keyboard to save a file containing inspection data. Proceed 
according to the paragraph 5.4.19 of this Operating Manual 
 

Click on  or press <Alt>+<Z> on the keyboard to zoom the ISONIC On-Line Imaging window 
 

Click on  or press <Alt>+<R> on the keyboard to reset to background in the ISONIC On-Line 
Imaging window 
 

Click on  or press <Alt>+<C> or Esc  on the keyboard to return back to the ISONIC Setup 
window 
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15.8. Postprocessing 
 

Refer to the paragraph 7.8 of this Operating Manual and to the figures below  

 
 

General 
 

o Both Global Side View and End View appear upon opening the CORROMAP results file  
o The thickness map appears with the palette (color scale), which was active entire the scanning 

o If the Coupling Monitor was active entire the scanning then the button  
becomes enabled upon opening the CORROMAP results file. To preview the separately recorded testing 

integrity plane click on the  or press <Alt>+<S> on the keyboard. To return 

click on  or press <Alt>+<S> on the keyboard 
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Image Processing 
 
Filtering 
 
Filtering ���� Start… 
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As a result: 
 

o two horizontal lines graphically representing 
the thickness threshold appear simultaneously 
above the Side View and End View 

 

o the mouse pointer is "sticked" to the horizontal 
line above the Side View 

 

o both horizontal lines may be moved up / down 
synchronously by the mouse or touch screen 
stylus or buttons ↑↑↑↑  ↓↓↓↓  on the keyboard 

 

o the thickness threshold (Yf) display is 
"sticked" to the horizontal line above the End 
View  

 

o the areas of the thickness map (Top View) 
related to the remaining thickness exceeding 
the thickness threshold are rejected 

 

o the areas of the Side View and End View 
under the thickness threshold line are 
lightened 

 

Release the touch screen stylus or left mouse 

click or press Enter  on the keyboard to fix the 
selected threshold and free the mouse pointer for 
the further procedures 
 
 
 
 
 
 
 
To interrupt the Filtering procedure right mouse 

click or press Esc  on the keyboard 
 
Filtering ���� No Filtering switches the active 
Filtering function off 

 

 
 

Thickness Threshold 
Line 
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Profiling 
 

Profiling ���� Profiling ON   
 

 
 

As a result: 
 

o two orthogonal lines appear above the Top View 
 

o the mouse pointer is "sticked" to the crossing point 
of the said lines 

 

o both lines may be moved up / down and left / right 
correspondingly by the mouse or touch screen 
stylus or buttons ↑↑↑↑  ↓↓↓↓  ���� ���� on the keyboard 

 

o the cross point coordinates display is "sticked" to 
the horizontal line 

 

o the horizontal line and its X-coordinate provide 
representing of the corresponding sectional Side 
View 

 

o the vertical line and its L-coordinate provide 
representing of the corresponding sectional End 
View 

 

Release the touch screen stylus or left mouse click or 

press Enter  on the keyboard to fix the obtained 
sectional Side View and End View and free mouse 
pointer for the further procedures 
 

To interrupt the Profiling procedure right mouse click 

or press Esc  on the keyboard 

Profiling ���� Profiling OFF switches the active Profiling function off 
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Polygons – Statistical Processing 
 

Measurements ���� Polygon  
 
 

 
 

 
 
 
Use the mouse or touch screen stylus or buttons ↑↑↑↑  ↓↓↓↓  ���� ���� 
on the keyboard to manipulate the cursor over thickness 
map. Release the touch screen stylus or left mouse click or 

press Enter  on the keyboard upon placing the cursor 
over the first apex of the desired polygon. This makes it 
possible to designate the first polygon’s rib through the 
appropriate manipulating of the cursor; said rib will connect 
the current cursor position and the first apex of the desired 
polygon. Place cursor over the next selected apex of the 
desired polygon and release the touch screen stylus or left 

mouse click or press Enter  on the keyboard. As the 
result the next polygon’s rib will be created  
 
To interrupt the Polygon procedure right mouse click or 

press Esc  on the keyboard 
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After designating the last tip of the desired polygon double 
left mouse click or double click with the touch screen stylus 

 

 

The statistics window appears then on the screen highlighting the selected polygon and representing the 
thickness distribution histogram over the polygon: 
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Placement of the cursor over a column causes the indication of its value and rank; said indication appears 
above the upper left corner of the histogram 
 
To print Postprocessing Page containing the image of the selected polygon and the corresponding histogram 

click on  
 

To close the statistical window click on  or press Esc  on the keyboard 
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16. Operating 'CORROMAP RD' Software 
Package - ISONIC Corrosion Mapping 

(Complete Raw Data Acquisition) 
 
 
 
 

The contents of this chapter is valid for the  
CORROMAP RD SW Package version 1.0.0.1 or higher 
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16.1. Preparing for the Inspection 
 

Refer to the Chapter 15.1 of this Operating Manual  
 

16.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

16.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

16.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

16.5. ISONIC Control Menu 
 

Refer to the paragraphs 7.5 and 15.5 of this Operating Manual 
 

16.6. Pre-Inspection 
 

Refer to the paragraphs 7.6 and 15.6 of this Operating Manual 
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16.7. Inspection 
 

 

Refer to the paragraph 15.7.2 of this Operating Manual.  
 
All kinds of data presentation, the imaging modes, the ISONIC control functions, and the typical screen during 
scanning using the CORROMAP RD Inspection SW Package are identical to the same while using the 
CORROMAP Inspection SW Package. The Thickness Mapping Logic, Thickness Map "Repair" Logic, 
and Thickness Map "Marks" Rule valid for the CORROMAP Inspection SW Package are also valid for the 
CORROMAP RD Inspection SW Package 
 
The only difference is that the unprocessed A-Scans are additionally captured while scanning using 
CORROMAP RD software. The A-Scan Capturing Logic for the CORROMAP RD is synchronized with the 
said Thickness Mapping Logic and Thickness Map "Repair" Logic: 
 

 

A-Scan Capturing Logic 
 

 

First placement of the probe above some spot on the scanning surface 
 

A-Scan is recorded unconditionally if placing the probe above some spot on the scanning surface 
at the first time  

 

Repeat scanning above the same spot – overwriting rules 
 

(a) Map Repair Function is not active 
 

Case 1. The valid echo for the thickness reading (echo matching with the gate and echo 
height exceeds the gate level) was received while pacing the probe above some spot on the 
scanning surface earlier  
 

•  If the valid echo was received again upon placing the probe above the same spot 
on the scanning surface next time and the new thickness reading is dominating (i.e. 
less then already recorded) then new A-Scan overwrites already recorded A-Scan 
otherwise there is no overwriting 

•  If the valid echo was not received upon placing the probe above the same spot on 
the scanning surface next time then there is no overwriting 

 

Case 2. The valid echo for the thickness reading was not received while pacing the probe 
above some spot on the scanning surface earlier   

•  If the valid echo was received upon placing the probe above the same spot on the 
scanning surface next time then new A-Scan overwrites already recorded A-Scan  

•  If the valid echo was not received upon placing the probe above the same spot on 
the scanning surface next time then there is no overwriting 

 

(b) Map Repair Function is active 
 

Each new A-Scan overwrites already recorded A-Scan unconditionally for each new 
placement of the probe above the same spot  
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16.8. Postprocessing 
 

The typical screen appearing upon opening the CORROMAP RD file is shown below. All postprocessing 
procedures related to the graphical data analysis are identical to the same functions applied to the 
CORROMAP file – refer to the paragraph 15.8 of this Operating Manual 
 

 
 
The off-line functions related to the A-Scan recovery, signal evaluation and thickness map transformations 
become available through the Image Processing Menu Bar where there are 2 additional topics with respect to 
the same bar related to the CORROMAP files postprocessing, said topics are Point and ROI (Region Of 
Interest)   
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Point by Point A-Scan Recovery and Evaluation 
 

 
 

 
 
 

 
 
 
 
 
 
Point ���� Add 
 
The cursor may be manipulated then 
over the Scanning Pattern - Top 
View area only using the touch screen 
stylus or mouse or buttons ↑↑↑↑  ↓↓↓↓  ���� ���� 
on the keyboard. The A-Scan 
corresponding to the entire cursor 
position is recovered and 
accompanied with the signal 
evaluation data such as  
 

� Depth, mm 
� Time of Flight ���� T, µµµµs 
� Echo to Gate Level ���� V, dB 
� Echo Height ���� H, % 
� Echo to DAC ���� ∆∆∆∆V, db (if 

applicable) 
 

To place a mark  above some point 
of interest left mouse click or release 

touch screen stylus or press Enter  
on the keyboard (N is the mark ##) 
 

Next selection Point ���� Add allows 
placing of the next, etc 
 

To interrupt the Point by Point A-
Scan Recovery and Evaluation 
procedure right mouse click or press 

Esc  on the keyboard 
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Left mouse click or touch screen stylus 
click on the existing mark will highlight 
it's coordinates and matching thickness 
value along with the corresponding A-
Scan and signal evaluation data 
 

Click on  to print the graphical data 
accompanied with the A-Scan and signal 
evaluation data for the selected mark  
 

Click on  to erase the selected 
mark 
 

Click on  to hide the mark's 
coordinates, the corresponding result, 
and the signal evaluation data 
 
 

Point ���� Clear Last erases the last 
mark on the Scanning Pattern – Top 
View 
 
 

Point ���� Clear All erases all marks from 
the Scanning Pattern – Top View 
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Redefine the Region of Interest 
 

 
 
 
 
 

 

 
Whilst effecting the Point by Point A-
Scan Recovery and Evaluation 
procedure it may be realized that 
some signals received and recorded 
were not matching with the Gate A 
while scanning. It's possible to 
Redefine the Region of Interest in 
order to rebuilt and reevaluate the 
thickness map and the whole 3D array 
off-line without secondary scanning. 
 

ROI ���� ON  
 

The cursor may be manipulated then 
over the Scanning Pattern - Top 
View area only using the touch screen 
stylus or mouse or buttons ↑↑↑↑  ↓↓↓↓  ���� ���� 
on the keyboard. The A-Scan 
corresponding to the entire cursor 
position is recovered and 
accompanied with the signal 
evaluation data such as  
 

� Depth, mm 
� Time of Flight ���� T, µµµµs 
� Echo to Gate Level ���� V, dB 
� Echo Height ���� H, % 
� Echo to DAC ���� ∆∆∆∆V, db (if 

applicable) 
 

To redefine the Region of Interest 
place cursor into the position 
corresponding to the A-Scan 
representing the received signal not 
matching with the Gate A and left 
mouse click or release touch screen 

stylus or press Enter  on the 
keyboard  
 

 
To interrupt the Redefine the Region 
of Interest procedure right mouse 

click or press Esc  on the keyboard 
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As a result the A-Scan representing the 
signal, for which the Gate A – Region of 
Interest settings to be changed becomes 
solid while the Gate A – Region of Interest 
manipulation buttons controllable through the 
left mouse click or touch screen stylus click 
appear: 
 

�  ,  - are the aStart - 
Region Depth controls 

 

�  ,  - are the aThreshold 
controls 

 

�  ,  - are the aWidth – 
Region Thick controls 

 

Clicking on  will negate the changes in 
the Gate A – Region of Interest settings 
and switch off the Redefine the Region of 
Interest procedure 
 

Clicking on  will accept the new Gate A 
– Region of Interest and redraw the 
Scanning pattern -Top View, Side View, 
and the End View accordingly 
 
All postprocessing procedures may be 
applied then to the new Scanning pattern -
Top View, Side View, and the End View 
data 
 
ROI ���� ON will return the Gate A – Region 
of Interest settings to the original values 
used entire the scanning procedure  
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Redefine the Region of Interest – Application Tip 
 

 
 

Sub-Region of Interest 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
It's possible to observe virtual zoom 
through narrowing the Gate A – 
Region of Interest settings entire the 
Redefine the Region of Interest 
procedure  
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Sub-Region of Interest 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The required segment of the Top View – 
Scanning Pattern becomes represented 
using more Color-Thickness grades, 
while the Side View and the End View 
become zoomed then 
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17. Operating 'CORROMAP CU' Software 
Package - ISONIC Corrosion Mapping – 

Scanning on Curved Surfaces 
 
 
 
 

The contents of this chapter is valid for the  
CORROMAP CU SW Package version 2.2.0.4 or higher 
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17.1. Preparing for the Inspection 
 

17.1.1. Fixture 
 

 

Apply the bar with the receivers of airborne 
ultrasound to the object under test at parallel to 
one of the curved sides of the scanning area. 
Use the fixture S 89000 ensuring the placement 
of the airborne ultrasound receivers on the small 
diameter objects, if it's found necessary – refer 
to the paragraph 9.1 of this Operating Manual. 
The value of Base (the distance between two 
receivers of airborne ultrasound) may be from 
100 to 300 mm or 4 to 12 in. The short bar is 
required if the value of Base is not exceeding 
200 mm or 8 in. If this is a case then the 
distance between the receivers is defined as: 
 

Base = 100 + Pos1 + Pos2, mm 
or 

Base = 4 + Pos1 + Pos2, in 
 

The long bar is required if the value of Base is more than 200 mm or 8 in. If this is a case then the distance 
between the receivers is defined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

In the above formulas Pos1 and Pos2 are the coordinates of the receivers taken form the left and right 
scales of the bar correspondingly 
 

The value of Base must be known prior to the scanning. Wrong determining of the Base causes the 
mistakes in monitoring probe location and corrosion mapping 
 
 
 
����  
 

•  The exact length of the inspected area  (Region Length) depends on Base and Curvature Diameter 
and it is calculated automatically while running the CORROMAP CU Inspection SW package (refer to the 
paragraphs 17.6 and 17.7 of this Operating Manual) 

 

•  It may occur that the reducing of the preliminary selected Base value will be required entire the software 
flow (refer to the paragraph 17.6 of this Operating Manual) 

 

 
 
Insert ultrasonic probe into the appropriate probe holder then fix the single emitter of airborne ultrasound on 
the top of the probe holder – refer to the paragraph 15.1 of this Operating Manual 
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17.1.2. Cabling 
 

Refer to the paragraph 15.1.2 of this Operating Manual 
 

 

17.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

17.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

17.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

17.5. ISONIC Control Menu 
 

Follow the instructions of paragraph 7.5 of this Operating Manual  
 

17.6. Pre-Inspection 
 

Refer to the paragraphs 7.6 and 15.6 of this Operating Manual and to the figures below  
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Curvature Diameter 
 

To setup the value of Curvature Diameter the following manipulations applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard shortcuts 
 

� Pressing <Alt>+<V> ⇒ Curvature Diameter fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard  (In the Curvature Diameter area letter v is underlined) 

 

•  Combined 
 

� Click on Curvature Diameter ⇒ Curvature Diameter fore color changes to white - then use ↑↑↑↑  , →→→→ , 
←←←← , ↓↓↓↓  buttons on the keyboard 

 
The value for the Curvature Diameter is set in mm or in 
The possible values of increment / decrement for Curvature Diameter are: 

 

Resolution Metric Imperial 
Fine 1 mm 0.05 in 

Medium 5 mm 0.25 in 
Coarse 10 mm 0.5 in 

 
 

���� 
 

•  The length of the inspected area  (Region Length) is defined by the CORROMAP CU Inspection SW 
package automatically with respect to the Base and Curvature Diameter values. Generally, the upper 
limit for Base is 300 mm, however it can be lower for some objects; hence the value of Base may be 
reduced automatically while keying in the Curvature Diameter. If this is a case then: 

 

� provide the distance between the receivers of airborne ultrasound equal to the value of Base 
recalculated and indicated by the CORROMAP CU software 

� re-refer probe location monitor as it is described in the paragraph 15.6 of this Operating Manual after 
each change of the distance between the receivers of airborne ultrasound 

 

•  The exact length of inspected area (Region Length) will be indicated in the ISONIC On-Line Imaging … 
window after starting inspection. It will be also stored in each file containing the inspection results and 
printed in the Inspection Report 

 

•  The settings of the Gate A (aStart and aWidth) define the minimal possible value for the Curvature 
Diameter: 

 
Minimal Curvature Diameter = 2××××(aStart + aWidth) = 2××××(RegionDepth + RegionThick) 
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17.7. Inspection 
 

 

 
 

 

The above screenshot illustrates the typical ISONIC screen while scanning using the CORROMAP CU 
software. The exact Region Length is shown between Top View and Side View images in the ISONIC On-
Line Imaging … window. The Scanning Pattern, Top View and Side View images are shown unfolded and 
the additional Side View - Real Shape window is generated simultaneously making it possible to monitor the 
thickness profile more precisely 
 

All kinds of the data presentation, the imaging modes, the ISONIC control functions, and the typical screen 
while scanning using the CORROMAP CU Inspection SW Package are identical to the same while using the 
CORROMAP Inspection SW Package - refer to the paragraph 15.7 of this Operating Manual 
 

17.8. Postprocessing 
 

All postprocessing procedures related to the graphical data analysis are identical to the same functions 
applied to the CORROMAP file – refer to the paragraph 15.8 of this Operating Manual. Real Shape is the 
only one additional item in the ISONIC Image Processing menu of the CORROMAP CU not existing in the 
same menu of the CORROMAP software. Click on the Real Shape topic recovers the true-to-scale curved 
Side View  
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18. Operating 'CORROMAP CU RD' 
Software Package - ISONIC Corrosion 

Mapping – Scanning on Curved Surfaces 
(Complete Raw Data Acquisition) 

 
 
 
 

The contents of this chapter is valid for the  
CORROMAP CU RD SW Package version 1.1.0.6 or higher 
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18.1. Preparing for the Inspection 
 

Refer to the paragraph 17.1 of this Operating Manual 
 

18.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

18.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

18.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

18.5. ISONIC Control Menu 
 

Follow the instructions of paragraph 7.5 of this Operating Manual  
 

18.6. Pre-Inspection 
 

Refer to the paragraphs 7.6, 15.6, and 17.6 of this Operating Manual  
 

18.7. Inspection 
 

Refer to the paragraphs 15.7, 16.7, and 17.7 of this Operating Manual 
 

18.8. Postprocessing 
 

Refer to the paragraphs 15.8, 16.8, and 17.8 of this Operating Manual 
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19. Operating 'MULTISCAN-COMBO-S' 
Software Package - ISONIC Multiscan-

Combo-S Inspection 
 
 
 
 

The contents of this chapter is valid for the  
MULTISCAN COMBO S SW Package version 3.3.0.0 or higher 
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19.1. Preparing for the Inspection 
 

Refer to the Chapter 15.1 of this Operating Manual  
 

19.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

19.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

19.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

19.5. ISONIC Control Menu 
 

Follow the instructions of paragraph 7.5 of this Operating Manual  
 

19.6. Pre-Inspection 
 

Refer to the paragraphs 7.6 and 15.6 of this Operating Manual and to the figures below  
 
Inspection Techniques 
 
There are 2 inspection techniques available while running the MUTISCAN COMBO S Inspection SW 
Package: 
 

•  The Pulse Echo Inspection and Mapping based on the analysis and mapping of the amplitudes 
and time delays of all signals matching with the gate designating the region of interest. The Pulse 
Echo Inspection and Mapping allows to capture the multi-layer amplitude C-Scans compressed 
into the single compact 3D array and recover the depth/thickness C-Scan from the captured 3D array 
in real time and/or off-line at the postprocessing stage 

 
•  The Attenuation Inspection based on the analysis and mapping of the amplitude of the signal 

located at the fixed time window determined by Gate A, said amplitude may be obtained through 
the getting of the backwall echo or through-transmitted signal. The Attenuation Inspection allows to 
capture the single-layer amplitude C-Scan representing the amplitude distribution for the single 
informative signal either backwall echo or through-transmitted captured over the scanning area. For 
the through transmission mode it’s necessary to fit the probes into the appropriate yoke - refer to the 
paragraph 34.3 of this Operating Manual 

 

 
 
To start with the Pulse Echo Inspection click on  
or press <Alt> + <O> on the keyboard 
 
 
 
 
To start with the Attenuation Inspection click on  
or press <Alt> + <A> on the keyboard 
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Pulse Echo Inspection and Mapping – Pre-Scanning window 
 

 
 

Color Scale (Palette) 
 

The MULTISCAN-COMBO-S's color scale (palette) may have up to 255 grades for the following palettes: 
 

•  Gray 
•  Thermo 
•  Pseudo-color 

 

Ultrasonic data captured while scanning the object is stored by the following way: both the amplitude and time 
of flight for each signal received from the gated Region of Interest (Region) and exceeding the gate level is 
stored in connection with the corresponding probe coordinates. The palette has two meanings 
simultaneously: 

 
 
 

The factory default quantity of the grades is 255 through the whole region of interest / dynamic range. The 
palette may be customized using the appropriate Palette Customizing Controls. It’s important that the 
volume and format of the data acquisition and storage are not affected if customizing the palette 

  Region of Interest (Gate) 

Echo Amplitude Dynamic Range 

Min Max 

End Start 

The Palette Customizing Controls 
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Attenuation Inspection and Mapping – Pre-Scanning window 
 

 

 
 
The coupling monitor is not optional for the Attenuation Inspection and Mapping 
 

The dynamic range is 40 dB for the Attenuation Inspection and Mapping 
 
 
High Resolution Scan Index   
 

The high resolution value of Scan Index may be setup to 0.25 or 0.5 mm / 0.01 or 0.02 in for both Pulse 
Echo and Attenuation inspections provided that the value of Base is less than 200 mm / 8 in 
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19.7. Inspection 
 

19.7.1. Volume Under Test and Data Presentation – Pulse Echo 
 
 

## Sketch Note 
 
1 

 

o Q1 (L1, X1, Y1) – Internal Reflector 1 
o Q2 (L2, X2, Y2) – Internal Reflector 2 
 

 
General 
 
(a) The Volume Under Test 

(Region of Interest) is 
located between the two 
parallel rectangles namely 
ABCD and EFGH 

(b) The scanning is provided 
above the surface of the 
rectangle A1 B1 C1 D1 

(c) The lines named A1 B1 
and AB are parallel to the 
line connecting the 
receivers of airborne 
ultrasound. The position 
of the lines A1 B1 and AB 
with respect to the said 
receivers is defined by 
setting up the Zero Line 
while calibrating the Probe 
Location Monitor 

(d) Refer to the ISONIC 
Setup window: 

 
 

o A1 A = Region Depth 
 

o AB = Region Length 
 

 

e
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o AD = Region Width 
 
o DH = Region Thickness 
 
(e) To give an example it is 

supposed that there are 
two reflectors Q1 and Q2 
in the object under test 
inside the Region of 
Interest, said reflectors 
have different dimensions 
and coordinates 
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## Sketch Note 
2  

 
 

 
 
The Scanning Pattern will be represented 
in the separate field if the coupling monitor 
was activated prior to the start of the 
inspection 

3  
 
 
 
 

 
Global Top View, Global Side and End 
Views 
 

Supposing that the scanning is well 
completed the reflectors Q1 and Q2 will be 
then detected and represented on the global 

Current 
Probe 
Position 

Actually 
Scanned 
Area 
(Coupling 
OK) 

 

 

Top View
 fr

Top View, Side View and End View 
according to the current sketch. 
 
The global Top View is obtained through the 
superimposing of the parallel planes the 
rectangles ABCD and EFGH. The global 
Top View may be presented in two modes: 
Depth (Time of Flight – TOF) Map and 
Amplitude Map. The Amplitude Map is 
composed through the overwriting of the low 
value of the echo amplitude with the higher 
value, providing the representation of the 
highest amplitude values. The Depth (TOF) 
Map is composed through the overwriting of 
the high reflector's depth value with the 

1 

1

2

2

Side View

lower reflector's depth value providing the 
representation of the reflectors closest to the 
scanning surface. Thanks to 3D-matrix 
storing of the acquired data it is possible to 
switch from one mode of the Top View 
presentation to another one while scanning 
 

 

 
2

End View
Q

Q

om Sonotro

The global Side View and End View are the 
orthogonal images obtained through the 
superimposing of the corresponding cross 
sectional views along and across the whole 
Region of Interest, said superimposing is 1

 

Q

Q

n N
Q

Q
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performed by overwriting of the low value of 
the echo amplitude with the higher value. 
This provides registering of the highest 
amplitude values 
 

All acquired data is stored into a 3D-matrix, 
so there is no any data loss – refer to the 
below sketches ## 4-6 exampling the 
sectional Top View, Side View and End 
View 
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## Sketch Note 
4 

 

 
Sketches ## 4 and 5 are the 
examples illustrating how the 
sectional Top View is 
composed  
 
If the sectional viewing is 
selected by an operator then 
the Top View section 
currently represented on the 
ISONIC screen will 
correspond to the current 
probe coordinates on the 
scanning surface: the 
horizontal plane, which 
corresponds to the reflector 
closest to the probe and will 
be represented as an 
Amplitude Map; replacement 
of the probe causes 
representation of the another 
Top View section 
 
Top View
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## Sketch Note 
5 
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## Sketch Note 
6 

 

Sketches ## 6 - 9 are the 
examples illustrating how the 
sectional Side View and End 
View are composed  
 
If the sectional viewing is 
selected by an operator then 
the section currently 
represented on the ISONIC 
screen will correspond to the 
current probe coordinate (X – 
for the sectional Side View; L 
– for the sectional Top View); 
replacement of the probe 
causes representation of the 
another sectional view 
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## Sketch Note 
7 
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## Sketch Note 
8 
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## Sketch Note 
9 
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19.7.2. Scanning – Pulse Echo 
 
 
 
 
 

 
 
 
 
 
The above screenshot illustrates the ISONIC screen while scanning using the MULTISCAN-COMBO-S 
software realizing the Pulse-Echo Inspection and Mapping. The target of the operator is to completely 
"paint" over the Scanning Pattern-Top View area providing the necessary testing integrity. The data is 
recorded automatically and the corresponding viewing is observed in real time  

Testing Integrity Current Probe position
Global Top View – 
Depth (TOF) Map 

Depth of the currently detected 
reflector and the amplitude of its echo

Global Side View – colors 
corresponds to the echo amplitudes 
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Depth (TOF) Mapping Logic applied to the Global Depth (TOF) Top View Mode: The current lower value 
depth reading (dominating) overwrites the already recorded higher value depth reading if placing the probe 
above the same spot again. The higher value depth reading does not overwrite the already recorded lower 
value depth reading (dominating) if placing the probe above the same spot again 
 

Amplitude Mapping Logic applied to the Global and Sectional Amplitude Top View Mode: The current 
higher amplitude reading (dominating) overwrites the already recorded lower amplitude reading if placing the 
probe above the same spot again. The lower amplitude reading does not overwrite the already recorded 
higher amplitude reading (dominating) if placing the probe above the same spot again 
 

Top View "Repair" Logic: The Map Repair Function is active while scanning and keeping pressed the 
<Space> button on the keyboard – the new depth and amplitude readings unconditionally overwrite already 
recorded data. This allows the map corrections after finding the non-relevant dominating data recorded 
 

Depth (TOF) Top View Map "Marks": Some eventually "unscanable" spots may exist on the scanning 
surface, for example the metal drops, deep surface corrosion, etc. or construction elements, such as rivets, 
bolts, etc. In order to mark the said spots one by one: place probe above each point to be marked and press 
<Shift>+<Space> on the keyboard. The corresponding marks appear over the Top View. To erase a mark 
use the Map Repair Function 
 

 
It is possible to use the different styles of the data presentation while scanning: 

o Click on  or press <Alt>+<A> on the keyboard for the Amplitude Map Global Top 
View representing 

o Click on  or press <Alt>+<N> on the keyboard for the Depth (TOF) Map Global top 
View representing 

o Click on  or press <Alt>+<T> on the keyboard for the Amplitude Map Sectional 
Top View representing 

o Click on  or press <Alt>+<D> on the keyboard for the Side View representing 

o Click on  or press <Alt>+<E> on the keyboard for the End View representing 

o Click on  or press <Alt>+<I> on the keyboard for the sectional representing of the 
currently active Side View or End View 

o Click on  or press <Alt>+<G> on the keyboard for the global representing of the currently 
active Side View or End View 

 

There are another 4 controls available on the ISONIC screen while scanning: 
 

Click on  or press <Alt>+<S> on the keyboard to save a file containing inspection data. Proceed 
according to the paragraph 5.4.19 of this Operating Manual 
 

Click on  or press <Alt>+<Z> on the keyboard to zoom the ISONIC On-Line Imaging window 
 

Click on  or press <Alt>+<R> on the keyboard to reset to background in the ISONIC On-Line 
Imaging window 
 

Click on  or press <Alt>+<C> or press Esc  on the keyboard to return back to the ISONIC Setup 
window 
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19.7.3. Scanning – Attenuation 
 

 
 

 
 
 

The above screenshot illustrates the ISONIC screen while scanning using the MULTISCAN-COMBO-S 
software realizing the Attenuation Inspection and Mapping. The target of the operator is to completely 
"paint" over the Top View - Amplitude area providing the necessary testing integrity. The data is recording 
automatically and the corresponding viewing is observed in real time 
 
 

Amplitude Mapping Logic applied to the Top View - Amplitude Map: There are 2 (two) Top View –
Amplitude maps simultaneously recorded while realizing the Attenuation Inspection and Mapping: 
 

� Over Min Map is created based on the following logic � the current lower amplitude reading 
(dominating) overwrites the already recorded higher amplitude reading if placing the probe above the 
same spot again. The higher amplitude reading does not overwrite the already recorded lower 
amplitude reading (dominating) if placing the probe above the same spot again 

 

� Over Max Map is created based on the following logic � the current higher amplitude reading 
(dominating) overwrites the already recorded lower amplitude reading if placing the probe above the 
same spot again. The lower amplitude reading does not overwrite the already recorded higher 
amplitude reading (dominating) if placing the probe above the same spot again 

 

Top View - Amplitude Map "Repair" Logic: The Map Repair Function is active while scanning and keeping 
pressed the <Space> button on the keyboard – the new depth and amplitude readings unconditionally 
overwrite already recorded data. This allows the map corrections after finding the non-relevant dominating
data recorded 
 

Top View - Amplitude Map "Marks": Some eventually "unscanable" spots may exist on the scanning 
surface, for example the metal drops, deep surface corrosion, etc. or construction elements, such as rivets, 
bolts, etc. In order to mark the said spots one by one: place probe above each point to be marked and press 
<Shift>+<Space> on the keyboard. The corresponding mark appears over the Top View. To erase a mark
use the Map Repair Function 
 

It's possible to switch between the maps while scanning by clicking on the  and 

 buttons or pressing <Alt>+<I> and <Alt>+<A> on the keyboard 

Current Probe position Top View –  
the Amplitude Map 
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Click on  or press <Alt>+<S> on the keyboard to save a file containing inspection data. Proceed 
according to the paragraph 5.4.19 of this Operating Manual 

Click on  or press <Alt>+<Z> on the keyboard to zoom the ISONIC On-Line Imaging window 

Click on  or press <Alt>+<R> on the keyboard to reset to background in the ISONIC On-Line 
Imaging window 

Click on  or press <Alt>+<C> or press Esc  on the keyboard to return back to the ISONIC Setup 
window 
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19.8. Postprocessing 
 
Refer to the paragraphs 7.8 and 15.8 of this Operating Manual and to the figures below 
 
Data Point Preview 
 
This mode becomes active immediately upon loading the file: place mouse pointer above the point of interest  

and read the result  
 

 
 

Image Processing – Pulse Echo Inspection 
 

 
 
Top View: Switch Between the Amplitude and Depth (TOF) Map 
 

The switching is implemented through the Top View Mode topic: 
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Top View: LX - Profiling 
 

 

Profiling ���� LX-Profiling 
 

As a result: 
 

o two orthogonal lines appear above the Top View
 

o the mouse pointer is "sticked" to the crossing 
point of the said lines 

 

o both lines may be moved up / down and left / 
right correspondingly by the mouse or touch 
screen stylus or buttons ↑↑↑↑  ↓↓↓↓  ���� ���� on the 
keyboard 

 

o the cross point coordinates display is "sticked" to 
the horizontal line 

 

o the horizontal line and its X-coordinate provide 
representing of the corresponding sectional Side 
View 

 

o the vertical line and its L-coordinate provide 
representing of the corresponding sectional End 
View 

 

 
 

Release the touch screen stylus or left mouse click or press Enter  on the keyboard to fix the obtained 
sectional Side View and End View and free mouse pointer for the further procedures 
 

To interrupt the LX-Profiling procedure right mouse click or press Esc  on the keyboard



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 386 of 550  

Top View: Y – Profiling (Slicing Top View) 
 

Profiling ���� Y-Profiling 
 

As a result: 
 

o Top View mode is switched into the Amplitude 
Map mode 

 

o two horizontal slicing lines reflecting the depth of 
the slice plane appear above the Side and End 
Views 

 

o the mouse pointer is "sticked" to the horizontal 
line above the Side View 

 

o both horizontal lines may be moved up / down 
synchronously by the mouse or touch screen 
stylus or buttons ↑↑↑↑  ↓↓↓↓  on the keyboard 

 

o the depth of the slice plane display is "sticked" 
to the horizontal line above the End View 

 

o the reflectors matching with the slice plane are 
only visible in the sectional Top View 

 

 

 

 
 
 
 

Release the touch screen stylus or left mouse click or press Enter  on the keyboard to fix the selected 
threshold and free the mouse pointer for the further procedures 

To interrupt the Y-Profiling (Top View Slicing) procedure right mouse click or press Esc  on the keyboard 
 
Profiling ���� Profiling OFF switches the active profiling function off

Slice Plane 

Slicing Lines 
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Filtering – Echo Amplitude 
 
 

Filtering ���� Amplitude ���� Filtering On 
 

As a result: 
 

o the amplitude color scale (palette) appears 
along with the horizontal amplitude 
threshold line above it 

 

o the amplitude threshold (filtration level) 
value is displayed simultaneously 

 

o the mouse pointer is "sticked" to the 
amplitude threshold line, which may be 
moved up / down by the mouse or touch 
screen stylus or buttons ↑↑↑↑  ↓↓↓↓  on the keyboard 

 

o all reflectors produced the echo amplitudes 
below the amplitude threshold (filtration 
level) are erased from the images 

 

 
Release the touch screen stylus or left mouse 

click or press Enter  on the keyboard to fix the 
selected amplitude threshold (filtration level) 
and free the mouse pointer for the further 
procedures 

 
To interrupt the Filtering – Echo Amplitude 

procedure right mouse click or press Esc  on 
the keyboard 
 
Filtering ���� Amplitude ���� No Filtering switches 
the active Filtering – Echo Amplitude function 
off 
 
���� 
If the Top View mode is TOF (Depth) then the 
effect of the Filtering – Echo Amplitude 
procedure is be visible on the Side and End 
Views only  

 

 

 

Amplitude 
Threshold 

(Filtration Level) 
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Filtering – Distance (Depth) 
 
 

Filtering ���� Distance ���� Filtering On 
 

As a result: 
 

o Top View mode is switched to TOF (Depth)  
 

o the horizontal distance (depth) threshold 
rectangle occupies the lower part of the End 
View and Side View 

 

o the distance (depth) threshold value is 
displayed simultaneously 

 

o the mouse pointer is "sticked" to the upper 
border of the distance (depth) threshold 
rectangle, which may be moved up / down by 
the mouse or touch screen stylus or buttons ↑↑↑↑  ↓↓↓↓  
on the keyboard 

 

o all reflectors covered by the distance (depth) 
threshold rectangle in the End and Side Views 
are erased from the Top View 

 
 

Depth Threshold Display

 
 
Release the touch screen stylus or left mouse click or 

press Enter  on the keyboard to fix the selected 
depth threshold (distance filtration level) and free 
the mouse pointer for the further procedures 

 
To interrupt the Filtering – Distance (Depth) 

procedure right mouse click or press Esc  on the 
keyboard 
 
Filtering ���� Distance ���� No Filtering switches the 
active Filtering – Distance (Depth) function off 

 

 

 

 

Distance 
(Depth) 

Threshold
Rectangle
 of 550 
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Mark Points of Interest 
 

 
Measurements ���� Point TOF & Echo Amplitude ���� Add 
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As a result: 
o mouse pointer manipulation area becomes limited inside the Top View rectangle 
o mouse pointer may be moved by touch screen stylus or mouse or buttons ↑↑↑↑  ↓↓↓↓  ���� ���� on the keyboard 
o to mark a Point of Interest place mouse pointer above it using either , then click on the touch screen 

or on the left mouse button or press Enter  on the keyboard. This causes marking of the point as 

Pi and displays of the corresponding echo amplitude and depth (TOF) 
 

 

 
 
 

o up to 10 (ten) marks may be placed on the Top View. After marking the last (tenth) point the Mark 
Points of Interest procedure terminates automatically. To interrupt Mark Points of Interest 

procedure unconditionally right mouse click or press Esc  on the keyboard 
o the printout of the postprocessing page contains the list of Points of Interest if marked 

 
 

Measurements ���� Point TOF & Echo Amplitude ���� Remove Last Point – removes the last mark placed 
over the Top View 
 

Measurements ���� Point TOF & Echo Amplitude ���� Remove Last Point – removes all marks placed over 
the Top View 
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Polygons – Statistical Processing 
 

The Polygon selection procedure is identical to the described above in the paragraph 15.8 of this Operating 
Manual. As an example the statistical window containing the image of the selected polygon on the Amplitude 
Top View and the amplitude distribution is shown below 
 
 

 
 
Placement of the cursor over a column causes the indication of its value and rank; said indication appears 
above the upper left corner of the histogram 
 
To print Postprocessing Page containing the image of the selected polygon and the corresponding histogram 

click on  
 

To close the statistical window click on  or press Esc  on the keyboard 
 
Image Processing – Attenuation Inspection 
 

 
 
Top View: Switch Between the Over Max and Over Min Maps 
 

The switching is implemented through the Domination Rule topic: 
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20. Operating 'MULTISCAN-COMBO-S RD' 
Software Package - ISONIC Multiscan-

Combo-S RD Inspection (Complete Raw 
Data Acquisition) 

 
 
 
 

The contents of this chapter is valid for the  
MULTISCAN COMBO S RD SW Package version 1.0.0.3 or higher 
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20.1. Preparing for the Inspection 
 

Refer to the Chapter 15.1 and 19.1 of this Operating Manual  
 

20.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

20.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

20.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

20.5. ISONIC Control Menu 
 

Follow the instructions of paragraph 7.5 of this Operating Manual  
 

20.6. Pre-Inspection 
 

Refer to the paragraphs 7.6, 15.6, and 19.6 of this Operating Manual  
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20.7. Inspection 
 
 

Refer to the paragraph 15.7, 16.7, and 19.7 of this Operating Manual and to the statements below  
 

All kinds of data presentation, the imaging modes, the ISONIC control functions, and the typical screen during 
scanning using the MULTISCAN-COMBO-S RD Inspection SW Package are identical to the same while 
using the MULTISCAN-COMBO-S Inspection SW Package.  
 
The Depth (TOF) Mapping Logic applied to the Global Depth (TOF) Top View Mode, Amplitude 
Mapping Logic applied to the Global and Sectional Amplitude Top View Mode, Top View "Repair" 
Logic, and Depth (TOF) Top View Map "Marks" Logic valid for the MULTISCAN-COMBO-S Inspection 
SW Package are also valid for the MULTISCAN-COMBO-S RD Inspection SW Package 
 
The only difference is that the unprocessed A-Scans are additionally captured while scanning using 
MULTISCAN-COMBO-S RD software. The A-Scan Capturing Logic for the MULTISCAN-COMBO-S RD is 
synchronized with the said Depth (TOF) Mapping Logic applied to the Global Depth (TOF) Top View 
Mode, Amplitude Mapping Logic applied to the Global and Sectional Amplitude Top View Mode, Top 
View "Repair" Logic: 
 

 

A-Scan Capturing Logic 
 

 

First placement of the probe above some spot on the scanning surface 
 

A-Scan is recorded unconditionally if placing the probe above some spot on the scanning surface 
at the first time  

 

Repeat scanning above the same spot – overwriting rules 
 

(a) Map Repair Function is not active 
 

Case 1. The valid echo (echo matching with the gate and echo height exceeds the gate 
level) was received while pacing the probe above some spot on the scanning surface earlier  
 

•  If the valid signal was received again upon placing the probe above the same spot 
on the scanning surface next time and the new Depth (TOF) or Amplitude reading is 
dominating then new A-Scan overwrites already recorded A-Scan otherwise there is 
no overwriting 

•  If the valid echo was not received upon placing the probe above the same spot on 
the scanning surface next time then there is no overwriting 

 

Case 2. The valid echo for the thickness reading was not received while pacing the probe 
above some spot on the scanning surface earlier   

•  If the valid echo was received upon placing the probe above the same spot on the 
scanning surface next time then new A-Scan overwrites already recorded A-Scan  

•  If the valid echo was not received upon placing the probe above the same spot on 
the scanning surface next time then there is no overwriting 

 

(b) Map Repair Function is active 
 

Each new A-Scan overwrites already recorded A-Scan unconditionally for each new 
placement of the probe above the same spot  

 

 
20.8. Postprocessing 
 
Refer to the paragraphs 7.8, 15.8, 16.8, and 19.8 of this Operating Manual 
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21. Operating 'MULTISCAN-COMBO-S CU' 
Software Package - ISONIC Multiscan-

Combo-S CU Inspection – Scanning on 
Curved Surfaces 

 
 
 
 

The contents of this chapter is valid for the  
MULTISCAN COMBO S CU SW Package version 3.3.0.0 or higher 
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21.1. Preparing for the Inspection 
 

Refer to the Chapter 16.1 of this Operating Manual  
 

21.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

21.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

21.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

21.5. ISONIC Control Menu 
 

Follow the instructions of paragraph 7.5 of this Operating Manual  
 

21.6. Pre-Inspection 
 

Follow the instructions of paragraphs 15.6, 17.6 and 19.6 of this Operating Manual 
 

21.7. Inspection 
 

Follow the instructions of paragraph 15.7, 17.7 and 19.7 of this Operating Manual 
 

21.8. Postprocessing 
 

Follow the instructions of paragraph 15.8, 17.8 and 19.8 of this Operating Manual 
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22. Operating 'MULTISCAN-COMBO-S CU 
RD' Software Package - ISONIC 

Multiscan-Combo-S CU R Inspection – 
Scanning on Curved Surfaces (Complete 

Raw Data Acquisition) 
 
 
 
 

The contents of this chapter is valid for the  
MULTISCAN COMBO S CU RD SW Package version 1.0.0.1 or higher 
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22.1. Preparing for the Inspection 
 

Refer to the Chapter 16.1 of this Operating Manual  
 

22.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

22.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

22.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
 

22.5. ISONIC Control Menu 
 

Follow the instructions of paragraph 7.5 of this Operating Manual  
 

22.6. Pre-Inspection 
 

Follow the instructions of paragraphs 15.6, 17.6 and 19.6 of this Operating Manual 
 

22.7. Inspection 
 

Follow the instructions of paragraph 15.7, 16.7, 17.7, 19.7, and 20.7 of this Operating Manual 
 

22.8. Postprocessing 
 

Follow the instructions of paragraph 15.8, 16.8, 17.8, 19.8, and 20.8 of this Operating Manual 
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23. Operating 'MULTISCAN-COMBO-SX' 
Software Package - ISONIC Multiscan-

Combo-SX 
 
 
 
 

The contents of this chapter is valid for the  
MULTISCAN COMBO SX SW Package version 1.1.0.0 or higher 
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23.1. Preparing for the Inspection 
 

ISONIC MULTISCAN COMBO SX Inspection SW Package allows to perform pulse echo and attenuation 
inspection and mapping while scanning above the large planar or quasi-planar surfaces up to 2000×3000 mm 
using the straight beam single element or dual probes 
 

23.1.1. Hardware 
 

In order to implement the large area scanning using the MULTISCAN COMBO SX Inspection SW Package 
the ISONIC 2001 unit (all modifications) must be equipped either with the Rear Panel Commutation Box 
(order code SH 98C0202 or SH 98C0202M) or with the Rear Panel Commutation Adapter (order code SH 
98C0203). The PC based ISONIC unit (all modifications) must be equipped with the Rear Panel 
Commutation Adapter (order code SH 98C0203) 
 

It’s also necessary to use the set of the additional fixtures and accessories required for the scanning of up to 
2X3 m area in one shot  (order code S 280766 LASC – vacuum attachments to the object under test or S 
280766 LASCM – magnetic attachments to the object under test): 
 
 

 

# 
 

Description 
 

Part # 

1 Long umbilical cable system 3X2X1 S 280766-001 
2 Left (IN X) receiver of airborne ultrasound – X-Receiver S 280766-005 
3 Central (IN Y) receiver of airborne ultrasound – Y-Receiver S 280766-006 
4 Right (IN Z) receiver of airborne ultrasound – Z-Receiver S 280766-007 
5 Power emitter of airborne ultrasound  S 280766-018 
6 Airborne ultrasound velocity calibration fixture S 280766-024 

 

 

 

 
It’s also necessary to use SE 20203 LASC card inside the ISONIC 2001 unit instead of the regular SE 20203 
card. SE 20203 LASC card is suitable for all other ISONIC Inspection SW Packages 
 
For the through transmission mode it’s necessary to fit the probes into the appropriate yoke - refer to the 
paragraph 34.3 of this Operating Manual 
 
23.1.2. Software 
 

The MULTISCAN COMBO SX Inspection SW may run only in the units with already installed MULTISCAN 
COMBO S Inspection SW Package 
 

4
3

2

1
5

2

6
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23.1.3. Cabling and Fixture 
 

 

 
 

 

 

 

Place the receivers of airborne ultrasound onto or close to 
the object under test by such a way that all of them will be 
situated on the same straight line. The minimal distance 
between the X-Receiver and Z-Receiver allowed is 500 
mm (or 20 in); the maximal distance between the X-
Receiver and Z-Receiver allowed is 3000 mm (or 120 in). 
The Y-Receiver to be placed between the X-Receiver and 
Z-Receiver approximately in the middle so that: 
 

B1,2 = 0.45…0.55·(B1 + B2) 
 

The cables outgoing from each receiver of airborne 
ultrasound to be connected to the correspondingly colored 
sockets of the triple connector of the long umbilical cable 
system 3X2X1 S 280766-001 
 

The probe to be fitted into the probe holder; the power 
emitter of airborne ultrasound to be fitted on the top of the 
probe holder 
 

The cable outgoing from the power emitter of airborne 
ultrasound to be connected to the correspondingly colored 
socket of the dual connector of the long umbilical cable 
system 3X2X1 S 280766-001 
 

For the single element probes: 
•  the probe socket to be connected to the green 

colored socket of the dual connector of the long 
umbilical cable system 3X2X1 S 280766-001 

•  the yellow colored single connector of the of the 
long umbilical cable system 3X2X1 S 280766-001 
to remain free 

 

For the dual element probes: 
•  the socket of the emitting crystal of the probe to be 

connected to the green colored socket of the dual 
connector of the long umbilical cable  3X2X1 S 
280766-001 

•  the socket of the receiving crystal of the probe to 
be connected to the yellow colored single 
connector of the of the long umbilical cable 
system 3X2X1 S 280766-001  

 

For the through-transmission technique: 
•  the emitting probe to be connected to the green 

colored socket of the dual connector of the long 
umbilical cable system 3X2X1 S 280766-001 

•  the receiving probe be connected to the yellow 
colored single connector of the of the long 
umbilical cable system 3X2X1 S 280766-001 

At the instrument side it’s necessary to ensure that the Out Ang socket of the ISONIC unit is free, while the 
yellow colored jumper is plugged into the Rec socket of the Pulser Receiver (refer to the Fig 4.1c – Chapter 4 
of this Operating Manual) and then to plug-in the long umbilical cable system 3X2X1 S 280766-001 
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23.2. Start Up 
Double click on the icon  located on the ISONIC desktop 
 

23.3. Operating the software: general hints 
 

Refer to the paragraph 7.3 of this Operating Manual 
 

23.4. Getting started... 
 

Refer to the paragraph 7.4 of this Operating Manual 
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23.5. ISONIC Control Menu 
 

 
23.5.1. Start New Inspection Procedure 
 

Click on the  or pressing <Alt>+<I> 
on the keyboard will cause the appearing of the ISONIC Pre-
Inspection Data window leading to the New Scanning 
Procedure through the necessary sequence of the preparations 
 
23.5.2. Continue the Paused Scanning  
 

Scanning of the large areas is the time consuming procedure so 
it’s often necessary to pause the scanning procedure with further 
continuation after some breakout time. For this purpose the 
MULTISCAN COMBO SX Inspection SW Package is featured 
with the special procedure of the scanning interrupt (refer to the 
below paragraph 23.7.4 of this Operating Manual). If the 
scanning was paused through the said procedure then the 

 button becomes enabled in the 
ISONIC Control Menu. Click on this button or pressing 
<Alt>+<N> on the keyboard will lead directly to the continuation 
of the paused scanning with the embedding the new data into the 
earlier stored file related to the incomplete scanning 
 

23.5.3. Start Postprocessing 
 

Click on the  button or pressing 
<Alt>+<P> on the keyboard to start the posprocessing 
 

Clicking on  this button or pressing <Alt>+<C> or 

Esc  on the keyboard will close the ISONIC 
Control Menu and return to the welcome 
window 
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23.6. Pre-Inspection 
 

Refer to the paragraphs 7.6, 14.6 and 16.6 of this Operating Manual and the specific notes below to provide 
the required settings 
 
23.6.1. Probe Data 
 
 
 
 
 
 
 
 
 
 

Click on  
or press <Alt>+<P> on the keyboard –  
the corresponding window appears: 
 

 
 
The probe name to be keyed in or confirmed in the 
corresponding field, while the value of the probe 
delay is just imported from the ISONIC Pulser 
Receiver window (submenu MEASURE). Click on 

 or press <Alt>+<A> 
on the keyboard to confirm the probe name, then 

click on  or press 

<Alt>+<C> or Esc  on the keyboard to return to the 
ISONIC Pre-Inspection Data window 
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23.6.2. Inspection Techniques 
 
There are 2 inspection techniques available while running the MUTISCAN COMBO SX Inspection SW 
Package: 
 

•  The Pulse Echo Inspection and Mapping based on the analysis and mapping of the amplitudes 
and time delays of all signals matching with the gate designating the region of interest. The Pulse 
Echo Inspection and Mapping allows to capture the multi-layer amplitude C-Scans compressed 
into the single compact 3D array and recover the depth/thickness C-Scan from the captured 3D array 
in real time and/or at the postprocessing stage 

•  The Attenuation Inspection based on the analysis and mapping of the amplitude of the signal 
located at the Fixed Time Window determined by Gate A, said amplitude may be obtained through 
the getting of the backwall echo or through-transmitted signal. The Attenuation Inspection allows to 
capture the single-layer amplitude C-Scan representing the distribution of the amplitude of the single 
informative signal either backwall echo or through-transmitted over the scanning area 

 

 
To perform the Pulse Echo inspection click on  
or press <Alt>+<O> on the keyboard 
 
To perform the Attenuation inspection click on  
or press <Alt>+<A> on the keyboard 
 

 

���� 
 

o The implementation of the Pulse Echo 
Inspection and Mapping is possible only 
after getting the Gate A, Probe Delay, US 
Velocity, Display Delay and Range properly 
setup in the Pulser Receiver window - refer to 
the below table defining the Region of 
Interest Area. It’s also necessary to setup 
Probe Angle = 0o in the submenu MEASURE 
of the ISONIC Pulser Receiver window 

 

o The implementation of the Attenuation 
Inspection and Mapping is possible only 
after getting the Gate A, Probe Delay, US 
Velocity, Display Delay and Range properly 
setup in the Pulser Receiver window - refer to 
the below table defining the Fixed Time 
Window. It’s also necessary to setup Probe 
Angle = 0o in the submenu MEASURE of the 
ISONIC Pulser Receiver window 
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MULTISCAN COMBO SX: Defining of the Region of Interest (ROI) / Fixed Time Window (FTW): ROI = FTW 
 

 

 

 

 
 
 
Case 1 

 

 
 

aStartSRD =  
 

aWidthRW =  

 
 
 
 
Case 2 

 

 

USVelocityayDisplayDelSRD ×=
2

 

 
SRDaWidthaStartRW −+=  

 
 
 
 
Case 3 

 

 
aStartSRD =  

 

aStartRange

USVelocityayDisplayDelRW

−+

+×=
2  

 
 
 
 
Case 4 

 

 
 

USVelocityayDisplayDelSRD ×=
2

 

 
RangeRW =  
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Pulse Echo Inspection and Mapping – Pre-Scanning window (ISONIC Setup) 
 

 
 

Attenuation Inspection and Mapping – Pre-Scanning window (ISONIC Setup) 

 
 

The coupling monitor is not optional for both Pulse Echo and Attenuation inspection and mapping modes of 
the MULTISCAN COMBO SX  
 

The dynamic range is 24 dB for the Pulse Echo and 40 dB for the Attenuation inspection and mapping 
mode 

The  button causing the beginning of the New Scanning Session becomes 
enabled only after the proper completing of the Probe Location Monitor Setup 
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23.6.3. Airborne Ultrasound Velocity Setup 
 
 

In the ISONIC Setup window 
click on the 

 
or press <Alt>+<A> on the 
keyboard 
 
Place the probe equipped 
with the probe holder and 
emitter of the airborne 
ultrasound on the object 
under test as it is shown on 
the first sketch appeared just 
after opening of the ISONIC 
Airborne Ultrasound 
Velocity Setup window at 
the Short Base distance of 
200 mm (8 in) from the X-
Receiver; the said distance 
measured by the ISONIC is 
indicated in the Current 
Result box and its value may 
differ from the actual 
distance if the Current 
Airborne US Velocity and 
Current Airborne Zero 
Offset are not properly 
calibrated. Click on the 

 or 
press <Alt>+<S> on the 
keyboard upon the distance 
reading at the meter 
becomes equal to the 
required Short Base value. 
Move probe into the new 
position at the distance of 
2500 mm (or 100 in) from 
the X-Receiver; the said 
distance measured by the 
ISONIC is indicated in the 
Current Result box and its 
value may differ from the 
actual distance if the Current 
Airborne US Velocity and 
Current Airborne Zero 
Offset are not properly 
calibrated.   

 

 

Click on the  or press <Alt>+<L> on the keyboard upon the distance reading at the 
meter becomes equal to the required Long Base value – this will automatically recalculate and setup the 
proper values for the Current Airborne US Velocity and Current Airborne Zero Offset 
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Click on  or press <Alt>+<R> on the keyboard to repeat the above calibration procedure 
 

Click on  or press <Alt>+<C> or Esc  on the keyboard to return to the ISONIC Setup 
window 
 
 
 

 

���� 
 

Perform the Airborne US Velocity Setup at the beginning of the working shift and repeat it only in case of 
10oC change of the ambient temperature entire the working shift 
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23.6.4. Probe Location Monitor Setup 
 

In the ISONIC Setup window 
click on the 

 
or press <Alt>+<L> on the 
keyboard 
 
Place the probe equipped 
with the probe holder and 
emitter of the airborne 
ultrasound on the object 
under test as it is shown on 
the first sketch appeared just 
after opening of the ISONIC 
Probe Location Monitor 
Setup window. The Zero 
Line must be distanced from 
the XYZ line at 90 …150 mm 
(3.55 …5.9 in), said distance 
is indicated in the D2 box.  

Click on  
or press <Alt>+<Z> on the 
keyboard upon 
 

The Base distances B1 
between X-Receiver and Y-
Receiver and B2 between 
the Y-Receiver and Z-
Receiver will be 
automatically defined after 
designating the Zero Line 
while two probe coordinates, 
namely L and W, will be 
determining the probe 
position on the object under 
test 
 

Click on  
or press <Alt>+<R> on the 
keyboard to rearrange the 
Zero Line positioning 
 

Click on  
or press <Alt>+<O> on the 
keyboard to confirm the Zero 
Line designation and to 
return to the ISONIC Setup 
window 

Click on  or press <Alt>+<C> or Esc  on the keyboard to discard the Zero Line 
designation and to return to the ISONIC Setup window 
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23.7. Inspection 
 

23.7.1. Volume Under Test and Data Presentation – Pulse Echo 
 

Refer to the paragraph 16.7.1 of the this Operating Manual and to the note below 
 
 

� 
 

To use instrument screen rationally the Side and End Views are not reproduced while scanning, however all 
necessary data is captured and the said views are available at the postprocessing stage 
 

 
 

23.7.2. Scanning – Pulse Echo 
 
 
 
 
 

 
 
 
 
 
 
 

The above screenshot illustrates the ISONIC screen while scanning using the MULTISCAN-COMBO-SX 
software realizing the Pulse-Echo Inspection and Mapping. The target of the operator is to completely 
"paint" over the Whole Scanning Area providing the necessary testing integrity. The data is recorded 
automatically and the corresponding viewing is observed in real time 

Current A-Scan Current Probe position

Top View  - Partial C-Scan View 
Related to the Current Probe 

Manipulation Area in the 
Automatically Scrolled Subwindow 

C-Scan – Related to the Whole 
Scanning Area 

Frame Designating the Position of the 
Partial C-Scan in the Scanning Area 
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Depth (TOF) Mapping Logic applied to the Global Depth (TOF) Top View Mode: The current lower value 
depth reading (dominating) overwrites the already recorded higher value depth reading if placing the probe 
above the same spot again. The higher value depth reading does not overwrite the already recorded lower 
value depth reading (dominating) if placing the probe above the same spot again 
 

Amplitude Mapping Logic applied to the Global and Sectional Amplitude Top View Mode: The current 
higher amplitude reading (dominating) overwrites the already recorded lower amplitude reading if placing the 
probe above the same spot again. The lower amplitude reading does not overwrite the already recorded 
higher amplitude reading (dominating) if placing the probe above the same spot again 
 

Top View "Repair" Logic: The Map Repair Function is active while scanning and keeping pressed the 
<Space> button on the keyboard – the new depth and amplitude readings unconditionally overwrite already 
recorded data. This allows the map corrections after finding the non-relevant dominating data recorded 
 

Depth (TOF) Top View Map "Marks": Some eventually "unscanable" spots may exist on the scanning 
surface, for example the metal drops, deep surface corrosion, etc. or construction elements, such as rivets, 
bolts, etc. In order to mark the said spots one by one: place probe above each point to be marked and press 
<Shift>+<Space> on the keyboard. The corresponding marks appear over the Top View. To erase a mark 
use the Map Repair Function 
 

 

It is possible to use the different styles of the data presentation while scanning: 

o Click on  or press <Alt>+<A> on the keyboard for the Amplitude C-Scan 
representing 

o Click on  or press <Alt>+<N> on the keyboard for the Depth C-Scan representing 
 

There are another 6 controls available on the ISONIC screen while scanning: 
 

Click on  to scroll the Partial C-Scan View Subwindow related to the current probe manipulation area 
providing the presentation of the current probe position in the center of the said subwindow 

Click on  or press <Alt>+<S> on the keyboard to save a file containing inspection data. 
Proceed according to the paragraph 5.4.19 of this Operating Manual 

Click on  or press <Alt>+<V> on the keyboard to reset to background the Partial C-
Scan View Subwindow without affecting the other captured data – the effect of such action is illustrated 
below: 
 

Before the <Clear View> Click 

 

After the <Clear View> Click 

 
 

Click on  or press <Alt>+<R> on the keyboard to reset to background the whole C-
Scan 

Click on  or press <Alt>+<C> or press Esc  on the keyboard to return 
back to the ISONIC Setup window 

Click on  or press <Alt>+<B> on the keyboard to pause the scanning and 
data capturing – see below paragraph 23.7.4 of the present Operating Manual 
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23.7.3. Scanning – Attenuation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

 
 
 

 
 
 
 
 

The above screenshot illustrates the ISONIC screen while scanning using the MULTISCAN-COMBO-SX 
software realizing the Attenuation Inspection and Mapping. The target of the operator is to completely 
"paint" over the Whole Scanning Area providing the necessary testing integrity. The data is recorded 
automatically and the corresponding viewing is observed in real time 

Current Probe position

Top View  - Partial C-Scan View 
Related to the Current Probe 

Manipulation Area in the 
Automatically Scrolled Subwindow 

Current A-Scan 

Frame Designating the Position of the 
Partial C-Scan in the Scanning Area 

C-Scan – Related to the Whole 
Scanning Area 
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Amplitude Mapping Logic applied to the Top View - Amplitude Map: There are 2 (two) Top View –
Amplitude maps simultaneously recorded while realizing the Attenuation Inspection and Mapping: 
 

� Over Min Map is created based on the following logic � the current lower amplitude reading 
(dominating) overwrites the already recorded higher amplitude reading if placing the probe above the 
same spot again. The higher amplitude reading does not overwrite the already recorded lower 
amplitude reading (dominating) if placing the probe above the same spot again 

 

� Over Max Map is created based on the following logic � the current higher amplitude reading 
(dominating) overwrites the already recorded lower amplitude reading if placing the probe above the 
same spot again. The lower amplitude reading does not overwrite the already recorded higher 
amplitude reading (dominating) if placing the probe above the same spot again 

 

Top View - Amplitude Map "Repair" Logic: The Map Repair Function is active while scanning and keeping 
pressed the <Space> button on the keyboard – the new depth and amplitude readings unconditionally 
overwrite already recorded data. This allows the map corrections after finding the non-relevant dominating
data recorded 
 

Top View - Amplitude Map "Marks": Some eventually "unscanable" spots may exist on the scanning 
surface, for example the metal drops, deep surface corrosion, etc. or construction elements, such as rivets, 
bolts, etc. In order to mark the said spots one by one: place probe above each point to be marked and press 
<Shift>+<Space> on the keyboard. The corresponding mark appears over the Top View. To erase a mark
use the Map Repair Function 
 

It's possible to switch between the maps while scanning by clicking on the  and 

 buttons or pressing <Alt>+<I> and <Alt>+<A> on the keyboard 

 

There are another 6 controls available on the ISONIC screen while scanning; their use is identical to the 
above described in the paragraph 23.7.2 of the present Operating Manual 
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23.7.4. Pause / Continue Scanning 
 

Scanning of the large areas is the time consuming procedure so it’s often necessary to pause the scanning 
procedure with further continuation after some breakout time. For this purpose the MULTISCAN COMBO SX 
Inspection SW Package is featured with the special procedure allowing pausing of the scanning without 
losing already captured data, said procedure is activating automatically upon clicking on the 

 button while scanning (see above paragraphs 23.7.2 and 23.7.3 of the 
present Operating Manual): the temporary swap file containing all data already captured entire the scanning 
will be stored on the ISONIC hard disk, said file is inaccessible through the procedures other then the 
provided while running the MULTISCAN COMBO SX Inspection SW Package. After the automatic saving of 
the temporary swap file there are few continuations becoming possible through the ISONIC Control Menu 
– refer to the above paragraph 23.5 of the present Operating Manual and to the below notes 
 

 

Clicking on  or pressing 
<Alt>+<N> on the keyboard will lead directly to the continuation 
of the paused scanning with the embedding the new data into 
the earlier stored temporary swap file related to the incomplete 
scanning, so it is possible just to continue the scanning from the 
point where it was paused. The obvious musts for that are: 

o  X-, Y- and Z-Receiver to remain at the same 
positions as before pausing the scanning 

o The ultrasonic probe to be the same as it was used 
before pausing the scanning 

 

If clicking on the  or pressing 
<Alt>+<I> on the keyboard after the pausing the scanning then 
the warning as below appears: 

 
It’s necessary to make the proper choice then 
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23.8. Postprocessing 
 
Refer to the paragraphs 7.8, 14.8 and 17.8 of this Operating Manual to get fully instructed on the off-line 
analysis of the scanning data for the Partial C-Scan area (Top View) accompanied with the B- and D-Scans 
(Side and End Views). To select the necessary portion of the scanned data use the scrolling bars as below: 
 
Vertical Scrolling  
 
 
 
 
 
 
 

Before 

 
 
 
 
 
 
 
 

Entire 

 
 
 
 
 
 
 
 

After 
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Horizontal Scrolling 
 
 
 
 
 
 
 

Before 

 
 
 
 
 
 
 

Entire 

 
 
 
 
 
 
 

After 
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24. Operating 'TOFD' Software Package - 
ISONIC TOFD Inspection 

 
 
 
 

The contents of this chapter is valid for the  
TOFD SW Package version 3.1.0.6 or higher 
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24.1. Preparing for the Inspection 
 

24.1.1. Fixture 
 
Place the bar with the receivers of airborne 
ultrasound aside of the scanning area at 
rectangle to the weld. The distance between 
two receivers (Base) on the bar is defined 
as: 
 

Base1 = 200 + Pos1 + Pos2, mm 
or 

Base1 = 8 + Pos1 + Pos2, in 
 

Pos1 and Pos2 are the coordinates of the 
receivers taken form the left and right scales 

of bar correspondingly. Wrong determining of the Base1 causes mistakes in monitoring probe location and 
defects imaging.  
 
Insert ultrasonic probes into their probe holders then: 

•  fix the probe holders with the TOFD probes on the rail at the necessary Base 2 distance (Base 2 is 
the probes separation – refer to the paragraph 24.6.4 of this Operating Manual) 

•  fix the emitter of airborne ultrasound on the TOFD rail 
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24.1.2. Cabling 
 
Refer to the cabling scheme below 

 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 421 of 550  

 

24.2. Start Up 
 

Double click on the icon  located on the ISONIC desktop 
 

24.3. Operating the software: general hints 
 
Refer to the paragraph 7.3 of this Operating Manual 
 

24.4. Getting started... 
 
Refer to the paragraph 7.4 of this Operating Manual 
  
 

24.5. ISONIC Control Menu 
 
Refer to the paragraph 7.5 of this Operating Manual 
 

24.6. Pre-Inspection 
 
24.6.1. Describe the object under test… 
 
Refer to the paragraph 7.6.1 of this Operating Manual  
 
24.6.2. Inspection Data … 
 
Refer to the paragraph 7.6.2 of this Operating Manual 
 
24.6.3. Instrument … 
 
Refer to the paragraph 7.6.3 of this Operating Manual 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 422 of 550  

24.6.4. TOFD Inspection - Ultrasonic Flaw Detector Calibration 
 

A number of parameters will be setup precisely prior to the implementation of the TOFD Inspection. The 
important guidelines below may be easy implemented with the reference to the paragraph 5 of this 
Operating Manual 
 

Probe Delay 
 

Two probes to be used in order to capture the TOFD Map. The Probe Delay to be precisely measured for 
each of them. 
 

Measuring Probe Delay - Miniature Probes (width of the contact face ≤≤≤≤ 12.5 mm / 0.5 in) 
 

 

 
 

Cabling to be according to the above paragraph 
24.1.2 without use of the Out Ang long LEMO 00 – 
LEMO 00 jumper or according to the appropriate 
scheme B.1 through B.5 as per paragraph 4.2.5 of 
the present Operating Manual 
 

Activate the PULSER topic then set: 
 

� Pulser Mode to Single 
� Energy to 120 µµµµJ �UDS 3-3 
� Energy to High�USLT 2000 
� Pulse Width to Spike (240 µµµµJ) for the probe having 

resonant frequency of 8 MHz and higher or to PW 
ns, were PW = 0.5 / F (F is the probe resonant 
frequency) for the probes having resonant frequency 
below 8 MHz �UDS 3-4 

� Damping to 333 ΩΩΩΩ �UDS 3-3 
� Damping to 500 ΩΩΩΩ �USLT 2000 
� Damping to 1000 ΩΩΩΩ �UDS 3-4 
� Tuning to NO�UDS 3-4 

 

Activate the RECEIVER topic then set: 
 

� Display to Full or RF  
� Filter to BB�UDS 3-4 
� Frequency to completely cover the probe's effective 

bandwidth  
 

Activate the BASICS topic then set: 
 

� US Velocity to 5920 m/s (233.1 in/ms) 
� Range to 100.0 mm (4 in) 
� Display Delay to 0 µs 
� Reject to 0% 

 
 

Stage 1: Manipulate the probe over the main 
working surface of the V-2 reference standard and 
maximize the longitudinal wave echo from 50 mm 
(2 in) radius concave surface  
 
Stage 2: Fix the probe in the found position 
 
Stage 3: Tune the Display Delay while the probe 
is still fixed in the found position until rising edge of 
the maximized longitudinal wave echo will match 
with 50%-grid of the A-Scan width: in such case 
the obtained value of Display Delay is equal to the 
actual Probe Delay 

���� 
♦  It's necessary to setup Gain bringing the height of the maximized echo to the level of 75-80% of the A-

Scan height 
 

♦  For the units equipped with UDS 3-4 Pulser Receiver Card it is recommended to optimize Tuning in the 
PULSER submenu upon obtaining the maximized echo. The goal of the optimization is increasing of the 
energy of ultrasonic excitation though the better matching between firing output and probe. Level of the 
energy of ultrasonic excitation is clearly represented by the echo amplitude. Upon completing optimization 
of the Tuning the Gain to be adjusted to bring the height of the maximized echo to the vertical level of 75-
80% of the A-Scan height 
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Measuring Probe Delay - Large and Medium Size Probes (width of the contact face ≥≥≥≥ 12.5 mm / 0.5 in) 

 

 

Cabling to be according to the above paragraph 
24.1.2 without use of the Out Ang long LEMO 00 
– LEMO 00 jumper or according to the appropriate 
scheme B.1 through B.5 as per paragraph 4.2.5 of 
the present Operating Manual 
 

Activate the PULSER topic then set: 
 

� Pulser Mode to Single 
� Energy to 120 µµµµJ �UDS 3-3 
� Energy to High�USLT 2000 
� Pulse Width to Spike (240 µµµµJ) for the probe having 

resonant frequency of 8 MHz and higher or to PW 
ns, were PW = 0.5 / F (F is the probe resonant 
frequency) for the probes having resonant frequency 
below 8 MHz �UDS 3-4 

� Damping to 333 ΩΩΩΩ �UDS 3-3 
� Damping to 500 ΩΩΩΩ �USLT 2000 
� Damping to 1000 ΩΩΩΩ �UDS 3-4 
� Tuning to NO�UDS 3-4 

 

Activate the RECEIVER topic then set: 
 

� Display to Full or RF  
� Filter to BB�UDS 3-4 
� Frequency to completely cover the probe's effective 

bandwidth  
 

Activate the BASICS topic then set: 
 

� US Velocity to 5920 m/s (233.1 in/ms) 
� Range to 200.0 mm (8 in) 
� Display Delay to 0 µs 
� Reject to 0% 

 
 

Stage 1: Manipulate probe over the main working 
surface of the V-1 reference standard and 
maximize the longitudinal wave echo from 100 
mm (4 in) radius concave surface  
 
Stage 2: Fix the probe in the found position 
 
Stage 3: Tune the Display Delay while the probe 
is still fixed in the found position until rising edge of 
the maximized longitudinal wave echo will match 
with 50%-grid of the A-Scan width: in such case 
the obtained value of Display Delay is equal to 
the actual Probe Delay 

���� 
♦  It's necessary to setup Gain bringing the height of the maximized echo to the level of 75-80% of the A-

Scan height 
 

♦  For the units equipped with UDS 3-4 Pulser Receiver Card it is recommended to optimize Tuning in the 
PULSER submenu upon obtaining the maximized echo. The goal of the optimization is increasing of the 
energy of ultrasonic excitation though the better matching between firing output and probe. Level of the 
energy of ultrasonic excitation is clearly represented by the echo amplitude. Upon completing optimization 
of the Tuning the Gain to be adjusted to bring the height of the maximized echo to the vertical level of 75-
80% of the A-Scan height 

 
 
 

 

Supposing the determined values of Probe Delay for the probes pair are PD1 and PD2 the 
Accumulated Probe Delay will be: PD = 0.5•••• (PD1 + PD2) 

In the MEASURE topic the value of Probe Delay to setup equal to PD 
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Direct Measuring of the Accumulated Delay for a Probes Pair  (all types of probes) 
 

 
 

Cabling to be according to the above paragraph 
24.1.2 or according to the appropriate scheme B.6 
through B.10 as per paragraph 4.2.5 of the 
present Operating Manual 
 
Activate the PULSER topic then set: 
 

� Pulser Mode to Dual 
� Energy to 120 µµµµJ �UDS 3-3 
� Energy to High�USLT 2000 
� Pulse Width to Spike (240 µµµµJ) for the probe having 

resonant frequency of 8 MHz and higher or to PW 
ns, were PW = 0.5 / F (F is the probe resonant 
frequency) for the probes having resonant frequency 
below 8 MHz �UDS 3-4 

� Damping to 333 ΩΩΩΩ �UDS 3-3 
� Damping to 500 ΩΩΩΩ �USLT 2000 
� Damping to 1000 ΩΩΩΩ �UDS 3-4 
� Tuning to NO�UDS 3-4 

Activate the RECEIVER topic then set: 
 

� Display to RF  
� Filter to BB�UDS 3-4 
� Frequency to completely cover the probe's effective 

bandwidth  
Activate the BASICS topic then set: 
 

� Display Delay to 0 µs 
� Reject to 0% 

 
 

���� 
 

For the units equipped with UDS 3-4 Pulser 
Receiver Card it is recommended to optimize 
Tuning in the PULSER to increase the energy 
of ultrasonic excitation though the better 
matching between firing output and probe. 
Level of the energy of ultrasonic excitation is 
clearly represented by the signal's amplitude. 
Upon completing optimization of the Tuning 
 

 

Stage 1: Manipulate probes over each other and 
setup of Gain, Range, and USVelocity providing 
firm indication of the signal propagating in the 
probes wedges from emitting to receiving crystal 
and maximize said signal  
 

Stage 2: Fix the probe in the found position 
corresponding to the highest signal amplitude 

 
���� 
It's necessary to setup Gain bringing the 
maximized signal's height to the level of 75-
80% of the A-Scan height 
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Stage 3: Increase Gain to provide the height of 
the first half wave of the received signal to 20 % of 
the total A-Scan height 

 

 
Stage 4: Decrease Range to provide ~ 50% of the 
A-Scan width occupied by the signal 
 
Stage 5: Start increasing of the Display Delay 
aiming displacement of the signal's start to the 
beginning of the A-Scan area 
 
Stage 6: Stop Display Delay manipulation upon 
reaching the target – the value of the Display 
Delay in the appropriate box becomes equal to 
the Accumulated Delay of the Probes Pair  
 

Activate the MEASURE topic and setup Probe 
Delay appropriately 
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Display Delay 
 

Display Delay to be setup through the submenu BASICS depends on the Probe Delay, Probe Separation, 
and US Velocity: 
 

 
Display Delay = Probe Delay + Probe Separation / US Velocity 

 

Here:  
� US Velocity is the actual value of longitudinal wave velocity in the material, of which the object 

under test is made 
� Probe Separation is the distance between incidence points of the emitting and receiving TOFD probes 

measured along the lateral wave trace: 
 

 
Probe separation should be selected based on the TOFD Inspection Procedure. In the ISONIC TOFD 
Inspection SW Package operating surface and in the ISONIC TOFD Inspection Report the Probe Separation 
is designated as Base 2 
 

� 
♦  It's recommended to determine US Velocity right on the object under test using the straight beam 

probe receiving the back echo at the known thickness area 
♦  If the Display Delay is setup properly then A-Scan starts with the rising edge of the lateral wave 

signal 
♦  After separating the probes the value of Base 2 may be determining precisely provided that the 

values of US Velocity and Probe Delay are already setup properly. For that purpose: 
� Gate A (or Gate B) to be activated through the appropriate submenu 
� Lateral wave signal must match with the active Gate A (or Gate B)  
� The rising edge of the lateral wave signal must be the first one crossing the Gate A (or Gate B) 
� The Meas Value to be selected as s(A) or s(B) depending on the active gate (submenu 

MEASURE) 
� The Meas Value to be setup as Flank (submenu MEASURE) 
� The value of Base 2 is determined as 0.5••••s(A) or 0.5••••s(B) where s(A) or s(B) is the digital 

readout generated in the Value box upon getting the rising edge of the lateral wave signal 
crossing the gate level: Base 2 = 0.5••••s(A)  or  Base 2 = 0.5••••s(B) 
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Range 
 
Supposing that US Velocity setup of the ISONIC Pulser Receiver matches with the actual value of 
longitudinal wave velocity in the material, the value of Range expressed in metric or imperial units must 
be setup as: 

 














−+••= ionobeSeparatDepthionobeSeparatinORmmRange Pr

4
Pr2)55.0...51.0(___ 2

2

 

In the above equation the maximal reasonable value for the Depth is the Thickness of the Object under 
test. Actually the value of Range expressed in mm or in has no direct depth reading use due to the non-
linearity of the beam angle spread. The µµµµs expression for the Range may be found from the above as: 
 

Range_µµµµs = Range_mm_OR_in / US Velocity 
 
 

���� 
The above way of the Range setup guarantees the receiving and recording of all pure longitudinal wave 
signals that may occur in the object under test. The representing and recording of the mode conversion 
signals is possible upon increasing the Range accordingly 
 

 
Gain 
 

Based on the Inspection Procedure (Inspection Specs) the Gain may be setup with the reference to the: 
 

� representative flaw sample 
� artificial diffractors in the form of EDM notches or V-shaped notches 
� side drilled holes 
� grain noise 
� lateral wave signal amplitude 

 
Pulser Setup (Sub Menu PULSER) 
 
TOFD Inspection supposes using of 2 probes. Hence the obvious setup for the Pulser Mode is Dual. All 
other settings of the Pulser are as described above under Probe Delay sub-caption in this paragraph 
 
Receiver Setup (Sub Menu RECEIVER) 
 
TOFD Inspection supposes use of the RF signal presentation and recording. Hence the Display must be 
setup to RF. All other settings of the Receiver are as described above under Probe Delay sub-caption in this 
paragraph 
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24.6.5. Probe(s) 
 
 

 
Click on  
 
 
 
 
 
or press <Alt>+<P> on the keyboard –  
the corresponding window 
appears 
 
 
 
 
 
 
 
There are two probe names to be keyed in for the 
implementing of the authentic TOFD mapping. 
The window allowing to key in two probe names 
appears if the Pulser Mode in the ISONIC 
Pulser Receiver window was setup to Dual: 
 

 

 

 
 
 
 

There are some inspections requiring capturing of 
the RF B-Scan Map using the single element 
probe. The window allowing to keying in just one 
probe name appears if the Pulser Mode in the 
ISONIC Pulser Receiver window was setup to 
Single: 

 
 
 
Key in new probe name(s) using the simplest word processing rules for Windows Applications, new name 

must be not longer than 8 symbols. Click on  or press <Alt>+<A> on the keyboard.  

Click on  or press Esc  or <Alt>+<C> on the keyboard upon completing 
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24.6.6. ISONIC System Setup… 
 
 

 
 
 

 

Base 1 – Distance between the microphones (airborne ultrasound receivers) 
 

The value of Base 1 must be selected providing the full coverage of the TOFD probe pair 
manipulation area. To setup or update the value of Base 1 the following manipulations are 
applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<1> ⇒ Base 1 fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 
on the keyboard  (In the Base 1 area digit 1 is underlined) 

 

•  Combined 
 

� Click on Base 1 ⇒ Base 1 fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 
the keyboard 

 

The value for the Base is set in mm or in 
The possible values of increment / decrement for Base are: 

 

Resolution Metric Imperial 
Fine 2 mm 0.25 in 

Medium 10 mm 0.5 in 
Coarse 100 mm 1 in 
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Base 2 – Probe Separation 
 
To setup or update the value of Base 2 the following manipulations are applicable: 
 
•  Mouse 

� Click on the corresponding spin    
 
•  Keyboard 
 
� Pressing <Alt>+<2> ⇒ Base 2 fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons 

on the keyboard  (In the Base 2 area digit 2 is underlined) 
 
•  Combined 
 
� Click on Base 2 ⇒ Base 2 fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on 

the keyboard 
 

The value for the Base is set in mm or in 
The possible values of increment / decrement for Base are: 

 

Resolution Metric Imperial 
Fine 1 mm 0.01 in 

Medium 10 mm 0.1 in 
Coarse 50 mm 1 in 

 
 
����  
The value of Base 2 (Probe Separation) will be stored along with all data in the TOFD Inspection 
results file and used for automatic calculations of the defects depth and heights in the ISONIC TOFD 
Postprocessing SW Package (TOFDPP). Hence it's strictly recommended to key in the proper 
value of the Base 2 
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Thickness – Material Thickness 
 

To setup or update the value of Thickness the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<H> ⇒ Thickness fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard  (In the Thickness area letter h is underlined) 

 

•  Combined 
 

� Click on Thickness ⇒ Thickness fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard 

 

The value for the Thickness is set in mm or in 
The possible values of increment / decrement for Thickness are: 

 

Resolution Metric Imperial 
Fine 1 mm 0.05 in 

Medium 2 mm 0.2 in 
Coarse 5 mm 1 in 

 
Region Width – the Weld Width 
 

To setup or update the value of Region Width the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<W> ⇒ Region Width fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard  (In the Region Width area letter W is underlined) 

 

•  Combined 
 
� Click on Region Width ⇒ Region Width fore color changes to white - then use ↑↑↑↑ , →→→→ , ←←←←, ↓↓↓↓  

buttons on the keyboard 
 

The value for the Region Width is set in mm or in 
The possible values of increment / decrement for Region Width are: 

 

Resolution Metric Imperial 
Fine 1 mm 0.05 in 

Medium 2 mm 0.2 in 
Coarse 5 mm 1 in 

 

 
����  
The values of Thickness and Region Width will be stored along with all data in the TOFD Inspection 
results file and used for the informative purposes only 
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US Velocity 
 

To setup the value of US Velocity the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<U> ⇒ US Velocity fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard  (In the US Velocity area letter U is underlined) 

 

•  Combined 
 

� Click on US Velocity ⇒ US Velocity fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard 

 

The value for the US Velocity is set in m/s or in/ms 
The possible values of increment / decrement for US Velocity are: 

 

Resolution Metric Imperial 
Fine 5 m/s 0.1 in/ms 

Medium 100 m/s 1 in/ms 
Coarse 500 m/s 10 in/ms 

 
 

 
����  
The value of US Velocity must be setup equally with actual longitudinal wave velocity in the 
object under test  
 
 

Region Length – the Scanning Path along / across the weld 
 

To setup or update the value of Region Length the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin    
 

•  Keyboard 
 

� Pressing <Alt>+<N> ⇒ Region Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard  (In the Region Length area letter N is underlined) 

 

•  Combined 
 

� Click on Region Length ⇒ Region Length fore color changes to white - then use ↑↑↑↑  , →→→→ , 
←←←← , ↓↓↓↓  buttons on the keyboard 

 

The value for the Region Length is set in m/s or in/ms 
The possible values of increment / decrement for Region Length are: 

 

Resolution Metric Imperial 
Fine 1 mm 0.05 in 

Medium 2 mm 0.2 in 
Coarse 5 mm 1 in 
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Setup Dynamic Parameters and Modes 
 
 
Scanning Direction – Scanning across or along the weld 
 

Click on  or press <Alt>+<D> on the keyboard to select scanning 
direction either along or across the weld. The corresponding indication is provided. 

 
 
Selection of the scanning start point (Zero Point) 
 

Click on  or press <Alt>+<L> on the keyboard to open the ISONIC 
Probe Location Monitor Setup window 

 
 
Place TOFD probe(s) into the start scanning position then click on  or press <Alt>+<S> on the 
keyboard 

To return back to ISONIC Setup window click on  or press <Alt>+<C> or 

Esc  on the keyboard 
 
 
����  
It's necessary to perform the above procedure prior to each scanning  
 
 
Airborne Ultrasound Velocity 
 
Refer to the paragraph 7.6.5 of this Operating Manual 
 
Coloring (palette) 
 

To select the coloring protocol for the TOFD map – Gray or Thermal refer to the paragraph 7.6.5 of 
this Operating Manual 
 

 
Start TOFD Inspection 

Click on  or press <Alt>+<I> on the keyboard 
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24.7. Inspection 
 
 
 
 
 

 
The above screenshot illustrates the typical screen while scanning using the TOFD software. The target of 
operator is to fill TOFD Map area completely providing the coupling integrity while scanning along the 
selected direction. It's possible to return to the areas, which were scanned with inadequate coupling and to 
rescan them 
 
Refer to the paragraph 7.7 of this Operating Manual to get instructed on control ISONIC while scanning 

Current position along 
the scanning directionTOFD Map 

Limit for deviation 
across the straight 
scanning line 
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24.8. Postprocessing 
 
Refer to paragraph 7.8 of this Operating Manual and to the figures below. For the off-line TOFD image 
processing and defects sizing refer to the Chapter 22 of this Operating Manual  
 
TOFD Postprocessing hints 
 

After loading results from a file the captured TOFD Map screen appears. Click on  
or or press <Alt>+<M> on the keyboard to start the off-line data analysis 
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Rebuild the A-Scan observed along the scanning path 
 
 

Click on  or press <Alt>+<R> on the keyboard to rebuild the A-Scan 
 

 
 
The mouse guided measuring line appears – place it at the selected place of TOFD Map and left mouse click 
– the recovered A-Scan appears
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Click on  or press <Alt>+<M> on the keyboard to place Time of Flight Markers on 
the recovered A-Scan and TOFD map – there are up to 3 markers available  

 
 
To zoom A-Scan just click on it 
 
To print measurements results including TOFD Map and A-Scan with markers click on 

 or press <Alt>+<P> on the keyboard 
 

To end measurements click on  or press <Alt>+<X> or press Esc  on the 
keyboard 
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Some typical TOFD Images are presented below (BS 7706): 
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 25. Operating 'EasyTOFD' Software 
Package - ISONIC EasyTOFD 

 
 
 
 

The contents of this chapter is valid for the  
EasyTOFD SW Package version 1.0.0.9 or higher 
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25.1. Preparing for the Inspection 
 

25.1.1. Fixture 
 
Insert ultrasonic probes into their probe holders then: 

•  fix the probe holders with the TOFD probes on the rail at the necessary Base 2 distance (Base 2 is 
the probes separation – refer to the below paragraph 20.6.4) 

•  fix the incremental encoder on the TOFD rail behind one of the TOFD probes. The encoder's wheel 
must be oriented at parallel to the desired probes' trace either along or across the weld using the 
twister 

 
 
 

 
 
 
 
 
 
TOFD Fixture and encoder positioning 
for scanning along the weld 

 
 
 
 

 
 
 
 
TOFD Fixture and encoder positioning 
for scanning across the weld 

 
 

 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 441 of 550  

 
 

25.1.2. Cabling 
 

Ultrasonic Flaw Detector PC Card Applicable Cabling Scheme Paragraph 
UDS 3-4 B.6; B.7 4.2.5 
UDS 3-3 B.8; B.9 4.2.5 

USLT 2000 B.10 4.2.5 
 

 

25.2. Start Up 
Double click on the icon  located on the ISONIC desktop 

 
 

25.3. Getting started... 
 

The Pulser Receiver Setup screen appears upon starting the EasyTOFD software package. The operating 
surface is identical to the PULREC – ISONIC Pulser Receiver software package, which is explained in 
details in the Chapter 5 of this Operating Manual 
 

 
 

Provide the necessary settings according to the instructions of the paragraph 20.6.4 of this Operating Manual 
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25.4. Inspection and Postrocessing 
 

Click on . The following intermediate window appears: 
 

 
 

 

To proceed further with the scanning click on  or press <Alt>+<I> on 
the keyboard 
 

For the off-line analysis of the stored data click on  or press 
<Alt>+<P> on the keyboard 
 

To return to ISONIC Pulser Receiver window click on  or press 

<Alt>+<C> or Esc  on the keyboard 
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25.4.1. Scanning 
 

The following screen appears prior to the first EasyTOFD scanning session 
 

 
Length 
 

The Length of the scanning line may be setup through the following manipulations 
 

•  Mouse 

� Click on the corresponding spin  
 

•  Keyboard 
 

� Pressing <Alt>+<L> ⇒ Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (due to the letter L is underlined) 

 

•  Combined 
 
� Click on Length ⇒ Length fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 
The value of the Length may vary from 100 to 1000 mm (or 4 to 40 in) in 50 mm (or 2 in) resolution 
 
 

Blank area to be filled 
with the TOFD Map 
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Base 2 (Probes Separation) 
 
The value of Base 2 may be setup through the following manipulations 
 

•  Mouse 

� Click on the corresponding spin  
 

•  Keyboard 
 

� Pressing <Alt>+<B> ⇒ Base 2 fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (due to the letter B is underlined) 

 

•  Combined 
 
� Click on Base 2 ⇒ Base 2 fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 
The value of the Base 2 may vary from 25 to 500 mm (or 1 to 20 in) in 1 mm (or 0.05 in) resolution. The 

increment of the Base 2 modifying may be selected through the clicking on  or pressing <Alt>+<1> on 
keyboard 
 
Scanning Direction 
 
The Scanning Direction may be selected through the following manipulations 
 

•  Mouse 

� Click on the corresponding spin  
 

•  Keyboard 
 

� Pressing <Alt>+<D> ⇒ Scanning Direction fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  
buttons on the keyboard  (due to the letter D is underlined) 

 

•  Combined 
 
� Click on Scanning Direction ⇒ Scanning Direction fore color changes to white - then use ↑↑↑↑  , →→→→ , 

←←←← , ↓↓↓↓  buttons on the keyboard 
 
There are two possible Scanning Directions – Longitudinal (along the weld) and Transversal (across the 
weld) 
 
Encoder Selection 
 
Select the encoder to be used and mouse click on its name: 
 

 
 



Scanning 

Clicking on  or pressing <Alt>+<S> on the keyboard starts scanning and recording of the 

EasyTOFD Map. The  button becomes invisible since the recording of the EasyTOFD Map starts. 

The  button occupies its position. Clicking on  or pressing <Alt>+<S> on the keyboard 

will complete recording of the EasyTOFD Map. The  button becomes invisible after completion of 

the EasyTOFD Map recording. The  button returns to its position 
 

To capture the EasyTOFD Map: 
 

•  Place the TOFD Probes Pair equipped with the encoder onto the start point of the selected scanning 

line and click on  or press <Alt>+<S> on the keyboard 
•  Guide the TOFD Probes Pair over the scanning line: the recording progress bar moves 

synchronously with the probes in both directions – the typical display during the scanning is shown 
and explained below 

 

n 
Current A-Sca
ISONIC Workstation from

 

Recording 
Progress Bar 

Current Probe 
Position  
Start Point
 Sonotron NDT - Operating Manual – Revision 8.00 - Page 445 of 550  
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Other Controls 
 

Click on  or press <Alt>+<C> or Esc  on the keyboard to return to the ISONIC Pulser Receiver 
window 
 

Click on  or press <Alt>+<A> on the keyboard to save the inspection results. The saving procedure 
corresponds to the regular Windows protocols: 
 

 
 
25.4.2. Postprocessing 
 

The off-line analysis and (postprocessing) of the inspection results is implemented in the EasyTOFD SW 
Package identically to the TOFDPP SW Package � refer to the Chapter 22 of this Operating Manual 
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26. Operating 'TOFDPP' Software Package 
- ISONIC TOFD Postprocessing 

 
 
 
 

The contents of this chapter is valid for the  
TOFDPP SW Package version 2.0.0.2 or higher 
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TOFDPP - ISONIC TOFD Postprocessing software package may run either in the ISONIC unit or in the 
regular PC equipped with Windows 98, 2000 or XP operating system 
 

26.1. Start Up 
 

Double click on the icon  located on the ISONIC desktop or click on Start then select Programs � 
ISONIC � ISONIC TOFD Postprocessing 
 

26.2. Opening ISONIC TOFD File (*.rst) / TOFD Postprocessing 
File (*.tfp) / EasyTOFD File (*.eti) / EasyTOFD Postprocessing 
File (*.etp)/ t-TOFD file (*.tfd) / t-TOFD Postprocessing file (*.ttp)   
 

 

 
Select File then Open to open the file 
 
Click on Language to select the User Interface language 
 
Select Exit to end the TOFD Postprocessing  

 

 
 
Select the file to open: the files 
located on the local disks or on 
the disks of the remote 
computers and ISONIC units 
connected to the local area 
networking and having the 
shared directories are available 
for the download. To open the file 
double click on its name 
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The TOFD Map appears and the TOFD Postprocessing Menu becomes active 
 

 
 
 

����  
Depending on the ISONIC setup whilst capturing the TOFD map the following notice may be generated upon 
opening the file: 
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26.3. Submenu 'File' 
 

 

 

Submenu File of the TOFD Postprocessing Menu allows the following operations: 
 

� Save – saving the TOFD Postprocessing file (*.tfp) or EasyTOFD 
Postprocessing file (*.etp) or t-TOFD Postprocessing file (*.ttp) created 
entire the postprocessing session - follow the regular rules for saving files in 
Windows environment 

� Print To – selection of the printer and paper size 
� Print – print the results of postprocessing procedures 
� Exit – exit to the ISONIC TOFD Postprocessing startup window 

 

 

 
Print � Whole Report prints out the graphical page including the 
current TOFD Map on the screen accompanied with measurements 
marks and results and appropriate A-Scan if existing along with 
inspection and setup data 
 

 
Print � Graphics Only prints out only the graphical page including the 
current TOFD Map on the screen accompanied with measurements 
marks and results and appropriate A-Scan if existing 
 

 
 
 
 
 
 
Print � Print To allows printer and paper size 
selection 
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26.4. Submenu 'View' 
 
Depending on the SW Package used for capturing of the TOFD Map the Submenu View may look as below: 
 
 

 
 

 

 

The Color Scale topic allows selecting between Grayscale and 
Thermal representation of the TOFD Map as well as to present it 
either in RF (i.e. raw) or rectified form. The screenshot below 
illustrates an example of the TOFD Map rectifying observed for the file 
captured using EasyTOFD SW Package 
 

 

 
 
The rectifying may be useful for better resolving of the TOFD Map segments corresponding to the weakest 
signals 
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Primary Information – allows to preview 
all data related to the captured TOFD Map 

� Description of the Object 
Under Test (keyed in prior to 
scanning – TOFD SW Package; 
*.rst and *.tfp files) 

� Inspection Data (keyed in prior 
to scanning – TOFD SW 
Package; *.rst and *.tfp files) 

� Ultrasonic Instrument setup 
made prior to scanning – all SW 
Packages and kinds of files 

� Probe(s) name(s) (keyed in prior 
to scanning – TOFD SW 
Package; *.rst and *.tfp files) 

� ISONIC System Setup 
predecessing the scanning 
(keyed in prior to scanning – 
TOFD SW Package; *.rst and 
*.tfp files) 

� Inspector's Comments (keyed 
in prior to scanning – PULREC 
SW Package – t-TOFD mode; 
*.tfd and *.ttp files) 

 
 

����  
Access to the Primary Information data is available directly through the View Submenu for the *.tfd and 
*.ttp files related to the PULREC SW Package – t-TOFD Mode  
 

 

26.5. Submenu 'Parameters' 
 
 
 

Click on the Parameters � the Settings subwindow appears allowing 
to vary the following 3 parameters: 
 

•  US Velocity (Ultrasonic Wave Velocity in the Object Under 
Test – Longitudinal Waves) 

•  Probe Delay – refer to the paragraph 19.6.4 of this Operating 
Manual 

•  Base 2 (Probes separation) 
 
The varying of these parameters may be necessary for the procedures 
belonging to the Edit and Measurements submenus. The target of 
such varying is eliminating of the inaccuracies in the defining and 
keying in of the said parameters that could occur at the pre-inspection 
stage 
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26.5. Submenu 'Edit' 
 

26.5.1. Linearization 
 

To correct for the non-linearity of the beam angle spread this function converts the vertical axis and the whole 
TOFD Map so that a direct depth reading becomes available. To invoke this function select Edit � 
Linearization � On  
 
 

 
 

 
 
To negate this function select Edit � Linearization � Off 

Originally 
Captured 

TOFD Map 

Time Reading

Direct Depth 
Reading 

Linearized 
TOFD Map 
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26.5.2. Lateral Wave Treating 
 
The removal of the Lateral Wave allows detection of near surface cracks/defects, which may have been 
obscured by the Lateral Wave itself. To start the Lateral Wave Treating, select Edit � Lateral Wave � 
Remove…. A series of horizontal and vertical cursors appear allowing selecting of the reference A-Scan, the 
Reference Area (i.e. the Reference Lateral Wave Signal), and the Treating Area. The sequence of the 
screenshots below illustrates all manipulations related to the Lateral Wave Treating 
 

 
# 

 
Screenshot 

 

 
Note 

 
1 

 

 

 
Start Lateral Wave 
Treating:  
 
Edit � Lateral Wave � 
Remove…  

 
2 

 

 
 

 
Selection of the reference 
A-Scan:  
 
Manipulate the vertical 
cursor over the TOFD 
Map using mouse or 
touch screen stylus or 
arrow keys of the 
keyboard. Left mouse 
click or release touch 
screen stylus or press 

Enter  upon 
completing  
 
Right mouse click or 

press Esc  to interrupt 
the Lateral Wave Treating 

Position of the 
Reference A-

Scan along the 
scanning line

Reference  
A-Scan 
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# 

 
Screenshot 

 

 
Note 

 
3 

 

 
 

 
Selection of the 
Reference Area (the start 
and the end of the 
Reference Lateral Wave 
Signal to be designated):  
 
Manipulate the horizontal 
cursor over the TOFD 
Map using mouse or 
touch screen stylus or 
arrow keys of the 
keyboard. The 
corresponding cursor 
synchronously moves 
above the reference A-
Scan, based on which the 
start and end of the 
Reference Lateral Wave 
Signal to be determined 
and designated through 
the left mouse click or 
release touch screen 
stylus or pressing 

4 

 

Enter  on the keyboard 
 
Right mouse click or 

press Esc  to interrupt 
the Lateral Wave Treating 

Designating 
the Start of the 

Reference 
Lateral Wave 

Signal 
(Reference 

Area) 
Designating 
the End of the 

Reference 
Lateral Wave 

Signal 
(Reference 

Area) 
Manual – Revision 8.00 - Page 455 of 550 
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# 

 
Screenshot 

 

 
Note 

 
5 

 

 
 

 
Selection of the Treating 
Area (the start and the 
end of the Treating Area 
along the scanning line to 
be designated):  
 
Manipulate the vertical 
cursor over the TOFD 
Map using mouse or 
touch screen stylus arrow 
keys of the keyboard. Left 
mouse click or release 
touch screen stylus or 

press Enter  upon 
completing  
 
Right mouse click or 

press Esc  to interrupt 
the Lateral Wave Treating 

6 

 
 

 

Designating 
the Start of the 
Treating Area

Designating 
the End of the 
Treating Area
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# 

 
Screenshot 

 

 
Note 

 
7 

  
The Lateral Wave 
Removal is effected 
immediately upon 
completing the 
designating of the end of 
the Treating Area 

8 
Treating Area –
the Lateral 

Wave is 
removed
notron NDT - Operating Manual – Revision 8.00 - Page 457 of 550  

 
 

 
 

Highlight the Treating 
Area: 
 
Edit � Lateral Wave � 
Show Area…  
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# 

 
Screenshot 

 

 
Note 

 
9 

 

 
 

 
Undo highlight of the 
Treating Area: Edit � 
Lateral Wave � Hide 
Area… 

 
Recover the removed Lateral Wave Signal: Edit � Lateral Wave � Restore 
 
 

Treating Area 
is highlighted
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26.5.3. Straightening 
 
To reduce the effects of uneven surfaces, the image may be straightened. To proceed with the Straightening 
select Edit � Straightening � ON. A series of horizontal and vertical cursors appear allowing selecting of 
the reference A-Scan, the Reference Area, and the Treating Area. The sequence of the screenshots below 
illustrates all manipulations related to the Straightening 
 

 
# 

 
Screenshot 

 

 
Note 

 
1 

 

 
 

 
Start Straightening:  
 
Edit � Straightening � 
On  

2 

 
 

Selection of the reference 
A-Scan:  
 
Manipulate the vertical 
cursor over the TOFD 
Map using mouse or 
touch screen stylus or 
arrow keys of the 
keyboard. Left mouse 
click or release touch 
screen stylus or press 

Enter  upon 
completing  
 
Right mouse click or 

press Esc  to interrupt 
the Straightening 

 

Reference  
A-Scan 

Position of the 
Reference A-

Scan along the 
scanning line
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# 

 
Screenshot 

 

 
Note 

 
3 

 

 
 

 
Selection of the 
Reference Area (the start 
and the end of the 
Reference Signal to be 
designated):  
 
Manipulate the horizontal 
cursor over the TOFD 
Map using mouse or 
touch screen stylus or 
arrow keys of the 
keyboard. The 
corresponding cursor 
synchronously moves 
above the reference A-
Scan, based on which the 
start and end of the 
Reference Signal to be 
determined and 
designated through the 
left mouse click or 
release touch screen 
stylus or pressing 

Enter  on the keyboard 
4 
 

 
 

 
Right mouse click or 

press Esc  to interrupt 
the Straightening  

 

Designating 
Start of the 
Reference 

Signal 
(Reference 

Area) 

Designating 
End of the 
Reference 

Signal 
(Reference 

Area) 
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# 

 
Screenshot 

 

 
Note 

 
5 

 

 
 

 
Selection of the Treating 
Area (the start and the 
end of the Treating Area 
along the scanning line to 
be designated):  
 
Manipulate the vertical 
cursor over the TOFD 
Map using mouse or 
touch screen stylus arrow 
keys of the keyboard. Left 
mouse click or release 
touch screen stylus or 

press Enter  upon 
completing  
 
Right mouse click or 

press Esc  to interrupt 
the Straightening  

6 

 
 

 

 

Designating 
Start of the 

Treating Area

Designating 
Start of the 

Treating Area
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# 

 
Screenshot 

 

 
Note 

 
7 

 

 
 

 
The Straightening is 
effected immediately 
upon completing the 
designating of the end of 
the Treating Area 

 
Switch off Straightening: Edit ���� Straightening ���� OFF 
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26.6. Submenu 'Recover A-Scan' 
 
The A-Scan recovery along the captured TOFD Map may be useful for the off-line scanning and visual 
analysis of the suspected image segments 
 

 
# 

 
Screenshot 

 

 
Note 

  

 

 
To proceed select: 
Recover A-Scan ���� ON 
 
Manipulate the vertical 
cursor over the TOFD 
Map using mouse or 
touch screen stylus arrow 
keys of the keyboard. Left 
mouse click or release 
touch screen stylus or 

press Enter  upon 
selecting the A-Scan of 
interest  
 
Right mouse click or 

press Esc  to interrupt 
the A-Scan Recovery  

  

 
 

 

 

Negate the A-Scan Recovery mode: Recover A-Scan ���� OFF 
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26.7. Submenu 'Measurements' 
 

Each indication found on the TOFD Map may be highlighted and evaluated – the Position and the End-to-End 
Distance along the scan line; the Depth and Height of each defect may be determined. To proceed with 
Measurements select Measurements � Add… on the keyboard. The sequence of the screenshots below 
illustrates all manipulations related to the Measurements procedures  
 

 
# 

 
Screenshot 

 

 
Note 

 
1 

 

 
 

 
For the determining of the 
defect Depth and Height  
select Measurements ���� 
Add ���� Height 
 
  

 
2 

 

 
 

 
Selection of the reference 
A-Scan:  
 
Manipulate the vertical 
cursor over the TOFD 
Map using mouse or 
touch screen stylus arrow 
keys of the keyboard. Left 
mouse click or release 
touch screen stylus or 

press Enter  upon 
completing  
 
Right mouse click or 

press Esc  to interrupt 
the Measurements 

 

Position of the 
Reference A-

Scan along the 
scanning line

Reference  
A-Scan 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 465 of 550  

 

 
# 

 
Screenshot 

 

 
Note 

 
3 

 

 

 
Finding the upper tip of the 
defect (the start of the first 
signal diffracted on the 
upper tip of the defect to be 
determined): 
 

Manipulate the horizontal 
cursor over the TOFD Map 
using mouse or touch 
screen stylus arrow keys of 
the keyboard. The 
corresponding cursor 
synchronously moves 
above the reference A-
Scan, based on which the 
first signal diffracted on the 
upper tip of the defect to be 
determined. Left mouse 
click or release touch 
screen stylus or press 

Enter  upon completing  

 
Based on the time of flight of the first signal the depth of the upper tip is calculated automatically   
 

Right mouse click or press Esc  to interrupt the Measurements

Designating the start 
of the first signal 

diffracted on the upper 
tip of the defect  

Depth of the 
upper tip of the 

defect 

Time of flight of 
the first signal  
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# 

 
Screenshot 

 

 
Note 

 
4 

 

 

 
Finding the lower tip of the 
defect (the start of the 
second signal diffracted on 
the lower tip of the defect 
to be determined): 
 

Manipulate the horizontal 
cursor over the TOFD Map 
using mouse or touch 
screen stylus arrow keys of 
the keyboard. The 
corresponding cursor 
synchronously moves 
above the reference A-
Scan, based on which the 
second signal diffracted on 
the lower tip of the defect 
to be determined. Left 
mouse click or release 
touch screen stylus or 

press Enter  upon 
completing  

 
Based on the time of flight of the second signal the height of the defect tip is calculated automatically with 
relate to the early calculated depth of the upper tip  
 

Right mouse click or press Esc  to interrupt the Measurements 
 

Designating the start 
of the second signal 

diffracted on the lower 
tip of the defect  

Height of the 
defect 

Time of flight difference 
between the first signal 

and second signal 
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# 

 
Screenshot 

 

 
Note 

 
5 

 

 

 
The indication is 
highlighted immediately 
upon designating the start 
of the second signal 
diffracted on the lower tip 
of the defect 

 
6 

 

 

 
Double click on the 
highlighted indication (point 
number) recovers the 
corresponding A-Scan with 
the designated start edges 
of the first and second 
diffracted signals. The 
subwindow containing the  
measurements results 
appears: 
� L – position of the 

indication along the 
scanning line 

� D – depth of the upper 
tip of the defect 

� t – time of flight of the 
first signal 

� H – height of the defect 
� dt – time of flight 

difference between the 
first signal and second 
signal 

 

� Click on  to closes the subwindow 

� Click on  to print out the A-Scan corresponding to the highlighted point, the measurements results, 
and the TOFD Map 

� Click on  to erase the highlighted point 
 
 
 

���� 
Up to 10 indications may be highlighted on the TOFD Map simultaneously. Measurements � Clear Last erases 
last made highlighted indication and related measurements. Measurements � Clear All erases all existing 
highlighted indications and related measurements 
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# 

 
Screenshot 

 

 
Note 

 
1 

 

 
 

 
For the determining of the 
defect's Position and the 
End-to-End Distance 
along the scan line select 
Measurements ���� Add 
���� Length 
 
  

2 

 

Selection of the defect:  
 
Manipulate the horizontal 
cursor over the TOFD 
Map using mouse or 
touch screen stylus arrow 
keys of the keyboard. The 
defect may be selected 
through the placement of 
the said horizontal cursor 
above the upper or lower 
tip of the defect. Left 
mouse click or release 
touch screen stylus or 

press Enter  upon 
completing  
 
Right mouse click or 

press Esc  to interrupt 
the Measurements 

Selection of 
the defect's tip 
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# 

 
Screenshot 

 

 
Note 

 
3 

 

 

 
Determining of the 
defect's insonification 
area along the scanning 
line:   
 

Manipulate the vertical 
cursor over the TOFD 
Map using mouse or 
touch screen stylus arrow 
keys of the keyboard to 
determine the left and 
right edges of the defect 
on the TOFD Map 
through reproducing the 
A-Scan sequence 
through the off-line 
scanning. The ends of the 
defect are characterized 
by appearance / 
disappearance of the 
defect's signal  
 

Right mouse click or 

press Esc  to interrupt 
the Measurements 

 
4 

 

 

 
Left mouse click or 
release touch screen 

stylus or press Enter  
upon placing the vertical 
cursor over the first 
defect's end either left or 
right 
 
Right mouse click or 

press Esc  to interrupt 
the Measurements 

Designating of 
the first end of 

the defect 

Manipulating the 
vertical cursor over 
the defect's position 
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# 

 
Screenshot 

 

 
Note 

 
5 

 

 

 
Left mouse click or release 
touch screen stylus or press 

Enter  upon placing the 
vertical cursor over the 
second defect's edge either 
left or right 
 
Right mouse click or press 

Esc  to interrupt the 
Measurements 

 
6 

 

 

 
The indication of the defect's 
longitudinal Position an End-
to-End Distance is 
highlighted immediately 
upon designating the second 
defect's edge 
 

Double click on the 
highlighted indication (point 
number) � the 
measurements results 
appear in the subwindow as: 
� D – depth of the 

selected tip of the defect 
� t – time of flight of the 

appropriate signal 
� L – coordinate of the left 

defect's edge of the 
defect (longitudinal 
Position) 

� W – length of the defect 
(End-to-End Distance) 

� Click on  to closes the subwindow 

� Click on  to print out the A-Scan corresponding to the highlighted point, the measurements results, 
and the TOFD Map 

� Click on  to erase the highlighted point 
 
 
 

���� 
Up to 10 indications may be highlighted on the TOFD Map simultaneously. Measurements � Clear Last erases 
last made highlighted indication and related measurements. Measurements � Clear All erases all existing 
highlighted indications and related measurements 
 
 

Designating of 
the second end 

of the defect 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 471 of 550  

 

 
 
 

 27. Operating 'FLOORMAP-L' Software 
Package - ISONIC FLOORMAP-L 

 
 
 
 

The contents of this chapter is valid for the  
FLOORMAP-L SW Package version 2.1.0.10 or higher 
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27.1. General 
 
FLOORMAP-L is the software package providing the express ultrasonic inspection and mapping of the pitting 
(corrosion) in the large metallic plates either flat or curved. The ultrasonic coverage of the whole plate is 
provided without scanning above the whole surface of the plate. The typical objects under test are: 
 

� Annular plates of the storage tank - inspection from outside 
� Shell and walls of the storage tank - inspection from outside 
� Floor plates of the storage tank - inspection from inside 
� Inaccessible pipe walls – inspection from outside (for example the pipe walls above the concrete 

support, coated pipes, etc.) 
� Walls of the underground storage tanks – inspection from outside 

 

 

The specially designed probe emits the ultrasonic beam 
having the width, duration of the wave package and basic 
wavelength comparable with the thickness of the plate. The 
components of the emitted wave package interfere between 
the plate's surfaces. The probe’s dead zone is located under 
the fillet weld, so the probable echoes from the welding area 
are significantly suppressed. After passing through the fillet 
weld area the ultrasonic wave package saturates the  

volume of the plate while propagating. Pitting and corrosion damage if any returns an echo picked up by the 
probe. 
 

The echo height correlates with the depth and surface dimensions of the pitting (corrosion damage), so the 
degree of the damage may be evaluated through the referring to the amplitude of the received signal.  
 

The defects located on both surfaces of the plate may be detected, however it's impossible to distinguish 
between echoes obtained from the defects belonging to the different surfaces 
 

FLOORMAP-L software package provides the pitting (corrosion damage) mapping of the plate through the 
linear scanning along the plate edge with capturing, processing and storing of all received ultrasonic signals 
(A-Scans). The mapping procedure may be either time-based (timed) or encoded (true-to-scale) 
 

The described principle of the pitting (corrosion damage) detection and mapping is usually applicable for the 
overall inspection range up to 1…1.5 m (40 – 60 in) providing that there is no another weld or plate wedge on 
the way of wave package propagation beside the fillet weld  
 
 

���� 
The high degree of the average scattered plate corrosion, inter-crystal corrosion dropping the elastic 
properties of the plate material and plate coatings of some types may reduce the overall inspection range 
significantly 
 
Summary: 

Restrictions 
•  No discrimination between top and reverse 

side corrosion is possible 
•  The scanning surface must be free of 

impurities, welding droplets, surface 
corrosion and coating (well bonded paint or 
coating is acceptable) 

•  Poor annular plate condition may decrease 
the inspection range 

 

Scope of Applications 
FLOORMAP_L is not restricted to Storage Tank 
Inspection, other applications for the technique 
constantly evolve: 

•  Pipe support areas 
•  Sleeved pipes 
•  Under clamp regions 
•  Under reinforcing plates 

 
 

 
 
   



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 473 of 550  

27.2. Hardware 
 
Probes 
 

The following specially designed ultrasonic probes are required for the inspection with the FLOORMAP-L 
software package: 
 

o Special Probe for the Fast Tank Floor / Wall Inspection for Pitting and Deep Corrosion Damages 
- Thickness Range 6 - 16 mm (0.25 – 0.64 in)– order code S 544007 

 

o Special Probe for the Fast Tank Floor / Wall Inspection for Pitting and Deep Corrosion Damages 
- Thickness Range 12 - 30 mm (0.5 – 1.25 in) – order code S 544008 

 

o Other special probes recommended by Sonotron NDT 
 
Encoder 
 

To observe the encoded (true-to-scale) pitting (corrosion) mapping the below specified encoder must be 
interfaced to the ISONIC: 
 

o Simplest One-Axis Mechanical Encoder with the Probe Clamping Unit - order code SK 2001108 
or SK 2001108 FM 

 
Alternatively the incremental encoders of other manufacturers may be in use provided that they're 
compatible with the ISONIC. For the details contact Sonotron NDT 

 
Reference plate 

 

It is necessary to provide and check the calibration of the unit prior to each inspection session. The 
reference plate containing the artificial defects simulating the different types of the pitting is 
recommended, said reference plate must have the acoustical properties (longitudinal and shear wave 
propagation velocity, attenuation) thickness and curvature differing from the same properties of the 
plate to be inspected in not more than ±10%.  
 

For the compact pitting representation it's recommended to use conically and/or spherically shaped 
drills having different depth and opening: 

 
For the elongated pitting representation it's recommended to prepare the slits in the reference plate, 
said slits must be parallel to one of the plate edges and may have different depth and, for example, 
the cylindrical bottom shape and spherically shaped edges 
 
The EDM notches are not applicable 
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27.3. Cabling and Fixture 
 

Ultrasonic Flaw Detector PC Card Applicable Cabling Scheme Paragraph 
UDS 3-4 B.1; B.2 4.2.5 
UDS 3-3 B.3; B.4 4.2.5 

USLT 2000 B.5 4.2.5 
 

For the encoded (true-to-scale) mapping: 
 

o clamp the probe into encoder  
o connect the encoder's cable to its input on the rear panel of the ISONIC 
 

 

 

Encoder Type 
and notes 
 

 

Fitting probe into encoder 
 

Ready to scan 

 
 

SK 2001108 
 

This encoder has 
the fixed frame. 
Encoder's wheel 
and probe contact 
face are situated on 
the same surface 
(scanning surface) 
This encoder is not 
manufactured by 
Sonotron any more 
since the advanced  
SK 2001108 FM 
model appeared 
 

 

 
 

 
 

SK 2001108 FM 
 

The encoder has 
the frame allowing 
two ways of fitting 
the probe into it:  
 
First way  
The encoder's 
wheel and probe 
contact face are 
situated on the 
same surface 
(scanning surface) 

 

 

 
Second way  
The encoder's 
wheel is situated on 
the surface 
rectangular to the 
scanning surface to 
which the probe 
contact face is 
applied. Actually 
this allows to apply 
the encoder's wheel 
to the shell while 
scanning along the 
annular plate's lip 
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27.4. Start Up 
Double click on the icon  located on the ISONIC desktop 

 

27.5. Getting started... 
 

The Pulser Receiver Setup screen appears upon starting FLOORMAL-L software package. The operating 
surface is identical to the PULREC – ISONIC Pulser Receiver software package, which is explained in 
details in the Chapter 5 of this Operating Manual 
 

 
 

The operating surface is required for the pre-scanning setup of the following parameters / modes: 
 

o Gain 
 

o DAC or TCG (Optionally) 
 

o Range 
 

o US Velocity 
 

o Display Delay 
 

The setup of the listed parameters determines the sensitivity and the overall inspection range 
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27.5.1. US Velocity and Display Delay 
 

The following procedure is recommended for the setup of the Display Delay and US Velocity 
 

 
 

(a) Setup the Range to 750 mm or 30 in  
(b) Setup the US Velocity to 3000 m/s or 120 in/ms (preliminary value) 
(c) Place the probe into position Pos 1 on the reference plate so that the distance between the front 

edge of the probe and the reference plate's edge will be 300 mm or 12 in 
(d) Tune the Gain to provide the height of the echo pulse from the plate's edge 80-90% of the A-Scan 

screen height 
(e) Tune the Display Delay until the rising edge of the plate's edge echo will match with 40% grid on the 

horizontal A-Scan screen scale 
(f) Place the probe into position Pos 2 on the reference plate so that the distance between the front 

edge of the probe and the reference plate's edge will be 600 mm or 24 in 
(g) Tune the US Velocity until the rising edge of the plate's edge echo will match 80% grid on the 

horizontal A-Scan screen scale 
(h) Place the probe into position Pos 1 on the reference plate so that the distance between the front 

edge of the probe and the reference plate's edge will be 300 mm or 12 in 
(i) Repeat steps (e) to (h) until the tuning will not be necessary, i.e. placement of the probe into positions 

Pos 1 and Pos 2 causes the echoes in the positions 40% and 80% on the horizontal scale 
correspondingly. Since that moment the Display Delay and US Velocity are calibrated and setup 
properly: 

 

 

Pos 1

Pos 2
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27.5.2. Gain 
 

Place probe onto the reference plate into the position providing detection of the artificial defect representing 
the smallest defect to be detected observing the distance of 400 – 600 mm (16 – 24 in) between the front 
edge of the probe and the artificial defect. Tune the gain until providing the appropriate echo height of at 
least 60% of the A-Scan screen height 
 
27.5.3. DAC or TCG 
 

Place probe onto the reference plate into the position providing detection of the selected reflector either real 
or artificial defect or the reference plate edge to be detected observing the minimal travel distance between 
the front edge of the probe and the reflector. Follow the instructions of the paragraph 5.4.12 of this Operating 
Manual to store the received signal as the first DAC sequence echo. Move the probe away from the reflector 
keeping it's echo maximized for each new echo to be recorded into the DAC sequence 
 
27.5.4. Range 
 

FOORMAP-L software package provides the creation of 2D map. Range determines the first dimension and 
the Scan Length (L) determines the second dimension of the map to be created. Setup the Range value to 
the required map dimension 
 

27.6. Inspection and Postrocessing 
 

Click on . The following subwindow appears: 
 

 
 

To proceed further with the time-based mapping click on  or press 
<Alt>+<T> on the keyboard 
 

To proceed further with the encoded mapping click on  or press 
<Alt>+<F> on the keyboard 
 

To return to ISONIC Pulser Receiver window click on  or press 

<Alt>+<C> or Esc  on the keyboard 
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27.6.1. Timed Mapping - tFMap 
 
The following screen appears upon starting timed-based mapping 
 
 
 

 
 
 

Blank area to be filled 
with the Pitting Map 
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Scan Length and Scan Time 
 
The Scan Length (L) is the length of the section of the plate to be displayed, over one side of which the 
probe must be driven during the measurement period. Time (Scan Time) is the duration of the said 
measurement period.  
 
To select the required value of Scan Length (L) the following manipulations are applicable: 
 
•  Mouse 

� Click on the corresponding button  or  
 
•  Keyboard 
 
� Pressing <Alt>+<L>  - L fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (due to the letter L is underlined) 
 
•  Combined 
 
� Click on L - L fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 

 
The value of the Scan Length (L) may vary from 100 to 2000 mm (4 to 80 in) in 100 mm (4 in) resolution 
 
 
To select the required value of Scan Time – Time the following manipulations are applicable: 
 
•  Mouse 
 

� Click on the corresponding button  or  
 
•  Keyboard 
 
� Pressing <Alt>+<T>  - Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Time area letter T is underlined) 
 
•  Combined 
 
� Click on Time - Time fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 

 
The value of the Scan Time – Time may vary from 5 to 60 sec; setup is 1 sec resolution 
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DAC Normalization 
 
 

 
 

 
 
 
 
 
 
If the DAC was active prior to switching to the scanning mode then 
the corresponding checkbox appears in the Fmap Control Panel. 
Depending on the selection made the map may be represented either 
normalized to the DAC or not while capturing, said selection may be 
changed entire the scanning without losing the data 

 
Echo Amplitude Palette (Color Scale) 
 
The color coding of echo amplitudes is observed over 48 dB range  (- 6 dB to + 42 dB). There are three 
palettes (color scales) available: 

o Clicking on  or pressing <Alt>+<G> on the keyboard will activate the Gray-Level coloring of 
echo amplitudes 

o Clicking on  or pressing <Alt>+<E> on the keyboard will activate the Thermo-Level coloring 
of echo amplitudes 

o Clicking on  or pressing <Alt>+<R> on the keyboard will activate the Rainbow-Level 
coloring of echo amplitudes 

 
Insert Text Note 
 

A text note may be keyed in to accompany the tFMap record. To proceed click on  or press 
<Alt>+<X> on the keyboard: 
 

 
 
 
 
Click on  or press <Alt>+<K> or Enter  on the 
keyboard to end typing and storing of the note 
 

Click on  or press <Alt>+<C> or Esc  on the 
keyboard to discard the new note / comments 

 



Scanning 
 

Clicking on  or pressing <Alt>+<S> on the keyboard starts the tFMap recording 

The  button becomes invisible since the recording of tFMap starts. The  button occupies its 

position. Clicking on  or pressing <Alt>+<S> on the keyboard will terminate the recording of tFMap 
prior to the automatic completion  

The  button becomes invisible after completion / termination of the tFMap recording. The  
button returns to its position. 
 

To capture tFMap: 
 

•  Place the probe onto the start point of the selected scanning line 

•  Click on  or press <Alt>+<S> on the keyboard 
•  Guide the probe over the scanning line synchronously with the recording progress bar – the typical 

display during the scanning is shown and explained below 
 

n 
Current A-Sca
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Recording 
Progress Bar 
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Storing the Results 
 

Clicking on  or pressing <Alt>+<A> on the keyboard will save the once captured tFMap data and 
accompanying instrument calibration dump into a file. Refer to the paragraph 5.4.19 of this Operating Manual 
to proceed with saving a file 
 
Return to the Pulser Receiver Setup screen 
 

Click on  or press <Alt>+<C> or Esc  on the keyboard 
 
Postprocessing 
 
The postprocessing procedure may be applied either to the recently captured map or to the map loaded from 

a file. To start postprocessing click on  or press <Alt>+<P> on the keyboard. The 
Postrpocessing screen appears: 
 

 
 

The following controls allow managing of the postrocessing procedures: 
 

o  - opening once captured tFMap data and accompanying instrument calibration dump 
from a file. Refer to the paragraph 5.4.20 of this Operating Manual to proceed with opening a file 

 

o  - previewing the comments made at the tFMap capturing time 
 

 

Recently captured or 
loaded from a file map 



o  or  - previewing the instrument calibration dump actual for the captured tFMap 

o  - printing the Floormap-L Report 

o  or pressing Esc  on the keyboard - return to the scanning screen 

o  - redrawing the map using the Gray-Level coloring 

o  - redrawing the map using the Thermo-Level coloring 

o  - redrawing the map using the Rainbow-Level coloring 

o  - Off-line virtual scanning with A-Scan recovery 

Clicking on  will place the cursor above the "scanning line" line allowing the off-line virtual 
scanning. The cursor position matching with the probe's excitation center is accompanied with its 
central beam trace and indicated as A-Scan (mm) 

n 

Probe position 
along the map 
Restored A-Sca
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The virtual scanning may be controlled by the touch screen stylus or mouse or ���� and ���� buttons on 
the keyboard. The A-Scans are recovered and represented dynamically for each cursor position 
 

Upon completing the virtual scanning and selection of the necessary A-Scan (for example –  

representing the maximal echo) release the stylus from the touch screen or click or press Enter  
on the keyboard – this will free the cursor for further procedures 

To switch off the restored A-Scan click on  
 

���� 

It's possible to interrupt the A-Scan recovery by pressing Esc  on the keyboard 
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o  - Filtering the FLOORMAP_L record through the suppressing of the 
echo amplitudes below the selected threshold level 
To proceed click on . As a result: 
 

� The amplitude threshold line representing the threshold level appears above the palette; the 
cursor is "sticked" to the amplitude threshold line, which may be moved up / down either by the 
touch screen stylus or by the mouse or by the ↑↑↑↑  , ↓↓↓↓  buttons on the keyboard 
 

� The value of the amplitude threshold is displayed as Filtering, dB 
 

� Images of the reflectors returning the echo amplitudes below the amplitude threshold are 
erased from the FLOORMAP_L record i.e. rejected 

 

To fix the threshold level left mouse click or release the stylus from the touch screen.  

To switch back to the unfiltered FLOORMAP_L record representation click on  
 

 
 

Amplitude Color 
Scale 

Amplitude 
Threshold 

Filtered Map: all areas corresponding to 
the echo amplitudes below threshold 

are suppressed (white) 
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o  - measuring defect's coordinate and width along the vertical map axis. 
To proceed click on . As a result: 
 

� The first horizontal measuring line appears on the FLOORMAP_L record; the mouse pointer 
is "sticked" to the first horizontal measuring line, which may be moved up / down either by the 
touch screen stylus or by the mouse or by the ↑↑↑↑  , ↓↓↓↓  buttons on the keyboard  

� The position of the first horizontal measuring line is indicated as Wr 
 
To fix the position of the first horizontal measuring line release the stylus from the touch screen or 

left mouse click or press Enter  on the keyboard 
 

 
 
 

 

The first horizontal 
measuring line (1) and its 

position 

1



As a result: 
 
� The second horizontal measuring line appears on the FLOORMAP_L record; the mouse 

pointer is "sticked" to the second horizontal measuring line, which may be moved up / down 
either by the touch screen stylus or by the mouse or by the ↑↑↑↑  , ↓↓↓↓  buttons on the keyboard 

� The position of the second horizontal measuring line is indicated as Wg 
 
To fix the position of the first horizontal measuring line release the stylus from the touch screen or 

left mouse click or press Enter  on the keyboard 
  

n
 
 
 

 
The second horizontal measuring line (2) and its positio
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To negate the horizontal measuring lines click on  
 
 

���� 

It's possible to interrupt measuring procedure by pressing Esc  on the keyboard 
 

 
  
 
 

1

2 
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o  - measuring defect's coordinate and length along the scanning line 
(horizontal axis of the map). To proceed click on . As a result: 

 
 

� The first vertical measuring line appears on the t-ABIScan (ABIScan) record; the cursor is 
"sticked" to the first vertical measuring line, which may be moved left / right either by the touch 
screen stylus or by the mouse or by the ←←←← , →→→→ buttons on the keyboard  

� The position of the first vertical measuring line is indicated as Lr 
 
To fix the position of the first vertical measuring line release the stylus from the touch screen or left 

mouse click or press Enter  on the keyboard 

 

The first vertical 
measuring line (3) and its 

position 

1

2 

  3
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As a result: 
 

� The second vertical measuring line appears on the FLOORMAP_L record; the mouse pointer 
is "sticked" to the second vertical measuring line, which may be moved left / right either by the 
touch screen stylus or by the mouse or by the ←←←← , →→→→ buttons on the keyboard  

� The position of the second vertical measuring line is indicated as Lg 
 

To fix the position of the second vertical measuring line release the stylus from the touch screen or 

left mouse click or press Enter  on the keyboard 
 

 
To negate the vertical measuring lines click on  
 
 

����  

It's possible to interrupt measuring procedure by pressing Esc  on the keyboard 

 

 
DAC Normalization 
 

If the DAC was active while scanning then the corresponding checkbox appears in the Fmap Control Panel 
upon opening the captured file.. Depending on the selection made the map may be represented either 
normalized to the DAC or not  
 
 

 
 

The second vertical 
measuring line (4) and its 

position 1

3 4
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27.6.2. True-to-Scale (Encoded) Mapping - FMap 
 
The following screen appears upon starting the encoded mapping 
 
 
 

 
Encoder Selection 
Select the encoder to be used and click on its name: 
 

 
 

Scan Length 
 

Refer to the paragraph 27.6.1 of this Operating Manual 
 
Echo Amplitude Palette (Color Scale) 
 

Refer to the paragraph 27.6.1 of this Operating Manual 
 

Insert Text Note 
 

Refer to the paragraph 27.6.1 of this Operating Manual 

Blank area to be filled 
with the Pitting Map 



ISON

Scanning 
 

Clicking on  or pressing <Alt>+<S> on the keyboard starts the FMap recording 

The  button becomes invisible since the recording of FMap starts. The  button occupies its 

position. Clicking on  or pressing <Alt>+<S> on the keyboard will terminate the FMap recording  

The  button becomes invisible after completion / termination of the FMap recording. The  button 
returns to its position. 
 

To capture FMap: 
 

•  Place the probe equipped with encoder onto the start point of the selected scanning line (refer to the 
screenshot and accompanying graphics below to understand the probe and encoder orientation with 
relate to the Recording Progress) 

•  Click on  or press <Alt>+<S> on the keyboard 
•  Guide the probe over the scanning line: the recording progress bar moves synchronously with the 

probe in both directions – the typical display during the scanning is shown and explained below 
 

 

n 
Current A-Sca
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Recording 
Progress Bar 

Current Probe 
Position  

(True-to-Scale) 

Start  
Point 
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Storing the Results 
 
Refer to the paragraph 27.6.1 of this Operating Manual 
 
Return to the Pulser Receiver Setup screen 
 

Refer to the paragraph 27.6.1 of this Operating Manual 
 
Postprocessing 
 
Refer to the paragraph 27.6.1 of this Operating Manual 
 
DAC Normalization 
 

Refer to the paragraph 27.6.1 of this Operating Manual 
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28. Operating 'FLOORMAP' Software 
Package - ISONIC FLOORMAP 

 
 
 
 

The contents of this chapter is valid for the  
FLOORMAP SW Package version 3.3.0.7 or higher 
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28.1. General 
 
FLOORMAP is the software package providing the express ultrasonic inspection and mapping of the pitting 
(corrosion) in the large metallic plates either flat or curved. The ultrasonic coverage of the whole plate is 
provided without scanning above the whole surface of the plate. The typical objects under test are: 
 

� Annular plates of the storage tank - inspection from outside 
� Shell and walls of the storage tank - inspection from outside 
� Floor plates of the storage tank - inspection from inside 
� Inaccessible pipe walls – inspection from outside (for example the pipe walls above the concrete 

support, coated pipes, etc.) 
� Walls of the underground storage tanks – inspection from outside 

 

 

The specially designed probe emits the ultrasonic beam 
having the width, duration of the wave package and basic 
wavelength comparable with the thickness of the plate. The 
components of the emitted wave package interfere between 
the plate's surfaces. The probe’s dead zone is located under 
the fillet weld, so the probable echoes from the welding area 
are significantly suppressed. After passing through the fillet 
weld area the ultrasonic wave package saturates the  

volume of the plate while propagating. Pitting and corrosion damage if any returns an echo picked up by the 
probe. 
 

FLOORMAP software package provides the pitting (corrosion damage) mapping of the plate through the: 
 

o continuous linear scanning with the probe along the plate edge / reservoir shell  
 

o probe swiveling near the shell at one or few points in front of mapping area 
 

o combination between linear scanning and swiveling 
 

The true-to-scale map is created using the capturing, processing and storing of all received ultrasonic signals 
in correlation with the probe position and swiveling angle, which are encoded non-mechanically using the 
typical ISONIC airborne ultrasound technique 
 

The described principle of the pitting (corrosion damage) detection and mapping is usually applicable for the 
overall inspection range up to 1…1.5 m (40 – 60 in) providing that there is no another weld or plate wedge on 
the way of wave package propagation beside the fillet weld  
 
 

���� 
The high degree of the average scattered plate corrosion, inter-crystal corrosion dropping the elastic 
properties of the plate material and plate coatings of some types may reduce the overall inspection range 
significantly 
 
Summary: 

Restrictions 
•  No discrimination between top and reverse 

side corrosion is possible 
•  The scanning surface must be free of 

impurities, welding droplets, surface 
corrosion and coating (well bonded paint or 
coating is acceptable) 

•  Poor annular plate condition may decrease 
the inspection range 

 

Scope of Applications 
FLOORMAP is not restricted to Storage Tank 
Inspection, other applications for the technique 
constantly evolve: 

•  Pipe support areas 
•  Sleeved pipes 
•  Under clamp regions 
•  Under reinforcing plates 
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28.2. Hardware 
 
Probes 
 

The following specially designed ultrasonic probes are required for the inspection with the FLOORMAP 
software package: 
 

o Special Probe for the Fast Tank Floor / Wall Inspection for Pitting and Deep Corrosion Damages 
- Thickness Range 6 - 16 mm (0.25 – 0.64 in)– order code S 544007 

 

o Special Probe for the Fast Tank Floor / Wall Inspection for Pitting and Deep Corrosion Damages 
- Thickness Range 12 - 30 mm (0.5 – 1.25 in) – order code S 544008 

 

o Other special probes recommended by Sonotron NDT 
 
Encoder 
 

To observe the pitting (corrosion) mapping it is required the standard set of acoustic sensors for 
mechanics free monitoring location and swiveling angle of manually manipulated ultrasonic probe; said 
set is included into the scope of supply of ISONIC and ISONIC 2001 workstation. The following 
components of the set are required to implement the mapping: 
 

� Double or Single Emitter of Airborne Ultrasound 
� 2 Airborne Ultrasound Receivers 
� Holder for Airborne Ultrasound Receivers – the Bar with Magnetic Attachments to the Object 

Under Test 
� Long Single Cable System 

 
Reference plate 
 

It is necessary to provide and check the calibration of the unit prior to each inspection session. The 
reference plate containing the artificial defects simulating the different types of the pitting is 
recommended, said reference plate must have the acoustical properties (longitudinal and shear wave 
propagation velocity, attenuation) thickness and curvature differing from the same properties of the 
plate to be inspected in not more than ±10%.  
 

For the compact pitting representation it's recommended to use conically and/or spherically shaped 
drills having different depth and opening: 

 
For the elongated pitting representation it's recommended to prepare the slits in the reference plate, 
said slits must be parallel to one of the plate edges and may have different depth and, for example, 
the cylindrical bottom shape and spherically shaped edges 
 
The EDM notches are not applicable 
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28.3. Cabling and Fixture 
 

The probes designed for the implementation of the FLOORMAP software package are equipped with the 
clamper for the airborne ultrasound emitters. Refer to the below sketches to provide the required cabling and 
fixture: 
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CASE 3  
� All kinds of scanning 
� Use of the Double Emitter of 

Airborne Ultrasound S 4055 
� The receivers of airborne ultrasound 

to be placed on the tank shell 
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In order to place the receivers of airborne ultrasound on the tank shell the special fixtu
The placement of the receivers of airborne ultrasound on the tank shell and the accom
are explained below 
 
 

1. Equipping 2 magnetic legs with elbow 

 
 

2. Fitting the legs into the receivers bar 
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re S 2045B is required. 
panying manipulations 
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4. Equipping the cable box with the separate 
magnetic leg 

 

 
 
 
 
 
 
 
 

5. Placement of the bar with the receivers and 
cable box on the shell 
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28.4. Start Up 
 

Double click on the icon  located on the ISONIC desktop 
 

28.5. Getting started... 
 

The Pulser Receiver Setup screen appears upon starting FLOORMAP software package. The operating 
surface is identical to the PULREC – ISONIC Pulser Receiver software package, which is explained in 
details in the Chapter 5 of this Operating Manual 
 

 
 

The operating surface is required for the pre-scanning setup of the following parameters: 
 

o Gain 
 

o DAC or TCG (Optionally) 
 

o Range 
 

o US Velocity 
 

o Display Delay 
 

The setup of the listed parameters determines the sensitivity and the overall inspection range 
 

28.5.1. US Velocity and Display Delay 
 

Refer to the paragraph 27.5.1 of this Operating Manual 
 

28.5.2. Gain 
 

Refer to the paragraph 27.5.2 of this Operating Manual 
 
28.5.3. DAC or TCG 
 

Refer to the paragraph 27.5.4 of this Operating Manual 
 

28.5.4. Range 
 

FOORMAP software package provides the creation of 2D map. Range determines the first and the Scan 
Length (L) determines the second dimension of the map to be created. Setup the Range value as below: 

o For all kinds of scanning (linear + swiveling) or swiveling:  
Range = Y / cos (Maximal Swiveling Angle Allowed) 

here Y is the vertical size of the map to be created 
o For the linear scanning only: Range = Y 
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28.6. Inspection and Postrocessing 
 

To start click on the  button: the subwindow appears on the ISONIC screen: 
 
 

 
 

 

To start the inspection click on  or press <Alt>+<F> on the keyboard  
 

To start the postprocessing click on  or press <Alt>+<P> on the 
keyboard 
 

To return to ISONIC Pulser Receiver window click on  or press 

<Alt>+<C> or Esc  on the keyboard  
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28.6.1. Inspection 
 
At the first pre-inspection stage the value of Base must be keyed in. The distance between two receivers 
(Base) on the bar is defined as: 
 

Base = 200 + Pos1 + Pos2, mm 
or 

Base = 8 + Pos1 + Pos2, in 
 

Pos1 and Pos2 are the coordinates of the receivers taken form the left and right scales of bar 
correspondingly. The value of Base must be known prior to the scanning. Wrong determining of the Base 
causes mistakes in monitoring probe location and swiveling angle and in the defects imaging 
 

 
 
To setup the value of Base the following manipulations are applicable: 
 

•  Mouse 

� Click on the corresponding spin  
 

•  Keyboard 
 

� Pressing <Alt>+<B> ⇒ Base fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 
keyboard  (In the Base area letter B is underlined) 

 

•  Combined 
 

� Click on Base ⇒ Base fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the keyboard 
 
The value of the Base may be vary from 220 to 480 mm (or 9 to 19 in) in 1 mm (or 0.25 in) resolution 
 

 
The value of Base determines the X-size (Length) of the map to be obtained 
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The procedure of Airborne US Velocity calibration must be performed at the first pre-inspection stage at the 
beginning of working shift; it also must be repeated only in case of 10oC change of the ambient temperature 

during the shift. To activate the procedure click on the  button or press <Alt>+<A> on 
the keyboard: the Airborne Ultrasound Velocity Setup window appears – refer to the paragraph 7.6.5 of 
this Operating Manual to get instructed on how to proceed 
 

A text note may be keyed in to accompany the FLOORMAP record. To proceed click on  
or press <Alt>+<M> on the keyboard 
 

 
 
 
 
Click on  or press <Alt>+<K> or Enter  on the 
keyboard to end typing and storing of the note 

Click on  or press <Alt>+<C> or Esc  on the 
keyboard to discard the new note / comments 
 

 

To proceed further to the second pre-inspection stage click on  or press <Alt>+<N> on the 
keyboard 
 

To return to ISONIC Pulser Receiver window click on  or press <Alt>+<C> or Esc  on the 
keyboard 
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At the second pre-inspection stage the probe location monitor must be referred to the Scanning Area. The 
placement of the airborne ultrasound receivers (Microphones Position) must be defined through the click 

on  (or pressing  <Alt>+<S> on the keyboard) or through the click on  (or 
pressing <Alt>+<H> on the keyboard) 
 

After defining the Microphones Position place the probe approximately in the middle of the Scanning Area 

and click on  or press <Alt>+<Z> on the keyboard. 
 

 
 

 
 

To proceed further to the third pre-inspection stage click on  or press <Alt>+<N> on the 
keyboard 
 

To return to the first pre-inspection stage click on  or press <Alt>+<A> on the keyboard 
 

To return to ISONIC Pulser Receiver window click on the  button or press <Alt>+<C> or 
Esc  on the keyboard 
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At the third pre-inspection stage the Probe Swiveling Angle monitor must be switched on or off depending on 
the scanning strategy selected 
 

 

o To negate the Probe Swiveling Angle monitor click on  or press <Alt>+<N> 
on the keyboard 

o To activate the Probe Swiveling Angle monitor click on  or press 
<Alt>+<S> on the keyboard 

 
There are two limits for the Probe Swiveling Angle to be settled (Angle Limits). If the Min limit is setup to 
0 deg then the whole sector defined through the Max limit will be imaged whilst just swiveling the probe 
in the range of [ - Max … + Max]: 

 
If the Min limit is not 0 deg then there are two sectors in the range of [ - Max … - Min] and [ + Min 
… + Max] to be imaged while the sector [ - Min … + Min] will remain not imaged: 
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Setup Min limit to the non 0 deg allows to avoid recording of the echoes from the fillet weld between the 
shell and annular plate, which may mask the close to shell pitting (corrosion damage). If the effect of the 
fillet weld echo is not found prior to the inspection it's recommended to setup Min limit to 0 deg. 
 
To setup the Min limit the following manipulations are applicable: 
 

•  Mouse 
 

� Click on the corresponding spin    
 
•  Keyboard 
 
� Press <Alt>+<I> ⇒ Min fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Min area letter i is underlined) 
 
•  Combined 

 
� Click on Min ⇒ Min fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 

The Min limit may vary from 0 to { Max Limit – 5 o } in 1 o resolution 
 
To setup the Max limit the following manipulations are applicable: 
 

•  Mouse 
 

� Click on the corresponding spin    
 
•  Keyboard 
 
� Press <Alt>+<M> ⇒ Min fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard  (In the Max area letter M is underlined) 
 
•  Combined 

 
� Click on Max ⇒ Max fore color changes to white - then use ↑↑↑↑  , →→→→ , ←←←← , ↓↓↓↓  buttons on the 

keyboard 
 

The Max limit may vary from 10 o or { Min Limit + 5 o } to 30o in 1 o resolution 
 

To return to the second pre-inspection stage click on  or press <Alt>+<A> on the keyboard 
 

To return to ISONIC Pulser Receiver window click on  or press <Alt>+<C> or Esc  on 
the keyboard 

To start scanning procedure click on  or press <Alt>+<K> or Enter  on the keyboard 
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The typical FLOORMAP screen is shown and explained below 
 

 
 
 
 
 
 
 
 
 
 

Click on  or p
accompanying instrument calibration dum
to proceed with saving a file 

Click on  or p
the field for a new data 

Click on  or p
procedure and return to the ISONIC Puls
 
DAC Normalization 
 

Refer to the paragraph 27.6.1 of this Ope
 

This rectangle represents 
the Scanning Area 

 

Pitting (Corrosion 
Damage) Map 

n 

 

This pointer represents the 
current probe position and 
orientation. On case if the 
probe position or orientation
is wrong the pointer is 
replaced with the 
appropriate warning
Current A-Sca
Palette selection
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ress <Alt>+<A> on the keyboard to save the once captured data and 
p into a file. Refer to the paragraph 5.4.19 of this Operating Manual 

ress <Alt>+<R> on the keyboard to erase the captured map freeing 

ress <Alt>+<C> or Esc  on the keyboard to terminate the scanning 
er Receiver window 

rating Manual 
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28.6.2. Postprocessing 
 

 
 

The typical FLOORMAP postprocessing window is shown above. Most of the postprocessing procedures are 
identical with the described above in the paragraph 27.6 of this Operating Manual related to FLOORMAP_L 
software package. To proceed with the FLOORMAP postprocessing just refer to the said paragraph and to 
the below A-Scan recovery instruction 
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To start the off-line virtual scanning with A-Scan recovery   click on    . The 
vertical A-Scan recovery line appears above the map; the position of the lower (starting) point of the said line 
along the map provides the selection of the probe's excitation center position. The cursor is initially "sticked" 
to the map zero line and may be controlled by the touch screen stylus or by mouse. The touch screen stylus 
release or left mouse click will fix the selection of the probe's excitation center position selected for the A-
Scan recovery. After that the cursor becomes "sticked" to the opposite end of the A-Scan recovery line, which 
position now may be controlled by the touch screen stylus or by mouse allowing varying of the insonification 
direction, over which the A-Scan will be recovered - the off-line virtual probe rotation. The touch screen stylus 
release or left mouse click will fix the probe orientation selected for the A-Scan recovery 
 
 

 
For the new selection of the  
A-Scan recovery line click on  

To terminate
click on  

 

               
 
DAC Normalization 
 

Refer to the paragraph 27.6.1 of this Operating Manual 
 

e 

Recovered  
A-Scan 
A-Scan Recovery Lin
anual – Revision 8.00 - Page 509 of 550 

 

 the A-Scan recovery line 
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29. Operating 'DSheet' Software Package - 
ISONIC D-Spreadsheet Creator 

 
 
 
 

The contents of this chapter is valid for the  
DSheet SW Package version 1.1.0.1 or higher 
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29.1. General Information 
 
ISONIC D-Spreadsheet Creator software allows representing of the inspection results obtained using 
CORROMAP, CORROMAP CU, CORROMAP RD, MULTISCAN-COMBO-S, MULTISCAN-COMBO-S CU 
SW Package in the format of the Depth Spreadsheet in Microsoft  Excel 
 
 

���� 
Microsoft  Excel must be installed on the computer prior to running the ISONIC D-Spreadsheet Creator 

 

 
29.2. Conversion of ISONIC Inspection Results into a Depth 
Spreadsheet 
 
The steps for the conversion of the inspection results into the Microsoft  Excel are as follows: 
 

o Start the ISONIC D-Spreadsheet Creator by double click on its icon  located on the desktop or 
through the Windows Programs Menu (Start � Programs � ISONIC � ISONIC D-Spreadsheet 
Creator) 

o In the appearing ISONIC D-Spreadsheet Creator window click on the  button or press 
<Alt>+<O> on the keyboard  
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The standard Windows file selection dialog appears: 

 

o Select the file to be converted and click on the  button or press <Alt>+<O> on the 
keyboard 

 

���� 
ISONIC D-Spreadsheet Creator recognizes only the files created by CORROMAP, CORROMAP CU, 
CORROMAP RD, MULTISCAN-COMBO-S, MULTISCAN-COMBO-S CU software packages 
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o Upon the successful opening of the file its name and the name of Inspection Software Package, 
which was used to create this file appear in the window: 

                            

File Name 

Name of the ISONIC 
Inspection Software 
Package 
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o Select the required conversion resolution for map dimension. The finest resolution (designated as 

“Actual” in the resolution selection boxes) is a resolution of data capturing while creating the file to be 
converted 

 

                     
 

o Upon selection of both conversion resolutions click on 
<Alt>+<E> on the keyboard. The conversion starts then accom
conversion ends the Microsoft  Excel software runs automat
Spreadsheet will appears on the screen 

 

29.3. Understanding the Depth Spreadshee
 

o The Depth Spreadsheet is a table of the inspected object thickne
file was created using the CORROMAP or CORROMAP CU or C
or a table of the minimal reflectors' depths (for the cases when th
MULTISCAN-COMBO-S or MULTISCAN-COMBO-S CU softwar

 
o Each value in the first numerical row designates the L-Co

corresponding column.  
 

o Each value in the first numerical column designates the X-C
corresponding row. 

 
o Cells containing “##” designate the areas with no data captured 

s
Resolution Selection boxe
vision 8.00 - Page 514 of 550 

 button or press 
panied with the progress bar. After 
ically and the just created Depth 

t 
ss (for the cases when the original 
ORROMAP RD software package) 
e original file was created using the 
e package) 

ordinate, in mm or in, for the 

oordinate, in mm or in, for the 
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30. Operating 'MULTIPP' Software 
Package - ISONIC Multiscan Evaluation 

 
 
 
 

The contents of this chapter is valid for the  
MULTIPP SW Package version 2.0.0.3 or higher 
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30.1. General Information 
 

ISONIC MultiScan Evaluation software allows to perform postprocessing of the ISONIC Inspection results 
obtained with CORROMAP, CORROMAP CU, CORROMAP RD, MULTISCAN-COMBO-S, MULTISCAN-
COMBO-S CU either in the office computer or in the instrument 
 

30.2. Start ISONIC Multiscan Evaluation 

Start the ISONIC MultiScan Evaluation by double click on its icon  located on the desktop or through 
the Windows Programs Menu (Start � Programs � ISONIC � ISONIC MultiScan Evaluation Package) 
 

30.3. Getting Started 
 

The following startup window appears upon starting 
 

 
 

Click on File then select the necessary topic to proceed with either file Opening, Language Selection or Exit 
the program: 
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The files located on the local disks or on the disks of remote computers and ISONIC units connected to the 
local area networking and having the shared directories are available for the downloading: 
 

 
 

In the appeared standard Windows file selection dialog select the file for the postprocessing and double click 
on it 
 

 

����  

ISONIC Multiscan Evaluation recognizes only the files created by CORROMAP, CORROMAP CU, 
CORROMAP RD, MULTISCAN-COMBO-S, MULTISCAN-COMBO-S CU software packages 
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30.4. Postprocessing 
 

 
 
 
 
 

 
 
 
 
 
 
Follow the instructions of the paragraphs 7.8, 14.8, 15.8, 16.8, 17.8, and 18.8 of this Operating Manual 
 

Name of the Inspection SW 
Package used for the 

capturing of the   
downloaded file 

Location of the 
downloaded file 
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31. Operating 'IOFFICE' Software Package 
- ISONIC Office 

 
 
 
 

The contents of this chapter is valid for the  
IOFFICE SW Package version 2.0.0.4 or higher 
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31.1. General Information 
 

ISONIC Office software allows observing all-function postprocessing for all types of the uinspection files 
captured using the ISONIC Inspection SW Packages: all postprocessing procedures described in the 
corresponding paragraphs of the Chapters 5 through 24 of this Operating Manual may be implemented in the 
office PC. If the Microsoft  Word is installed in the office PC then at any moment the postprocessing 
screenshot including all graphichs and accompanying setup and / or measurement data may be converted 
into the Microsoft  Word (.doc) file 
 

31.2. Start Up 
 

Start the ISONIC Office by double click on its icon  located on the desktop or through the Windows 
Programs Menu (Start � Programs � ISONIC � ISONIC Office) 
 

 

31.3. ISONIC Office explorer window 
 

 
 

The left panel of the ISONIC Office explorer window allows selecting of the required directory (folder), which 
may be located as on the local disk as on the remote computer or the ISONIC unit provided that the remote 
devices have shared directories allow the Full Access (Not Read Only). The right panel represents all 
readable files from the selected folder. The inspection files located on the local disk are accompanied with 
the name of the Inspection SW Package, which was used for the file creation, and the appropriate icon. The 
Microsoft  Word (.doc) files if existing in the selected folder will be also represented if the Microsoft  Word is 
installed in the office PC 
 

Double click on the file name to open it. Clicking on the Microsoft  Word (.doc) file name runs Microsoft  
Word opening it above the ISONIC Office explorer window. Clicking on the inspection file causes 
transforming of the ISONIC Office explorer window into the corresponding ISONIC Postprocessing window 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 521 of 550  

31.4. ISONIC Office Postprocessing window 
 

ISONIC Office Postprocessing window allows all-functions postprocessing of the uploaded file though the 
Postprocessing Menu  
 

 
 

The contents of the Postprocessing Menu depend on the type of inspection stored in the file. The same 
rules and principles of the off-line data analysis as described above in the corresponding paragraph of the 
Chapters 5 through 24 of this Operating Manual are applicable 
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At any moment the comprehensive Inspection Report or Postprocessing Page including the graphics, setup 
and off-line processing and measurement data may be printed out or converted into the word file: 
 

 
 

•  Select File � Print To � Printer… to designate the necessary printer and paper size 
•  Selection of File � Print To � Microsoft  Word will designate the Microsoft  Word as the default 
•  Selection File � Print depending on the selected printer will print the Inspection report or 

Postprocessing page or convert it into the Microsoft  Word (.doc) file. If so you'll be prompted to key 
in the file name and select the folder for the file creation 

•  Selection File � Exit will return to the ISONIC Office explorer window 
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32. Operating 'CSMAN' Software Package 
- ISONIC Color Scale Manager 

 
 
 
 

The contents of this chapter is valid for the  
CSMAN SW Package version 1.0.0.0 or higher 
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32.1. General Information 
 

CSMAN - ISONIC Color Scale Manager software utility allows to create / import / export / setup the palette 
for the mapping and imaging defects / corrosion using the following software packages: 
 

o I2-SONIC  - Inspection of Planar Butt Joints, scanning from One Side 
 

o PLCROSS - Inspection of Planar Butt Joints, scanning from Both Sides  
 

o LONGWELD - Inspection of the Longitudinal Welds in Pipes, Scanning from Both Sides 
 

o CIRCROSS - Inspection of Circumferential or Spiral Butt Joints, scanning from Both Sides, weld 
diameters 400 mm and more 

 

o SM_PIPE  - Inspection of Small Diameter Welds (80 to 400 mm) 
 

o TRANSCAN - Inspection of Butt Joints for Defects Transversal to the Weld as per HP5/3 Standard, 
scanning from Both Sides and/or Above Machined Weld Enforcement 

 

o CORROMAP – Inspection with Sraight Beam Ultrasonic Probes for Corrosion Mapping and Internal 
Defects, for Example, Delaminations 

 

o CORROMAP - CU – Inspection with Sraight Beam Ultrasonic Probes for Corrosion Mapping and 
Internal Defects, for Example, Delamination  - Scanning above Cylindrical or Quasi-Cylindrical 
Surface (Curvature Radius 40 - 200 mm) 

 

o EXPERT – High Resolution Scanning of Welds (Frontal Resolution - 0.25 mm) 
 

o NOZZLE – Inspection of Nozzle Welds 
 
 

32.2. Start ISONIC Color Scale Manager 
Start the ISONIC Color Scale Manager by double click on its icon  located on the desktop or through 
the Windows Programs Menu (Start � Programs � ISONIC � ISONIC Color Scale Manager) 
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32.3. Getting Started and Operating 
 

The following window appears upon starting: 
 
 
 
 

 
 

 
 
 
 
 
 
 
 

Click On Keyboard Shortcut Action 
 

 
 

 

<Alt> + <N> 
 

Open dialogue for creating a new customized palette 

 

 
 

 

<Alt> + <E> 
 

Open dialogue to edit the existing customized palette 
selected in the Customized Color Scales field 

 

 
 

 

<Alt> + <L> 
 

Delete the existing customized palette selected in the 
Customized Color Scales field 

 

 
 

 

<Alt> + <M> 
 

Import of the customized palette from a disc or network 
device 

 

 
 

 

<Alt> + <X> 
 

Export of the customized palette selected in the 
Customized Color Scales field to a disc or network 
device 

 

 
 

 

<Alt> + <S> 
 

Activation of the palette selected in the Customized 
Color Scales field or among the Standard Color 
Scales field 

 

 

 

<Alt> + <C> or Esc  
 

End of the ISONIC Color Scale Manager session 

 

Standard 
ISONIC 
Color 
Scales' List 

Field for the customized / 
imported color scales' list 

Previewed 
Color Scale 

Name of the 
Currently 
Active Color 
Scale 

Dialogue 
language 
setup 
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33. Operating 'Par2Txt' Software Package 
- ISONIC Par2Txt Coverter 

 
 
 
 

The contents of this chapter is valid for the  
Par2Txt SW Package version 1.0.0.0 or higher 
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33.1. General Information 
 

ISONIC Par2Txt Manager software utility allows to create the *.txt files from the *.par files storing either pure 
A-Scans or A-Scans accompanied with the frequency domain (FFT) graph. Both the A-Scan and FFT 
graphs are data are presented in the ASCII format in the *.txt files. This allows further off-line signal analysis 
using the popular Mathlab, Labview, and the like software packages 
 
 

33.2. Start ISONIC Color Scale Manager 
 
Click on Start then select Programs � ISONIC � ISONIC Par2Txt Converter 
 

33.3. Getting Started and Operating 
 

The window as below appears upon starting 
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Select the file of interest then select File ���� Convert Files: 
 

 
 
As a result the corresponding *.txt file containing the A-Scan graph (and the FFT graph if existing) converted 
into the ASCII format appears 
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34. ISONIC Workstation – Servicing 
Issues 
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34.1. Software Upgrade 
 

34.1.1. Software upgrade for the ISONIC Workstations equipped with an 
internal or external CD ROM / Writer 
 
Internal CD-ROM / Writer 
 

o Insert the CD into the drive 
o Insert the CD into the drive 
o On the ISONIC Workstation double click My Computer icon and then double click the CD drive icon 
o Double click the icon of Software Packages Setup folder 
o For each application to be upgraded perform the following sequence of operations: 

� Double click the icon of the corresponding folder 
� Run setup.exe program placed in this folder 
� The prompt to delete previous installation of application will appear. Click on Yes button and 

follow the instructions appearing on the screen, confirming all requests by clicking on Yes, OK or 
other corresponding buttons 

� Upon uninstall procedure completed run setup.exe program again 
� Follow the instructions appearing on the screen, confirming all requests by clicking on Yes, OK 

or other corresponding buttons 
 
External CD-ROM / Writer 
 

o Connect External CD ROM / Writer Drive to the ISONIC Workstation 
o Insert the CD into the drive 
o On the ISONIC Workstation double click My Computer icon and then double click the CD drive icon 
o Double click the icon of Software Packages Setup folder 
o For each application to be upgraded perform the following sequence of operations: 

� Double click the icon of the corresponding folder 
� Run setup.exe program placed in this folder 
� The prompt to delete previous installation of application will appear. Click on Yes button and 

follow the instructions appearing on the screen, confirming all requests by clicking on Yes, OK or 
other corresponding buttons 

� Upon uninstall procedure completed run setup.exe program again 
� Follow the instructions appearing on the screen, confirming all requests by clicking on Yes, OK 

or other corresponding buttons 
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34.1.2. Software upgrade for the ISONIC Workstations equipped with an 
Ethernet (Network) connection 
 

o Connect the ISONIC Workstation to your local network 
o Switch on the local computer, which is also connected to the local network and equipped with the CD 

drive 
o Provide sharing for the CD drive, i.e. the CD drive must become accessible from the ISONIC 

Workstation via the local network 
o Insert the CD into the drive 
o On the ISONIC Workstation double click Network Neighborhood icon and then find the shared CD 

drive in the network and double click on its icon 
o Double click the icon of Software Packages Setup folder 
o For each application to be upgraded perform the following sequence of operations: 

� Double click the icon of the corresponding folder 
� Run setup.exe program placed in this folder 
� The prompt to delete previous installation of application will appear. Click on Yes button and 

follow the instructions appearing on the screen, confirming all requests by clicking on Yes, OK or 
other corresponding buttons 

� Upon uninstall procedure completed run setup.exe program again 
� Follow the instructions appearing on the screen, confirming all requests by clicking on Yes, OK 

or other corresponding buttons 
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34.1.3. Software upgrade for the ISONIC Workstations not equipped 
with an Ethernet (Network) connection and / or internal or external CD 
ROM / Writer - Using the FastLynx Package 
 
 
What is required 
 

o A desktop or a laptop computer (hereinafter – local computer) equipped with CD-ROM drive and 
parallel port 

o ISONIC Workstation (hereinafter – remote computer) 
o Parallel File Transfer Cable (hereinafter – PFTC, said cable was included into your first upgrade 

package that you received in past) 
o ISONIC Software Upgrade CD-ROM (included into the first upgrade package) 

 
Upgrade the ISONIC Software 
 
The procedure of ISONIC Software Upgrade consists of two stages: 

o Transferring of setup files from the local computer to the remote computer, with the replacing of 
previous files on the remote computer’s HD 

o Installation of new versions of ISONIC Applications on the ISONIC Workstation 
 
Transferring of setup files 
 
 

���� 
All images shown below are for illustration purposes only. The actual content of the disks may differ from the 
content shown on the images 
 

 
Starting the FastLynx program 
 
The file transfer program FastLynx must be started in the following order: 

o Shut down and turn off at least one computer, either local or remote 
o Connect computers using the PFTC 

 

����  

At least on of the computers should be turned off prior to connecting 
the PFTC. Leaving both computers turned on while connecting them 
with PFTC may cause a damage 
 

 
o Turn on both computers and wait while the Windows starts 
o Insert the ISONIC Software Upgrade CD-ROM into the CD drive of the local computer 
o On the remote computer: click on the Start button then click on Run…. Key in “d:\fx\fx.exe” 

in the “Open:” field and click on the OK button 
o On the local computer: click on the Start button then click on Run…. Key in the path to the 

fx.exe program on the ISONIC Software Upgrade CD-ROM in the “Open:” field and click on 
the OK button. For example, if the letter designating the CD-ROM drive is “e:” then key in 
“e:\fx\fx.exe” 
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o At the first stage both local and remote computer will indicate the identical screens as below: 
 

 
 

o On the local computer press Enter key - the following screen appears on the local computer: 
 

 
 

o Since this moment all file transfers can be operated from the local computer only. The 
remote computer will just indicate files transfer progress 
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Operating the FastLynx program on the local computer 
 

o The FastLynx screen is divided into 2 panels. The left panel shows the content of the current 
directory on the local computer. The right panel shows the content of the current directory on 
the remote computer. The file transfer is always performed between current directories, e.g., 
from left to right panel or vice versa 

o There is a gray line (hereinafter – cursor) that controlled by arrows keys on the keyboard. 
The panel containing the cursor is recognized as the active panel. The up and down arrows 
keys will move the cursor up and down inside the active panel. The right and left arrows keys 
will move the cursor from one panel to another 

 
 

���� 
Mouse manipulations are impossible 
 

 
o Each panel has at least two rows. The first row, “*          all files in directory”, is used for 

selection of all files in the current directory at once. The second row, “..             <DIR> move 
up directory” is used for moving up into the parent directory. If the cursor is placed over this 
row, the parent directory will become current directory upon pressing the Enter key  

o Other rows in panels show the names of files and directories contained in current directory. 
The directories are shown in capital letters, the files are shown in small letters.  

o To enter directory, place cursor over its name and press Enter key. 
o To change current directory or drive directly, press F2, key in the path and press Enter 
o To select multiple files, perform the following procedure for each file: 

� Place cursor over file name 
� Press F5 key 
� Selected files will appear in yellow color 

o To start file transfer, press F3 key. To delete selected file(s) press Delete key 
 

 

���� 

 

FastLynx is DOS-based program, which does not support long filenames 
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Transferring Setup files to the ISONIC Workstation 
 
o Make the left panel active then press F2 key 
o Key in the letter of CD-ROM drive of local computer followed by colon and backslash symbols 

(for example “e:\”) then press Enter 
 

 
 

o Make the right panel active then press F2 key 
o Key in “d:\” then press Enter 
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o In the local computer panel: enter the directory named ISONIC~X, where X is a digit. This 
directory will contain directories with setup files of all ISONIC applications to be upgraded. 

o In the remote computer panel: enter the directory named ISONIC~X, where X is a digit. This 
directory will contain directories with setup files of all currently installed ISONIC applications  

 

 
 

o For each ISONIC Application to be upgraded perform the following sequence of operations: 
� On the local and remote computer: enter the directories containing setup files of 

corresponding ISONIC application 
� On the remote computer: select the first row in the panel (e.g., select all files). Press Del 

key. Select Yes then press Enter 
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o In the local computer panel: select the first row in the panel (e.g., select all files). Press F3 
key. The file transfer will start and the file transfer progress will be indicated on the screen: 

 

 
 

o Wait until the “Press any key to continue …” prompt appears then press any key 
 

 
 

o In the local and remote computer panels: select the second row in the panel then press 
Enter (e.g. return to the parent directory) 

o Repeat the procedure for the remaining ISONIC Software Setup Packages 
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Disconnecting the computers 
 

o On both computers press Esc key several times until the prompt to exit the FastLynx 
appears 

o Select Yes then press Enter 
o Shut down and turn off at least one computer, either remote or local 
o Disconnect PFTC 

 
Installation of new versions of ISONIC Applications 
 

o On the ISONIC Workstation double click My Computer icon and then double click the icon of the 
disk D 

o Double click the icon of ISONIC Setup folder 
o For each application to be upgraded perform the following sequence of operations: 

� Double click the icon of the corresponding folder 
� Run setup.exe program placed in this folder 
� The prompt to delete previous installation of application will appear. Click on Yes button and 

follow the instructions appearing on the screen, confirming all requests by clicking on Yes, OK or 
other corresponding buttons 

� Upon uninstall procedure completed run setup.exe program again 
� Follow the instructions appearing on the screen, confirming all requests by clicking on Yes, OK 

or other corresponding buttons 
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34.2. How to use the vacuum attachment system 
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34.3. Use of Yokes 
 

34.3.1. Short Yoke (0.5 m) 
 

 
 

Assembling - Step 1 
 

Assembling - Step 2 
 

 
Assembling - Step 3 

 

 
Assembling - Step 4 
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Assembling - Step 5 

 
Assembling - Step 6 

 

 
Assembling - Step 7 

 

 
Probe Fitting Preparation – 4 X M6 

 
Assembling - Step 8 

 

 
The emitter of airborne ultrasound to be placed above 
the center of the emitting or receiving probes, said 
probes to be oriented coincidentally 
 

  

 

Handling yoke while scanning 
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34.3.2. Long Yokes ( >0.5 m) 
 

 
 

Assembling - Step 1 
 

Assembling - Step 2 
 

 
Assembling - Step 3 

 

 

 
Assembling - Step 4 

 

 



ISONIC Workstation from Sonotron NDT - Operating Manual – Revision 8.00 - Page 544 of 550  

 
Assembling - Step 5 

 
Assembling - Step 6 

 

 
Assembling - Step 7 

 

 
Probe Fitting Preparation – 4 X M6 

 
Assembling - Step 8 

 

 
The emitter of airborne ultrasound to be placed above 
the center of the emitting or receiving probes, said 
probes to be oriented coincidentally 

  

 

Handling yoke while scanning 
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34.4. Assembling and spare parts 
 

 
SC 1000 
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# DRW # Title Q-ty Note 
1 S 80400 Single Card PC 1  
2 SE 20101 Emitters Card 1  
3 SE 20203 Receivers Card 1  
4 S 112000 Pulser Receiver Card 1  
5 SE 20212 Mother Board 1  
6 PD65-40LC DC/DC Adapter 1  
7 512 311-1532 Fan 1  
8 OEM VP110 Micr4omodule - mouse pointer 1  
9 S GF1009 Keyboard 1  

10 23BA-10 Hard disk 1  
11 TA1024 Touch Screen Adapter 1  
12 ZZZCXA-0214 DC/DC Converter 1  
13 SHDLQ64D343 LCD Screen 1  
14 GNZ-24 Touch screen panel 1  
15 SC 1010 Ironwork assy 1  
16 SC 1063 Hard disk adapter 1  
17 SC 1062 Leds holder 1  
18 PSA 00.250. CTL 

C 22 
Connector 2 LEMO SA 

19 SK 2001102 Rechargeable Battery 1  
20 SW DPSR Power switch 1  
21 170M25S Connector 1 Amphenol 
22 350-679 Potentiometer with knob 47 k 1 Vishay 
23 719 09-9765-30-04 Socket 1 Binder 
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SC 1010 
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# DRW # Title Q-ty Note 
1 SC 1020 Front Panel 1  
2 SC 1021 Rear Panel 1  
3 SC 1022 Right Tie 1  
4 SC 1023 Left Tie 1  
5 SC 1024 Cover 1  
6 SC 1025 Bottom 1  
7 SC 1027 Panel 1  
8 SC 1028 First Lath 2  
9 SC 1029 Corner 1  

10 SC 1030 Cramp 1  
11 SC 1031 Cramp 1  
12 SC 1032 Screw 8  
13 SC 1034 Screw 2  
14 SC 1035 Plate 1  
15 SC 1038 Casing 1  
16 SC 1045 Support 2  
17 SC 1046 Link 2  
18 SC 1057 Detent 1  
19 SC 1047 Fals-Panel 1  
20 SC 1048 Fals-Panel 1  
21 SC 1058 Filler 1  
22 SC 1060 Stop 1  
23 SC 1026 Washer 2  
31 61-160-60 Side Arm Assembled 1 Elma 
32 66-308-21 Handle Extrusion 1 Elma 
33 048 2500 114 07 Leg 4 Skiffy 
34 304 4100 400 50 Spacer M4X10X6 4 Skiffy 
36 005 3182 000 02 Spacer 8 Skiffy 
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Remove Cover – Sequence of Moves 
 

# Move 
1 

 
2 

 
3 

 
4 

 
5 

 
6 
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